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1 PREFACE 

The Bruker Compass DataAnalysis 4.0 application (referred to as ‘DataAnalysis’) is the 
state-of-art Windows XP application for processing, advanced data mining, and 
browsing analyses acquired on Bruker Daltonics mass spectrometers, including UV 
and other external data. DataAnalysis is specifically designed to process analyses 
acquired on the esquire/HCT ion trap, the micrOTOF ESI time-of-flight and the APEX 
FTMS mass spectrometers. 
 
DataAnalysis can load multiple analyses at a time. All processed results are stored with 
an analysis for later retrieval or re-processing. Dedicated algorithms are available, e.g., 
for protein/peptide analysis, structural elucidation, and compound identification. The 
most advanced library search of MS, MS/MS, and MS(n) spectra, originally based on 
the NIST algorithm, is available. DataAnalysis also communicates with various 
software packages, such as Bruker Compass TrapControl, micrOTOF control, 
apexControl, BioTools, HyStar, ACD SpecManager and Agilent ChemStation. Data, 
processing results and graphics can be pasted onto the clipboard or exported in 
various file formats including Agilent ChemStation, netCDF, Mascot, XML, mzXML, 
ASCII. Printed reports in various layouts are available and custom layouts can be 
created using the Bruker Compass ReportDesigner. 
 
DataAnalysis can be configured to show commands only related to ESI, APCI and 
APPI instruments (all instruments of the Esquire-, micrOTOF-, and APEX-line) or to 
show also commands related to MALDI instruments (reflex-line). The latter ‘All 
instruments (including MALDI)’ configuration fits all types of instruments mentioned. 
Note: Since DataAnalysis allows switching between different configurations, DataAna-

lysis Help refers to the ‘All instruments’ configuration providing help on all tools 
available in any configuration. Menus, dialog boxes etc are shown, as they will 
appear in the ‘All instruments (including MALDI) configuration if not stated 
otherwise. 

 
DataAnalysis can be used interactively or fully automated using embedded Visual 
Basic Scripting. 
Note: In order to make full use of the build-in VisualBasic scripting using a graphical 

user interface panel, one or more of certain Microsoft applications (e.g., Micro-
soft Office) must be installed. If this module is not available, DataAnalysis will 
assist you in downloading and installing a free version of a minimal application 
(ActiveX Control Pad) containing this module. 

 
The DataAnalysis 4.0 Reference Manual describes the DataAnalysis 4.0 menus and 
commands. Since DataAnalysis allows switching between different configurations, this 
Reference Manual refers to all tools available for processing chromatogram or mass 
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spectrum analyses in any configuration. Features not available in specific configura-
tions are indicated in the corresponding topics. 
 
For reference on how to work with DataAnalysis 4.0, please refer to the DataAnalysis 
4.0 User Manual, and for reference on DataAnalysis automation, please refer to 
DataAnalysis 4.0 Scripting Reference Manual. The DataAnalysis 4.0 manuals are 
available as PDF documents on the installation CD. 
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2 FILE MENU 

The File menu offers the following commands: 

  
Figure 2-1 File menu (when in Compliance mode and BioTools and/or ACD Spec-

Manager is installed) 

Command Used to … 

Open Open the selected analysis. 
Close Close the selected analysis. 
Close All Close all open analyses. 
Save Save the current state of the selected analysis and the process-

ing method attached to it under the same file name. 
Save All Save the current states of all open analyses and the processing 

methods attached to them under the same file names. 
Sign Electronic 

Record 
Sign the saved state of the selected analysis. 
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Command Used to … 

Result History Show the result history of the selected analysis. 
Audit Trail Show the audit trail of the selected analysis in the Bruker 

Daltonics AuditTrailViewer. 
Export Pop up commands for exporting specific data. 
Print Preview Show how a selected report will look if you print it. 
Print Print a selected report on a printer. 
Send Pop up commands for sending a report, analysis or spectrum. 

(If neither BioTools nor ACD SpecManager is installed the Send 
Report To popup command is present instead.) 

Properties Display properties of the selected analysis or mass spectrum. 
Recent file list Open the analysis corresponding to the selected file name. 
Exit Close DataAnalysis. 
 
 
2.1 Open Command 

The Open command is used to open a chromatogram or mass spectrum analysis. This 
command can be applied to multiple selected analyses at once. 
DataAnalysis writes a new, additional result file on each saving operation you perform 
on an analysis. Thus, each analysis contains the raw data and a history of processed 
results. If only one analysis is selected any of the previous results including the raw 
data can be selected for opening. By default, the last result is selected. After the analy-
sis has been loaded it is also possible to load another result from the history using the 
Result History command from the File menu. For multiple selected analyses, always 
the last saved results are loaded.  
On initial loading of a chromatogram analysis separated TIC (Total Ion Chromatogram) 
traces are generated for polarity and MS or MS(n) and displayed in the Chromatogram 
window – yet, up to four traces. In addition, the corresponding TIC ±All trace is avail-
able but initially disabled. For an APEX FTMS analysis, line spectra are created and 
stored. (Note: It is strongly recommended to save the results afterwards. This may take 
some time.) Furthermore, the density data and the spectral background data are 
created as a file during first opening an analysis in DataAnalysis. When initially loading 
a mass spectrum analysis its raw spectrum is displayed in the Mass Spectrum window. 
When opening an analysis again, the last saved result or the respective selected data 
is loaded with the processing method attached and displayed in the corresponding 
windows if these are open. 
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The command opens the Open Analysis dialog, which allows you to specify the 
analysis you want to open. If for the chosen analysis the Result box contains more 
than one result, you can select the result you to be loaded. 
 

  
Figure 2-2 Open Analysis dialog 

Look in and folder list 
Navigate to the drive and folder that contains the analysis you want to open. Double-
click the analysis or select it and click Open. 
You can open several analyses at once using multiple selections if they are all located 
in the same folder. 

Analysis name 
Enter the file name or select it from the folder list. 
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Type 
Select the type of analyses to be displayed in the folder list. 

All Analyses. Lists all files of the following analysis formats. 
Compass Analyses (*.d). Lists *.d files from TrapControl, micrOTOFcontrol, 

apexControl and flexControl analyses.  
Esquire OS/2 Analyses (*.anl;*.msf;*.scs). Lists *.anl, *.msf and *.scs files from 

Esquire OS/2 analyses. 
netCDF Analyses (*.cdf). Lists *.cdf files from netCDF analyses.  
MM1 Analyses (*.mmd). Lists *.mmd files from MM1 analyses. 
XMass Analyses (*.ser;fid). Lists *.ser and fid files from XMass analyses. 
All (*.*). Lists all files available. 

Analysis type 
Type of the selected analysis e.g., ‘MS’, ‘LC/MS’. 

Instrument 
Instrument the selected analysis was acquired with. 

Sample 
Name of the analyzed sample the selected analysis derived from. 

Method 
Method used to acquire the selected analysis. 

Description 
Current description for the selected analysis. This description can be edited in the 
General tab of the Analysis Properties dialog. 

Operator 
Name of the operator who acquired the selected analysis. 

Date 
Date and time the selected analysis was acquired. 

Result 
Select from this list the result you want to load for the selected analysis to be opened. 
You can choose between loading the raw data or a certain saved result. The last saved 
result is set by default. 

Inherit chromatogram trace definitions 
Check this option to carry over the chromatogram trace definitions used for a previous-
ly loaded chromatogram analysis for the analysis you want to open now. All corre-
sponding chromatogram traces will automatically be created on opening the selected 
analysis.  
Note: Inherit chromatogram traces will work, if and only if traces are selected but no 

analysis is selected. 
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Open  
If a single folder is selected, the program opens the folder and displays its contents in 
the folder list. 
If a single analysis is selected and more than one result is available for this analysis, 
the data that is currently loaded and displayed in the corresponding data windows 
depends on the current selection in Result. If several analyses are selected, the 
respective last saved results are loaded. 
If for (a) chromatogram analysis/analyses Inherit chromatogram trace definitions is 
checked, the respective chromatogram traces are created automatically. 

Shortcuts 
Button:  
Keys: Ctrl+O 

 
 
2.2 Close Command 

The Close command closes the selected analysis. It can be applied to multiple 
selected analyses at once. If the current processing state of an analysis you wish to 
close has not been saved yet, a confirmation request will appear asking you if you 
would like to save the current state of processing including the embedded method.  

Shortcuts 
Button:  
Keys: Ctrl+F4 

 
 
2.3 Close All Command 

The Close All command closes all open analyses at once. If the current processing 
state of an open analysis has not been saved yet, a confirmation request will appear 
asking you if you would like to save the current state of processing including the 
embedded method. 
 
 
2.4 Save Command 

The Save command saves the current state of the selected analysis including the 
processing method embedded under the same file name. Each saving operation 
results in a new, additional result file being created and stored for the respective 
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analysis. Existing result files are not overwritten. This command can be applied to 
multiple selected analyses. 

Shortcuts 
Button:  
Keys: Ctrl+S 

 
 
2.5 Save All Command 

The Save All command saves the current states of all open analyses at once, including 
the processing method embedded, under the same file names. Each saving operation 
results in a new, additional result file being created and stored for each analysis. 
Existing result files are not overwritten. 

Shortcuts 
Button: � 
Keys: Shift+Ctrl+S 

 
 
2.6 Sign Electronic Record Command 

Note: The Sign Electronic Record command is available only in Compliance mode. 

The Sign Electronic Record command is used to sign electronically the electronic 
record (= result of an analysis with corresponding method) that corresponds to the 
current result of the selected analysis. An electronic signature consists of operator ID 
and password. Optionally the meaning of signing can be given. Multiple signing of 
results is allowed. 
If you do not want to sign the current but a previous result of the selected analysis you 
have to use the Result History command from the File menu and. In the appearing 
Result History dialog, select the respective result and initiate signing by clicking the 
Sign button. 
Note: Only operators who have the right to sign electronic records can sign a result. If 

the currently logged in operator does not have this right, an operator having this 
right can sign immediately. There is no need to change the logged in operator 
previously. 

Before selecting this command, the selected analysis needs to be saved if changes 
made to it have not been saved yet. 
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The command (or clicking the Sign button in the Result History dialog) opens the 
Sign Electronic Record dialog, which allows you to sign the current (selected) result. 
If the current analysis state has not been saved yet, first a message appears informing 
you that the analysis has been modified and asking if you want to save and sign the 
result. Affirming this request saves the analysis and opens the Sign Electronic 
Record dialog.  

 
Figure 2-3 Sign Electronic Record dialog 

Operator 
Enter your operator ID. 

Password 
Enter your password. 

Meaning 
Enter the meaning of signing the selected result if desired. 

Sign 
If operator ID and password meet and if the respective operator has the right to sign 
electronic records, the specified result is signed. This enters corresponding information 
in the analysis’ result history, which you can show using the Result History command 
from the File menu. 
If operator ID and password do not meet or the operator does not have the right to sign 
electronic records a corresponding error message appears. 

Shortcut 

Button:  
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2.7 Result History Command 

The Result History command is used to view the result history of the selected analysis 
and to load or delete a certain result of it. When DataAnalysis is running in Compliance 
mode, it is also possible to sign a certain result.  
 
The command opens the Result History dialog. Depending on whether DataAnalysis 
is running in Non-Compliance or Compliance mode, the dialog displays different infor-
mation and allows for different operations. Generally, the raw data and all results saved 
for this analysis since its setup are listed along with corresponding information about 
saving date and time, operator who saved as well as whether or not a result was 
deleted. When in Compliance mode, also information on already signed results is 
displayed. 
Note: Saving of various results of the same analysis and, therefore, result history is 

supported only from DataAnalysis version 3.2 on. Thus, a result of an analysis 
that was saved with a previous DataAnalysis version is indicated as ‘Previous 
results’ in result history. In addition, the raw data is listed as ‘Raw data’. 

 

 
Figure 2-4 Result History dialog for an analysis when in Non-Compliance mode 
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Figure 2-5 Result History dialog for an analysis when in Compliance mode 

(Result history list) 
Lists raw data and results that have been saved since analysis setup. This also 
includes already deleted results. An arrow in front indicates the currently loaded result. 
The results are listed with a running number referring to the chronology of saving (No.), 
saving date (Date Saved), who saved (Saved By), whether the result is signed 
(Signed) or deleted (Deleted) and the DataAnalysis version used (Version). 
Note: The Signed column is only available when DataAnalysis is running in Com-

pliance mode. 
 
Additional information for the selected result is displayed below the list concerning the 
following parameters: 

Saved by 
Operator who saved the selected result. For ‘Raw data’ or ‘Previous results’ this infor-
mation is not available. 

Date 
Date and time the selected result was saved. For ‘Raw data’ or ‘Previous results’ this 
information is not available. 
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Program version 
Program version used for saving the selected result. For ‘Raw data’ or ‘Previous 
results’ this information is not available. 

Deleted by 
Operator who deleted the selected result. 

The Signature list displays the following information about signing the selected result: 
Note: This list is only available when DataAnalysis is running in Compliance mode. 

Signer 
Lists the operator(s) who signed the selected result. 

Date 
Date and time the selected result was signed by the named signer. 

Meaning 
Meaning of signing the selected result by the named signer. 

Validity 
Result of signature check for the named signer. 

Load 
Loads the selected result of the open batch file. If changes made to the currently 
loaded result have not been saved yet, first a confirmation request on saving changed 
state will appear. 

Delete 
Deletes the selected result from the active analysis after you have affirmed the corre-
sponding confirmation request. Multiple selected results can be deleted at once. 
Deletion is indicated by a ‘yes’ being entered for this result under Deleted. 
Note: When DataAnalysis is running in Compliance mode, only an operator who has 

the respective right can perform deleting a result. 

Sign 
Allows you to sign the selected result of the active analysis. Opens the Sign Electro-
nic Record dialog (see Sign Electronic Record command). 
Note: The Sign button is only available when DataAnalysis is running in Compliance 

mode. 
Note: Only operators who have the right to sign electronic records can sign a result. If 

the currently logged in operator does not have this right, an operator having this 
right can sign immediately. There is no need to change the logged in operator 
previously. 

Shortcut 

Button:  
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2.8 Audit Trail Command 

Note: The Audit Trail command is available in Compliance mode only. 

The Audit Trail command is used to view the audit trail (= electronic record) of the 
selected analysis. The audit trail records each action happened on the analysis. 
 
The command starts the Bruker Daltonics AuditTrailViewer and loads the audit trail of 
the selected analysis.  
 

 
Figure 2-6 Bruker Daltonics AuditTrailViewer showing audit trail entries for the analy-

sis named in the title bar 

The AuditTrailViewer lists all entries currently contained in the loaded audit trail in 
chronological order by default. Each action is recorded with corresponding Type, 
Operator name, Action happened, what Reason, Program name with version number 
and Date/Time are shown.  
Note: The AuditTrailViewer 4.2 supports two audit trail formats currently used with 
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Bruker Daltonics applications. DataAnalysis audit trails, at present, write a com-
plete sentence in the Action column and do not fill the columns Object, Old 
State and New State. 

When selecting an entry corresponding full information is displayed in the boxes below 
the entries list. You can filter the entries using the various Filter options, which allow 
you to display only the entries you are interested in. In addition, you can sort the entries 
with increasing or decreasing order of a selected column item.  
Note: For detailed information on how to use AuditTrailViewer, please refer to Audit-

TrailViewer help tools.  

Shortcut 

Button:  
 
 
2.9 Export Popup Command 

Pointing to this submenu pops up the following export commands: 

 
Figure 2-7 Export popup 

Command Used to … 

Chromatogram 
Analysis 

Export the selected chromatogram analysis. 

Mass Spectrum Export the selected mass spectrum. 
Compounds Export the Compound List for the selected chromatogram 

analysis or selected compounds. 
Graphic Export the contents of the currently displayed data windows. 
 
 
2.10 Export > Chromatogram Analysis Command 

The Export > Chromatogram Analysis command is used to export the selected 
chromatogram analysis to mzXML, mzData, netCDF, ChemStation or ASCII File format 
to load and process the data with another application (e.g. Excel, Agilent 
ChemStation). In case of the mzXML format, the raw data of the analysis are exported. 
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Line as well as profile spectra can be exported to each format. 
Note: Only one chromatogram must be selected when selecting this command. The 

selected chromatogram will serve as a filter for the type of mass spectral data to 
be exported, except for the export to mzXML format. 

 
The command opens the Export Chromatogram Analysis dialog to specify file name, 
target folder and file format to convert the analysis to as well as the type of spectra to 
export. 
 

  
Figure 2-8 Export Chromatogram Analysis dialog 

Filter by chromatogram 
Displays the type of the selected chromatogram trace that will be used as filter. In case 
of export to mzXML format, this selection has no effect. 

Save in and folder list 
Navigate to the drive and folder in which you want to save the exported file.  
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File name 
Enter a new file name or select an existing name from the folder list. 

Save as type 
Select the file format the chromatogram analysis should be converted to: 

mzXML File (*.mzXML). Converts the raw data to mzXML File format.  
 For detailed description of the mzXML format we refer to the following website: 
 http://sashimi.sourceforge.net/software_glossolalia.html 
mzData File (*.mzData). Converts to mzData File format.  
 For detailed description of the mzXML format, we refer to the following website: 
 http://psidev.info/index.php?q=node/80#mzdata 
netCDF File (*.cdf). Converts to netCDF File format. 
ChemStation File (*.d). Converts to the ChemStation File format. A *.d file can be 

opened in Agilent ChemStation. Specific export options can be defined after click-
ing Options. 

ASCII File (*.ascii). Converts to ASCII File format (Section 2.10.1). An *.ascii file can 
be opened in Excel. 

Spectrum type 
Note: These options are only available if mzXML, mzData, netCDF or ASCII format is 

selected. For ChemStation format, this setting can be made after clicking 
Options. 

Select the type of spectra to be exported for the selected chromatogram analysis: 
Line Spectra. Exports line spectra. 
Profile Spectra. Exports profile spectra. 

Options 
For ChemStation format selected, the software allows you to view the additional infor-
mation that will be exported with the selected analysis. It opens the Export Agilent 
ChemStation Options dialog (see below). You can change and/or supplement the 
information displayed and alter the default export options. 

Save 
For ChemStation format selected, first a sub-folder is created in the chosen target 
folder which is named with the file name (*.d) previously specified in File name. Then 
the software converts the analysis data to the ChemStation format and creates the data 
file MSD1.MS that is stored in the newly created sub-folder. 
For mzXML, mzData, netCDF or ASCII format selected, the software converts the 
selected chromatogram analysis to the selected file format and saves the created file 
under the specified name in the chosen target folder. 
 
Export Agilent ChemStation Options dialog 
You can use the Export Agilent ChemStation Options dialog to view, change, and/or 
supplement additional information that will be exported with the selected chromatogram 

http://sashimi.sourceforge.net/software_glossolalia.html�
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analysis or mass spectrum. The information already contained in this dialog comes 
from general analysis properties stored in the data file. Changing or supplementing this 
information does not affect the stored analysis properties. 

  
Figure 2-9 Export Agilent ChemStation Options dialog for exporting a chromatogram 

analysis 

Under Additional, the general analysis properties currently defined for the selected 
analysis are displayed. You can change and/or supplement this information.  

Operator 
Displays the name of the operator. 

Instrument 
Displays the instrument used for data acquisition. 

Inlet 
Enter the inlet type used. 

Sample Name 
Displays the sample name. 

Misc. Info 
Displays the sample description currently contained in Description of the General tab 
of the Analysis Properties dialog. 

Vial Number 
Displays the vial number. 
 
Under Export, define the following options for export: 
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Divide intensity by 
The ChemStation File format cannot hold intensities higher than 8388096. Thus, if a 
chromatogram analysis or mass spectrum should be exported having intensities 
higher than this maximum value, all intensity values have to be divided. The displayed 
factor is calculated by the program and cannot be set. 

Spectrum type 
Note: These options are only available when exporting a chromatogram analysis. 
Select the type of spectra to be exported for the selected chromatogram analysis: 

Line Spectra. Exports line spectra. 
Profile Spectra. Exports profile spectra. 

OK 
Changes the additional information to be exported and returns to the Export Chroma-
togram Analysis or Export Mass Spectrum dialog. 
 

2.10.1 ASCII File Format (*.ascii) 

The ASCII File format (*.ascii) for exporting chromatogram analyses and mass spectra 
has the following specifications: 

ASCII File format (*.ascii) specifications: 
The format contains one spectrum per row. 
Each row starts with the parameters in the format "retention time, polarity, ionization 
type, MS/MS generation, MS/MS precursor, profile/line spectrum, mass range, number 
of points {/ increment}," with 

- retention time retention time in minutes 
- polarity polarity: {+, -} 
- ionization type ionization type: {ESI, APCI, ...} 
- MS/MS generation MS/MS stage: {ms1, ms2, ...} 
- MS/MS precursor precursor ions: {m1->m2->m3} 
- profile/line spectrum text: {profile, line} 
- mass range mass range: {m1-m2} 
- number of points  number of data points 
- increment optionally for profile spectra with equidistant data points: 
 increment 

The parameters are followed by the data presented either as pairs (m1 i1, m2 i2, m3 i3, 
...) if no increment is given or as vectors (i1, i2, i3, ...) if an increment is given. 
An example looks as follows: 
3.031,+,ESI,ms1,-,line,50.0-550.0,308,50.0 23552,51.0 161280,52.0 1536,53.0 2048,... 
3.049,+,ESI,ms1,-,line,50.0-550.0,289,50.0 23552,51.0 157696,52.0 2560,53.0 512,... 
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2.11 Export > Mass Spectrum Command 

The Export > Mass Spectrum command is used to export the selected mass spec-
trum of the active chromatogram or mass spectrum analysis to Mass Spectrum XML, 
ChemStation, ASCII, Simple x-y ASCII File, BioTools ASCII, ASCII MS Spectrum, 
Mascot Generic or MassList File format to load and process the data with another 
application (e.g. Excel, Agilent ChemStation, BioTools, LibraryEditor, Matrix Science 
Mascot). Line as well as profile spectra can be exported. 
Export of multiple selected mass spectra to Mascot Generic and Mass Spectrum XML 
File format is possible and creates a single file. The other formats can write a single 
spectrum only. 
 
The command opens the Export Mass Spectrum dialog to specify file name, target 
folder and file format the mass spectrum should be converted to.  
 

 
Figure 2-10 Export Mass Spectrum dialog 
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Save in and folder list 
Navigate to the drive and folder in which you want to save the exported file.  

File name 
Enter a new file name or select an existing name from the folder list. 

Save as type 
Select the file format the mass spectrum should be converted to. 

Mass Spectrum XML File (*.xml). Converts to the eXtended Markup Language File 
format. 

ChemStation File (*.d). Converts to the ChemStation File format. A *.d file can be 
opened in Agilent ChemStation. Specific export options can be defined by clicking 
Options. 

ASCII File (*.ascii). Converts to the ASCII File format. An *.ascii file can be opened in 
Excel. 

Simple x-y ASCII File (*.xy). Converts to the Simple x-y ASCII File format containing 
x-y values only.  

BioTools ASCII File (*.bsc). Converts to the BioTools ASCII File format. A *.bsc file 
can be opened and processed in BioTools.  

ASCII MS Spectrum File (*.spectrum). Converts to the ASCII MS Spectrum file 
format (Section 2.11.1), which is fully compatible with NIST format. A *.spectrum 
file can be imported into a user library set up using the LibraryEditor application. 

Mascot Generic File (*.mgf). Converts to the Mascot Generic File format according 
to the Export - Peptide Database Query method parameters for Mascot export. A 
*.mgf file can be used for the BioTools batch search via local Mascot server or for 
the Internet based search via a Mascot server. 

MassList File (*.asc). Converts to an ASCII file format. 

Options 
For ChemStation format selected, the software allows you to view in the appearing 
Export Agilent ChemStation Options dialog (Section 2.10) the additional information 
that will be exported with the selected mass spectrum. You can change and/or supple-
ment this information and alter the default export options. 

Save 
For ChemStation format selected, first a sub-folder is created in the chosen target 
folder which is named with the file name (*.d) previously specified in File name. Then 
the software converts the mass spectrum data to the ChemStation format and creates 
the data file MSD1.MS that is stored in the newly created sub-folder. 
For ASCII, BioTools ASCII, ASCII MS Spectrum, Mascot Generic, Mass Spectrum XML 
or MassList format selected, the software converts the active mass spectrum to the 
selected file format and saves the created file under the specified name in the chosen 
target folder.  
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2.11.1 ASCII MS Spectrum File Format (*.spectrum) 

The ASCII MS Spectrum File format (*.spectrum) for exporting mass spectra is fully 
compatible to the NIST mass spectra file format and has the following specifications: 
Each row of the file is introduced by a special case-insensitive keyword, which is 
immediately followed by a colon, separating the key from the corresponding value(s). 
Spaces or other characters between the keyword and the colon are not allowed. Some 
keywords can be abbreviated; the optional part is listed in parentheses in the table 
below. 
The order of the keywords is irrelevant, but the first one must be the Name keyword 
and the last one must be the Num Peaks keyword. Other keywords are optional, but 
may appear only once (except for the Synonym keyword). 
Note: Some keywords accept only predefined arguments, which are listed in braces. 
 
Keyword Description 
Name This entry is required, only ASCII characters between ' ' 

(ASCII no. 32) and '~' (ASCII no. 126) are allowed, see table II 
a below. For Greek characters, see table II b below. 

CAS The chemical abstracts registry number (with or without '-'). 
NIST The database entry number of NIST libraries. 
UN The four-digit United Nations number of the compound. 
MW The molecular weight in the sense of a nominal mass (an inte-

ger number). 
Form(ula) The chemical formula. 
Syn(onym) A synonym for the compound. This entry can appear multiply.
Com(ment) Any comment. 
Struc(ture) The hexadecimally coded structure information of an MDL® 

MOL file, continuously written in the same line. Each single 
byte value is a two-digit number, where each digit must be a 
hexadecimal number (0..9,A..F,a..f). 
Example: The first five bytes of some arbitrary MDL MOL file 

with the molecule name H2O in the first line should 
start with 

                Structure: 48324F0D0A... 
Cont(ributor) Contributor, recommended as "Name, Organization". 
InstType Type of instrument. Recognized symbols are: {IT, TQ, Q, TOF, 

ICR, FTMS, ESI-TOF}. 
InstName Any description for the instrument. 
IoniMethod Method of ionization. Recognized symbols are: {EI, CI, APCI, 
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Keyword Description 
ESI, nano-ESI, TS, MALDI, CAESIUM, APMALDI, APPI}. 

IonPol(arity) Ion polarity. The following symbols are recognized: {neg or 0
for negative, pos or 1 for positive, -1 for undefined polarity, 
both or 2 for both polarities}. 

MSMS(Stage) An integer number n describing the MS(n) stage. 
PreIon A comma-separated list of precursor ions in m/z (floating-point 

numbers). Although not obligatory, it is recommended to pro-
vide a list of n-1 precursor ions, if the MSMS stage was speci-
fied to be of order n. 

ProdIon A floating-point number describing the product ion in m/z. 
TrapDrive A floating-point number describing the trap drive value of the 

esquire instruments. 
Skim1 A floating-point number describing the skim 1 value of the 

esquire instruments. 
FragAmpl A floating-point number describing the fragmentation ampli-

tude value in V. 
IsolWidth A floating-point number describing the isolation width value in 

m/z. 
TargetGas Any identifier for the target gas. 
TargetGasPres(sure) A floating-point number describing the target gas pressure in 

hPa. 
ReagentIon Any identifier for the reagent ion. 
ReagentGasPres(sure) A floating-point number describing the reagent gas pressure in 

hPa. 
ColEnergy A floating-point number describing the collision energy in eV. 
PeakWidth A floating-point number describing the original mass spectral 

peak width of the raw spectrum in m/z. 
Refl(ector) Integer number describing the reflector mode as linear {0} or 

reflector {1}. 
PSD Integer number describing whether the spectrum is a post 

source decay spectrum {0, 1}. 
ChargeDecon(volved) Integer number denoting whether the spectrum has been 

charge deconvoluted into the singly charged state {0, 1}. 
Date Date and time of the analysis given as a local time in the ISO 

8601 format:  
YYYY-MM-DD[T| ]HH:MM:SS[+|-]hh:mm  
Each item is presented as an integer value, hh:mm  corre-
sponds to the time offset between local time and the Coordi-
nated Universal Time (UTC), such that UTC = local time -
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Keyword Description 
hh:mm 

Column Any description of the chromatographic column. 
RetTime A floating-point number describing the retention time of the 

spectrum in analysis in seconds. 
SSID Unique software system ID of the analysis (Bruker-specific). 
AnalID Unique ID of the analysis (Bruker-specific). 
AnalName Any descriptive identifier of the analysis. 

 
Mass(Range) Two comma-separated floating-point numbers describing the 

lowest and the highest mass values of the MS measurement 
range. 

Num(Peaks) This item is obligatory and must be the last one of the list. The 
format is as follows: An integer number of peaks followed by 
pairs of mass (floating-point) and intensity (floating-point) 
values delimited by characters of the set " \n,;:')([]{}". 

 
List of ASCII symbols allowed in the Name field 
SPACE ! " # $ % & ' ( ) 

* + , - . / 0-9 : ; < 
= > ? @ A-Z [ \ ] ^ _ 
` a-z { | } ~     

 
Greek characters in the Name and Synonym fields can be embedded by placing their 
English transcription between dots: 

Greek characters in the Name and Synonym fields 
.alpha. .beta. .gamma. .delta. .epsilon. .zeta. 
.eta. .theta. .iota. .kappa. .lambda. .mu. 
.nu. .xi. .omicron. .pi. .rho. .sigma. 
.tau. .upsilon. .phi. .chi. .psi. .omega. 
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2.12 Export > Compounds Command 

The Export > Compounds command is used to export compounds found in the 
selected chromatogram analysis to Mascot Generic, Compound XML or Comma 
Separated Values File format to load and process the data with another application 
(e.g. Matrix Science Mascot, Excel). You can export either the complete Compound 
List or one or multiple selected compound(s).  
The command opens the Export Compound List dialog to specify file name, file 
format and target folder the compounds should be exported to. 
 

 
Figure 2-11 Export Compound List dialog 
 

Save in and folder list 
Navigate to the drive and folder in which you want to save the exported file.  

File name 
Enter a new file name or select an existing name from the folder list. 
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Save as type 
Select the file format the compounds should be converted to. 

Mascot Generic File (*.mgf). Converts to Mascot Generic File format according to 
the Export - General and Export - Peptide Database Query method parameters 
for Mascot compound export found in the Method Parameters dialog. Which 
parameters are used depends on the kind of data to be exported. An *.mgf file can 
be used for the BioTools batch search via local Mascot server or for the Internet 
based search via a Mascot server. 

Compound XML File (*.xml). Converts to eXtended Markup Language file format 
according to the Export - General method parameters for XML compound export 
found in the Method Parameters dialog. The mass values for exported com-
pounds use the numeric precision defined in the Display method parameters. 

Comma Separated Values File (*.csv). Converts to Comma Separated Values file 
format. A *.csv file can be opened in Excel. 

Save 
Converts the selected compounds' data of the active chromatogram analysis to the 
selected file format and saves the new file under the specified name in the chosen 
target folder. 
 
 
2.13 Export > Graphic Command 

The Export > Graphic command is used to export a graphic to Windows Enhanced 
Metafile format to insert the graphic in an appropriate application (e.g. Window Office 
applications). The graphic file includes all currently opened data windows and the data 
displayed except the title and scroll bars. If you export a graphic containing the Chro-
matogram window or Mass Spectrum window, a legend is automatically added to the 
respective data window that indicates the chromatograms or mass spectra displayed.  
Note: You can use the Copy command from the Edit menu to copy a graphic for a 

single data window (e.g. Chromatogram window) to the clipboard in order to 
paste it directly into the desired application. However, this applies only to the 
currently active data window and does not store a permanent graphics file 
(*.emf). 

 
The command opens the Export Graphic dialog to specify file name and target folder. 
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Figure 2-12 Export Graphic dialog 

Save in and folder list 
Navigate to the drive and folder in which you want to save the exported file.  

File name 
Enter a new file name or select an existing name from the folder list. 

Save as type 
Select the file format the graphic is to be converted to. 

Windows Enhanced Metafiles (*.emf). Converts to the Windows Enhanced Meta-
file format.  

Save 
Converts the graphic to the Windows Enhanced Metafiles format and saves the graphic 
file under the specified name in the chosen target folder.  
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Figure 2-13 Exported graphics file showing the contents of the currently open Chro-

matogram window and Compound Spectra window (example) 
 
 
2.14 Print Preview Command 

The Print Preview command is used to preview the selected report before printing it. It 
shows on the screen how the report will look if you print it. This allows you to first look 
at the report, and decide whether it should be printed or sent. All layouts can be printed 
in portrait and landscape format. 
When using this command, the DataAnalysis window is replaced by the Report Pre-
view window that displays the selected report in its printed format. The Report Preview 
toolbar offers you options to toggle between different display sizes, to zoom in and out 
of pages, to browse through the report, to initiate a print job and to return to the 
DataAnalysis window. 
 
The command opens the Print Preview dialog, which allows you to select the report 
layout you want to preview as well as printer settings. If on selecting this command the 
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current processing state of a selected analysis has not been saved yet, first a 
corresponding message appears that asks you about saving the respective analysis. 
Affirm this request, to save the analysis and open the Print Preview dialog. 
 

  
Figure 2-14 Print Preview dialog 

In Printer select the printer and print properties to be used: 
Name 
Displays the currently connected printer. If you wish to use another printer, select it 
from this list. 

Properties 
Allows you to define page set up and further options for the selected printer. Opens the 
Properties of 'printer' dialog, which is printer specific. Select e.g. the printer orienta-
tion to print the report in Portrait or Landscape format. 

Status 
Displays the status of the selected printer. 

Type 
Displays the type of the selected printer. 
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Where 
Localizes the selected printer. 

Comment 
Displays a comment, if available. 

In Print range, the All option is permanently checked for printing the entire report.  

In Copies, select how many copies of the selected report you wish to print:  
Number of copies 
Enter or select the number of copies you wish to print.  

Collate 
Check this option if the printer should print copies in page number order, instead of 
separated multiple copies of each page. This option is only available when the selected 
printer is able to sort copies. 

 (Print sequence for copies) 
Displays the print sequence for copies. This sequence depends on whether Collate is 
checked or unchecked. 
 
In Report Layout, select the report layout you wish to print. Appropriate report layouts 
depending on the instrument used are listed automatically. 

Instrument 
Displays the instrument for which appropriate report layouts are listed in Layout.  
The instrument used for acquiring the selected analysis is selected by default, e.g. 
'Esquire'. If multiple analyses are selected originating from different instruments, '<inde-
pendent>' is selected. 
If you want to select a layout appropriate for another instrument category, uncheck 
Select automatically to enable this list box and select the desired category. This sub-
sequently lists the corresponding layouts in Layout.  
The following categories are available: 

<all>. Lists all layouts available. 
<independent>. Lists instrument-independent layouts. 
APEX. Lists apex layouts. 
APEX-XMASS. Lists apex-XMass layouts. 
Esquire. Lists esquire layouts. 
micrOTOF. Lists micrOTOF layouts. 
micrOTOF-Q. Lists micrOTOF-Q layouts. 

Select automatically 
Check this option to list automatically report layouts appropriate for the instrument used 
for acquiring the selected analysis. This selects the respective instrument in Instru-
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ment and lists corresponding layouts in Layout. Uncheck this option if you want to 
select a layout set up for another instrument. Default is checked. 
Layout 
Lists the report layouts appropriate for the category selected in Instrument. Select 
from this list the type of report you want to print.  

ReportDesigner 
Starts the ReportDesigner and loads the report layout selected in Layout. The Report-
Designer allows you to create your own report layouts. 
Note: If you want to create a new report layout, it is recommended not to modify the 

original layout but to save the modified layout under a new file name. Other-
wise, there is a risk that your changed layout version becomes overwritten by a 
later system upgrade. 

Note: New DataAnalysis layouts must be saved to: "C:\BDALSystemData\Report 
Layouts\DataAnalysis". Otherwise, DataAnalysis will not list them in Layout. 

Preview 
Creates the specified report for the active analysis and displays it in the Report Preview 
window on the screen. 
If the selected report type requires saved processed data, a confirmation request will 
appear to prompt you to save the data.  
 

Shortcut 
Button:  

 
 
2.15 Print Command 

The Print command is used to print a selected report directly on a printer. All layouts 
can be printed in portrait and landscape format. 
Note: With older printer models, there might be the problem that printing of a report 

takes a very long time. To overcome this, a registry switch now supports faster 
printing on printers with insufficient firmware performance (see below). 

Tip: You can directly print a report using the least recently selected printer and 

report layout by clicking the Print toolbar button . 
 
The command opens the Print dialog, which allows you to select the report layout you 
want to print and to specify the destination printer, other printer setup options, and the 
number of copies. If on selecting this command the current processing state of a 
selected analysis has not been saved yet, first a corresponding message appears that 
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asks you about saving the respective analysis. Affirm this request, to save the analysis 
and open the Print dialog. The Print dialog is the same as the Print Preview dialog 
described in Section 2.14 except that the Preview button is changed into the OK 
button. 

OK 
Creates the specified report and prints it on the selected printer. 
If the selected report type requires saved processed data, a confirmation request will 
appear to prompt you to save the data. 

Shortcuts 
Button:  
Keys: Ctrl+P 

 
 
2.15.1 Support for Printing on Older Printer Models 

With older printer models, there might be the problem that printing of a report takes a 
very long time since the firmware is too slow when converting the vector graphic into a 
bitmap graphic. To overcome this problem a registry switch is now available which lets 
DataAnalysis create the bitmap already and thus speeds up printing on such printers. 
Note: Administrator privileges are required for setting the registry key. 

1. Click . 
2. Click Run. This opens the Run dialog. 
3. In Open, type in "regedit" and click OK. This opens the Registry Editor. 
4. Navigate to "Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Bruker Daltonik".  
5. Right-click the key "Bruker Daltonik" and from the context menu select New > Key. 

Overwrite the default key name with "Printer". 
6. Right-click the key "Printer" and select New > Key from the context. Overwrite the 

default key name with the name of the printer for which you want to set the registry 
key, e.g. "HP LaserJet 5000 Series PCL". You must type in the name the 
respective printer is referred with in the DataAnalysis Print dialog. 

7. Right-click the key "[printer name]" and select New > DWORD Value from the 
context select. This enters a double word (dword) value for the key "[printer name]" 
which is specified by the Name "New Value #1", the Type "REG_DWORD" and 
the Data "0x00000000 (0)". Overwrite the default name with "UseBitmaps". 

8. Right-click the name "UseBitmaps" and select Modify from the context. In the Edit 
DWORD Value dialog change the current Value data value from "0" to "1" and 
click OK. This changes the "UseBitmaps" value accordingly and thus switches the 
key on. 
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9. Close the Registry Editor. 

  
Figure 2-15 Example registry key for faster printing on the named printer 
 
 
2.16 Send Popup Command 

Note: The Send command is available when BioTools and/or ACD SpecManager 
is/are installed on your system. Otherwise, the Send Report To command is 
present. 

Pointing to this submenu pops up further submenus for sending a report, an analysis or 
a spectrum. 

  
Figure 2-16 Send popup 

Command Used to … 

Report To Pop up commands for sending a report. 
Analysis To Pop up commands for sending an analysis to another application. 
Spectrum To Pop up commands for sending a spectrum to another application. 
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2.17 Send (>) Report To Popup Command 

Note: Depending on whether BioTools and/or ACD SpecManager is/are installed on 
your system either the Send > Report To or the Send Report To popup com-
mand is present. 

Pointing to this submenu pops up the following commands for sending a report: 

  

  
Figure 2-17 Send > Report To (top) and Send Report To (bottom) popups 

Command Used to … 

Mail Recipient Print a selected report to a PDF file and sends this to a specified 
email address. 

PDF Document Print a selected report to a PDF file. 
 
 
2.18 Send (>) Report To > Mail Recipient 

The Send (>) Report To > Mail Recipient command is used to print a selected to a 
PDF file and send this automatically as an attachment of an email to a specified email 
address. The report is saved with the name of the selected layout. 

The command opens the Send Report To Mail Recipient dialog, which allows you 
select the report to be created and the recipient to whom you want to send this report 
as email. If on selecting this command the current processing state of a selected 
analysis has not been saved yet, first a corresponding message appears that asks you 
about saving the respective analysis. Affirm this request, to save the analysis and open 
the Send Report To Mail Recipient dialog. 

Email address 
Enter the email address of the recipient to whom you want to send the report. 

Send 
Opens the Choose Profile dialog (see below) to select the profile you want to use with 
Microsoft Exchange.  
 
For the other parameters, please refer to Section 2.14.  
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Figure 2-18 Send Report To Mail Recipient dialog 

Shortcut 

Button:   
 

Choose Profile dialog 
The Choose Profile dialog is used to select the profile to be used with Microsoft 
Exchange. In addition, this dialog allows you to set up a new profile and specify 
advanced options for logging on. 

Profile Name 
Select the profile you want to use. 

New 
Allows you to create a new profile. Opens the Windows Messaging Setup Wizard. To 
create a new profile, follow the instructions of the wizard. 

Options 
Expands the dialog and displays the following advanced options for logging on. 
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Set as default profile 
Sets the selected profile as the default. You can set some messaging applications, 
such as Microsoft Exchange, to log on automatically using your default profile. 

Show Logon screens for all information services 
Displays the logon dialogs for each information service in the selected profile. 

OK 
Creates the selected report, saves it as PDF document, and sends it as email to the 
specified recipient. If no email address is specified, the email program will prompt for it. 

 
Figure 2-19 Expanded Choose Profile dialog (after clicking Options) 
 
 
2.19 Send (>) Report To > PDF Document 

The Send Report To > PDF Document command is used to print a selected report to 
a PDF file and save it to a chosen target folder. 
 
The command opens the Send Report To PDF Document dialog, which allows you to 
select the report to be created and to specify path and name for the PDF document to 
be saved. If on selecting this command the current processing state of a selected 
analysis has not been saved yet, first a corresponding message appears that asks you 
about saving the respective analysis. Affirm this request, to save the analysis and open 
the Send Report To PDF Document dialog. 

PDF file name 
Enter path and name for the PDF document to be saved. The folder of the active ana-
lysis and the name ‘Report.pdf’ are suggested by default.  
If you want to save the PDF document with another name, change the name as 
desired. If you want to save the document to another folder, either enter the respective 
path or click  and select the desired folder in the appearing dialog. 
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Save 
Creates the selected report and saves it as PDF document with the specified name in 
the chosen target folder. 
 
For the other parameters, please refer to Section 2.14.  
 

 
Figure 2-20 Send Report To PDF Document dialog 

Shortcut 

Button:   
 
 
2.20 Send > Analysis To Popup Command 

Note: The Analysis To popup command is available if BioTools is installed on your 
system. 

Pointing to this submenu pops up the following commands for sending an analysis to 
BioTools to (automatically) further process it: 
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Figure 2-21 Send > Analysis To popup 

Command Used to … 

BioTools Load processing results of the selected analysis with BioTools. 
Mascot Batch 

Search with 
BioTools 

Send processing results of the selected analysis to BioTools 
and automatically perform a Mascot batch search. 

 
 
2.21 Send > Analysis To > BioTools Command 

Note: This command is available if BioTools is installed on your system.  

The Send > Analysis To > BioTools command is used to send processing results of 
the selected analysis to BioTools to further process them using the specific tools of this 
application. 
 
The command starts BioTools and opens the Open Analysis Result dialog. Do the 
desired settings and click Open to open your analysis in BioTools. 
Note: For detailed information on how to use BioTools, please refer to the BioTools 

help tools.  

  
Figure 2-22 BioTools' Open Analysis Result dialog 

Shortcut 

Button:   
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2.22 Send > Analysis To > Mascot Batch Search 
with BioTools Command 

Note: This command is available if BioTools is installed on your system and requires a 
local Matrix Science Mascot version be installed. 

The Send > Analysis To > Mascot Batch Search with BioTools command is used to 
send the processing results of the selected analysis to BioTools to automatically 
perform a Mascot Batch Search with BioTools and via local Mascot server. Processing 
results are exported to a temporary MFG file (with BioTools 3.0 and older versions) or 
XML file (with BioTools 3.1) which is set up based on the settings in the Export  tab of 
the Method Parameters dialog. 
In order to identify an analyzed protein digest, you can perform an 'MS Fingerprint' 
either on compound(s) from an LC-MS analysis or on a single profile spectrum from a 
mass spectrum analysis. You can also perform a 'MS/MS' search on compound(s) 
found for an LC-MS/MS analysis.  
Note: For detailed information please refer to the tutorial 'Protein Identification within 

the Bruker Proteineer Line' and the BioTools help tools. 
 
Example: Performing a Mascot 'MS/MS' search on an LC-MS/MS analysis from a 

tryptic digest of enolase 
Defining the method parameters to be used for an 'MS/MS' search in BioTools 
Database search is performed according to the method parameters defined in the 
selected BioTools method. How to set up the search parameters depends on your 
current BioTools version; for description please refer to the tutorial 'Protein Identifi-
cation within the Bruker Proteineer Line'. The following figure shows the BioTools 3.0 
Edit Method dialog with the MS/MS search parameters settings used in the Mascot 
MS/MS search of our enolase example. 
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Figure 2-23 Example of setting MS/MS search parameters (applies to BioTools 3.0) 
 
Preprocessing the LC-MS/MS analysis for an 'MS/MS' search 
Preprocess the LC-MS/MS analysis in DataAnalysis as needed for a Mascot 'MS/MS' 
search. For more information, please refer to the tutorial 'Protein Identification within 
the Bruker Proteineer Line'. 
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Figure 2-24 LC-MS/MS analysis (tryptic digest of enolase, Saccharomyces cerivisae) 

with charge deconvoluted compounds 
 
Running a Mascot MS/MS search on the preprocessed LC-MS/MS analysis 
Selecting the Send > Analysis To > Mascot Batch Search with BioTools command 
exports the processing results to a temporary MFG (for BioTools 3.0 and older 
versions) or XML file (for BioTools 3.1) and sends it to BioTools. This file is immediately 
loaded with BioTools, which starts automatically, and a Mascot Batch Search is 
performed. When search is completed, the Status tab of the Mascot Batch Mode 
dialog displays the search results. 
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Figure 2-25 Mascot Batch Mode - Status tab displaying the results of an MS/MS search 
on the processed LC-MS/MS analysis  

Shortcut 

Button:   
 
 
2.23 Send > Spectrum To Popup Command 

Note: The Spectrum To popup command is available if BioTools and/or ACD 
SpecManager is/are is installed on your system. 

Pointing to this submenu pops up the following commands for sending a spectrum to 
another application to further process it: 
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Figure 2-26 Send > Spectrum To popup 

Command Used to …  

BioTools Send the selected mass spectrum to BioTools. 
ACD SpecManager Send the selected mass spectrum to ACD SpecManager. 
 
 
2.24 Send > Spectrum To > BioTools Command 

Note: This command is available if BioTools is installed on your system.  

The Send Spectrum To > BioTools command is used to send the selected mass 
spectrum to BioTools to further process it using the specific tools of this application. 
The command exports the selected mass spectrum to a temporary XML file (applies to 
BioTools 3.1). With older BioTools versions the MGF format is used, with version 2.1 
the BSC format is used when a single spectrum (not a compound) is selected. Export 
to the XML resp. the MGF format is based on the settings in the Export tab of the 
Method Parameters dialog. The exported file is immediately loaded with BioTools, 
which starts automatically. 
Note: For detailed information on how to use BioTools, please refer to the BioTools 

help tools.  

Shortcut 

Button:   
 
 
2.25 Send > Spectrum To > ACD SpecManager 

Command 

Note: This command is available if ACD SpecManager is installed on your system. 

The Send > Spectrum To > ACD SpecManager command is used to send the 
selected mass spectrum to ACD SpecManager to further process it using the specific 
tools of this application. 
Note: For detailed information on how to use ACD SpecManager, please refer to ACD 

SpecManager help tools. 



Bruker Daltonik GmbH File Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  2-41

The command exports the selected mass spectrum to a temporary file of ASCII file 
format. ACD SpecManager starts with the three-step dialog Import from ASCII File... 
which allows you to import the ASCII file written in column-type text format. 
In the Import from ASCII File (Step 1 of 3) ... dialog define the way that the raw data 

is to be divided into columns and rows to be read in. Then click . 
 

 
Figure 2-27 Step 1 of importing a mass spectrum from ASCII File (default settings) 

In the Import from ASCII File (Step 2 of 3) ... dialog define the columns formed in 
Step 1 to be x or y values of the spectrum. Select in Selector the required axis and 
then click the column header to assign the selected axis to a data column. Repeat this 

for the other axis. Then click . 
Note: To be able to proceed to Step 3, you should select at least one y-column. If no 

x-column is selected, you will be asked. 

In the Import from ASCII File (Step 3 of 3) ... dialog, which allows you to preview the 

file header, click . This finishes import and displays the imported mass 
spectrum in the ACD/SpecManager: Processor Window. 
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Figure 2-28 Step 2 of importing a mass spectrum from ASCII File: Selecting spectrum 

type and defining axis columns 

  
Figure 2-29 Step 3 of importing a mass spectrum from ASCII File: Preview of the file 

header 
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Figure 2-30 Mass spectrum imported in ACD SpecManager 

Once the mass spectrum has been imported in ACD SpecManager, you can save it 
under a desired file name using the Save As command from the ACD SpecManager's 
File menu and then process it. 

Shortcut 
Button:   

 
 
2.26 Properties Command 

The Properties command is used to review measurement conditions (e.g. sample 
description, instrumental parameters) of the selected analysis. It opens the tabbed 
'Analysis name' - Analysis Properties dialog containing the following tabs: General 
(opens by default), Analysis, Sample, Method, Segments, Mass Spectrum, Calibra-
tion Status and Details. 
Note: The Segments tab is available when a chromatogram analysis is selected. 
 The Mass Spectrum tab is available when a mass spectrum analysis or a 

single compound spectrum of a chromatogram analysis is selected.  
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Shortcuts 
Button:  
Key: F8 

 
 
2.26.1 Properties Command - General 

The General tab shows general information about data acquisition of the selected 
analysis and to edit the analysis comment. Detailed information about the respective 
analysis can be found in the other tabs.  
 

  
Figure 2-31 Analysis Properties dialog - General tab 

File name 
File name of the selected analysis. 

Date 
Date and time this analysis was acquired. 

Instrument 
Instrument used for acquiring this analysis. 
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Operator 
Name or status of the operator who performed data acquisition. 

Task 
Measurement task this analysis is assigned to. 

Batch 
Sample batch this analysis is assigned to. 

Method 
Method used to acquire this analysis. 

Sample 
Name of the analyzed sample this analysis derived from. 

Description 
Current analysis comment, which is shown in the Analysis Info window as a part of the 
Analysis Info. Normally, the operator enters the analysis comment during data acqui-
sition but you are allowed to edit it in DataAnalysis and save the changes in the 
analysis. To edit the current comment, add additional text or change or remove existing 
text. Click in this field and edit the current text as required.   

Apply 
Applies the changes made in Description while keeping the dialog open and changes 
the Analysis Info accordingly. 

OK 
Applies the changes made in Description, closes this dialog, and changes the 
Analysis Info accordingly. 
 
 
2.26.2 Properties Command - Analysis 

The Analysis tab shows the instrument parameters used to acquire the selected analy-
sis. The instrument parameters are arranged in groups of closely related parameters. 
On selecting a group, the parameters and corresponding values are listed. 
Note: If a column is too small to display complete information, it is assigned by the 

text followed by '...'. Use the Column width cursor to adjust the column width to 
display the full information. 

Group 
Select the group of acquisition parameters whose values you want to view.  

Acquisition Parameter 
Lists all acquisition parameters in the selected Group. 
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Value 
Lists the numeric value, on/off state, or mode for the shown parameters.  
 

  
Figure 2-32 Analysis Properties dialog - Analysis tab 

 
 
2.26.3 Properties Command - Sample 

The Sample tab shows the parameters stored in the HyStar sample info of the selected 
analysis. The parameters are arranged in groups of closely related parameters. On 
selecting a group, the parameters and corresponding values are listed. 

Group 
Select the group of parameters whose values you want to view.  

Acquisition Parameter 
Lists all acquisition parameters in the selected Group. 

Value 
Lists the current numeric value, on/off state or mode for the shown parameters.  
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Figure 2-33 Analysis Properties dialog - Sample tab 

 
 
2.26.4 Properties Command - Method 

The Method tab shows information about the method currently attached to the selected 
analysis. 

Method name 
Displays the name of the method that is attached to the selected analysis. 

Method Part Type 
Lists the method part types currently contained in the method attached. 

Method Part Name 
Lists the names of the method parts contained in the method attached. 

Comment 
Displays the comment for the method attached, if available. 

Status 
Displays the status of the method attached whether it is writable or read-only. 
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Figure 2-34 Analysis Properties dialog - Method tab 

 
 
2.26.5 Properties Command - Segments 

Note: The Segments tab is only available when a chromatogram analysis is selected. 

The Segments tab shows the acquisition time segments of the selected chromatogram 
analysis. The segment numbers and the corresponding start and end retention times 
are given. Vertical dash lines indicate the time segments in the Chromatogram window.  

Segments available 
Displays the number of time segments available in the analysis. 

Segment # 
Lists the number of the segment. 

Ret. Time, Start ['unit'] 
Lists the start retention time of the segment. 

Ret. Time, End ['unit'] 
Lists the end retention time of the segment. 
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Figure 2-35 Analysis Properties dialog - Segments tab 

 
 
2.26.6 Properties Command - Mass Spectrum 

Note: The Mass Spectrum tab is available if a mass spectrum analysis or a single 
compound spectrum of a chromatogram analysis is selected. 

The Mass Spectrum tab shows the instrument parameters used to acquire the 
selected mass spectrum (Note: If you have selected the Properties command from the 
context menu of the Compound Mass or Mass Spectrum window, the information that 
refers the right-clicked mass spectrum is shown.). The instrument parameters are 
arranged in groups of closely related parameters. On selecting a particular group, the 
corresponding settings (numeric value, on/off state, or mode) of the variables are listed. 
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Figure 2-36 Analysis Properties dialog - Mass Spectrum tab 

Sequence number 
Displays the sequence number of the selected mass spectrum. For an averaged mass 
spectrum the corresponding sequence number range is given. 

Segment number 
Displays the number of the time segment the mass spectrum was acquired in. 

Background 
Displays information on type of subtracted background. 

Group 
Select the group of instrument variables whose settings during data acquisition of the 
selected mass spectrum you want to display.  

Acquisition Parameter 
Lists all acquisition parameters contained in the selected Group. 

Value 
Lists the current numeric value, on/off state or mode for the parameters listed under 
Acquisition Parameter. 
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2.26.7 Properties Command - Calibration Status 

The Calibration Status tab shows information about the current calibration status of 
the selected analysis. The data can concern e.g. initial calibration from acquisition or 
internal calibration from DataAnalysis. For positive and negative polarity separate 
calibration data may be available. 
 

 
Figure 2-37 Analysis Properties dialog - Calibration Status tab 

(Select calibration data box) 
Indicates where the calibration data of the selected analysis originates from e.g. 'Initial 
calibration from acquisition' or 'Internal calibration'. If separate calibration data for 
positive and negative polarity is available, select the polarity of which you want to view 
the corresponding data.  

(Calibration data field) 
Displays the calibration data that concern the selected polarity. 
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2.26.8 Properties Command - Details 

The Details tab shows detailed information about acquisition and processing of the 
selected analysis. 
 

  
Figure 2-38 Analysis Properties dialog - Details tab 

In Acquisition, detailed information about acquisition of the selected analysis is given: 

Analysis created 
Date and time the analysis was created. 

Original name 
Original name of the analysis that was specified in data acquisition. 

Instrument 
Instrument type used. 

Serial number 
Serial number of the instrument used.  

Acquisition program 
Acquisition program used. 
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Acquisition program version 
Program version of the acquisition program used. 

Instrument program version 
Instrument program version used. 

Acquisition method 
Data acquisition method used. 
 
In Processing, detailed information about processing of the selected analysis is given: 

DataAnalysis results modified 
State of the results file, modified yes or no. 

Processing method 
Processing method used. 

DataAnalysis version 
DataAnalysis program version used. 

Results file created 
Date and time the results file was created. 

Results file last modified 
Date and time the results file was last modified. 

History 
Allows you to view the result history of the analysis. Opens the Result History dialog. 
 
 
2.27 Recent File List 

Use the numbers and analyses names listed in the recent file list at the bottom of the 
File menu to quickly open one of the up to ten recently opened analyses. Select the 
number that corresponds to the analysis you want to open. This loads the last saved 
result of the analysis.  
When holding down the Ctrl key while selecting an analysis the Open Analysis dialog 
is opened in the folder of the analysis instead. 
When pointing on a recent file, corresponding full path name is displayed in a tool tip. 

 
Figure 2-39 Tooltip displaying full path name of selected recent file 
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2.28 Exit Command 

The Exit command closes the current DataAnalysis session. On closing DataAnalysis, 
the current user interface settings are automatically stored for the current user logged 
into Windows. 
If the current processing state of at least one open analysis has not been saved yet, a 
confirmation request appears asking you if you would like to save the current process-
ing state of the named analysis including the embedded method. Click Yes or Yes to 
All to save the processing state of all unsaved analyses. Click No or Not to all if you 
do not wish to save any of the yet unsaved analyses. After answering the request(s), 
DataAnalysis is closed.  

  
Figure 2-40 Confirmation dialog on saving the current processing state of the open 

analysis/analyses 

Shortcuts 
Keys: Alt+F4 
Mouse: Click the application's Close . 

 -or- 
 Double-click the application's Control menu button. 
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3 EDIT MENU 

The Edit menu offers the following commands: 

  
Figure 3-1 Edit menu 

Command Used to … 

Chromatograms Edit chromatograms for the selected analysis. 
Color Pop up the color palette to change the display color of the 

selected chromatogram or mass spectrum. 
Copy Copy specific data belong to a selected item to the clipboard. 
Copy to Compound 

Spectra 
Copy the spectrum selected in the Spectrum View window to 
the Compound Spectra folder of the selected chromatogram 
analysis. 

Copy to Work List Copy the selected spectrum to the Work List. 
Paste Paste the current clipboard content (chromatogram trace 

definition or processing method) into the selected analysis. 
The data pasted depends on what was selected when the 
Copy command is chosen. 
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Command Used to … 

Paste Pop up the various commands for pasting specific data. 
Hide/Show Analysis Hide/Show the selected analysis. 
Disable/Enable Disable/Enable the selected analysis, chromatogram, 

compound or spectrum. 
Delete Delete the selected item (e.g. chromatogram, compound, 

spectrum, mass peak) from the corresponding list. 
Select All Select all open analyses including all chromatograms and/or 

mass spectra. 
Select None Deselect all currently selected analyses, chromatograms 

and/or spectra. 
Range Selection Select a retention time range or mass range in the active 

data window. 
Clear Range 

Selection 
Clear the current retention time or mass range selection in 
the active data window. 

Select Range/View 
Spectra 

Toggle between Select Range mode and View Spectra 
mode. 

Range/Box Selection Toggle between Range Selection mode and Box Selection 
mode. 

 
 

3.1 Chromatograms Command 

On initial loading of a chromatogram analysis in DataAnalysis, separated TIC (Total Ion 
Chromatogram) traces are generated for polarity and MS or MS(n) and displayed in the 
Chromatogram window – yet, up to four traces. In addition, the corresponding TIC ±All 
trace is available but initially disabled. You can use the Chromatograms command to 
add new chromatogram traces for the selected analysis and to change or delete 
existing traces. 
 
The command opens the Edit Chromatogram Traces dialog, which allows you to edit 
new or exiting traces. 
Note: The parameters that have to be specified to edit a new or existing trace depend 

on the chromatogram type selected in Type. In the following, all parameters 
possibly present in this dialog are described. 
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Figure 3-2 Edit Chromatogram Traces dialog (example with 'Extracted Ion Chromato-

gram' and 'All MS’ filter selected) 

File name 
Displays the name of the selected analysis. 

Traces 
Lists all chromatogram traces currently defined for the selected analysis. This can be a 
default Total Ion Chromatogram (TIC) as well as chromatograms created by the pro-
gram or defined by the user. 
Each trace is represented by a color box indicating the color the trace is displayed with 
in the Chromatogram window and by a short description drawn in black color. When a 
trace is disabled, its color box is crossed out and its description is drawn in grey color. 
On selecting a trace, its specification is shown below this list box.  

Type 
Select the type of chromatogram trace you want to add from this list. When a trace is 
selected in Traces, its corresponding type is shown here. Depending on the selected 
type, specific associated options will be displayed below the list box that define the 
respective trace. 
The following trace types are available: 

Total Ion Chromatogram. (Default) Adds a chromatogram calculated by summing up 
the intensities of all masses contained in the mass spectra. Abbreviation is 'TIC'. 

Extracted Ion Chromatogram. Adds a chromatogram calculated by summing up the 
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intensities of the specified mass(es) or mass ranges contained in the mass spec-
tra. Abbreviation is 'EIC'. 

Base Peak Chromatogram. Adds a chromatogram calculated by using the intensity 
of the most intense ion in every data point in the mass spectra. Abbreviation is 
'BPC'.  

Constant Neutral Loss Chromatogram. Adds a chromatogram calculated for (a) 
specified constant neutral loss(es). 

Detected Neutral Loss Chromatogram. Adds a chromatogram calculated for (a) 
selected neutral loss(es) detected by the acquisition program (TrapControl). 

UV Chromatogram. Adds a UV chromatogram created from selected ChemStation, 
HyStar or netCDF UV data. 

UV Chromatogram (Base Peak). Adds a UV chromatogram acquired from selected 
HyStar, ChemStation or netCDF UV data, taking the maximum intensity value of 
DAD data in the specified wavelength range. 

LC Chromatogram. Adds an LC chromatogram acquired from HyStar. 
Mass Position Chromatogram. Used by service engineers during instrument check-

up; not useful for normal users. 
Isotope Cluster Analysis Chromatogram. Adds a chromatogram calculated by 

summing up the intensities of isotopomer peak pairs of specified m/z difference 
and intensity ratio values. 

Acquisition Parameter Chromatogram. Adds a chromatogram showing the run of a 
selected acquisition parameter during data acquisition. 

Imported External Data Chromatogram. Adds the selected external data chromato-
gram after importing it. 

Processed Chromatogram. Chromatogram created by the program, e.g. by smooth-
ing, interpolating or baseline subtracting operations. 

Background Chromatogram. Adds a chromatogram from the specified background. 
Mass Defect Chromatogram. Adds a chromatogram of mass defect filtered spectra. 

Filter 
For a Total Ion, Extracted Ion, Base Peak or Constant Neutral Loss Chromato-
gram to be edited for an MS(n) spectra containing analysis, select the type of mass 
spectra to be filtered: 

All (MS and MSn). Uses all mass spectra including all MS and MS(n) spectra (no 
filter). 

All MS. Uses only all MS spectra. 
All MSn. Uses only all MS(n) spectra. 
MSn. Uses only the MS(n) spectra that originate from the precursor specified in of. 
All MS2. Uses only all MS2 spectra. 
All MS3. Uses only all MS3 spectra. 
All MS4. Uses only all MS4 spectra. 
All MSn n>4. Uses only all MS(n) spectra of n>4. 
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Scan mode 
For a Total Ion, Extracted Ion or Base Peak Chromatogram for which the All MS 
filter is chosen, select the scan mode to be used as a filter. 

All. Uses all mass spectra. 
Full Scan. Uses full scan spectra only. 
Maximum Resolution. Uses maximum resolution (MaxRes) scan spectra only. 
isCID. Uses in-source collision-induced dissociation (ISCID) spectra only. 
bbCID. User broadband collision-induced dissociation (bbCID) spectra only. 

Fragm. mode  
For a Total Ion, Extracted Ion or Base Peak Chromatogram for which the All MSn 
filter is chosen, select the fragmentation mode to be used as a filter. 

Any. Uses mass spectra from any fragmentation mode. 
CID. Uses mass spectra from Collision-Induced Dissociation (CID) only. 
ETD. Uses mass spectra from Electron Transfer Dissociation (ETD) only. 
CID-ETD. Uses mass spectra from Collision-Induced Dissociation – Electron Transfer 

Dissociation (CID-ETD) only. 
PTR. Uses mass spectra from Proton Transfer Reaction (PTR) only. 

of 
For a Total Ion, Extracted Ion, Base Peak or Constant Neutral Loss Chromato-
gram for which the MSn filter is chosen, select the precursor ion(s) whose MS(n) 
spectra should be used. The list includes all isolated and fragmented masses that were 
used in acquiring the selected analysis. Extraction of ETD MSn traces of specific pre-
cursor is also supported. 

Masses 
For an Extracted Ion, Base Peak, Constant Neutral Loss or Mass Position Chro-
matogram, enter the mass values or mass ranges to be used. Default set to full mass 
range.  
Single masses: Separate each mass value by a comma, semicolon, or plus sign.  
Mass ranges: Separate start and end mass by a hyphen "-". Leaving start (or end) 

mass empty will result in the first (or last) measured mass of the chromatographic 
run being chosen. Entering only a hyphen will cover the full mass range. 

Note: Exclusion masses are not included in the respective calculation. 
For a Detected Neutral Loss Chromatogram, select the neutral loss(es) to be used 
from the drop down list. The list includes all neutral losses detected in the selected 
analysis by the acquisition program (TrapControl) during data acquisition. The trace 
can be calculated for a single or multiple selected neutral losses. 

Mass Defect 
For a Mass Defect Chromatogram, enter the mass defect (values 0 - 1). 
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Signal 
For a UV Chromatogram, UV Chromatogram (Base Peak) or LC Chromatogram, 
select the UV or LC signal to be used. Such signals are all constant wavelength signals 
acquired with HyStar, ChemStation or netCDF plus DAD if available and contained in 
the selected analysis. 
File name 
For a UV Chromatogram, UV Chromatogram (Base Peak) or LC Chromatogram, 
select the UV or LC data for which a trace should be added from the list. This can be 
ChemStation, HyStar or netCDF UV data stored in a data file that must be placed in the 
analysis folder to be listed here. 
m/z difference 
For an Isotope Cluster Analysis Chromatogram, enter the m/z difference that must 
exist between two peaks to consider the respective peak pair for chromatogram set up. 
Default is '0'. 
Tolerance (for m/z difference) 
For an Isotope Cluster Analysis Chromatogram, enter an absolute tolerance to be 
applied to the specified m/z difference.  
Intensity ratio 
For an Isotope Cluster Analysis Chromatogram, enter the intensity ratio (I1/I0) a 
peak pair with the specified m/z difference (+/- tolerance) found must have to rate the 
peak pair as isotopomer and use the corresponding peak intensities for chromatogram 
set up.  
Tolerance (for Intensity ratio) 
For an Isotope Cluster Analysis Chromatogram, enter the percentage tolerance to 
be applied to the specified intensity ratio. 
Parameter 
For an Acquisition Parameter Chromatogram, select from this list the acquisition 
parameter whose trace you wish to display. The parameters available depend on the 
instrument settings used for data acquisition. 
Width 
For an Extracted Ion, Base Peak, Constant Neutral Loss or Mass Defect Chroma-
togram, select a mass precision range from the list of pre-defined precision ranges or 
enter a customized range. The precision range to be used depends on how precise 
and accurate the respective measurement was. If this parameter is set to less than 
±0.5 for a single ion trace, the chromatogram short description contains the specified 
delta mass width, too.  
Polarity 
For a Total Ion, Extracted Ion, Base Peak, Constant Neutral Loss, Detected Neu-
tral Loss, Isotope Cluster Analysis or Mass Defect Chromatogram, select the 
polarity of the ions to be used: 
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both (±). Uses both positive and negative ions. 
positive (+). Uses positive ions only. 
negative (−). Uses negative ions only. 

Background 
For a Total Ion Chromatogram, Extracted Ion or Base Peak Chromatogram for 
which the All MS filter is chosen, select the type of background to be subtracted from 
the MS spectra resp. for a Background Chromatogram, select for which background 
type a trace should be created. 

None. Does not subtract any background.  
Constant (Background MS). Subtracts the proper of maximal four background mass 

spectra which are contained in the analysis’ Background Mass Spectra folder resp. 
creates the corresponding trace. 

Spectral. Subtracts the spectral background calculated by the program resp. creates 
the corresponding trace. The spectral background is calculated for LC/MS and 
LC/MS(n) analyses only. 

Color 
Select the color of the chromatogram to be displayed. 

Import 
For an Imported External Data Chromatogram, allows importing an external data file 
of Comma Separated Values File format (*.csv). It opens the Import Internal Data 
dialog to select the file.  
Example of external data file "Biological Activity.csv" which can be found among the 
demo data (…\\Data\Demo\Esquire, HCT\Natural Products\Mix20002.d). 

 

The file name (here "Biological 
Activity.csv") gives the trace 
definition. 
 
The 4th column header (here 
"Activity") gives the y-scale text. 
 
The Start and End columns 
define the data. 

Figure 3-3 Example of external data *.csv file loaded in Excel 
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Enabled 
Check this option to enable the selected trace or uncheck it to disable the selected 
trace. Default is checked. 

Add  
Adds the new defined chromatogram to Traces. 

Change 
Changes the selected chromatogram in Traces. 

Delete 
Deletes the selected chromatogram from Traces. 

OK 
Edits the chromatogram traces currently defined in Traces in the Chromatogram win-
dow except for the disabled ones. Also enters or changes the corresponding Analysis 
List entries for the respective analysis.  
If an ‘All MS’ trace is to be edited with Spectral background subtraction set and yet no 
spectral background is stored in the analysis, DataAnalysis first calculates the spectral 
background of the LC analysis and then creates the desired trace. 

Shortcuts 
Button:  
Key: F7 

 
 
3.2 Color Command 

The Color command is used to change the display color of the selected chromatogram 
or spectrum. The command pops up a 40-colors palette in which the current color of 
the selected chromatogram or mass spectrum is marked. To change the color click the 
desired new color.  

  
Figure 3-4 Color palette with 40 colors 
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3.3 Copy Command 

The Copy command is used to copy specific data belonging to the selected item to the 
clipboard in order to paste the data into DataAnalysis again or into another application. 
Depending on the item that is selected when using this command, the following data is 
copied: 
- Analysis: When an analysis is selected, the method parameters and script that 

belong to the processing method currently attached to the analysis are copied to the 
clipboard. The processing method or a specific part of it can then be pasted and 
attached to another analysis selected in DataAnalysis. 

- Chromatogram trace(s): When (a) chromatogram trace(s) is/are selected, the corre-
sponding trace definition(s) is/are copied to the clipboard. The trace definition(s) can 
then be pasted into another analysis selected in DataAnalysis in order to create the 
corresponding chromatogram trace(s) in this analysis. 

- Data window: When a data window (Survey View, Chromatogram, Spectrum View, 
Compound Spectra, Work List or Mass Spectrum window) is active, a graphic is 
copied to the clipboard. This includes the data window and the data contained that 
belong to the selected analysis. The graphic can then be pasted into another applica-
tion (e.g. Windows Office applications).  

- Spectrum Data window / Compound List window: When a currently data contain-
ing tab of the Spectrum Data window or the Compound List window is active (this is 
indicated by one or several entries being highlighted by a blue bar) the data contained 
in the selected rows are copied as a tab-separated list to the clipboard. The table can 
then be pasted into another application (e.g. Windows Office applications). 

 
Before selecting the command, you have to select the item whose data you want to 
copy to the clipboard. To copy 
- processing method data, select in the Analysis List the root level entry of the analy-

sis whose attached processing method is to be copied.  
- chromatogram trace definitions, select in the Analysis List the respective chroma-

togram trace(s) whose trace definitions are to be copied. The selected chroma-
tograms may belong to different analyses. 

- a graphic of a data window, activate the data window and select the analysis whose 
data should be included in the graphic. Its blue title bar indicates the active data 
window. 

- data from Spectrum Data or Compound List window open the window/tab and 
activate it by selecting the rows whose contents are to be copied. Blue bars indicate 
selected rows.  

 
The command copies the data that correspond to the current selection on the 
clipboard. You can use the DataAnalysis paste commands from the Edit menu, Paste, 
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Paste > Chromatogram Trace Definitions, Paste > Method, Paste > Method Para-
meters and Paste > Method Script to paste the clipboard data into a selected 
analysis. Alternatively, you can use the corresponding command in the application the 
copied data should be pasted in. 
 
Shortcuts 

Button:  
Keys: Ctrl+C 

 
 
3.4 Copy to Compound Spectra Command 

The Copy to Compound Spectra command copies the mass spectrum or UV spec-
trum selected in the Spectrum View window to the Compound Spectra folder of the 
active chromatogram analysis. The spectrum is entered at the bottom of the analysis’ 
Compound Spectra folder and Compound List and displays in the Compound Spectra 
window. Copying a single measured or averaged spectrum to Compound Spectra 
allows you to process the copied spectrum. 
Tip: In case of a mass spectrum, the Copy to Compound Spectra and Identify 

command and Copy to Compound Spectra and Deconvolute command from 
the context menu of the Spectrum View window allow copying the selected 
spectrum to Compound Spectra and simultaneously performing a library search 
resp. a charge deconvolution operation on it. 

Shortcut 
Button:   

 
 
3.5 Copy to Work List Command 

The Copy to Work List command copies the spectrum selected in the Spectrum View 
or Compound Spectra window to the Work List. 

Shortcut 
Button:   
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3.6 Paste Command 

The Paste command pastes the chromatogram trace definitions or the processing 
method contained on the clipboard into the selected analysis. The command is only 
enabled if a chromatogram trace definition or processing method data was previously 
copied to the clipboard using e.g. the Copy command from the Edit menu. Before 
selecting the command, you have to select the analysis into which the clipboard 
content should be pasted. 
Depending on the data pasted, one of the following will happen: 
• Pasting chromatogram trace definitions into an analysis creates corresponding 

chromatogram trace(s) in the Chromatogram window and enters them in the analy-
sis' Chromatogram folder.  

• Pasting a processing method into an analysis attaches the method to the analysis 
by overwriting the previously attached method.  
Tip: If you wish to paste only a part of the processing method contained on the 

clipboard, such as the method parameters or the method script, you can use 
the Paste > Method Parameters command or Paste > Method Script com-
mand from the Edit menu. 

Shortcut 
Keys: Ctrl+V 

 
 
3.7 Paste Popup Command 

Pointing to this submenu pops up the following pasting commands: 

 
Figure 3-5 Paste popup command 

Command Used to … 

Chromatogram Trace 
Definitions 

Paste the chromatogram trace definition(s) contained on the 
clipboard into the selected analysis and create the corre-
sponding chromatogram trace(s). 

Method Paste the processing method contained on the clipboard into 
the selected analysis to attach it to this analysis. 
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Command Used to … 

Method Parameters Paste the method parameters of the processing method 
contained on the clipboard into the selected analysis. 

Method Script Paste the script of the processing method contained on the 
clipboard into the selected analysis. 

 
 
3.8 Paste > Chromatogram Trace Definitions 

Command 
The Paste > Chromatogram Trace Definitions command pastes the chromatogram 
trace definitions contained on the clipboard into the selected analysis. This adds the 
respective chromatogram traces to this analysis. The corresponding chromatogram 
trace(s) is/are created in the Chromatogram window and entered in the analysis' Chro-
matogram folder. 
 
 
3.9 Paste > Method Command 
The Paste > Method command pastes the processing method contained on the clip-
board into the selected analysis. This attaches the method to the analysis with auto-
matically overwriting the previously attached processing method. The entire method is 
pasted which is in contrast to the Paste > Method Parameters and Paste > Method 
Script commands from the Edit menu where only a special part of the method is 
pasted. 
 
 
3.10 Paste > Method Parameters Command 
The Paste > Method Parameters command pastes the method parameters of the 
processing method contained on the clipboard into the selected analysis. This auto-
matically overwrites the previous parameter settings and thus modifies the method 
parameter settings for this analysis. 
 
 
3.11 Paste > Method Script Command 

The Paste > Method Script command pastes the script of the processing method 
contained on the clipboard into the selected analysis. This allows running the script in 
this analysis.  
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3.12 Hide/Show Analysis Command 

The Hide/Show Analysis command hides/shows the selected analysis. It can be 
applied to multiple selected analyses. On hiding an analysis, all its chromatograms 
and/or spectra are not displayed but remain enabled which means that you can still 
process them. A hidden analysis is indicated by its corresponding Analysis List folders, 
chromatogram traces and spectra being grayed out. On showing a hidden analysis 
again, its chromatograms and/or spectra are shown again in the corresponding data 
window(s) and its Analysis List entries are displayed in black. 

  
Figure 3-6 Display of a hidden analysis in the Analysis List 

Shortcut 
Key: Ctrl+Ins 

 
 
3.13 Disable/Enable Command 

The Disable/Enable command disables/enables the selected analysis, chromatogram, 
compound and/or spectrum. It can be applied to multiple selected chromatograms, 
compounds and/or spectra, even when they belong to different analyses. 
On disabling an analysis, all corresponding chromatograms, compounds and/or spectra 
are not displayed and disabled for processing. On enabling an analysis, all currently 
disabled chromatograms, compounds, and/or spectra are enabled again and displayed 
in the respective data windows. 
On disabling a chromatogram, compound or spectrum, these items are not displayed 
and cannot be processed. On enabling a chromatogram, compound or spectrum, they 
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are enabled again and displayed in the corresponding data window, therefore, allowed 
be processed. 

  
Figure 3-7 Display of a disabled analysis in the Analysis List 

Shortcut 
Key: Ins 

 
 
3.14 Delete Command 

The Delete command is used to delete the selected chromatogram, compound or 
spectrum from the Analysis List or the selected compound or mass peak from the 
corresponding list (Compound List, Mass List, SmartFormula List). Which operation will 
be performed depends on the item(s) currently selected. The command can be applied 
to multiple selected chromatograms, compounds or spectra, even if they belong to 
different analyses. It can also be applied to multiple selected items of different types 
(chromatograms and spectra) after affirming a corresponding confirmation request. 
Multiple selected compound or mass peaks can be deleted at once. 
The command deletes the selected item(s) from the respective list. In case of deleting 
items from the Analysis List the following confirmation request will appear if the current 
selection includes both chromatograms and spectra. Click All if you really wish to 
delete all selected items. If you want to delete only the selected chromatograms or the 
selected spectra, click Chromatograms Only or Spectra Only, respectively. If the cur-
rent selection includes an item you do not wish to delete, cancel the request and then 
unselect all selected items using the Select None command from the Edit menu. Then 
select the item(s) actually to be deleted and select the Delete command again. 
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Figure 3-8 Confirmation request appearing in case the current selection includes 

both, chromatograms and spectra� 
Shortcuts 

Button:  
Key: Del 

 
 
3.15 Select All Command 

The Select All command selects all Analysis List items and, therefore all open analy-
ses including their chromatograms and/or mass spectra. 
Shortcut 

Keys: Ctrl+A 
 
 
3.16 Select None Command 

The Select None command deselects all selected Analysis List items. This is when 
you wish to delete a mass spectrum but simultaneously a chromatogram is selected. 
Then, using this command, you can unselect all selected items and subsequently 
select only the desired one. 
Shortcut 

Keys: Ctrl+D 
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3.17 Range Selection Command 

The Range Selection command is used to select a retention time range in the Chro-
matogram window or a mass range in the Spectrum View window, Compound Spectra 
window or Mass Spectrum window. With the 'box selection' mode chosen, you can also 
select a specific intensity range. The corresponding data window must be active to 
enable this command.  
The command opens the Range Selection dialog for the active data window, which 
allows you to select the desired range. 

  
Figure 3-9 Range Selection dialog (for Chromatogram window) 

Retention Time [current unit] or Mass [m/z] 
Displays the currently selected retention time or mass range. 
Enter the start (left box) and end (right box) values for the retention time or mass range 
you want to select. 

Intensity 
Displays the currently selected intensity range. This parameter is only enabled when 
the Box Selection mode is active. 
Enter the start (left box) and end (right box) values for the intensity range you want to 
select.  

 Range/box selection type 
Click this button to select either the Range Selection or Box Selection mode. When this 
button is depressed, the Box Selection mode is active. When it is not depressed, the 
Range Selection mode is active.  

Clear 
Clears the current range selection in the active data window. 

OK 
Displays the defined selected range in the active data window.  
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3.18 Clear Range Selection Command 

The Clear Range Selection command clears the current retention time range selection 
in the Chromatogram window or mass range selection in the Spectrum View window, 
Compound Spectra window, or Mass Spectrum window.  
 
 
3.19 Select Range/View Spectra Command 

The Select Range/View Spectra command toggles between Select Range mode and 
View Spectra mode. The View Spectra mode is applicable only to the Chromatogram 
and Survey View windows. The Select Range mode is applicable to the Chromatogram 
window and it is always active for the Spectrum View, Compound Spectra and Mass 
Spectrum windows even if the View Spectra mode appears to be active, i.e. when the 
corresponding tool button is being pressed. 

Select Range mode: Use this mode to select a retention time range or mass range in 
the selected chromatogram or spectrum. This mode is active when the command's 
tool button is not being pressed. Which of the two range selection modes is currently 
active depends on the actual state of the Range/Box Selection command from the 
Edit menu. 
Tip: When currently in another permanent interaction mode, you can quickly switch 

to the Select Range mode. You can do this by holding down the Space key 
(for Range Selection mode, single selection), the Ctrl+Space keys (for Range 
Selection mode, multiple selections), the Shift+Space keys (for Box Selection 
mode, single selection) or the Shift+Ctrl+Space keys (for Box Selection mode, 
multiple selections). The Select Range mode will be temporarily active as long 
as these keys are held down. When they are released, the previous active 
mode will be activated again. 

View Spectra mode: Use this mode to view spectra from a chromatogram analysis in 
the Spectrum View window. The mode applies to the Chromatogram and Survey 
View windows only. It is active when the command's tool button is being pressed. 
Tip: When currently in another permanent interaction mode, you can quickly switch 

to the View Spectra mode by holding down the Ctrl key. The View Spectra 
mode will be temporarily active as long as the Ctrl key is held down. When it 
is released, the previous active mode will be activated again. 

 
Selecting a retention time range 
To select a retention time range, first switch to the Select Range mode and then select 
the desired retention time range (Section 3.20). 
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Viewing spectra 
To view spectra from a chromatogram analysis, switch to the View Spectra mode. Posi-
tion the View Spectra cursor  in the Chromatogram window or Survey View window 
to the data point for which you want to view the corresponding spectrum/spectra and 
click the left mouse button.  
Selecting a data point on a chromatogram trace: 
When selecting a data point in the chromatogram window the Spectrum View window 
displays the corresponding spectrum/spectra. Which types of spectra are displayed 
depends on the acquired data and the current display settings for the Spectrum View 
window (Auto, Profile MS, Line MS, Fragment MS, UV). The selected data point is 
marked on the chromatogram by the Fixed Data cursor . You can quickly inspect 
neighboring spectra by using the corresponding tool buttons or keys or by dragging the 
mouse. 
 

  
Figure 3-10 Viewing spectra belonging to a selected data point on a chromatogram 

trace: here showing corresponding profile and line MS and MS/MS spectra 
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Selecting a data point in the MS Survey View: 
When selecting a data point in the Survey View window, the corresponding BPC trace 
is created and displayed in the View tab of the Chromatogram window. The Spectrum 
View window displays the corresponding spectrum/spectra for the selected data point 
that is marked on the BPC trace by the Fixed Data cursor . In the Survey View 
window, yellow crosshairs mark the selected data point.  
 

 
Figure 3-11 Viewing spectra belonging to a data point selected in an MS Survey View: 

here showing corresponding line and profile MS and MS/MS spectra 

Shortcut 
Button:  

Dedicated key for View Spectra mode 
Ctrl 
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3.20 Range/Box Selection Command 

The Range/Box Selection command toggles the Chromatogram window, Spectrum 
View window, Compound Spectra window and Mass Spectrum window between the 
Box Selection and Range Selection modes which are available for selecting a retention 
time range or mass range. Multiple selections of ranges are possible. 
Note: To select a retention time range, the Select Range/View Spectra command 

from the Edit menu must be switched to Select Range mode, specifically the 
command's tool button should not be pressed. 

The command activates the Range Selection mode when the Box Selection mode is 
active and vice versa: 
Range Selection mode: Use this mode if you want to select retention time or a mass 

range with the intensity range automatically set to full scale. This mode is active when 
the command's tool button is not pressed. 

Box Selection mode: Use this mode if you want to select a retention time or mass and 
also a specific intensity range. This mode is active when the command's tool button is 
pressed. The mouse cursor indicates this mode. 

Tip: When currently in another permanent interaction mode, you can quickly switch to 
the Select Range mode. You can do this by holding down the Space key (for 
Range Selection mode, single selection), the Ctrl+Space keys (for Range 
Selection mode, multiple selections), the Shift+Space keys (for Box Selection 
mode, single selection) or the Shift+Ctrl+Space keys (for Box Selection mode, 
multiple selections). The Select Range mode will be temporarily active as long as 
these keys are held down. When they are released, the previous active mode will 
be activated again. 

To select a retention time or mass range, first switch to the selection mode you cur-
rently want to use. Then position the tip of the mouse cursor at the desired start point 
and drag the mouse with the left mouse button held down to the desired end point. 
While dragging, the currently selected range is displayed inverted. On releasing the 
mouse button, the selected range remains inverted until you clear the retention time 
selection or mass range selection. If you use the Range Selection mode this can be 
any data point that corresponds to the retention time or mass value at which you want 
to start.  
Multiple selections of ranges can be performed while holding down the Ctrl+Space 
keys (for Range Selection mode) or Shift+Ctrl+Space keys (for Box Selection mode).  
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Figure 3-12 Selecting a retention time using Range Selection (left) or Box Selection 

(right) mode 

    
Figure 3-13 Selecting a mass range using Range Selection (left) or Box Selection 

(right) mode 

Shortcut 
Button:  

Dedicated keys for the Select Range modes available: 
Space  for Range Selection, single selection 
Ctrl+Space  for Range Selection, multiple selections 
Shift+Space for Box Selection, single selection 
Shift+Ctrl+Space for Box Selection, multiple selections 
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4 FIND MENU 

The Find menu offers the following commands: 

  
Figure 4-1 Find menu 

Command Used to … 

Integrate Only - 
Chromatogram 

Integrate the selected chromatogram. 

Compounds - 
Chromatogram 

Find compounds on the selected chromatogram. 

Compounds - MS(n) Find compounds on all acquired More Ion Mode and 
Manual LC-MS/MS chromatograms. 

Compounds - AutoMS(n) Find compounds on all acquired Auto-LC-MS(n) chroma-
tograms. 

Compounds - Dissect Find compounds using the Dissect algorithm. 
Compounds - Molecular 

Features 
Find compounds using the Molecular Features algorithm. 

Compounds - Fractions Find compounds on fractions. 
Compounds Manually - 

Chromatogram 
Find and integrate compounds on the selected chroma-
togram manually. 

Filter Filters the Compound List of the selected analysis using 
(a) specified filter criterion/criteria. 

Clear Results Clears all compound finding results available for the 
selected analysis. 
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Command Used to … 

Parameters Defines the Find method parameters for the selected 
analysis. 

 
 
4.1 Integrate Only - Chromatogram Command 

The Integrate Only - Chromatogram command is used to find automatically com-
pounds on the selected chromatogram (e.g. a TIC, MS or an EIC). The Integrate Only - 
Chromatogram finding function integrates the chromatogram within the selected reten-
tion time range and creates compounds without calculating compound spectra. 
Note: If you want compound spectra to be calculated for the compounds found, you 

have to use the Compounds - Chromatogram command. 

The command performs compound finding on the selected chromatogram according to 
the Find - Chromatogram, MS(n) method parameter settings defined for the selected 
analysis. Recognition of peak start and end and the baseline height is based on the 
actual S/N. 

  
Figure 4-2 Results of Integrate Only - Chromatogram performed on a "TIC, MS" trace 
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Chromatogram trace 
The chromatogram trace is labeled according to the current Display method parameter 
settings.  

Compounds 
The compounds found are entered in the analysis' Compound Spectra folder and their 
peak data is stored in the corresponding Compound List.  

Shortcut 
Button:   

 
 
4.2 Compounds - Chromatogram Command 

The Compounds - Chromatogram command is used to automatically find compounds 
on the selected chromatogram trace (e.g. TIC, MS or EIC). The Compounds – Chroma-
togram finding function integrates the chromatogram trace within the selected retention 
time range, creates compounds with calculating compound spectra. Depending on the 
data acquired and the current method settings, compound mass spectra and/or com-
pound UV spectra can be created. For compound mass spectra, the corresponding 
Mass Lists are set up. If you do not want compound spectra to be calculated for the 
compounds found, you have to use the Integrate Only - Chromatogram command. 
Integrating a UV chromatogram trace includes calculating an averaged compound 
mass spectrum of all mass spectra in the selected range, which are weighted with the 
UV chromatogram intensity.  
Note: This operation is not suitable for AutoMS(n) data since all mass spectra in the 

selected range will be taken for averaging. 
 
The command performs compound finding on the selected chromatogram according to 
the Find - Chromatogram, MS(n) method parameter settings defined for the selected 
analysis. Recognition of peak start and end and the baseline height is based on the 
actual S/N. 

Chromatogram trace 
The chromatogram trace is labeled according to the Display method parameter 
settings. 

Compounds and compound spectra 
The compounds found are entered in the analysis' Compound Spectra folder and their 
peak data are stored in the analysis' Compound List.  
For each compound the corresponding averaged compound spectrum/spectra is/are 
calculated. Depending on the data acquired and the current parameter settings, com-
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pound line and/or profile mass spectra and/or compound UV spectra can be created. 
The mass spectra are displayed along with corresponding information. 
Compound mass spectra are generated by intensity weighted averaging which uses 
the intensity of the selected chromatogram trace above the compound baseline. Addi-
tional background subtraction is performed on them if the corresponding option in the 
method parameters is set.  
A Mass List is set up for each compound mass spectrum. Mass peak finding on profile 
spectra is performed according to the Mass List method parameters defined for the 
selected analysis. 
You can view the compound spectra in the Compound Spectra window and the 
Compound List in the Compound List window. 
 

  
Figure 4-3 Results of Compounds - Chromatogram performed on a 'TIC, MS' trace 

with calculating line and profile spectra for a compound 
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Figure 4-4 Results of Compounds - Chromatogram performed on a "UV Chromato-
gram 200-400 nm" within a selected retention time range (with option Add 
UV spectrum, resp. mass spectrum, if available set) 

Shortcut 
Button:   

 
 
4.3 Compounds - MS(n) Command 

The Compounds - MS(n) command is used to automatically find compounds on all 
acquired More Ion Mode and Manual LC-MS/MS chromatograms of the selected analy-
sis. The Compounds - MS(n) finding function searches the analysis within the selected 
retention time range for all acquired MS(n) spectra, creates compounds at all fragment 
(MS/MS) spectra and sets up the Mass Lists for the calculated compound mass 
spectra. If also UV spectra were acquired the analysis compound UV spectra can be 
created for the compounds additionally to the mass spectra. 
 
The command performs compound finding according to the Find - Chromatogram, 
MS(n) method parameter settings defined for the selected analysis.  

Chromatogram traces 
The corresponding 'TIC [polarity] [MS/MS stage] ([precursor ion])' traces are created in 
Chromatogram window with the MS(n) compound peaks found being labeled according 
to the Display method parameter settings.  
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Compounds and compound spectra 
The compounds found are entered in the analysis' Compound Spectra folder and their 
peak data is stored in the corresponding Compound List.  
For each compound, the corresponding averaged MS(n) compound spectrum/spectra 
is/are calculated and displayed along with the corresponding polarity, MS/MS stage, 
precursor ion, spectrum type, retention time and sequence index. Depending on the 
parameter setting for mass spectrum calculation as well as on the type of data ana-
lyzed, line and/or profile spectra are calculated. In contrast to compound spectra gen-
erated by the Compounds - Chromatogram or Compounds Manually - Chromatogram 
functions, no intensity weighted averaging is performed.  
A Mass List is set up for each compound spectrum. Mass peak finding on profile 
spectra is performed according to the Mass List method parameters defined for the 
selected analysis. 

Example: Finding compounds in an MS(n) analysis acquired in 'More ions' mode 
The following figure illustrates the results of a Compounds - MS(n) operation performed 
on an MS(n) analysis acquired in 'More ions' mode. For each compound the corre-
sponding profile and line spectra are calculated.  

 
Figure 4-5 Results of Compounds - MS(n) performed on an MS(n) analysis acquired 

in 'More ions' mode with calculating line and profile spectra for a com-
pound 

Shortcut 
Button:  
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4.4 Compounds - AutoMS(n) Command 

The Compounds - AutoMS(n) command is used to automatically find compounds on 
all acquired Auto-LC-MS(n) chromatograms of the selected analysis. Positive, negative 
and alternating polarity analyses can be searched. Positive, negative and alternating 
polarity analyses can be searched. The Compounds - AutoMS(n) finding function 
searches the analysis within the selected retention time range for all acquired MS(n) 
spectra, creates compounds at all (averaged) precursor (MS) and fragment (MS/MS) 
spectra and sets up the Mass Lists for the calculated compound mass spectra. If also 
UV spectra were acquired the analysis compound UV spectra can be created for the 
compounds additionally to the mass spectra. 
The MS spectrum which is taken as precursor spectrum in data processing is normally 
identical to the MS spectrum that has been effective in data acquisition, i.e. the MS 
spectrum (precursor spectrum) is the immediate precursor of the MS(n) spectrum (frag-
ment spectrum). If the quality (intensity and resolution) of the spectrum that on the time 
scale follows the fragment spectrum is better, that spectrum will be chosen as precur-
sor spectrum. In case the same precursor has been chosen again within the time range 
specified average spectra will be created and the above logic does not apply. 
Depending on the data acquired, specific options can be set to control the AutoMS(n) 
compound finding. If the Filter for detected neutral losses only option is set only 
those compounds will be filtered out which have a fragment spectrum that was 
acquired due to a "detected neutral loss" (in TrapControl) (see example below). If the 
Merge positive and negative compounds option is set and precursors are about 2 
amu apart ([M+H]+ and [M–H]–) positive and negative spectra will be combined in one 
compound (see example below). If the Fragments qualified by option is set com-
pounds will be generated only if the fragment spectra are positively qualified by the 
selected building block set. 
 
The command performs compound finding according to the Find – AutoMS(n) and 
corresponding Find - Chromatogram, MS(n) method parameter settings defined for 
the selected analysis.  

Chromatogram trace 
The corresponding 'AutoMS(n): TIC [polarity]All MS FullScan' trace is created in the 
Chromatogram window with the MS(n) compound peaks found being labeled according 
to the Display method parameters settings. AutoMS(n) chromatogram peak labels are 
placed on all TIC, EIC and BPC traces. 

Compounds and compound spectra 
The compounds found are entered in the analysis' Compound Spectra folder and their 
peak data is stored in the Compound List.  
For each compound, the corresponding averaged MS and MS(n) compound spectra of 
each generation are calculated and displayed along with the corresponding polarity, 
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MS/MS stage, precursor ion(s) (if n>1), spectrum type, retention time and sequence 
index. Compounds of alternating polarity analyses contain positive and negative MS 
and MS(n) spectra if precursors are about 2 amu apart ([M+H]+ and [M-H]-).  
Depending on the parameter setting for mass spectrum calculation as well as on the 
type of data analyzed, line and/or profile spectra are calculated. In contrast to com-
pound spectra generated by the Compounds - Chromatogram or Compounds Manually 
- Chromatogram functions, no intensity weighted averaging is performed. The MS com-
pound spectra automatically become background subtracted if the corresponding 
option is set in the method parameters.  
A Mass List is set up for each compound spectrum. Mass peak finding on profile 
spectra is performed according to the Mass List method parameters defined for the 
selected analysis. 
 

Example: Finding compounds in an enhanced Collision-Induced Dissociation 
(eCID) AutoMS(n) analysis without/with filtering for detected neutral 
losses only 

The following two figures illustrate the results of a Compounds - AutoMS(n) operation 
performed on an eCID AutoMS(n) analysis first without and then with the Filter for 
detected neutral losses only option set. Without filtering, a total of 249 compounds 
were found when using the parameters' default values. Filtering reduces the compound 
number to 20 compounds with fragment spectra acquired due to a "detected neutral 
loss". 
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Figure 4-6 Results of Compounds - AutoMS(n) on an eCID AutoMS(n) analysis with-

out the Filter for detected neutral losses only option set 

 
Figure 4-7 Results of Compounds - AutoMS(n) on an eCID AutoMS(n) analysis with 

the Filter for detected neutral losses only option set 
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Example: Finding compounds in an AutoMS(n), alternating polarity analysis 
with merging positive and negative compounds 

The following figure illustrates the results of a Compounds - AutoMS(n) operation 
performed on an AutoMS(n), alternating polarity analysis with the Merge positive and 
negative compounds option set. Merged compounds contain MS and MS/MS spectra 
of positive and negative polarity.  

 
Figure 4-8 Results of Compounds - AutoMS(n) on an AutoMS(n), alternating polarity 

analysis with the Merge positive and negative compounds option set 
Shortcut 

Button:  
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4.5 Compounds - Dissect Command 
The Compounds - Dissect command is used to automatically find compounds on an 
LC-MS chromatogram trace even if the peaks almost completely overlap. Dissect also 
supports AutoMS(n), alternating polarity and in-source Collision-Induced Dissociation 
(ISCID) analyses. Compounds with spectra of each species are calculated. The Com-
pounds - Dissect finding function searches the analysis within the selected retention 
time range as described below, creates compounds and sets up the Mass Lists for the 
compound mass spectra. If also UV spectra were acquired the analysis compound UV 
spectra can be created for the compounds additionally to the mass spectra. 
Dissect is based on the principle that all ions that have the maximum intensity at the 
same time belong to the same compound. The Dissect algorithm utilizes fuzzy-logic 
algorithms, which allow a peak separation process to be run without the need for user 
interaction or any prior information.  
Dissect works using the following main steps: 
- Dissect starts by examining the single ion chromatograms and registers every single 

ion peak by its position, retention time, height, width and other criteria that define a 
"good peak" (e.g. symmetrical, no shoulders, etc.). 

- All potential peak positions are examined by a simple fuzzy-logic process to eliminate 
noise spikes based on a simple rule: If "several masses have their peak at this posi-
tion" and "at least one intensive single ion peak is present" and "the width and other 
peak criteria indicate a good peak", then "it is likely that there is a compound peak". 
Otherwise it is a noise spike. 

- For each compound peak found the most intensive mass is selected as represen-
tative. 

- Following this evaluation, a more complex fuzzy-logic process is used to examine 
neighboring peaks. "If the peak positions are far apart" and "the peak shapes are dif-
ferent" and "both are good and intensive peaks", then "the neighboring peaks belong 
to different compounds". Otherwise, both peaks belong to the same compound and 
the intensity of the smaller peak will be added to the intensity of the larger peak. 

- Finally, the intensities of all masses of the leftover peaks are calculated with the result 
that a clean mass spectrum is obtained for every peak. This step also contains a 
background subtraction, a correction for overloaded mass intensities, and the calcula-
tion of the integrated peak. This integrated peak intensity is calculated from all the 
mass lines for a given compound. 

The Dissect algorithm makes it possible to separate overlapping peaks even if their 
retention times differ by half the scan time and their intensities differ by more than one 
order of magnitude. There are only few restrictions. To separate almost completely 
overlapping peaks, a different specific mass is needed for each compound. This is 
usually the case for compounds that are not isomers. The separation of overlapping 
isomeric compounds (e.g. with similar mass spectra) is possible if there is a minimum 
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between the peaks of the single ion chromatograms. Isomeric compounds without such 
a minimum cannot be separated by this algorithm. Note that the Internal S/N thres-
hold setting can have a strong influence on the number of compounds being found. 
 
The command performs compound finding according to the Find - Dissect method 
parameter settings defined for the selected analysis. 

Chromatogram traces 
The corresponding 'Dissect: Cmpd [number], [retention time]' traces are created in the 
Chromatogram window with the Dissect compound peaks found being labeled 
according to the Display method parameter settings.  

Compounds and compound spectra 
The compounds found are entered in the analysis' Compound Spectra folder and their 
peak data is stored in the corresponding Compound List.  
For each compound, one or several averaged compound spectra are calculated 
depending on the type of analysis that is processed. For example, for alternating 
polarity analyses, mass spectra of positive and negative polarity can be added. For 
AutoMS(n) analyses, fragment compound spectra are added of those fragment spectra 
whose precursor intensity in the precursor (MS) spectrum exceeds 30%; ISCID 
fragment spectra are always added. 
Each compound spectrum is displayed along with corresponding information, e.g. its 
polarity, spectrum type, retention time range and sequence index. A Mass List is set up 
for each compound spectrum. Mass peak finding on profile spectra is performed 
according to the Mass List method parameters defined for the selected analysis. 
 

Example: Finding compounds an MS, positive polarity analysis 
The following figure illustrates the results of a Compounds - Dissect operation per-
formed on an MS, positive polarity analysis. One compound spectrum of positive 
polarity is calculated for each compound. 



Bruker Daltonik GmbH Find Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  4-13

  
Figure 4-9 Results of Compounds - Dissect on an MS, positive polarity analysis; one 

compound spectrum is calculated for each compound 

Example: Finding compounds an AutoMS(n), alternating polarity analysis 
The following figure illustrates the results of a Compounds - Dissect operation per-
formed on an AutoMS(n), alternating polarity analysis. Compounds with MS and 
MS/MS spectra of positive and negative polarity were found. In case of the selected 
compound, two MS2 spectra of negative polarity are added since in both cases the 
intensity of the precursor in the respective precursor spectrum was above 30%. 
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Figure 4-10 Results of Compounds - Dissect performed on an AutoMS(n), alternating 

polarity analysis showing five compound mass spectra being calculated 
for the selected compound 

Shortcut 
Button:   

 
 
4.6 Compounds - Molecular Features Command 
The Compounds - Molecular Features command is used to automatically find 
compounds on an LC-MS chromatogram trace. The Compounds - Molecular Features 
finding function searches the selected chromatogram within the selected retention time 
range and generates compounds with Mass Lists for each compound. 
The Molecular Feature Extraction algorithm is based on the principles that the traces of 
all ions belonging to one compound have a high time-correlation and that the chroma-
tographic peaks of these ions are strongly overlapping. Furthermore, the algorithm 
interprets mass distances (e.g. as distances of isotopes or as distances according to 
different charges) between ions. Finally, a compound is a collection of ions satisfying 
the two criteria 'high correlation in time' and 'the mass distances can be interpreted'.  
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The core algorithm is applied to line spectra. If no line spectra are available or if the 
option to use Profile spectra only is set, then the line spectra are computed in a pre-
processing step using the current method parameter settings for Mass List finding.  
Note: However, the SNAP peak finder must not be used. 
Optionally the spectral background can be subtracted from the line or profile spectra 
prior to applying the Molecular Feature Extraction algorithm.  
Compounds - Molecular Features works using the following main steps: 
- The algorithm defines peak clusters. Each peak cluster contains peaks from subse-

quent mass spectra. The masses of these peaks must be in a narrow mass range, 
which is derived from the MS peak width.  

- The chromatographic peak finder, version 2.0, is applied to the traces of these peak 
clusters to pre-detect possible compounds.  

- The algorithm builds charge states by combining peak clusters, which have both a 
high correlation in time and a m/z distance according to the charge. Each peak cluster 
is replaced by a single, calculated mass peak obtained by averaging over the peaks 
of the respective peak cluster. 

- The algorithm defines compounds from charge states. Charge states with the same 
neutral mass and strongly overlapping chromatographic peaks will be combined to 
one compound. Each compound requires at least one charge state with at least two 
peak clusters. Isolated peak clusters are ignored. 

The S/N threshold parameter is the main parameter for controlling the number of 
compounds generated by the algorithm. 
 
The command performs compound finding according to the Find - Features method 
parameters settings defined for the selected analysis.  
Note: A started Compounds - Features operation can be stopped by clicking Cancel 

in the progress bar. In this case, NO results are entered in the analysis at all.  

Chromatogram traces 
No additional traces are created in the Chromatogram window and no compound labels 
are set. 

Compounds and compound spectra 
The compounds found are entered in the analysis' Compound Spectra folder and their 
peak data is stored in the corresponding Compound List.  
For each compound, an averaged line spectrum is calculated. The lines represent the 
mass peaks that were calculated for the individual peak clusters of the charge states 
found, one mass peak per cluster. A compound spectrum can contain lines from one or 
more charge states with each charge state having at least two lines. 
A Mass List is set up for each compound spectrum. It contains the calculated peak 
cluster mass peaks of all charge states present.  
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Example: Finding all compounds in a proteomics LC-MS analysis 
The following figure illustrates the results of a Compounds - Molecular Features opera-
tion performed on a proteomics LC-MS analysis within the displayed retention time 
range. The default parameter values were used except that the Proteomics option was 
set. This results in a total of 772 compounds found. 
The Chromatogram window shows the TIC trace. Almost all compounds found consist 
of one or two charge states. As an example, the Compound Spectra window displays 
the compound spectrum of Cmpd 22, which consists of lines from three charge states. 
Charge state 1 combines three peak clusters, charge state 2 five clusters and charge 
state 3 four clusters. The corresponding Mass List is shown in the Mass List tab of the 
Spectrum Data window. 

 
Figure 4-11 Results of Compounds - Molecular Features performed on a proteomics 

LC-MS analysis 
Shortcut 

Button:   
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4.7 Compounds - Fractions Command 

The Compounds - Fractions command is used to automatically find compounds in a 
fractionation analysis. For each fraction, one compound is created by integrating the 
MS spectra within the respective retention time range defined by the corresponding 
start ("trapping (#)") and end (end trapping (#)") events. MS/MS spectra are not 
concerned. No parameters can be set for this compound finding function. 

Chromatogram traces 
No additional chromatogram traces are created in the Chromatogram window but each 
fraction gets its corresponding compound label according to the current Display 
method parameter settings.  

Compounds and compound spectra 
The compounds found are entered in the analysis' Compound Spectra folder and their 
peak data is stored in the corresponding Compound List. For each compound an 
averaged compound spectrum is calculated and displayed along with corresponding 
information, e.g. its polarity, spectrum type, retention time range and sequence index. 
A Mass List is set up for each compound spectrum. Mass peak finding on profile 
spectra is performed according to the Mass List method parameters defined for the 
selected analysis. 
 

 
Figure 4-12 Results of Compounds - Fractions performed on a fractionation analysis 



Find Menu Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 4-18 

Shortcut 
Button:   

 
 
4.8 Compounds Manually - Chromatogram Com-

mand 
The Compounds Manually - Chromatogram command is used to manually find a 
new compound peak on the selected chromatogram and add it to the Compound Spec-
tra folder and the Compound List of the analysis. The Compounds Manually - Chroma-
togram function calculates the peak data for the new compound and the corresponding 
averaged compound spectrum/spectra and sets up the respective Mass List(s). In 
addition, you can use this command to manually integrate an existing compound peak 
on the selected chromatogram.  
Manual integration of a UV chromatogram trace includes calculating an averaged com-
pound mass spectrum of all mass spectra in the selected range, which are weighted 
with the UV chromatogram intensity.  
Note: This operation is not suitable for AutoMS(n) data since all mass spectra in the 

selected range will be taken for averaging. 

The command activates/deactivates the Manual Integration mode. When this mode is 
active, this is indicated by the command's tool button being pressed. To find a new or 
integrate an existing compound peak, activate the Manual Integration mode. This 
displays the Manual Integration cursors when the mouse cursor is positioned in the 
Chromatogram window. Which of the four Manual Integration cursors currently appears 
depends on the current Data cursor position and the selection state of a peak.  

Finding a new compound peak 
To add a new compound peak manually, you have to define start and end of the 
respective peak. First, position the Data cursor on the desired start point of the peak for 

which the 'not selected' cursor  must be displayed. This indicates that the 
respective data point does not belong to a pre-defined compound. Then position this 
cursor nearly to this data point so that it changes to the 'add new' cursor  and drag 
this cursor with the left mouse button held down to the desired end of the peak. During 
dragging, two black handles appear indicating the selected start point and the data 
point that corresponds to the current cursor position.  
On releasing the mouse button, the new compound is labeled and entered in the Com-
pound Spectra folder with the peak data is stored in the Compound List. 
For the new compound, the corresponding averaged compound spectrum/spectra is/ 
are calculated and displayed in the Compound Spectra window. Depending on the 
Find - Chromatogram, MS(n) parameter settings currently defined for mass spectrum 
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calculation as well as on the type of data analyzed, line and/or profile spectra are 
calculated. The compound spectra are generated by intensity weighted averaging 
which uses the intensity of the chromatogram trace above the compound baseline. 
They automatically become background subtracted if the respective method parameter 
is set. A Mass List is set up for each compound spectrum. For profile spectra, mass 
peak finding is performed according to the Mass List method parameters currently 
defined for the selected analysis. 

     
Figure 4-13 Finding and integrating a new compound peak manually 

  
Figure 4-14 Manually found compound ('Cmpd 5') with corresponding Analysis List 

and Compound List entries and calculated compound mass spectra 
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Integrating an existing compound peak 
To integrate a pre-defined compound peak manually, position the 'selected' cursor  
on a data point that belongs to the desired peak and click left mouse button. This 
selects the peak and displays two connected black handles indicating the peak's cur-
rently defined start and end. Position the mouse cursor near the handle whose position 
you want to change until it changes to the 'on handle' cursor . Then drag this handle 
with the left mouse button held down to the desired new position.  
On releasing the mouse button, the compound peak is recalculated which results in 
changing the corresponding peak data. The Compound List and Mass List entries are 
altered and the integration type changes to 'Manual'. The corresponding compound 
spectrum/spectra is/are calculated as described above for a new compound.  

     
Figure 4-15 Integrating an existing compound peak manually 

Shortcut 
Button:   

 
 
4.9 Filter Command 

The Filter command is used to filter the Compound List of the selected analysis 
according to certain library search and spectrum properties. The filter criteria you can 
use concern the type of library spectra (positive/negative, MS, MS/MS spectra) used in 
identifying compounds, the effective Purity score, the intensity of positive/negative 
precursors of fragment spectra as well as the total intensity of positive/negative 
fragment spectra. 
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Filtering results in enabling only those compounds and mass spectra that match the 
specified criteria. All compounds and spectra not matching these criteria are disabled 
in the Compound Spectra folder and are hidden from being displayed the Compound 
List. In the Chromatogram window, the corresponding peak labels are displayed in 
light grey. Thus, filtering may be a helpful tool in case of large Compound Lists as e.g. 
from AutoMS(n) runs.  
Related to the filter criteria that can be used, specific Compound List items are avail-
able to display corresponding information. If an item you want to have in the Com-
pound List, as e.g. the intensity of the precursor of positive polarity, is currently not 
displayed, first edit the Compound List layout accordingly. 
 
The command opens the Compound List Filter dialog, which allows you to select the 
desired filter criterion/criteria. 
 

 
Figure 4-16 Compound List Filter dialog (default setting) 

In Identification by Library Search, define which compounds should be enabled 
concerning the type of library spectra used in identification: 

Identified by MS/MS 
Check this option if compounds identified by fragment MS/MS spectra should be 
enabled. 

Identified by MS 
Check this option if compounds identified by precursor MS spectra should be enabled. 

Identified by +MS, +MS/MS 
Check this option if compounds identified by MS and/or MS/MS spectra of positive 
polarity should be enabled. 
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Not identified by MS/MS 
Check this option if compounds not identified by any fragment MS/MS spectra should 
be enabled.  

Not identified by MS 
Check this option if compounds not identified by any precursor MS spectra should be 
enabled.  

Identified by -MS, -MS/MS 
Check this option if compounds identified by MS and/or MS/MS spectra of negative 
polarity should be enabled. 

Minimum ‘effective Purity’ score 
Enter the minimum effective Purity score a compound must exceed to be enabled.  
 
In Spectrum properties, define intensity thresholds concerning positive and negative 
fragment spectra: 

Minimum precursor intensity 
Define the intensity threshold the precursor of the positive or the negative fragment 
spectrum of a compound must exceed to enable the compound. Compounds with 
fragment spectra whose precursors do not reach this intensity value are disabled. 

pos.  
Enter the minimum intensity the precursor ion of a positive fragment spectrum must 
exceed to enable the corresponding compound.  

neg.  
Enter the minimum intensity the precursor ion of a negative fragment spectrum must 
exceed to enable the corresponding compound.  

Minimum total fragment spectrum intensity 
Define the total intensity threshold the positive or negative fragment spectrum of a 
compound must exceed to enable the compound. Compounds with fragment spectra 
not reaching this total intensity value will be disabled. 
pos.  
Enter the minimum total intensity a positive fragment spectrum must exceed to enable 
the corresponding compound.  

neg.  
Enter the minimum total intensity a negative fragment spectrum must exceed to 
enable the corresponding compound.  

Reset 
Resets the current filter settings to default values. 
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OK 
Filters the Compound List according to the current filter settings with closing the 
dialog. 

Apply 
Filters the Compound List according to the current filter settings while keeping the 
dialog open. 
 

 
Figure 4-17 Result of filtering a Compound List with intensity threshold of the + pre-

cursor set to 20,000 

Shortcut 
Button:  
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4.10 Clear Results Command 

The Clear Results command clears the compound finding results currently available 
for the selected chromatogram analysis. This removes all compounds found and all 
MS(n) chromatogram traces created from the Compound Spectra and Chromatograms 
folders of the selected analysis. 

Shortcut 
Button:  

 
 
4.11 Parameters Command 

The Parameters command is used to define the parameter settings to be used for the 
selected analysis in compound finding operations. The command opens the Find -
 Chromatogram, MS(n) , - AutoMS(n), - Dissect or - Molecular Features tab of the 
Method Parameters dialog. 
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5 MASSLIST MENU 

The MassList menu offers the following commands: 

  
Figure 5-1 MassList menu 

Command Used to … 

Find Find a Mass List in the selected mass spectrum. 
Edit Edit the Mass List of the selected mass spectrum. 
Clear Clear the Mass List of the selected mass spectrum. 
Integrate Manually Manually find and integrate Mass List peaks in the selected 

mass spectrum. 
Parameters Define the MassList method parameters for the selected 

analysis. 
 
 
5.1 Find Command 

The Find command is used to automatically find a Mass List in the selected mass 
spectrum using the defined mass peak finder. This command can be applied to multiple 
selected mass spectra in the same analysis at once. 
The Apex, Centroid, SNAP1, Sum Peak and FTMS peak finders can be applied to 
profile spectra only whereas the SNAP2 peak finder can work on line spectra, too. 
Depending on the data to be analyzed, you should use (one of) the corresponding 
appropriate peak finder(s). Mass Lists can be filtered for specified exclusion masses 
while being set up. 
 
The command performs mass peak finding on the selected mass spectrum according 
to the Mass List method parameter settings defined for the selected analysis. The 
results are stored in the mass spectrum's Mass List. You can view the Mass List of the 
selected mass spectrum in the Mass List tab of the Spectrum Data window. If you want 
to show other/additional Mass List items as the currently displayed ones, you have to 
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edit the Mass List layout accordingly. The Mass List can be filtered and manually 
edited. 
In the mass spectrum, the mass peaks found become labeled according to the settings 
in the Labels tab of the Options dialog and with the numeric mass precision defined in 
the Display method parameters. When the SNAP algorithm is used, the label also 
includes the corresponding charge state. Mass labels of SNAP2 peaks are placed at 
appropriate, shifted position at the average mass of the isotope pattern. If the mass 
label is shifted the label string starts with a tic ('). Not all SNAP2 peaks become shifted. 
 
Example: Apex mass peak finding on a profile spectrum 

  
Figure 5-2 Results of Apex peak finding on a profile spectrum (intensity threshold 

set to '1000') 

Example: SNAP2 mass peak finding on a profile spectrum without/with the 
option Include component isotope pattern set 

The following figures show results of a SNAP2 mass peak finding on a profile spectrum 
without/with the Include component isotope pattern option set. If the option is not 
set, the mass peaks found are labeled in the mass spectrum with corresponding m/z, 
charge state and component information. Shifted mass labels are indicated by a tic. If 
the option is set, snapped pattern spectra are additionally created labeled with corre-
sponding m/z. A spectrum including all snapped isotopic patterns is available as well as 
the individual pattern spectra. The Mass List for the selected spectrum can be viewed 
in the Mass List tab and the deconvolution results are shown in the Deconvolution 
Results tab. 
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Figure 5-3 Results of SNAP2 peak finding on a profile spectrum without Include 

component isotope pattern option set and corresponding Mass List data 

 
Figure 5-4 Results of SNAP2 peak finding on a profile spectrum without Include 

component isotope pattern option set and corresponding deconvolution 
results 

  
Figure 5-5 Results of SNAP2 peak finding with Include component isotope pattern 

option set: here snapped isotopic pattern spectra are created additionally 
and entered in the Analysis List; one spectrum includes all snapped 
patterns whereas the other contain an individual isotopic pattern each 
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Figure 5-6 SNAP2 peak finding with Include component isotope pattern option set: 

display of the mass spectrum created from all snapped patterns 

  
Figure 5-7 SNAP2 Mass List finding with Include component isotope pattern option 

set: display of a single snapped isotopic pattern for the given m/z and 
charge 

 
Example: SNAP2 mass peak finding on a line spectrum 

  
Figure 5-8 Results of SNAP2 peak finding on a line spectrum with Include compo-

nent isotope pattern option set 

Shortcut 
Button:  
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5.2 Edit Command 

The Edit is used to manually add a new peak to or delete an existing peak from the 
Mass List of the selected profile spectrum displayed in the Compound Spectra window 
or Mass Spectrum window. A peak is added/deleted by selecting it from the profile 
spectrum using the corresponding Edit Mass List cursor. 
The command activates/deactivates the Edit Mass List mode; the mode is active when 
the command's tool button is being pressed. In the Edit Mass List mode, the Edit Mass 
List cursor is displayed when the mouse cursor is positioned in the active data window. 
Which of its two shapes appears depends on whether the Data cursor is currently 
positioned on an already defined peak. 
Tip: When currently in another permanent interaction mode, you can quickly switch to 

the Edit Mass List mode by holding down the Ctrl key. The Edit Mass List mode 
will be temporarily active as long as the Ctrl key is held down. When the key is 
released, the previous active mode will be activated again. 

 
Adding a new mass peak 

To add a new mass peak, position the 'add' cursor  on the peak and click left the 
mouse button. This defines the new peak, labels it according to the settings in the 
Labels tab of the Options dialog and enters it in the Mass List. The peak's m/z value is 
calculated by using the mass peak finder selected in the Mass List method parameter 
settings for the selected analysis if the Use parameters to calculate peak position 
option is checked.  

      
Figure 5-9 Adding a new mass peak to a Mass List 
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Deleting an existing mass peak 

To delete an existing peak from the Mass List, position the 'delete' cursor  on the 
peak and click the left mouse button. This removes the mass peak from the Mass List.  

      
Figure 5-10 Deleting a peak from a Mass List 

Shortcut 
Button:  

Dedicated key for Edit Mass List mode 
Ctrl 

 
 
5.3 Clear Command 

The Clear command clears the Mass List of the selected mass spectrum. You can 
clear only Mass Lists of profile spectra and of line spectra that were set up using the 
SNAP2 peak finder; the automatically set up line spectrum Mass Lists cannot be 
cleared. If a SNAP2 Mass List of a line spectrum is cleared, the automatically set up 
Mass List for this line spectrum will be displayed again. The command can be applied 
to multiple selected mass spectra in the same analysis at once. 

Shortcut 
Button:  
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5.4 Integrate Manually Command 

The Integrate Manually command is used to manually add a new peak to or integrate 
an existing peak in the Mass List of the selected profile spectrum displayed in the 
Compound Spectra window or Mass Spectrum window.  
The command activates/deactivates the Manual Integration mode; the mode is active 
when the command's tool button is being pressed. In Manual Integration mode, the 
Manual Integration cursor is displayed when the mouse cursor is positioned in the 
active data window. Which of its four shapes currently appears depends on the actual 
Data cursor position and the selection state of the peak.  
 
Adding a new mass peak 
To manually add a new mass peak you have to define the start and end of the peak. 
First, position the Data cursor on the start point of the peak to display the 'not selected' 

cursor  is displayed. This indicates that the respective data point does not belong 
to an already defined peak. Then position the cursor nearly to this data point so that it 
changes to the 'add new' cursor  and drag the cursor with the left mouse button 
held down to the end of the peak. While dragging, two connected black handles will 
appear indicating the selected start point and the data point that corresponds to the 
current cursor position.  
On releasing the mouse button, the new peak becomes labeled according to the 
settings in the Labels tab of the Options dialog and is entered in the Mass List of the 
analysis. The peak's m/z value is calculated by using the mass peak finder selected in 
the Mass List method parameter settings for the selected analysis if the Use para-
meters to calculate peak position option is checked.  

       
Figure 5-11 Adding and integrating a new Mass List peak manually 
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Reintegrating an existing peak 
To manually reintegrate an already defined peak, move the mouse cursor over the 
desired peak to display the 'selected' cursor  and then click the left mouse button. 
This selects the peak and displays two connected black handles indicating the current 
start and end of the peak. Position the mouse cursor near the handle whose position 
you want to change so that the cursor changes to the 'on handle' cursor . Then drag 
this handle with the left mouse button held down to the desired new position and 
release the mouse button. This recalculates the Mass List peak and changes the corre-
sponding Mass List entries.  

       
Figure 5-12 Reintegrating an already defined Mass List peak manually 

Shortcut 
Button:   

 
 
5.5 Parameters Command 

The Parameters command is used to define the parameter settings to be used for the 
selected analysis in mass peak finding operations. The command opens the Mass List 
- Apex, - Centroid, - SNAP, - Sum Peak or - FTMS tab of the Method Parameters 
dialog. The tab displayed depends on the peak finder currently selected in the open 
method. 
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6 DECONVOLUTE MENU 

The Deconvolute menu offers the following commands: 

  
Figure 6-1 Deconvolute menu 

Command Used to … 

Mass Spectra (Charge) Deconvolute the selected mass spectrum. 
Clear Results Clear previous charge deconvolution results for selected 

mass spectrum. 
Charge State Ruler Activate the Charge State Ruler mode to select mass peaks 

for manual charge deconvolution. 
Deconvolute with 

Charge State Ruler 
Manually charge deconvolute the selected mass spectrum 
using a modified Mass List defined by the Charge State 
Ruler. 

Parameters Define the Charge Deconvolution method parameters for 
the selected analysis. 

 
 
6.1 Mass Spectra Command 

The Mass Spectra command is used to (charge) deconvolute the selected mass 
spectrum of the active analysis. DataAnalysis provides three different types of (charge) 
deconvolution: Proteins/large molecules charge deconvolution, Peptides/small mole-
cules charge deconvolution and Maximum Entropy deconvolution. Charge deconvolu-
tion uses up to 10,000 most intense peaks of each spectrum. The command can be 
applied to multiple selected spectra in the same analysis at once. 

Proteins/large molecules and Peptides/small molecules charge deconvolution 
Note: To charge deconvolute higher charge states when using the Proteins/large 

molecules or Peptides/small molecules algorithm, you will need the 'ESI Com-
pass 1.3, Charge Deconvolution Option' license. Without that license, you are 
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permitted to deconvolute isotope-resolved signals only. The parameters that 
apply to related-ion deconvolution will not be present. 

Proteins/large molecules deconvolution is suitable for proteins and other large mole-
cules, Peptides/small molecules deconvolution for peptides and other small molecules. 
Both types apply to profile as well as line spectra.  
These deconvolution types provide resolved-isotope deconvolution and related-ion 
deconvolution to be used. If both deconvolution functions are used, related-ion decon-
volution will pre-dominate the resolved-isotope deconvolution for compounds of 5 or 
more peaks or if the Min. peaks in comp. parameters is set to 5 or higher. Otherwise, 
the resolved-isotope deconvolution will pre-dominate the related-ion deconvolution. 
Proteins/large molecules and Peptides/small molecules charge deconvolution require a 
Mass List to be already set up for each mass spectrum you want to deconvolute. Mass 
List set up is the essential step in calculating the correct charge deconvolution results.  
How the molecular mass of a component is calculated depends on whether the com-
ponent contains isotopically resolved peaks. If isotopically resolved peaks are avail-
able, the molecular mass of that component is calculated based on the isotopically 
resolved signals only, while signal intensity is also taken into account. Calculations of 
molecular mass of components without any isotopically resolved signals are based on 
signal intensity only. 
Proteins/large molecules or Peptides/small molecules charge deconvolution delivers 
specific charge deconvolution results (components found, their molecular mass, abso-
lute and relative abundances as well as component details) for each spectrum charge 
deconvolution is performed on. The charge deconvolution results can be viewed in the 
Deconvolution Results tab of the Spectrum Data window. The abundance reported 
here is the sum of all monoisotopic peaks; e.g., if a component A has a 2+, 3+ and 4+ it 
sums up the intensity of the three monoisotopic peaks. 
Whether additional deconvolution results spectra are created, depends on the current 
settings in the General tab:  
• If the Include shifted spectrum option is set, the corresponding shifted (= deconvo-

luted) spectrum is created that contains the calculated deconvoluted peaks for all 
components found. It is entered in the Analysis List as a subentry of the original 
spectrum. Depending on whether a singly charged or a neutral spectrum is created 
the deconvoluted component peaks are labeled either by e.g. '1+ (A)' for singly 
charged spectra or by 'Mr (A)' for neutral spectra together with the corresponding 
molecular mass calculated for the component. All peaks of the original spectrum that 
were included in calculating the deconvolution results will be labeled with the 
corresponding charge states and component information (e.g. '3+ (A)'). 
If this option is not set, no deconvolution results spectra are created. In this case, the 
peaks of the original spectrum, which were included in calculating the deconvolution 
results, are labeled with the corresponding charge states without any component 
information (e.g. 3+'). 
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• If the Include component details option is set additionally, also the corresponding 
component detail spectra are created that contain the sets of related ions and charge 
states. These are entered in the Analysis List as subentries of the shifted spectrum. 
Component detail spectra are disabled by default. 

• If the Retain residual option is set, a residual spectrum containing all data points 
that were not found to belong to the set(s) of related ions will be created and entered 
in the Analysis List as a subentry of the original spectrum. The residual spectrum is 
disabled by default. 

• If the Show component details and residual option is set, the component detail 
spectra and/or residual spectrum, if created, are enabled automatically. 

 
Maximum Entropy deconvolution 
(Maximum Entropy Deconvolution: Copyright 1991-2004 Spectrum Square Associates, 
Inc. All rights reserved. This program or documentation contains confidential informa-
tion and trade secrets of Spectrum Square Associates, Inc. Reverse compiling, disas-
sembling, other reverse engineering and modification of object code are prohibited. 
Use, copying and disclosure are subject to a written license agreement with Spectrum 
Square Associates, Inc. Use of copyright notice is precautionary and does not imply 
publication.) 
Note: To deconvolute profile spectra using the Maximum Entropy algorithm, you will 

need the 'ESI Compass 1.3, Maximum Entropy Deconvolution Option' license. 
Without that license, the Maximum Entropy option and corresponding tab will 
not be available. 

Maximum entropy deconvolution is suitable for large molecules, e.g. proteins, showing 
different charge states of the same component. It is e.g. the method of choice if smaller 
components are to be detected. This deconvolution type applies to profile spectra only. 
In contrast to the other charge deconvolution algorithms, the Maximum Entropy decon-
volution delivers a single, contiguous, deconvoluted spectrum within the mass range 
boundaries defined. Currently, the deconvoluted spectrum is not labeled but you can 
label it by performing Mass List finding on it. The Deconvolution Results tab of the 
Spectrum Data window does not display any deconvolution results. 
Also note that a mass range of the original spectrum can be selected for deconvolution. 
This is e.g. helpful for micrOTOF spectra when containing no information in the low 
mass region but a great number of data points to consider. Excluding a non-significant, 
low mass range of a micrOTOF spectrum will increase calculation time significantly. 
 
The Mass Spectra command performs (charge) deconvolution according to the 
deconvolution parameter settings defined for the selected analysis in the Method 
Parameters dialog. For Maximum Entropy the settings in the Charge Deconvolution 
- Maximum Entropy tab are applied. For Proteins/large molecules the settings in the 
- Proteins/Large Molecules and - General tabs are used, for Peptides/small mole-
cules the settings in the - Peptides/Small Molecules and - General tabs. 
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Note: A started deconvolution operation can be aborted by clicking the Cancel button 
in the progress bar.  

 
Example 1: Results of a Proteins/large molecules related-ion deconvolution 
The first example shows results of a Proteins/large molecules related-ion deconvolution 
performed on a single profile spectrum from myoglobin. 
The following figures show the non-deconvoluted spectrum and results obtained with 
certain options being set or not. 
 

  
Figure 6-2 Original single profile spectrum before charge deconvolution (section) 

  
Figure 6-3 Proteins/large molecules related-ion deconvolution (Include shifted spec-

trum option not set): Display of the original profile spectrum with peaks 
labeled with charge state (section) 
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Figure 6-4 Proteins/large molecules related-ion deconvolution (Include shifted spec-

trum and Include component details options set): Display of original 
profile spectrum with peaks labeled with charge state and component 
information (section) 

 
Figure 6-5 Proteins/large molecules related-ion deconvolution (Include shifted spec-

trum and Include component details options set): Display of the original 
profile spectrum (red/left) and the deconvoluted, singly charged spectrum 
with calculated component peaks (green/right) and corresponding decon-
volution results (bottom) 
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Figure 6-6 Proteins/large molecules related-ion deconvolution (Include shifted spec-

trum and Include component details options set): Display of the compo-
nent A detail spectrum 

  
Figure 6-7 Proteins/large molecules related-ion deconvolution (Retain residual 

option set): Display of the residual spectrum (section) 

 
Example 2: Results of a Peptides/small molecules resolved-isotope deconvolu-
tion 
The following example shows results of Peptides/small molecules resolved-isotope 
deconvolution performed on a profile spectrum obtained from a tryptic cytochrome C 
digest sample. The following figures show the non-deconvoluted spectrum and results 
obtained with certain options being set or not. 
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Figure 6-8 Original single profile spectrum before charge deconvolution (section) 

  
Figure 6-9 Peptides/small molecules resolved-isotope deconvolution (without 

Include shifted spectrum option set): Display of original profile spectrum 
with peaks labeled with charge state (section) 
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Figure 6-10 Peptides/small molecules resolved-isotope deconvolution (with Include 

shifted spectrum and Include component details options set): Display of 
the deconvoluted, singly charged spectrum with the calculated compo-
nent peaks (top) and corresponding deconvolution results (bottom) 

 
Examples 3 and 4: Results of Maximum Entropy deconvolution 
The following examples show results of Maximum Entropy deconvolution performed on 
profile spectra from two micrOTOF analyses. In the first example, a measured spec-
trum and its corresponding calculated Maximum Entropy deconvoluted spectrum are 
shown. The second example displays results of Maximum Entropy deconvolution that 
were obtained for compounds found with the Dissect finding function performed on the 
TIC +All MS trace for an intact ribonuclease. 

  
Figure 6-11 Maximum Entropy deconvolution: acquired spectrum (above) and decon-

voluted spectrum (below) with Mass List finding already performed on it 



Bruker Daltonik GmbH Deconvolute Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  6-9

  
Figure 6-12 Maximum Entropy deconvolution: the Chromatogram window displays the 

traces for the Dissect compounds found while the Compound Spectra 
window shows the corresponding Dissect compound spectra and the 
respective calculated deconvoluted spectra 

Shortcut 
Button:  

Key: F4 
 
 
6.2 Clear Results Command 

The Clear Results command clears the current charge deconvolution results for the 
selected mass spectrum. This command can be applied to multiple selected spectra of 
the same analysis.  
Shortcut 

Button:  
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6.3 Charge State Ruler Command 

The Charge State Ruler command activates/deactivates the Charge State Ruler 
mode. This shows/hides the Charge State Ruler in the Compound Spectra or the Mass 
Spectrum window, respectively. The mode is active when the command's tool button is 
being pressed. 
The Charge State Ruler allows selecting a modified Mass List for the active mass 
spectrum containing mass peaks of different charge states. This list can then be used 
as input for manual charge deconvolution using the Deconvolute with Charge State 
Ruler command from the Deconvolute menu. Setting up this modified Mass List is 
based on the mass peaks contained in the current Mass List of the mass spectrum; 
thus, with the Charge State Ruler you can select only already defined mass peaks. 
You can also use the Charge State Ruler to search for a dimer or for isotopes of the 
center mass. For the latter the displayed mass range must be less than m/z 20.  

Setting up Charge State Ruler 
To set up the Charge State Ruler activate the Charge State Ruler mode.  
In the Charge State Ruler toolbar, select the Adduct Ion and Charge State to be 

used in initial setup of the Charge State Ruler. Press  if the ruler should attach only 
to existing peaks when it is moved; otherwise, you can move it continuously.  

In the mass spectrum, position the Charge State Ruler cursor  on that data point 
you want to assign the specified charge state to and click left mouse button. The 
Charge State Ruler is set up according to the current adduct ion and charge state 
settings and the m/z of the selected data point.  
All Charge State Ruler lines are labeled with corresponding charge state. Lines that 
currently match an existing Mass List peak are displayed in dark blue whereas lines not 
matching such a peak are displayed in light blue. Mr gives the neutral mass which is 
calculated from the m/z of the selected peak, the charge state currently assigned to it 
(e.g. +15) and the adduct ion specified. If the appearing charge state lines and the 
peak pattern do not match, select another charge state in the toolbar and set up the 
Charge State Ruler again.  

Selecting a modified Mass List for manual charge deconvolution 
To perform manual charge deconvolution using the Deconvolute with Charge State 
Ruler command you have to set up a modified Mass List using the Charge State Ruler. 
Since only mass peaks that correspond to dark blue colored lines will be included in the 
modified Mass List when selecting this command, try to select as many mass peaks as 
possible, especially the mayor ones, by moving the Charge State Ruler along the mass 
spectrum and looking for matches. 
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The Charge State Ruler cursor should be attached to the charge state defined in the 
toolbar. Position the cursor to this charge state line so that it changes to  and then 
drag the ruler with the left mouse button held down until the Charge State Ruler lines 
match the ion envelope. During dragging, the Charge State Ruler is continuously 
updated with regard to the current cursor position. 
When finding peaks of different charge states was successfully, you can perform 
charge deconvolution on them by selecting the Deconvolute with Charge State 
Ruler command. 

  
Figure 6-13 Selecting a data point for setting up Charge State Ruler 

  
Figure 6-14 Charge State Ruler set up according to the current adduct ion and charge 

state settings and the m/z of the selected data point 
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Figure 6-15 Charge State Ruler after moving along the mass spectrum to include in 

the modified Mass List as many mass peaks as possible 

Showing dimer 
The Charge State Ruler also shows a dimer line which is labeled with ‘x2’. It repre-
sents the dimer mass calculated based on the current mass value the charge-‘1’-line 
is positioned on. To search for a potential dimer peak, you can move the Charge 
State Ruler along the mass spectrum. Concerning its color, the dimer line behaves as 
same as the charge lines. When it is positioned on a Mass List peak, it is displayed in 
dark blue, otherwise in light blue. 

 
Figure 6-16 Charge State Ruler showing dimer line (‘x2’) 
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Showing isotopes of center mass 
The Charge State Ruler also shows isotope lines calculated for the current center 
mass. The center mass is that mass that corresponds to the last handled ruler line. 
Isotope lines are only visible if the displayed mass range is less than m/z 20. They are 
displayed in light blue without any labels. 

 
Figure 6-17 Charge State Ruler showing three isotope lines for current center mass 

Shortcut 
Button:  

 
 
6.4 Deconvolute with Charge State Ruler 

Command 

The Deconvolute with Charge State Ruler command is used to manually charge 
deconvolute the selected mass spectrum. This applies to Proteins/large molecules or 
Peptides/small molecules charge deconvolution only. Manual charge deconvolution 
uses a modified Mass List that has to be defined using the Charge State Ruler 
command before selecting the Deconvolute with Charge State Ruler command. 
With manual charge deconvolution, you limit charge deconvolution on selected mass 
signals to one component only whereas the automatic procedure via the Mass Spectra 
command from the Deconvolute menu allows deconvoluting several components at 
once.  
The command sets up the modified Mass List containing those peaks that match 
current Charge State Ruler lines. Such lines are indicated in dark blue. Based on this 
modified Mass List, charge deconvolution is performed according to the corresponding 
parameter settings currently defined for the selected analysis. Depending on the 
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selected deconvolution type, the parameter settings currently defined in the Charge 
Deconvolution - Proteins/Large Molecules and - General tabs or the - Peptides/ 
Small Molecules and - General tabs are used. Additionally, the molecular mass is 
restricted to a narrow window at the molecular mass displayed in the Charge State 
Ruler (Mr 'molecular mass'). 
Note: The adduct ion setting made in the Charge State Ruler toolbar will be super-

seded by the respective setting in the method parameters. 

If manual charge deconvolution was successful, the deconvolution results are dis-
played in the respective data window. The data currently shown depends on whether 
the Include shifted spectrum, Include component details and Show component 
details options found in the General tab are set. The charge deconvolution results can 
be viewed in the Deconvolution Results tab of the Spectrum Data window. For a 
detailed description, please refer to the Mass Spectra command from the Decon-
volute menu. 
 
The following example shows results from a manual charge deconvolution performed 
on a protein.  
 

  
Figure 6-18 Selecting the mass peaks for manual charge deconvolution with the 

Charge State Ruler 
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Figure 6-19 Manual charge deconvolution (Include shifted spectrum, Include compo-

nent details and Show component details options set): display of the 
original spectrum labeled with charge state and component information 

  
Figure 6-20 Manual charge deconvolution (Include shifted spectrum, Include compo-

nent details and Show component details options set): display of the 
component spectrum (blue/left) and the deconvoluted, singly charged 
spectrum (green/right)  

Shortcut 
Button:   
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6.5 Parameters Command 

The Parameters command is used to define the parameter settings to be used for the 
selected analysis in (charge) deconvolution operations. The command opens the 
Charge Deconvolution - Maximum Entropy, - Proteins/Large Molecules or - 
Peptides/Small Molecules of the Method Parameters dialog. The tab displayed 
depends on the deconvolution type currently selected in the open method.  
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7 IDENTIFY MENU 

The Identify menu offers the following commands: 

  
Figure 7-1 Identify menu 

Command Used to … 

Mass Spectra Perform a library search on the selected mass spectrum. 
Add to Library Add the selected mass spectrum to a chosen custom library. 
Clear Results Clear the identification results for the selected mass spec-

trum. 
Show Spectrum in 

LibraryEditor 
Show the selected library spectrum in LibraryEditor. 

Determine Molweight 
from Adducts 

Calculate the molecular weight of a compound from possible 
adduct ions. 

Parameters Define the Library Search method parameters for the 
selected analysis. 

 
 
7.1 Mass Spectra Command 

The Mass Spectra command is used to perform automatically a library search on a 
selected individual mass spectrum or entire compound from a compound finding func-
tion. Compounds with only one or more than one compound spectra (at the moment, 
the latter applies to AutoMS(n) and Dissect compounds only) can be identified. Profile 
as well as line spectra can identified using either a single or a set of search libraries. 
When using multiple libraries, hierarchical or parallel search is possible. This command 
can be applied to multiple individual spectra or entire compounds selected in the same 
analysis. 
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The command performs a library search according to the Library Search - Libraries, - 
Settings, - Retention Time, - Parameter Matching, - Add, and - Advanced method 
parameter settings defined for the active analysis.  
Only mass signals with a signal-to noise ratio of at least 5 are taken into account (to 
avoid high Fit scores on low signals). 
How search proceeds, what results are obtained and how these are rated depends on 
whether a single or a set of libraries is searched, a hierarchical or parallel search is 
performed and an individual mass spectrum or an entire compound with only one or 
more than one compound spectrum is selected. The following examples show search 
results for an individual mass spectrum, for multiple compounds with only one com-
pound spectrum and for an AutoMS(n) compound with an MS and an MS/MS spectrum 
without/with applying cross matching. 
Note: For explanation of the library search scores Purity, Fit, RFit and Parameter 

Match and the (combined) effective scores Purity', Fit' and RFit' and how these 
scores are calculated please refer to Sections 12.6.4.2.1 and 12.6.4.2.2). 

 

Example: Library search on an individual mass spectrum 
This example shows results of a library search performed on an averaged MS3 spec-
trum of a chromatogram analysis. Two library hits were found that sufficiently met the 
specified parameter settings.  
The respective library spectra are entered in the Analysis List as a subentry of the 
searched mass spectrum sorted by the score value of the decisive score (here the 
Purity score) and are displayed in the Compound Spectra window (for mass spectrum 
analyses in the Mass Spectrum window). In principle, along with each library spectrum 
the name of the library it derives from and the calculated P, F, R and M scores for the 
Purity, Fit, R(everse)Fit, and Parameter Match scoring factors are shown. The 
structural formula of the compound is also displayed if it is available in the search libra-
ry. Depending on the settings defined for the display of library spectra (see Options - 
Info dialog), additionally the compound name, specific spectrum information including 
instrument type, ionization method, ion polarity, MS/MS stage or the compound's CAS 
number can be shown.  
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Figure 7-2 Library search results for the averaged MS3 spectrum displayed in the top 

window; the library spectra are displayed along with library name, com-
pound name, spectrum info and calculated scores 

 

Example: Library search on multiple compounds with one compound spectrum 
each 

The following example shows the results of a library search performed on three com-
pounds found in a Compounds - MS(n) finding operation.  
The library spectra for the library hits found are entered in the Analysis List and 
displayed in the Compound Spectra window as described in the example above. In 
contrast to library search on an individual mass spectrum, also the 'effective' scores 
Purity', Fit' and RFit' are calculated and entered in the analysis' Compound List. 
These effective scores derive from combining the calculated P, F and R scores with the 
calculated M score and, thus, take into account the differences that may exist in the 
acquisition parameters used to acquire the mass spectrum vs. the library spectra. Only 
library hits for which the calculated effective score (e.g. the Purity' score) passes the 
compound post search filter, which is specified by the Minimum effective score and 
Relative minimum score difference settings, are entered in the Compound List.  
You can view the resulting effective scores as well as further library search data when 
the Compound List window is open and the respective Compound List items are 
displayed. If an item you want to have in the Compound List window is currently not 
shown, edit the Compound List layout accordingly.  
The search results shown in the following figure were obtained with the Minimum 
effective score set to '500' and the Relative effective score difference set to '100' for 
the Purity' score. For Cmpd 2 two identification results are entered in the Compound 
List. A third possible result exceeded the defined minimum effective score threshold but 
not the second, higher threshold calculated from the relative effective score difference 
setting and thus was eliminated from the results list again. With a relative effective 
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score setting of '50' (internal default value) the Compound List will show only one result 
for Cmpd 2. 
 

  
Figure 7-3 Library search results for three compounds from a Compounds - MS(n) 

finding operation; the Compound List displays the effective Purity', Fit' 
and RFit' scores for the library hits found 

Example: Library search on an AutoMS(n) compound with MS and MS/MS 
compound spectra without/with applying cross matching 

The following example shows the results of a library search performed on an 
AutoMS(n) compound with an MS and an MS/MS spectrum found in a Compounds - 
AutoMS(n) finding operation. Library search was performed without/with setting the 
Cross match found library compounds to all compound spectra option. In contrast 
to library search on compounds with only one compound spectrum (described above), 
library search on compounds with more than one compound spectrum calculates the 
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combined 'effective' scores Purity', Fit' and RFit' which combine the individual scoring 
results that are reported for each spectrum of the compound separately. How the com-
bined effective scores are calculated depends on whether the Cross match found 
library compounds to all compound spectra option is set or not. Only library hits for 
which the calculated effective score (e.g. the Purity' score) passes the compound post 
search filter, which is specified by the Minimum effective score and Relative mini-
mum score difference settings, are entered in the Compound List. You can view the 
resulting combined effective scores in the Compound List window as described above. 
The search results shown in the following two figures were obtained without (first 
figure) and with (second figure) the Cross match found library compounds to all 
compound spectra option being set. The Minimum effective score was set to '400', 
the Relative effective score difference to '350' for the Purity' score (the large relative 
effective score difference value is needed to show the effect of cross matching; with a 
smaller value there would be only one library compound even if cross matching is not 
set). Comparison of both results shows that applying cross matching and compound 
post search filter has reduced the results list for Cmpd 1 from three to only one library 
compound. 

  
Figure 7-4 Combined library search result for the AutoMS(n) compound obtained 

without setting the Cross match found library compounds to all com-
pound spectra option; the Compound List shows three library compounds 
found for Cmpd 1 with corresponding data 
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Figure 7-5 Combined library search result for the AutoMS(n) compound now 

obtained with setting the Cross match found library compounds to all 
compound spectra option; the Compound List contains only one library 
compound now 

Shortcuts 
Button:  
Key: F3 

 
 
7.2 Add to Library Command 

The Add to Library command is used to add a selected mass spectrum to a custom 
library either as a new compound entry or as a new mass spectrum to an already 
existing compound. You can add a single mass spectrum or multiple selected mass 
spectra either of the same or of different compounds at once. This command allows 
you to build your own MS and MS/MS libraries using the LibraryEditor application. 
Line as well as profile spectra can be added. When adding a profile spectrum only the 
detected mass peaks in the Mass List are exported to the library whereas all mass 
lines present in a line spectrum are exported. If exclusion masses are currently defined 
for the analysis the respective mass spectrum belongs to, these masses will be 
excluded from being exported. 
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If you add one or multiple mass spectra of the same compound, you can enter an expli-
cit compound name as well as specific compound information to be exported with the 
mass spectra. If you add multiple spectra of different compounds, then an auto-name is 
given to the compounds consisting of the analysis name and the compound's retention 
time.  
The mass spectrum/spectra can be added to a pre-existing compound in the chosen 
library or as a new compound entry. You can define how to proceed if the target library 
already contains a compound of the specified name. When a mass spectrum is added 
to the chosen target library, some specific data associated with the mass spectrum 
(e.g. instrument type, ionization method, MS/MS stage, precursor ions) are automati-
cally entered. 
The command opens the tabbed Add Spectra to Library dialog containing the 
following tabs: Spectra (opens by default), Compound Details and Options  

Shortcut 
Button:  

 
 
7.2.1 Add to Library Command - Spectra 

The Spectra tab is used to enter the compound name with which the spectrum/spectra 
should to be added to the target library. If only one identified compound or just spectra 
are selected, the dialog uses an initial compound name. Entering a name is only 
possible if Auto-name is not checked. If Auto-name is checked, the name '[analysis 
name]-[retention time]' is entered automatically. 

Add compounds/spectra 
Lists the compound(s) and corresponding spectrum/spectra currently selected to be 
added to the target library specified in Library. This list can contain one or several 
compounds with one or several spectra in each case.  
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Figure 7-6 Add Spectra to Library dialog - Spectra tab showing one compound with 

two spectra 

In Ad as compound define the compound name with which the spectrum/spectra 
should be added to the target library: 

Auto-name 
Check this option if the compound should get an auto-name consisting of the analysis 
name and the compound's retention time. In this case the entry '[analysis name]-
[retention time]' will automatically be entered in Compound name. Uncheck this 
option if you want to enter an explicit compound name which has to be specified in 
Compound name. This option will automatically be checked and disabled if more than 
one compound is listed in Add compounds/spectra. 

Compound name 
Enter the compound name with which the spectrum/spectra should to be added to the 
target library. If the selected spectrum/compound has already been identified, the 
respective compound name is entered automatically. Entering a name is only possible 
if Auto-name is not checked. If Auto-name is checked, the name '[analysis name]-
[retention time]' is entered automatically. In the Options tab, you can define how to 
proceed if the entered compound name already exists in the chosen library.  
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Figure 7-7 Add Spectra to Library dialog - Spectra tab showing two compounds with 

two spectra each 

In Add to library, define the target library the spectrum/spectra should be added to: 

Library 
Enter path and name of the target library or click the drop-down button and select the 
library from the recent library list, which keeps the ten last used libraries. Alternatively, 
you can  to open the Select Library dialog and select it (see below). The previously 
selected library is suggested by default. 
 
OK 
Adds the spectrum/spectra and the information defined in the Compound Details tab 
under the specified name or an auto-name to the chosen target library.  
Adding is performed according to the settings currently defined in the Options tab. If 
the specified compound name already exists in the chosen library and If compound 
exists, ask for action is selected, the Add New Spectrum dialog will appear. This 
informs you that the respective compound already exists in the chosen library and 
requests you to select an existing compound or to specify a new compound the 
spectrum/spectra should be added to. 
If the mass spectrum to be added contains more masses than the maximum number 
of most abundant masses currently defined in the Library Search - Add tab of the 
Method Parameters dialog the masses contained resulting library spectrum will be 
reduced to this specified number. 
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Select Library dialog 

This dialog is used to select the target library the mass spectrum/spectra is/are to be 
added to. 

 
Figure 7-8 Select Library dialog 

Look in and folder list 
Navigate to the drive and folder that contains the library you want to add. Double-click 
the library file or select it and click Open. 

File name 
Enter the name of the library you want to add or select a library from the folder list. 

Files of type 
Select the type of files to be displayed in the folder list. 

Library Files (*.mlb). Mass spectral library format; needed for libraries to be used 
with DataAnalysis. 

Open 
If a single folder is selected, the program opens the folder and displays its contents in 
the folder list. 
If a single library is selected, the program adds the selected library to Library in the 
Add Spectra To Library - Spectra dialog. 
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7.2.2 Add to Library Command - Compound Details 

The Compound Details tab is used to optionally enter information about the com-
pound listed in the Spectra tab. This information will be saved with the respective 
compound in the chosen target library. 
Note: The Compound Details tab is disabled when more than one compound is 

listed in the Spectra tab. 
Note: It is also possible to assign this information after the compound has been added 

to the target library, then using the LibraryEditor application. 
 

  
Figure 7-9 Add Spectra to Library dialog - Compound Details tab 

Compound Name 
Displays the compound name specified in Compound name of the Spectra tab. This 
can be an explicit or an auto-name. The current compound name cannot be changed 
here. 

CAS number 
Enter the CAS number of the compound provided a CAS number is available for this 
compound. 

Formula 
Enter the chemical formula of the compound. 
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Structure 
Enter path and name of the corresponding structure file (*.mol) or click  and select it 
in Select Mol File dialog (see below).  

Synonyms 
Enter synonyms for the compound. 

Compound comment 
Enter a comment on the compound. 

Spectrum comment 
Enter a comment on the mass spectrum. 

Contributor 
Enter the name of the contributor the mass spectrum originates from. 

Use as default contributor 
Check this option if the name of the contributor currently entered in Contributor should 
be used as default contributor. 
 
Select Mol File dialog 
This dialog is used to select a structure file (*.mol) for the compound specified in the 
Compound Details tab of the Add Spectra to Library dialog.  

Look in and folder list 
Navigate to the drive and folder that contains the *.mol file you want to select. Double-
click the file or select it and click Open.  

File name 
Enter the name of the *.mol file you want to select or select it from the folder list. 

Files of type 
Displays the type of files to be shown in the folder list. 

Mol Files (*.mol). Lists all *.mol files. 

Open 
If a *.mol file is selected, it returns to the Compound Details tab and enters the 
respective file name in Structure. 
If a folder is selected, it opens the folder and displays its contents in the folder list. 
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Figure 7-10 Select Mol File dialog 
 
 
7.2.3 Add to Library Command - Options 

The Options tab is used to define how to proceed if the specified compound name 
already exists in the chosen target library. 

In Add to existing compound select how to proceed if the specified compound alrea-
dy exists. The option currently set in the Library Search - Add tab of the Method 
Parameters dialog is checked by default. If you want to change this setting, you can 
change it only for the current adding operation you want to perform or in the corre-
sponding method, too. The following options are available: 

If compound exists, add spectra without information. (Default) Adds the spec-
trum/spectra to the existing compound without any information. 

If compound exists, ask for action. Displays the Add New Spectrum dialog and 
asks about the action to be performed. This allows you to add the spectrum/spec-
tra either to the existing compound or as a new compound entry.  

Always create a new compound. Always creates a new compound entry. 
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Figure 7-11 Add Spectra to library dialog – Options tab 

Current method parameter setting is: ‘    ‘ 
Displays the current method parameter setting. 

Apply to Method 
Applies the actual Add to existing compound setting to the current method parame-
ters. This button is only enabled when both settings differ. 
 

Add New Spectrum dialog 
This dialog is used to define how a mass spectrum whose compound name already 
exists in the chosen target library is to be added to the library. You can add this mass 
spectrum either to an already existing compound or as a new compound entry.  

New compound 
Displays the compound name currently assigned to the mass spectrum/spectra to be 
added in the Spectra tab of the Add Spectra to Library dialog.  
If you want to add the mass spectrum as a new compound entry, change the com-
pound name shown and click New. You are also allowed to use the same compound 
name, which will result in two compound entries having the same name. Otherwise, 
leave the entry unchanged. 

(Compound list) 
Lists the compounds currently contained in the chosen target library having the same 
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name as the compound specified in the Add Mass Spectrum to Library dialog. These 
compounds are displayed with the corresponding compound ID in front.  
If you want to add the mass spectrum as a new mass spectrum to an existing com-
pound, select the respective compound from this list and click Add to.  
 

  
Figure 7-12 Add New Spectrum dialog 

New 
Adds the mass spectrum as a new compound entry to the library using the compound 
name specified in New compound.  

Add to 
Adds the mass spectrum as a new spectrum to the compound selected in the com-
pound list. This button is activated when a compound is selected in the compounds list. 
 
 
7.3 Clear Results Command 

The Clear Results command clears all identification results currently available for the 
selected mass spectrum. This command can be applied to multiple selected profile 
spectra in the same analysis. 

Shortcut 
Button:   
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7.4 Show Spectrum in LibraryEditor Command 

The Show Spectrum in LibraryEditor command starts/activates the LibraryEditor and 
shows the selected library spectrum. In LibraryEditor, the library the selected library 
spectrum originates from is opened with displaying the respective library spectrum and 
corresponding compound data. This allows getting more information on the respective 
library spectrum and the compound it belongs to. If no library spectrum is selected 
when selecting this command, a corresponding error message will appear. (Note: If 
you select the command from the context menu of the Compound Spectra or Mass 
Spectrum window, the right-clicked library spectrum is shown.) 

Shortcut 
Button:    

 
 
7.5 Determine Molweight from Adducts 

The Determine Molweight from Adducts command is used to determine the mole-
cular weight of a compound based on its corresponding adduct ions found in the ESI 
mass spectrum. You can process profile and line spectra obtained in positive or 
negative ion mode. This command can be applied only to a single mass spectrum or to 
two mass spectra, one of positive and one of negative polarity. This tool records the 
mass differences between the Mass List peaks of the selected mass spectrum, assigns 
peaks having characteristic mass differences to specific adduct ions and then 
calculates the molecular weight of the respective compound.  
Before selecting this command, a Mass List has to be set up for the selected mass 
spectrum, either automatically or manually. 
The command searches the Mass List of the selected mass spectrum for mass peaks 
having characteristic mass differences, which can be assigned to specific adduct ions. 
If at least two possible adduct ions are found, the algorithm calculates the correspond-
ing molecular weight. The results obtained by this operation are presented in the 
appearing Determine Molweight - Adduct List dialog. This lists all possible Adduct 
ions found with their corresponding m/z and Intensity values and the calculated 
molecular weight MW. In diff, the m/z difference between the measured m/z of the 
adduct ion and the m/z calculated for the respective adduct ion is displayed. Coverage 
gives the ratio of the sum of intensities of all adduct ions found relative to the sum of all 
intensities. The diff and Coverage values allow you to assess the result of the respec-
tive molecular weight determination. 
The following example shows molecular weight determination on two ESI mass spectra 
obtained for the same compound (acetyldigitoxin), one in negative (above) and the 
other in positive (below) ion mode. 
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Figure 7-13 Results of molweight determination on an ESI spectrum obtained in nega-

tive ion mode 
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Figure 7-14 Results of molweight determination on an ESI spectrum obtained in posi-

tive ion mode 
 
 
7.6 Parameters Command 

The Parameters command is used to define the parameter settings to be used for the 
selected analysis in library search operations. The command opens the Library 
Search - Libraries tab of the Method Parameters dialog. 
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8 CHEMISTRY MENU 

The Chemistry menu offers the following commands:  

  
Figure 8-1 Chemistry menu 

Command Used to … 

SmartFormula Calculate molecular formulae for all peaks of all selected mass 
spectra in the active analysis. 

Edit Edit the SmartFormula List of the selected mass spectrum. 
Clear Clear the SmartFormula List of the selected mass spectrum. 
SmartFormula 

Manually 
Calculate molecular formulae for a given m/z value. 

SmartFormula3D Calculate molecular formulae by combining precursor and frag-
ment ion formulae. 

Verify Formula Verify a given molecular formula in the selected mass spectrum. 
Simulate Pattern Simulate the theoretical isotopic pattern for a given molecular 

formula. 
Parameters Define the Chemistry method parameters for the selected ana-

lysis. 
 
 
8.1 SmartFormula Command 

The SmartFormula command automatically calculates possible molecular formulae for 
all peaks of all selected mass spectra of the active analysis. It can be restricted to a 
selected mass range. The results of SmartFormula calculation are presented in the 
SmartFormula tab of the Spectrum Data window. The tab lists for the selected mass 
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spectrum all measured m/z value for which corresponding sum formulae could be 
calculated along with corresponding data. If several formulae are available for a m/z 
value the formulae are ordered according to their Score value by default. The current 
SmartFormula result can be printed in a 'Mass Spectrum SmartFormula Report' and 
will be saved to the respective mass spectrum when the analysis is saved. The 
theoretical isotopic pattern for a selected formula can be simulated and saved to the 
original spectrum, too. 
SmartFormula calculation is performed according to the current settings in the 
Chemistry - SmartFormula tab of the Method Parameters dialog. It is based on the 
isotope masses and abundances and the valencies defined in the Table of Atomic and 
Isotopic Data. The valencies used for calculating the rings and double bonds, the 
electron configuration and the nitrogen rule you can quickly inspect in the Table of 
Valencies, too. (To view these data tables, please refer to the DataAnalysis Online 
Help.) 
The following data is displayed by default but you can edit the list layout and thus the 
data shown via the Layouts - SmartFormula List Layout tab of the Method Parame-
ters dialog. Changing the current layout settings for the SmartFormula List will update 
the list immediately. 
Column Description 
Meas. m/z Measured m/z value. 
# Running number of formula (for each m/z). 
Formula Sum formula. 
Score Score of the formula (a value between 0 and 100%). 
m/z Calculated m/z of the formula. 
err [mDa] Deviation between measured mass and theoretical mass of the 

selected peak in [mDa]. 
err [ppm] Deviation between measured mass and theoretical mass of the 

selected peak in [ppm]. 
mSigma Sigma is a rate for the agreement of the theoretical and measured 

isotopic pattern of the mass peak of interest. It combines the 
standard deviation of the masses and intensities for all isotopic 
peaks. The values are given in [milliSigma] and lower numbers 
indicate a better fit. 

rdb Electron configuration of the ion formula. 
e–Conf Indicates whether the electron configuration is even or odd. 
N-Rule Indicates whether the nitrogen rule is fulfilled. 
 
The following example shows results of automatic SmartFormula generation on an 
MS/MS spectrum. 
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Figure 8-2 Results of performing a SmartFormula operation on an MS/MS spectrum 

Shortcuts 
Button:  
Key: F8 

 
 
8.2 Edit Command 

The Edit command is used to manually add a new m/z value to the SmartFormula List 
of the selected mass spectrum with automatically calculating corresponding molecular 
formulae for it. The command can also be used to delete a m/z value already contained 
in the list and its corresponding formulae from the list. This allows you e.g. to manually 
edit the automatically generated SmartFormula results obtained via the SmartFormula 
command or to manually set up a result list. A m/z value can be added/deleted by 
selecting it from the mass spectrum in the data window using the corresponding Edit 
SmartFormula List cursor. 
The command activates/deactivates the Edit SmartFormula List mode. The mode is 
active when the command's tool button is being pressed. In the Edit SmartFormula List 
mode, the Edit SmartFormula List cursor is displayed when the mouse cursor is 
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positioned in the active data window. Which of the two cursor shapes appears depends 
on whether the Data cursor is currently positioned on a m/z value which is already 

contained in the SmartFormula List ('delete' cursor ) or not ('add' cursor ). 
SmartFormula generation is based on the current parameter settings in the Chemistry 
- SmartFormula tab of the Method Parameters dialog. All SmartFormula results 
obtained will be saved in the analysis when the analysis is saved. 
The SmartFormula List is presented in the SmartFormula tab of the Spectrum Data 
window. The tab lists all measured m/z value for which molecular formulae have been 
calculated so long and their corresponding data. If several formulae are available for a 
m/z value the formulae are ordered according to their Score value by default. The 
layout of the SmartFormula List can be edited via the Layouts - SmartFormula List 
Layout tab of the Method Parameters dialog. Changing the current layout settings for 
the SmartFormula List will update the list immediately.  

Adding a new m/z value with corresponding formula(s) to the SmartFormula List:  
To add a new m/z value and corresponding molecular formulae to the SmartFormula 
List, position the 'add' cursor  on the desired peak in the spectrum and click the left 
mouse button. If at least one molecular formula can be calculated for the selected m/z, 
the respective m/z value is added in the SmartFormula List along with the generated 
formula(s) and corresponding data. Otherwise, the selected m/z value is not included in 
the list. 

Deleting a m/z value with corresponding formula(s) from the SmartFormula List:  
To delete an existing m/z value from the SmartFormula List position the 'delete' cursor 

 on the desired peak in the spectrum and click the left mouse button. This deletes 
the respective m/z value and its corresponding data from the SmartFormula List.  

Shortcut 
Button:  

 
 
8.3 Clear Command 

The Clear command clears the SmartFormula list of the selected mass spectrum which 
displays in the SmartFormula tab of the Spectrum data window. 

Shortcut 
Button:  
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8.4 SmartFormula Manually Command 

The SmartFormula Manually command is used to calculate possible molecular 
formulae for a given m/z value. The calculated molecular formulae are listed in the 
Manual SmartFormula List in the SmartFormula Manually dialog and also in the 
SmartFormula List shown in the SmartFormula tab of the Spectrum Data window. The 
current SmartFormula Manually result can be printed in a 'Mass Spectrum SmartFor-
mula Report' and will be saved to the respective mass spectrum when the analysis is 
saved. The theoretical isotopic pattern for a selected formula can be simulated and 
saved to the original spectrum, too. 
The calculation of molecular formulae is based on the parameters settings defined in 
the SmartFormula Manually dialog and the isotope masses, their abundances and the 
valencies defined in the Table of Atomic and Isotopic Data. The valencies used for cal-
culating the rings and double bonds, the electron configuration and the nitrogen rule 
you can quickly inspect in the Table of Valencies, too. To view these tables, please 
refer to the DataAnalysis Online Help. 
 
The command opens the SmartFormula Manually dialog to enter the m/z value for 
which possible formulae should be calculated and to specify how calculation should be 
performed. 
Note: The SmartFormula Manually dialog always opens with the values currently 

defined in the Chemistry - SmartFormula tab of the Method Parameters dia-
log. However, changing values in this dialog will not change the values in the 
method.  

Min and Max 
Enter all elements with their allowed minimum (Min) and maximum (Max) atom num-
bers on which formula calculation should be based. Formula calculation will start at the 
formula entered in Min and stop at the formula entered in Max.  
Note: For m/z values < 2000, the elements C, H, N and O are considered implicitly. 
Tip: The PeriodicTableEditor application allows defining new isotopically labeled 

elements. This application is available via Windows Start menu > Programs > 
Bruker Daltonics > PeriodicTableEditor.  

Hints on how to enter minimum and maximum formulae: 
- If you want to generate formulae for m/z values < 2000 and if the element C, H, N or 

O should be excluded from calculation, you must explicitly set the respective element 
to ‘0’. For example, if there should be no N in the formulae you have to enter ‘N0’. 

- Sorting of elements is not needed. 
- Hard brackets can be used to enter fixed atom ratios that should not be resolved. For 

example, when entering ‘[N3P3O6]CHF’ for Min and ‘[N3P3O6]C100H21F80’ for 
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Max, then calculation will use exactly 3 N, 3 P and 6 O but 1 to 100 C, 1 to 21 H and 
1 to 80 F. 

- Chemical notation can be used. For example, ‘(CH3)6’ will be resolved to C6H18. 

(Allowed elements and minimum/maximum atom numbers) 
Lists the constraints for generating formulae as specified in Min and Max, i.e. the 
elements and minimum/maximum atoms numbers allowed. Within these bounds 
molecular formula calculation will occur. 
 

 
Figure 8-3 SmartFormula Manually dialog (here with the minimum and maximum 

atom numbers used in the example below already entered) 

Measured m/z 
Enter the measured m/z value for which possible formulae should be calculated. You 
can enter the value as follows:  
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- Type the m/z value into the box. 
- Select the m/z value in the selected mass spectrum. For this, position the SmartFor-

mula Manually cursor  at the desired data point and click the left mouse button. 
This enters the corresponding m/z value: Note: If Generate immediately is set, this 
immediately starts generating formulae. 

Tolerance 
Enter an absolute or relative tolerance for the specified m/z value, which determines 
the total mass range within which the m/z of the calculated formulae must lie. Enter the 
desired value and select the corresponding unit ([mDa] or [ppm]).  

Charge 
For multiple charged ions, enter the assumed charge the ion of the Measured m/z has. 
Please consider the sign of the charge. The mass of the electron is not negligible for 
high mass precision instruments. Switching between +1 and -1 makes a difference of 
two electrons or 1.1 mDa which means 2 ppm for a molecule with 548 Da. 

Automatically locate monoisotopic peak 
Check this option if the monoisotopic peak that corresponds to the Measured m/z 
should be located automatically. The algorithm will search to the left and right of the 
selected Measured m/z for appropriate sum formulae with their corresponding mono-
isotopic peaks. 
To use this option, select the largest peak of the pattern. If search was successful, the 
formula(s) corresponding to the monoisotopic peak(s) found will be entered in the 
results list, too. For formulae that have a monoisotopic peak different from the selected 
peak the monoisotopic mass differs by a few mDa from the selected mass. The mass 
error nevertheless is calculated for the selected peak and the exact theoretical mass of 
that peak based on the formula from Alan L. Rockwood et al. (J.Am.Soc. Mass 
Spectrom. 2004, 15, 12-21). 

Maximum number of formulas 
Enter the maximum number of formulae to be calculated at the most. The formulae with 
the smallest relative error based on the measured m/z will be picked out.  

Check rings plus double bonds 
Check this option if possible formulae should be checked whether the number of rings 
and double bonds present keeps within the bounds specified in Minimum and Maxi-
mum. This will exclude all possible formulae with deviating double bond equivalence 
numbers.  
The rings plus double bounds number is calculated from the number of atoms and their 
valency: 

2
)2(2 −×Σ+

=+ atomatom valencyndbR  
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The valency of C and Si is 4, for N and P a valency of 3 is assumed. For O and S it is 
2, for H and the halogen atoms it is 1. For this limited set of atoms the equation 
simplifies to 

1
2
1

2
1

),(),,,,,()( ++−=+ PNIBrClFDHC nnndbR  

All other elements are considered, too. Double bonds occurring with higher valence 
states like 4 or 6 for sulfur cannot be taken into account since these valence states are 
not known. 

Minimum 
Enter the minimum number of rings plus double bonds to be contained in a formula at 
least. This number may be negative for protonated clusters. 

Maximum 
Enter the maximum number of rings plus double bonds to be contained in the formula 
at most. 

Electron configuration 
Select the electron configuration to be applied: 

even. Generates only molecular formulae having an even electron configuration.  
odd. Generates only molecular formulae having an odd electron configuration. 
both. Generates molecular formulae of both electron configurations. 

The electron configuration is calculated under the assumption that we have molecular 
ions. The electron configuration is even, if [n(atom) x valency(atom) + z(ion)] is even. 

Filter H/C element ratio 
Check this option if possible molecular formulae should be filtered for their ratio of the 
elements H and C. Only formulae that comply with the H/C ratios specified in Minimum 
H/C ratio and Maximum H/C ratio will be displayed. 

Minimum H/C ratio 
For H/C ratio filter enabled, enter the minimum H/C ratio to be applied. 

Maximum H/C ratio 
For H/C ratio filter enabled, enter the maximum H/C ratio to be applied. 

Estimate carbon number 
Check this option if the minimum number of carbon atoms to be used in generating 
molecular formulae should be estimated by the program. The estimated number will be 
entered in Min after generating formulae has been started. If Min already contains a 
manually entered carbon number, the manually entered and the estimated number will 
be compared and the higher of both carbon numbers will be taken over. This option 
should be set if the monoisotopic peak could not be determined reliably e.g. in case of 
a large number of carbon atoms or metal organic compounds. 



Bruker Daltonik GmbH Chemistry Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  8-9

For estimating the carbon number, the following assumptions are made: The selected 
m/z value corresponds to the m/z of the monoisotopic peak. The next peak that 
corresponds to the isotopomer with one ^12C less and exactly containing one ^13C, is 
± 1.003355 apart from the selected m/z value. From the intensity ratio of both peaks, a 
carbon number is estimated and rounded down. This number is then used as the 
minimum carbon number in generating formulae. 

Generate immediately 
Check this option if generating SmartFormula should immediately start when clicking 

with the SmartFormula Manually cursor  on a m/z value in the selected mass 
spectrum. 

Generate 
Generates for the mass range specified by the Measured m/z and Tolerance values 
possible molecular formulae that meet the specified parameter settings and enters 
them with corresponding data in the molecular formula list. If Show Pattern is already 
turned on, the pattern of the first formula in this list will be displayed below the original 
spectrum and entered in the Analysis List as a subentry of the original spectrum.  
 

(Manual SmartFormula List) 
Lists the generated formulae for the given Measured m/z value including various 
score, error and statistical values. The layout of the Manual SmartFormula List is 
similar to that of the SmartFormula List displayed in the SmartFormula tab of the Spec-
trum Data window. For explanation of the data shown, please refer to the description of 
the SmartFormula command.  
You can edit the layout of the list to show e.g. additional statistical values and rankings. 
For this, right click in the list, select Layout from the context menu and change the 
layout in the Layouts - SmartFormula List Layout tab of the Method Parameters 
dialog. Changing the current layout settings for the SmartFormula List will update the 
list immediately. 

Show Pattern 
Allows you to show and again remove the pattern of a molecular formula selected in 
the molecular formula list.  
On first clicking this button, the show pattern function is turned on which results in the 
pattern of the currently selected formula being displayed below the original spectrum 
and entered in the Analysis List as a subentry of the original spectrum. When selecting 
another formula from the list, the previous pattern is replaced by the current one; the 
same occurs to the Analysis List entry. If on performing formula generation this function 
is already turned on, the pattern of the first formula in the list will be displayed and 
entered automatically. 
On clicking the button again, the show pattern function is turned off which results in 
removing the currently shown pattern and its Analysis List entry.  
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If you want to preserve one of the patterns to save it to the original spectrum, select the 
respective formula and close the SmartFormula Manually dialog without turning off 
the show pattern function. If you want to preserve more than one pattern, repeat 
generating formulae operation using the same parameter settings, show the desired 
additional pattern and close the dialog without turning show the pattern function off. 
 

 
Figure 8-4 Results of a SmartFormula Manually operation: the SmartFormula Manu-

ally dialog lists four possible molecular formulae calculated for the 
selected Measured m/z (default SmartFormula List layout); the Compound 
Spectra window shows the original spectrum in which the Measured m/z 
was selected (top) and the pattern for the selected formula (bottom); the 
SmartFormula tab of the Spectrum Data window shows the results, too. 

Shortcut 
Button:  

Key. Shift+F8 
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8.5 SmartFormula3D Command 

The SmartFormula3D command is used to calculate possible molecular formulae for 
an MS precursor ion by combining the results from SmartFormula operations 
performed on the precursor ion as well as on all of its fragment ions. SmartFormula3D 
requires either two spectra, e.g. an MS and an MS/MS spectrum which may originate 
from different analyses, or one spectrum, e.g. an ISCID spectrum, being selected.  
The SmartFormula3D algorithm evaluates all the results of the SmartFormula algorithm 
of an MS precursor ion and all of its fragment ions based on the settings of the Chemi-
stry - SmartFormula and - SmartFormula3D parameters of Method Parameters 
dialog. Proposed sum formulae of precursor ions are stored if at least one formula for a 
fragment ion in combination with an explanation for the neutral loss exists. All other 
formulae which cannot be related to a precursor ion, or a fragment ion, respectively, 
are omitted. This reduces the list of possible formulae dramatically and organizes the 
suggestions for the formula of the precursor ion and all formulae for its fragment ions in 
sets. 
The SmartFormula3D algorithm consists of following steps: 
• Performing SmartFormula on the peak lists of the precursor ion and the fragment ion.  
• Checking whether a formula for a fragment ion is a subset of a formula for the precur-

sor ion. Testing whether the formula of the neutral loss derived by subtraction of both 
formulae fits with the observed mass difference for both peaks. 

• Subsequent filtering of these results can be performed. Different filters are available. 
 
Before choosing the command you have to select those two mass spectra (e.g. an MS 
and an MS/MS spectrum) or that one mass spectrum (e.g. an ISCID spectrum) for 
which you want to calculate formulae using the SmartFormula3D algorithm. 
 
The command opens the SmartFormula3D dialog and enters the peak list(s) of the 
selected spectra/spectrum. The dialog consists of three groups of GUI elements. On 
top, a row of buttons allowing various operations is available. Below them, the 
description of the spectra/spectrum used for formula calculation is shown. Below those 
descriptions, two rows of list controls representing the peak lists of the spectra/spec-
trum and the calculated and related formulae are placed. The left pane is associated 
with the data of the MS spectrum (peak list of precursor ion) and the right pane is 
associated with the data of the MS/MS spectrum (peak list of fragment ions) by default. 
The two upper lists represent the observed peaks in the spectra. After a calculation 
was performed the lower two lists contain the formulae identified for the certain peaks 
in the peak lists. 
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Figure 8-5 SmartFormula3D dialog after being opened; the peak lists of two selected 

spectra, an MS precursor spectrum (left) and an MS/MS fragment 
spectrum (right), are shown in the upper lists 

Function of buttons 

 Allows viewing and editing the generating SmartFormula and Smart-
Formula3D parameters. Opens the Chemistry tab of the Method 
Parameters dialog and displays the SmartFormula3D tab by 
default. 
Note: For m/z values < 2000, only the elements C, H, N and O are 

considered implicitly; the other elements have to be specified 
explicitly in the Chemistry - SmartFormula tab of the 
Method Parameters dialog. For m/z values > 2000 all 
elements have to be specified. 



Bruker Daltonik GmbH Chemistry Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  8-13

 Clears the current SmartFormula3D results. 

 Calculates possible sum formulae (see below). 

 Offers filter options for filtering SmartFormula3D results (see 
below). 

 Creates a simulated spectrum for the selected sum formula (see 
below). 

 Offers export options for exporting SmartFormula3D results (see 
below). 

 Moves the spectrum currently displayed in the left list to the right list 
and vice versa (e.g. MS <-> MS/MS). If results have already been 
calculated these will be removed. 

 If the selected MS spectrum and the MS/MS spectrum belong to 
two different analyses, creates a compound in the MS spectrum's 
analysis containing those two spectra. 

 
Calculating SmartFormula3D 

Clicking  invokes the SmartFormula3D algorithm. According to the current 
parameter settings the algorithm calculates possible sum formulae for those peak list 
peaks that were found within the mass range [isolation mass – 5] to [isolation mass + 
10] m/z. The resulting formulae for the precursor ion and its fragment ions are listed in 
the precursor ion formula list (left lower list) and the fragment ions formula list (lower 
right list). 
 



Chemistry Menu Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 8-14 

 
Figure 8-6 Result of a SmartFormula3D calculation; here a precursor ion formula 

with a lower goodness value is selected to illustrate the different color 
coding of fragment ion peaks 

Viewing SmartFormula3D results 
After SmartFormula3D formula calculation is finished the peaks in the peak lists get a 
special color coding and the formula lists show the formulae calculated for the precur-
sor ion and its fragment ions. The following and information is shown: 

• Precursor spectrum peak list and fragment spectrum peak list: 
After formula calculation the entries in the MS and MS/MS peak lists are color coded. 
In the MS/MS peak list, the color coding changes with the selection in the precursor ion 
formula list (lower left pane). 
Color coding: The color coding follows this scheme: 
- Violet entries denote a monoisotopic peak.  
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- Green entries are associated to related isotopic peaks.  
- Yellow and orange entries are used additionally in the MS/MS peak list if for the 

particular peak a formula is assigned in another set of explained MS/MS peaks than 
the currently selected one. The intensity of the respective peak determines whether 
the peak is highlighted orange or yellow. If the intensity is above the threshold 
calculated from the n most intensive peaks then the peak is marked orange (important 
peaks), if the intensity of the peak is below the threshold the peak is marked yellow 
(less important peaks). 

- Red entries can be used additionally in the MS/MS peak list if the particular peak is 
not explained in any of the sets of explained MS/MS peaks although its intensity is 
above the threshold calculated from the n most intensive peaks. For this coding, the 
corresponding option in the Chemistry - SmartFormula3D tab has to be active. 

- Gray entries denote the selected peak/formula within a list when the respective list 
currently does not have the focus. This explains why in the figure above the monoiso-
topic peak in the MS peak list (m/z 811.4268) is marked gray; here the violet coding is 
only shown at the right end of the row. 

- Gray font color is used for peaks which are not explained at all. 

• Precursor ion formula list and fragment ions formula list: 
The content of the lower lists depends on the current selection. Selecting a peak in the 
upper left list for the observed peaks of the MS spectrum shows corresponding sum 
formulae of this peak. Selecting a formula in the lower left pane changes the color 
coding in the upper right peak list of the MS/MS spectrum and displays the related 
formula candidates of the MS/MS peaks related to the selected formula of the selected 
MS peak. The sum formula candidates are listed along with the following data: 
Precursor ion formula list: This list presents the following data:  
Column Description 
SumFormula Empirical formula of the precursor ion. 
m/z calc m/z calculated for the corresponding monoisotopic peak of 

the formula. 
err[mDa] Mass measurement error between that formula and the 

measured value in [mDa]. 
err[ppm] Mass measurement error between that formula and the 

measured value in [ppm]. 
mSigma Sigma is a rate for the agreement of the theoretical and 

measured isotopic pattern of the mass peak of interest. It 
combines the standard deviation of the masses and intensi-
ties for all isotopic peaks. The values are given in [milliSigma] 
and lower numbers indicate a better fit.  

eConf Electron configuration of the ion formula. 
Comb. mSigma Combined Sigma score, based on a weighted average of 
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Column Description 
precursor and fragment ion formulae. 

Comb. err[mDa] Combined error, based on an average of precursor and 
fragment ion formulae. 

Comb. m/z Loss Measure of the errors of the elements lost in fragmentation 
steps from the given precursor ion formula. 

I expl. Absolute summed-up intensity of the peaks explained in the 
precursor ion formula. 

I expl.[%] Relative summed-up intensity of the peaks explained in the 
precursor ion formula. 

Peaks expl. Absolute number of peaks explained in the precursor ion 
formula. 

Peaks expl.[%] Relative number of peaks explained in the precursor ion 
formula. 

 
Fragment ions formula list: This list presents the following columns: 
Column Description 
SumFormula Empirical formula of the fragment ion. 
SumFormula Loss Corresponding formula loss from the precursor ion selected to 

give that fragment. 
m/z Loss Molecular weight of the SumFormula Loss. 
err[mDa] Loss Mass measurement error between the calculated SumFor-

mula Loss mass and the expected mass value of the loss in 
[mDa]. 

Delta SF Difference between a selected fragment ion formula and all of 
the others in that list. This column is only filled when a formula 
is selected (clicked, highlighted) in this list. 

Intensity Intensity of an ion, in counts. 
m/z calc Calculated fragment ion formula mass. Results are ranked in 

order of this mass, high to low. 
err[mDa] Mass measurement error between the calculated fragment ion 

formulae. 
mSigma Sigma is a rate for the agreement of the theoretical and 

measured isotopic pattern of the mass peak of interest. It 
combines the standard deviation of the masses and intensi-
ties for all isotopic peaks. The values are given in [milliSigma] 
and lower numbers indicate a better fit.  

eConf Electron configuration of the ion formula. 
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Filtering SmartFormula3D results 
You can filter the sum formula candidates currently in the precursor ion formula list. 
Four different filter algorithms are available to reduce the list which can be chosen by 
clicking : 
• Filter Automatically. This algorithm deletes all sets which do not explain the n most 

intense peaks in the MS/MS spectrum. The number n of most intense peaks is 
defined in the method. 

• Filter Mandatory Peaks. This algorithm deletes all sets which do not explain manda-
tory peaks. The mandatory peaks have to be defined in upper right MS/MS peak list 
by checking the corresponding check boxes before the filter option is selected. 

• Filter by Fragments. This algorithm disables sets not containing a distinct fragment. 
The respective fragment has to be specified in the Filter Fragment Formula dialog 
which opens after selecting this option. 

 
Figure 8-7 Filter Fragment Formula dialog 

• Filter by Neutral loss. This algorithm disables sets not containing a distinct neutral 
loss. The respective neutral loss has to be specified in the Filter Neutral Loss 
Formula dialog which opens after selecting this option. 

 
Figure 8-8 Filter Neutral Loss Formula dialog 

For the two upper filters, filtering is performed on all sets in the precursor ion formula 
list immediately when you select the respective option and may result in deleting 
formulae from the list. In case of the two lower filters, you have to set the check mark 
for the candidates to be filtered in the precursor ion formula list before you select the 
respective filter option. If a set does not fulfill the filter criteria it will get unchecked.  
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Creating a simulated spectrum for a formula 

Clicking  creates a simulated SmartFormula3D spectrum for the selected 
precursor ion formula consisting of the simulated isotopic patterns for each explained 
peak in the MS/MS spectrum plus the isotopic peak pattern of the precursor ion 
formula. The simulated spectrum is entered in the Compound Spectra folder as a 
subentry of the MS/MS spectrum and displays in the Compound Spectra window. The 
peaks are labeled with the corresponding generated sum formula and calculated m/z 
error. The description for the 'SmartFormula3D spectrum' includes the sum formula of 
the precursor ion, its theoretical m/z, the calculated m/z error in [mDa] and [ppm], the 
mSigma and further statistical values. 

 
Figure 8-9 Simulated SmartFormula3D spectrum created for the selected precursor 

ion formula 

Exporting SmartFormula3D results 

You can export SmartFormula3D results. Clicking  offers the following 
export options:  
• Export All. This option exports all sets of precursor ion formula and fragment ions 

formulae in a SmartFormula3D.csv and a SmartFormula3D.xml file. 
• Export Selected. This option exports the currently selected set of precursor ion for-

mula and its fragment ions formulae in a SmartFormula3DResults_[sum formula].csv 
file.  
Additionally, it sets up a .csv file containing a matrix of precursor ion formulae and the 
corresponding interfragment losses formulae (SmartFormula3DResults_[sum formu-
la]_InterFragmentLosses.csv). 

Selecting an export option exports the respective data and sets up the corresponding 
files in the analysis folder. 
 
Context menus of the SmartFormula3D lists 
The context menus of the fragment spectrum peak list, precursor ion formula list or 
fragment ions formula list offer various commands for e.g. (un)checking entries, 
deleting formulae, copying formulae, showing signal, manual formula generation or 
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spectrum annotation (For further information, please refer to the description of the 
SmartFormula3D lists context menus). 
 

Shortcuts 
Button:  

Key. Ctrl+F8 
 
 
8.6 Verify Formula Command 

The Verify Formula command is used to verify a given molecular formula in a selected 
mass spectrum. The charge state of the chemical formula can be specified. A 
SmartFormula Manually operation is run on the mass spectrum to search for a peak 
which complies with the given molecular formula. The search is performed according to 
the current settings in the Chemistry - SmartFormula tab of the Method Parameters 
dialog and additionally considers a build-in, standard set of adducts. The result is 
entered in the SmartFormula tab of the Spectrum Data window.  
The command opens the Verify Formula dialog to enter the molecular formula to be 
verified and start the search by clicking OK. 
The following example shows the verification of the formula C46H59N4O9^1+ in a 
selected MS/MS spectrum.  

 
Figure 8-10 Verify Formula dialog with a molecular formula and charge state specified 

If the specified formula could be verified in the selected mass spectrum, the found peak 
possibly explaining the given formula is entered with corresponding data in the 
SmartFormula tab of the Spectra Data window (for explanation of the data shown, 
please refer to the description of the SmartFormula command). You can double-click 
on the entry to show the respective peak pattern enlarged and centered in the data 
window. 
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Figure 8-11 Information on verification of the specified formula 

  
Figure 8-12 Result of verifying the specified molecular formula in the selected MS/MS 

spectrum 
 
 
8.7 Simulate Pattern Command 

The Simulate Pattern command is used to simulate the theoretical isotope pattern for 
a given molecular formula. This allows you to confirm or discard an assumption made 
on a specific group of peaks in the selected mass spectrum displayed in the Compound 
Spectra window or Mass Spectrum window. The calculations in simulating isotopic 
patterns are based on the isotope masses and abundances given at the Table of 
Atomic and Isotopic data we use. To view this table, please refer to the DataAnalysis 
Online Help. 
The command opens the Simulate Isotopic Pattern dialog, which allows you to enter 
a molecular formula for which the corresponding isotopic pattern is to be simulated and 
displayed in the data window. 
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Figure 8-13 Simulate Isotopic Pattern dialog with settings for simulating the isotope 

pattern for the given Ruthenium complex 

Molecular formula 
Enter the molecular formula the theoretical isotope pattern is to be simulated for. 
Tip: The PeriodicTableEditor application allows defining new isotopically labeled 

elements. This application is available via Windows Start menu > Programs > 
Bruker Daltonics > PeriodicTableEditor.  

Charge 
Select or enter the charge state based on which isotopic peaks are to be simulated. If 
an adduct is present select the adduct from the combo box on the right.  

Monoisotopic 
Displays the monoisotopic neutral mass and m/z values that are calculated by the pro-
gram for the molecular formula entered and the charge state set. 

Average 
Displays the average neutral mass and m/z values that are calculated by the program 
for the molecular formula entered and the charge state set. 

Nominal 
Displays the nominal neutral mass and m/z values that are calculated by the program 
for the molecular formula entered and the charge state set. 

Width (FWHM) 
Select or enter the peak width at half height (Full Width a Half Maximum) the isotopic 
peaks are to be simulated with. 

Int(ensity) 
Select or enter the intensity the base peak of the isotopic pattern is to be simulated 
with.  



Chemistry Menu Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 8-22 

Replace simulated mass spectrum 
Check this option to replace the selected, previously simulated pattern spectrum by the 
newly simulated one. When this option is not checked, an additional pattern spectrum 
will be set up.  

OK 
Creates the corresponding simulated isotopic pattern spectrum of the given molecular 
formula and displays it in the data window with closing the dialog. The simulated spec-
trum is described by its molecular formula and its calculated average mass. If Replace 
simulated mass spectrum is checked, the newly simulated spectrum replaces a 
previously simulated one. Otherwise, an additional simulated spectrum is created.  

Apply 
Creates the corresponding simulated isotopic pattern spectrum for the given molecular 
formula as described above and displays it in the data window without closing the 
dialog. This allows quickly repeating simulating a pattern. 

  
Figure 8-14 Simulated isotopic pattern for the given Ruthenium complex that is 

assumed to give the respective group of peaks zoomed in the mass spec-
trum shown above (default parameter setting used) 

Shortcuts 
Button:  
Key: Alt+F8 

 

8.8 Parameters Command 

The Parameters command is used to define the parameter settings to be used for the 
selected analysis in SmartFormula operations. The command opens the Chemistry - 
SmartFormula tab of the Method Parameters dialog. 
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9 PROCESS MENU 

The Process menu offers the following commands: 

  
Figure 9-1 Process menu 

Command Used to … 

Smooth Chromatogram Smooth the selected chromatogram trace. 
Subtract Chromatogram 

Baseline 
Subtract a baseline from the selected chromatogram 
trace. 

Average Mass Spectrum Create an averaged mass spectrum from a specified 
retention time range. 

Smooth Mass Spectrum Smooth the selected profile spectrum. 
Subtract Mass Spectrum 

Baseline 
Subtract a baseline from the selected profile spectrum. 

Subtract View Spectrum as 
Background 

Subtract the mass spectrum currently displayed in the 
Spectrum View window as background from the 
selected compound spectrum. 

Neutral Loss Spectrum Create a neutral loss spectrum. 
Auto-Correlation Spectrum 
 

Create an auto-correlation spectrum of a specified 
mass range. 
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Command Used to … 

Define Background Mass 
Spectra 

Define a constant background for the selected chroma-
togram analysis to be used in background subtracting 
MS spectra. 

Enable Mass Spectra 
Recalibration 

Show the Calibrate menu in the menu bar if not 
visible. 

Recalculate Line Spectra Recalculate line spectra in the selected profile spec-
tra containing analysis. 

Delete Recalculated Line 
Spectra 

Delete the recalculated line spectra in the selected 
analysis. 

Parameters Define the Process method parameters for the 
selected analysis. 

 
 
9.1 Smooth Chromatogram Command 

The Smooth Chromatogram command is used to smooth the selected chromatogram. 
You can perform smoothing either on the entire chromatogram or on a selected portion 
of it. The smoothing result depends on the number of data points smoothed, the 
smoothing algorithm used, and the number of smoothing cycles run. The command can 
be applied to multiple selected chromatograms in the same analysis. 
The command opens the Smooth Chromatogram dialog which shows you the para-
meter settings currently defined for the smoothing procedure in the Process tab of the 
Method Parameters dialog. This dialog allows you to check and if desired to change 
the current settings before performing the smoothing operation.  
 

  
Figure 9-2 Smooth Chromatogram dialog (setting for the example below) 

Smooth 
Displays the type of the (first of the) currently selected chromatogram(s). 



Bruker Daltonik GmbH Process Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  9-3

Smoothing algorithm 
Displays the smoothing algorithm currently selected in the corresponding method. 

Savitzky Golay. Algorithm with cubic splines. 
Gauss. Gauss algorithm.  
Square. Square algorithm.  

Smoothing width 
Displays the smoothing width currently defined in the corresponding method in [s].  
Note: This value should not be set too high; otherwise, the curve shape can be 

dramatically affected. If stronger smoothing is required, run more Cycles.  

Cycles 
Displays the number of smoothing cycles currently defined in the corresponding 
method. 

Replace original chromatogram 
Determines whether the original chromatogram is to be replaced.  

Disable original chromatogram 
Determines whether the original chromatogram should be disabled if it is not replaced.  

Use same color as original 
Determines whether the smoothed chromatogram is to be displayed with the same 
color as the original chromatogram.  

OK  
Smoothes the selected chromatogram(s) according to the current parameter settings. 
Depending on these settings, the smoothed chromatogram is entered in the Analysis 
List either as a subfolder of the original chromatogram or in place of the original data. 
 

  
Figure 9-3 Smoothing a chromatogram with the smoothed trace displayed in a differ-

ent color in addition to the original data 
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Shortcut 
Button:   

 
 
9.2 Subtract Chromatogram Baseline Command 
The Subtract Chromatogram Baseline command is used to subtract a baseline 
(baseline = chemical background) from the selected chromatogram. You can perform 
baseline subtraction either on the entire chromatogram or on a selected portion of it. 
The result will depend on the flatness set for the baseline. The command can be 
applied to multiple selected chromatograms in the same analysis. 
The command opens the Subtract Chromatogram Baseline dialog which shows you 
the parameter settings currently defined for the baseline subtraction procedure in the 
Process tab of the Method Parameters dialog. This dialog allows you to check and if 
desired to change the current settings before performing the baseline subtraction 
operation.  

  
Figure 9-4 Subtract Chromatogram Baseline dialog (setting for the example below) 

Flatness [0.0-1.0] 
Displays the flatness currently defined in the corresponding method. Values between 
'0.0' and '1.0' are allowed. For example, a value of '0.0' subtracts a convex/concave 
(waved) baseline and a value of '1.0' (= total flatness) subtracts a straight baseline. 

Replace original data 
Determines whether the original chromatogram is to be replaced.  

Disable original data 
Determines whether the original chromatogram should be disabled if it is not replaced. 

Use same color as original 
Determines whether the baseline subtracted chromatogram is to be displayed with the 
same color as the original chromatogram.  
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OK  
Performs baseline subtraction on the selected chromatogram according to the current 
parameter settings. Depending on these settings, the baseline-subtracted chromato-
gram is entered in the Analysis List either as a subfolder of the original chromatogram 
or in place of the original data. 

Shortcut 
Button:   

 

  
Figure 9-5 Subtracting a baseline from a chromatogram with the baseline subtracted 

trace displayed in a different color in addition to the original data 
 
 
9.3 Average Mass Spectrum Command 

The Average Mass Spectrum command is used to calculate an average mass spec-
trum from a single or multiple selected retention time ranges of the selected chromato-
gram. The resulting average spectrum is displayed in the Spectrum View window. 
Depending on the data acquired a profile spectrum and/or a line spectrum can be 
displayed. 
Before selecting this command, select the retention time range(s) an average spectrum 
is to be calculated from and adjust the spectrum display of the Spectrum View window 
according to the type of data to be displayed. If no retention time range is selected 
when selecting this command, a confirmation request will appear asking you if you 
really want to make an average spectrum of the entire retention time range. 

The command calculates the average mass spectrum from the selected retention time 
range(s) by averaging the corresponding mass spectra. Depending on the data 
acquired and the current settings for the Spectrum View window, the average profile 
and/or line spectrum/spectra is/are displayed in the Spectrum View window along with 
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information about its/their origin (e.g. MS stage, retention time range, sequence 
number range(s), 100% intensity). In the Chromatogram window, the start and end 
data points of the retention time range(s) the average spectrum/spectra correspond(s) 
to is/are marked by Fixed Data cursors . If you want to process an average mass 
spectrum, you must copy it to the Compound Spectra folder of the analysis. 
Tip: You can quickly create an average mass spectrum by dragging with the right 

mouse button held down in the Chromatogram window. On releasing the mouse 
button, the average mass spectrum will be calculated and displayed. If the Ctrl 
key is held down when releasing the mouse button, the average mass spectrum 
will automatically be copied to the Compound Spectra folder. 

 

  
Figure 9-6 Calculating an average line and an average profile spectrum from the 

selected retention time range marked in the Chromatogram window 

Shortcut 
Button:   

 
 



Bruker Daltonik GmbH Process Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  9-7

9.4 Smooth Mass Spectrum Command 

The Smooth Mass Spectrum command is used to smooth the selected profile 
spectrum. You can perform smoothing either on the entire mass spectrum or on a 
selected portion of it. The result will depend on the number of data points smoothed, 
the smoothing algorithm used, and the number of smoothing cycles run. The command 
can be applied to multiple selected profile spectra in the same analysis. 
 
The command opens the Smooth Mass Spectrum dialog which shows you the para-
meter settings currently defined for the smoothing procedure in the Process tab of the 
Method Parameters dialog. This dialog allows you to check and if desired to change 
the current settings before performing the smoothing operation. 
 

  
Figure 9-7 Smooth Mass Spectrum dialog (setting for the example below) 

Smooth 
Displays the type of the (first of the) currently selected mass spectrum (spectra). 

Smoothing algorithm 
Displays the smoothing algorithm currently selected in the corresponding method. 

Savitzky Golay. Algorithm with cubic splines. 
Gauss. Gauss algorithm.  
Square. Square algorithm.  

Smoothing width 
Displays the smoothing width currently defined in the corresponding method in [Da].  
Note: This value should not be set too high; otherwise, the curve shape can be 

dramatically affected. If stronger smoothing is required, run more Cycles.  

Cycles 
Displays the number of smoothing cycles currently defined in the corresponding 
method. 
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Replace original mass spectrum 
Determines whether the original mass spectrum is to be replaced.  

Disable original mass spectrum 
Determines whether the original mass spectrum should be disabled if it is not replaced.  

Use same color as original 
Determines whether the smoothed mass spectrum is to be displayed with the same 
color as the original mass spectrum.  

OK 
Smoothes the selected mass spectrum according to the current parameter settings. 
Depending on these settings, the smoothed mass spectrum is entered in the Analysis 
List as a subfolder of the original mass spectrum or is stored in place of the original 
data. 
 

  
Figure 9-8 Smoothing a profile spectrum with the smoothed spectrum displayed in a 

different color additionally to the original spectrum 

Shortcut 
Button:   

 
 
9.5 Subtract Mass Spectrum Baseline Command 

The Subtract Mass Spectrum Baseline command is used to subtract a baseline 
(baseline = chemical background) from the selected profile spectrum. This command 
can be applied to multiple selected profile spectra in the same analysis. You can 
perform baseline subtraction either on the entire profile spectrum or on a selected 
portion of it. The result of baseline subtraction depends on the flatness set for the 
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baseline. 
The command opens the Subtract Baseline dialog which shows you the parameter 
settings currently defined for the baseline subtraction procedure in the Process tab of 
the Method Parameters dialog. This dialog allows you to check and if desired to 
change the current settings before performing the baseline subtraction operation.  
 

  
Figure 9-9 Subtract Baseline dialog (setting for the example below) 

Flatness [0.0-1.0] 
Displays the flatness currently defined in the corresponding method. Values between 
'0.0' and '1.0' are allowed For example, a value of '0.0' subtracts a convex/concave 
(waved) baseline and a value of '1.0' (= total flatness) subtracts a straight baseline. 

Replace original data 
Determines whether the original chromatogram is to be replaced.  

Disable original data 
Determines whether the original chromatogram is to be disabled if it is not replaced.  

Use same color as original 
Determines whether the baseline subtracted mass spectrum is to be displayed with the 
same color as the original mass spectrum.  

OK  
Performs baseline subtraction on the selected mass spectrum according to the current 
parameter settings. Depending on these settings, the baseline subtracted mass spec-
trum is entered in the Analysis List as a subfolder of the original mass spectrum or in 
place of the original data. 
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Figure 9-10 Subtracting a baseline from a profile spectrum with the baseline sub-

tracted spectrum displayed in a different color in addition to the original 
spectrum 

Shortcut 
Button:   

 
 
9.6 Subtract View Spectrum as Background 

Command 

The Subtract View Spectrum as Background command is used to subtract the mass 
spectrum currently displayed in the Spectrum View window as background from the 
selected Compound Spectra spectrum. The command applies to MS and MSn spectra, 
to line and profile spectra; however, it is recommended that the spectrum to be 
processed and the background spectrum are of the same type. Furthermore, the 
command can be used to subtract a viewed UV spectrum as background from a 
compound UV spectrum. Using multiple selections, you can perform this background 
subtraction on several spectra in the same chromatogram analysis at once. 
Before selecting the command, the mass spectrum resp. UV spectrum you want to use 
as background spectrum has to be displayed in the Spectrum View window. You can 
use either a single measured or better an averaged spectrum as background spectrum.  
 
The command subtracts the defined background spectrum from the selected mass 
spectrum resp UV spectrum. The resulting background subtracted mass spectrum 
resp. UV spectrum is entered in the Analysis List as a subentry of the original spectrum 
and is displayed in the Compound Spectra window. 
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Figure 9-11 Subtracting viewed spectrum as background: the average mass spectrum 

in the Spectrum View window was used as background spectrum in sub-
tracting background from the mass spectrum shown in the upper Com-
pound Spectra window; the resulting background subtracted mass 
spectrum is displayed below the original spectrum 

Shortcut 
Button:  

 
 
9.7 Neutral Loss Spectrum Command 

The Neutral Loss Spectrum command is used to calculate a neutral loss spectrum 
from the selected line or profile spectrum. This command applies to MS/MS fragment 
spectra only. Using multiple selections, you can calculate neutral loss spectra from 
several spectra at once. 
Note: This kind of “Neutral Loss Spectra” may not be confused with those acquired on 

triple-quad instruments in the neutral loss scanning mode. 
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A neutral loss spectrum displays the m/z difference values that exist between the pre-
cursor (indicated in the fragment spectrum by ) and resulting fragment ions. Thus, it 
elucidates the masses lost in fragmentation of the respective precursor. Knowing these 
neutral loss masses might help you in drawing conclusions on the nature of the com-
pound examined.  
Tip: It is also possible to view neutral loss spectra from edited Constant Neutral Loss 

Chromatogram traces. 

The command calculates the neutral loss spectrum from the selected fragment spec-
trum by subtracting the m/z of each fragment ion present from the m/z of the precursor 
ion. The resulting m/z difference values are displayed with the intensity of the corre-
sponding fragment ion. The neutral loss spectrum is entered in the Analysis List as a 
subentry of the fragment spectrum and is displayed in the Compound Spectra window 
below it. 

 
Figure 9-12 Creation of the corresponding neutral loss spectrum (bottom) from an MS 

spectrum (top) and its fragment spectrum (middle) 
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9.8 Auto-Correlation Spectrum Command 
The Auto-Correlation Spectrum command is used to calculate for the selected mass 
spectrum an auto-correlation spectrum of a defined mass range. Auto-correlation 
allows you to examine the spectrum for the presence of specific differences with m/z 
values contained within the mass range specified. This command applies to line and 
profile spectra of both MS and MS/MS type. Using multiple selections, you can calcu-
late several auto-correlation spectra in the same analysis at once. 
The command opens the Auto-Correlation Spectrum dialog, which allows you to 
specify the mass range the auto-correlation spectrum is to be calculated of. 

 
Figure 9-13 Auto-Correlation Spectrum dialog (setting for the example below) 

Mass range 
Enter the start and end values for the mass range of which you want to calculate an 
auto-correlation spectrum.  

OK 
Calculates an auto-correlation spectrum of the specified mass range and enters it in 
the Compound Spectra folder as subentry of the original spectrum. 

 
Figure 9-14 Auto-correlation spectrum (below) of mass range m/z 20 to 200 calculated 

for the MS/MS fragment spectrum shown above 
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9.9 Define Background Mass Spectra Command 

The Define Background Mass Spectra command is used to define for the selected 
chromatogram analysis (an) appropriate background spectrum/spectra to be used as 
constant background in background subtracting MS spectra. A constant background 
needs to be defined when you want to edit an ‘All MS’ chromatogram trace or perform 
a Compounds – AutoMS(n) or Compounds - Molecular Features finding operation with 
the background subtraction mode being set to Constant (Background MS). 
The Define Background Mass Spectra command applies to MS spectra only and 
requires a retention time range to be selected on the selected chromatogram trace. A 
single or multiple retention time ranges can be selected. Depending on the types of MS 
spectra acquired (line/profile spectra, of positive/negative polarity) up to four back-
ground mass spectra can be calculated by averaging the spectra in the selected reten-
tion time range(s). For example, for an analysis for which line and profile MS spectra of 
alternating polarity have been acquired four background spectra will be calculated: a 
profile spectrum of positive and one of negative polarity, a line spectrum of positive and 
one of negative polarity. 
Before selecting this command the retention time range(s) in which background mass 
spectra are to be calculated has/have to be selected. Otherwise, an error message 
will appear when selecting this command.  
 
The command calculates as many as four background spectra from the selected 
retention time range(s) depending on the data acquired. The background spectra are 
entered in the analysis' Background Mass Spectra folder and are displayed in the 
Compound Spectra window on top of the compound mass spectra. If background mass 
spectra have already been defined for the selected analysis these become overwritten 
by the new ones.  
Note: If the selected chromatogram trace does not contain any MS spectra within the 

selected range(s), no background mass spectrum is calculated and no Back-
ground Mass Spectra folder is set up for the selected analysis. A previously 
present Background Mass Spectra folder is removed from the tree view. 

 



Bruker Daltonik GmbH Process Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  9-15

  
Figure 9-15 Defining background mass spectra on the 'TIC, ±All' trace of an alternating 

polarity analysis for which line and profile spectra have been acquired 

Shortcut 
Button:   

 
 
9.10 Recalculate Line Spectra Command 

The Recalculate Line Spectra command recalculates the line spectra in the selected 
profile spectra containing analysis. The function uses the current mass peak finder with 
its current settings defined for the analysis in the Mass List tab of the Method Para-
meters dialog. The recalculated line spectra are stored side by side to the analysis.baf 
file. All algorithms using line spectra will take the recalculated line spectra instead of 
retrieving those generated during acquisition. If line spectra have already been 
recalculated in the analysis, a message will inform you accordingly and ask you 
whether to delete them and recalculate new line spectra. 
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9.11 Delete Recalculated Line Spectra Command 

The Delete Recalculated Line Spectra command deletes the recalculated line spectra 
from the selected analysis. Afterwards the line spectra calculated during acquisition will 
be used further on. 
 
 
9.12 Enable Mass Spectra Recalibration Command 

The Enable Mass Spectra Recalibration command shows the Calibrate menu in the 
menu bar if currently not visible. This command applies only to DataAnalysis' ‘ESI, 
APCI and APPI instruments’ configuration of; in the ‘All instruments (including MALDI)' 
configuration the Calibrate menu is always visible.  
 
 
9.13 Parameters Command 

The Parameters command is used to define the parameter settings to be used for the 
selected analysis in smoothing and baseline subtraction operations on chromatogram 
traces and mass spectra. The command opens the Process tab of the Method 
Parameters dialog.  
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10 CALIBRATE MENU 

Note: In the ‘ESI, APCI and APPI instruments’ configuration the Calibrate menu is 
visible in the menu bar only if the Enable Mass Spectra Recalibration com-
mand in the Process menu is selected. 

The Calibrate menu offers the following commands: 

  
Figure 10-1 Calibrate menu 

Command Used to … 

Internal Manually calibrate the selected or all mass spectra in the 
selected analysis internally. 

External Calibrate all mass spectra in the selected analysis externally. 
Apply Lock Mass 

Calibration 
Turn on/off applying lock mass calibration. 

Automatic Internal Automatically calibrate all mass spectra in the selected analysis 
internally. 

Parameters Define the Calibration method parameters for the selected 
analysis. 

 

10.1 Internal Command 

The Internal command is used to calibrate the mass spectra in the selected analysis 
internally using (a) calibrant(s). Alternatively, calibration can be restricted to the 
selected mass spectrum only. The calibration coefficients obtained can be used later 
for external calibration of other analyses. 
For calibration curve set up, you have to load a calibration list (reference mass list) 
suitable for your data and select an appropriate single measured or averaged mass 
spectrum in the analysis. You can prepare this mass spectrum before selecting it; this 
differs to automatic internal calibration performed via the Automatic Internal command 
where the mass spectrum used is automatically averaged from the specified retention 
time range. The selected mass spectrum is used to assign current masses of peaks 
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that are present in the spectrum to reference masses that are stored in the loaded 
calibration list. You can assign current masses to reference masses either automatic-
ally by running the Auto Search routine or interactively by selecting them manually from 
the mass spectrum. The calibration curve is calculated from all calibration points 
(reference/current mass pairs) currently defined in the calibration table provided that 
the number of calibration points required at least for the selected calibration mode is 
reached. The calibration curve will be recalculated immediately each time you change 
the calibration table or the calibration mode. 
Note: In case of Space Charge Correction calibration (for FTMS analyses only), 

deleting of all compounds is required to apply the calibration. Therefore, if you 
want to apply calibration to your compounds, you first must perform Space 
Charge Correction calibration and then create compounds. 

The command opens the Internal Mass Spectrum Calibration - ‘analysis name’ 
dialog which allows defining the calibration points for calibration curve setup and 
recalibrating either all mass spectra in the analysis or only the selected one. 

  
Figure 10-2 Internal Mass Spectrum Calibration dialog (a reference mass list is already 

assigned to the analysis) 
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Calibration list 
Displays the name of the selected calibration list. If you want to use another calibra-
tion list, click Select List and select the desired list. 

(Calibration table) 
Lists the substances of the selected calibration list along with the reference masses 
and corresponding calibration data. The calibration data currently present depend on 
the state of calibration curve setup. The calibration table can display the following 
data: 

Substance 
Lists the calibrant substances contained in the selected calibration list ordered by 
increasing reference mass values. 

Ref. Mass 
Lists the reference masses (theoretical masses) for the substances in the calibration 
list. To manually assign a mass value present in the selected mass spectrum to a 
reference mass, first the desired reference mass has to be selected in the calibration 
table. If Zoom is not set to 'off', this will result in the spectrum displaying data window 
being automatically zoomed to display the respective part of the spectrum that corre-
sponds to the chosen reference mass.  

Cur. Mass 
Lists the current masses that are currently assigned to reference masses. You can 
assign current masses either automatically or interactively. 
To automatically assign current masses: Define the Search range (m/z) and Intensity 
threshold. Then click Auto Search to run the Auto Search routine. This assigns cur-
rent masses to all reference masses for which matching m/z values that exceed the set 
intensity threshold could be found in the Mass List of the selected mass spectrum. 
To interactively assign a current mass: Select the reference mass you want to assign a 
current mass to in the calibration table. If you have chosen a Zoom range, the display 
range of the data window is zoomed accordingly to show the corresponding m/z range. 
In the mass spectrum then position the Internal Calibration cursor  on top the 
desired peak and click the left mouse button. This assigns the selected m/z value to the 
selected reference mass. 

Res. (m/z) 
Lists the resulting masses for the current masses as calculated based on the current 
calibration curve. These values will be the new m/z values for the respective current 
mass peaks if a calibration of the spectrum will be performed. 

Error [ppm] / Error (m/z) 
Lists the calibration error that is calculated for a reference/current mass pair based on 
the current calibration curve shown in the calibration curve display.  
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Errors are indicated in the dimension [ppm] or (m/z); toggling between both dimensions 
is performed by right clicking the error column and selecting the currently not active 
option from the context menu: 

Error [ppm] is related to the relative error calculated using the following formula: 
 (current mass – reference mass) / reference mass ∗ 610  
Error (m/z) is calculated by subtracting the reference mass from the current mass. 

I(ntensity) 
Lists the absolute intensity of the current mass. 

Standard deviation 
Displays the standard deviation of a least-squares regression of the current calibration 
curve which is determined using the following equations: 
m/z deviation of calibrants: 
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Minimal number of calibration points 
Displays the minimal number of calibration points that is required for the chosen cali-
bration mode to calculate a calibration curve. If the number of currently defined calibra-
tion points does not reach this value a corresponding message will appear below the 
calibration curve display and no calibration curve is calculated.  

(Calibration curve display) 
The calibration curve display is used to show the current calibration curve. The calibra-
tion curve is drawn in green as the calibration function over the mass scale. 
The blue circles indicate the single calibration points. Their distance to the calibration 
curve, which is recorded on the ordinate, reflects the remaining error given under Error 
[ppm] (resp. Error (m/z)) in the calibration table.  
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The gray lines indicate the relative intensities of the current masses belonging to the 
respective calibration points. This allows a quick view which of the calibration points 
belong to current masses with a larger intensity and which to masses with a lower 
intensity.  
The display is updated immediately when the calibration table or a calibration parame-
ter is changed.  
Below the display the status of the current calibration is shown e.g. if the calibration is 
valid or if it failed due to what reason. It is also displayed here if the number of required 
calibration points is currently not reached. Information such as e.g. calibration has 
failed or too few calibration points being available displays red highlighted. 

Mode 
Select the calibration mode to be used. 
Note: The calibration modes actually available depend on the instrument type the 

selected analysis was acquired with (ion trap, quadrupole, time-of-flight or 
Fourier transform) and on the calibration mode used by the data acquisition 
software (mode 1 or 2). If the instrument is not known all modes are offered. 

Linear. Performs linear calibration which applies to analyses from all instruments. 
Quadratic. Performs quadratic calibration which applies to analyses from all instru-

ments. 
HPC. Performs high precision calibration (HPC) which applies to micrOTOF analyses 

only. The HPC mode improves calibration in the lower mass range. micrOTOFcon-
trol can take calibration coefficients from HPC to use them in external calibration. 
About HPC and number of calibration points required: Considering larger mass 
ranges (starting with a mass difference of 400 Da), it can be observed that the 
quadratic relationship between the square root of (m/z) and the ion flight time is 
distorted. The residual is smooth such that the mass accuracy can be increased by 
an empirical fit of the residual using a higher order polynomial. This idea has been 
developed originally for pulsed ion extraction based time of flight mass 
spectrometry, for details see Gobom J. et al., Anal. Chem. 2002, 74, 3915-3923. 
HPC calibration requires 7 calibration points at least. The calibration points should 
be distributed equally across the entire mass range. The distance between two 
successive calibration points should be about 60-70 Da and not greater than 100 
Da. This can be achieved, e.g., by using Li-clusters having a mass difference of 
about 52 Da. 
HPC should be applied if systematic smooth mass errors larger than 3 ppm can be 
observed using the standard quadratic calibration. Then, the usage of HPC 
reduces the mass error to values below 3 ppm across the whole mass range. 

Enhanced Quadratic. Performs enhanced quadratic calibration which applies to 
micrOTOF analyses only. The enhanced quadratic mode combines the accuracy 
of HPC and the robustness of the quadratic calibration. A newly developed calibra-
tion function enables compensation for residual systematic errors occurring with 
quadratic calibration especially in the lower mass region (<400 m/z), with a low 
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number of calibration points required. If the recommended number of calibration 
points is used (>= 5), the enhanced quadratic calibration function will yield 
accurate results even if larger gaps (several hundred Da) are present. 

Linear Correction. Performs linear correction calibration which applies to micrOTOF 
analyses only. The linear correction mode is designed for the recalibration of single 
spectra but can also be applied to complete analyses if required. In this mode the 
calibration function is not newly calculated but the current one is adapted to the 
found calibration points (also a single mass is possible). This makes it possible to 
recalibrate spectra or analyses (having a reasonable base calibration) with only 
one known calibration point. This is especially useful if no dedicated calibrant was 
added to the analysis, but at least one mass in the spectrum is known. 

Single Point Correction. Performs single point correction calibration which applies to 
FTMS analyses only. Only one calibration point is needed. The single point correc-
tion mode changes calibration coefficient C1 only. 

Space Charge Correction. Performs space charge correction calibration which 
applies to FTMS analyses only. The FTMS mass measurement is based on the 
measurement of the ion frequency in a magnetic field. Increasing charge density 
will lower the observed frequency and thus increase the apparent m/z. In order to 
compensate for this effect, DataAnalysis allows for space charge correction. It is 
required to acquire a chromatogram containing mass spectra with different total ion 
current (TIC). 

Search range (m/z) 
Enter for the Auto Search procedure the mass range by which reference mass and 
current mass may differ at most to be rated as a match. Be careful not to set a too 
large search range to avoid wrong mass assignment. 

Intensity threshold 
Enter for the Auto Search procedure the absolute intensity threshold a current mass 
that was found within the Search range (m/z) of a reference mass must exceed to be 
assigned to that reference mass in the calibration table. 

Zoom 
To manually assign current masses to reference masses it is helpful to automatically 
zoom in the mass spectrum for the currently chosen reference mass. Automatic 
zooming in results in the peak that corresponds to the selected reference mass is being 
displayed in the center of the zoomed m/z range. 
Select the zoom range to be used. You can choose between various relative (in 
percent of the currently selected reference mass value: 0.1%, 0.5%, 1%, 5%, 10%) and 
absolute (5 Da, 10 Da, 50 Da, 100 Da) zoom ranges. The mass range displayed in 
each case is two times the chosen zoom range, centered around the selected 
reference mass value (e.g. for a reference mass value of 1000 and a zoom range of 
5% the mass range displayed reaches from 950 to 1050 m/z). The appropriate zoom 
range depends on the quality of the calibration currently needed for the spectrum. 
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Select List 
Allows selecting the calibration list you want to use if not already chosen. Opens the 
Calibration - Internal Calibration tab of the Method Parameters dialog.  

Auto Search 
Automatically searches the Mass List of the selected mass spectrum for current 
masses that differ from a reference mass in the calibration list by not more than the 
specified Search range [m/z]. All current masses that are found to agree sufficiently to 
any of the reference masses and which also exceed the specified Intensity threshold 
are automatically entered in Cur. Mass for the reference masses they match. Auto 
Search is performed on all reference masses currently selected in the calibration table. 
If no reference mass is selected, Auto Search will search all reference masses present.  

Remove 
Removes the Cur. Mass, Res. Mass and Error entries for the substance selected in 
the calibration table. If more than one substance is selected, only the entries of the first 
of the selected substances will be removed.  

Remove All 
Removes all Cur. Mass, Res. Mass and Error entries currently present in the 
calibration table. 

Recalibrate Spectrum Only 
Calibrates only the selected mass spectrum using the current calibration function but 
leaves all other mass spectra in the respective analysis unchanged. 

Recalibrate 
Calibrates all mass spectra in the selected analysis using the current calibration 
function. The original data is replaced and the mass spectra are redrawn. 
In case of a Space Charge Correction calibration (applies to FTMS only), first a 
request will appear to delete all compounds. Confirm this request to apply calibration.  
 
Example 1: Automatically defining calibration points and setting up calibration 

curves 
The following example shows results of automatically assigning current masses in the 
selected mass spectrum to reference masses in the used calibration list by running 
Auto Search and setting up a corresponding calibration curve. The resulting curve 
depends on the calibration mode applied. In the first figure shown below the Quadratic 
mode was applied. Selecting another calibration mode immediately recalculates the 
calibration curve and updates the calibration table and calibration curve display 
accordingly. The next two figures show the resulting curve and corresponding data 
when switching to the HPC or the Enhanced Quadratic mode, respectively.  
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Figure 10-3 Internal Mass Spectrum Calibration dialog showing a calibration table and 

corresponding calibration curve set up from automatically found calibra-
tion points by applying the Quadratic mode 



Bruker Daltonik GmbH Calibrate Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  10-9

 
Figure 10-4 Calibration curve for the same reference/current mass pairs when the HPC 

mode is applied 

 
Figure 10-5 Calibration curve for the same reference/current mass pairs when the 

Enhanced Quadratic mode is applied 
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Example 2: Interactively defining calibration points for setting up a calibration 
curve 

Alternatively to defining calibration points via Auto Search, you can manually assign 
current masses in the mass spectrum to selected reference masses in the calibration 
table. For this you first have to select a reference mass in the calibration table and then 
select the corresponding current mass in the mass spectrum by clicking on it with the 
Internal calibration cursor . A calibration curve is first calculated when at least as 
many calibration points are defined as are required for the current calibration mode. In 
the example shown below, five interactively defined reference/current mass pairs are 
shown. The highlighted row shows the last added calibration point which was defined 
by assigning that current mass that is marked in the mass spectrum.  

  
Figure 10-6 Internal Mass Spectrum Calibration dialog showing a calibration table with 

five interactively defined calibration points and corresponding calibration 
curve; right to the dialog the selection of the last added current mass can 
be seen 

Shortcut 

Button:   
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10.2 External Command 

The External command is used to calibrate the mass spectra in the selected analysis 
externally using the calibration coefficients of an already calibrated analysis. Alterna-
tively, you can use the Paste > Calibration command from the context menu of the 
Analysis List to paste the calibration coefficients from a calibrated analysis, which has 
been copied to the clipboard, into the active analysis. 
Note: In case of using coefficients from a Space Charge Correction calibration (for 

FTMS analyses only), deleting of all compounds is required to apply the cali-
bration. Therefore, if you want to apply external calibration to your compounds, 
you first must perform external calibration and then create compounds. 

The command opens the External Mass Spectrum Calibration dialog to select the 
analysis whose calibration coefficients should be used.  
 

  
Figure 10-7 External Mass Spectrum Calibration dialog before an analysis is selected 

Load 
Allows selecting the source analysis whose calibration coefficients you want to use. 
Opens the Open Analysis dialog (this dialog is similar to the Open Analysis dialog 
used to open analyses but without analysis information displayed). After selection, the 
analysis to load is displayed in External Mass Spectrum Calibration dialog. 

 
Figure 10-8 External Mass Spectrum Calibration dialog when an analysis is selected 

OK 
Calibrates all mass spectra in the active analysis using the calibration coefficients of 
the selected source analysis. The recalibrated mass spectra replace the original data. 
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In case of a Space Charge Correction calibration, first a request will appear to delete 
all compounds. Confirm this request to apply calibration. 
 
 
10.3 Apply Lock Mass Calibration Command 

The Apply Lock Mass Calibration command is used to turn on/off applying lock mass 
calibration for the current analysis. A checked box in front of the command indicates 
lock mass calibration is turned on. (Note: This command has the same function like the 
Apply lock mass calibration option in the Calibration - Lock Mass Calibration tab 
of the Method Parameters dialog.) 
The lock mass calibration provides an automated way of applying the linear correction 
calibration to each spectrum in the analysis. This mode requires the presence of 
continuous signals during the analysis. When lock mass calibration is applied, each 
spectrum is searched for the masses from the specified user-definable reference mass 
list and the current calibration is adapted to the found masses. A list of lock masses 
can consist of a single or multiple entries (added substances or known background 
signals), while the result will be more accurate as more masses are found. The lock 
mass approach is especially useful to further increase accuracy for long analyses (> 
1h) in environments that show fast or large temperature changes that cannot be 
completely compensated with the online temperature compensation during acquisition. 
Lock mass calibration should be applied after recalibration.  
Lock mass calibration requires an appropriate reference mass list (= lock masses to 
use) defined in the Calibration - Lock Mass Calibration tab of the Method Parame-
ters dialog. 
 
To turn on applying lock mass calibration 
Select the command to turn on the lock mass calibration mode.  
If currently no reference mass list is specified, first a corresponding message appears. 
Clicking Yes opens the Calibration - Lock Mass Calibration tab to select the 
reference mass list to use. To continue with applying lock mass calibration either check 
the Apply lock mass calibration option in this tab and click OK/Apply or leave the 
dialog without setting that option and again select the Apply Lock Mass Calibration 
command. 
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Figure 10-9 Information on no reference mass list being defined 

Since applying lock mass calibration will invalidate mass spectra which were previously 
created in the analysis, e.g. by compound finding operations, you will be asked prior to 
applying lock mass calibration whether to delete compounds/compound spectra if such 
compounds exist. Then click Yes or No to start applying lock mass calibration with or 
without deleting compounds/compound spectra.  

 
Figure 10-10 Confirmation request on applying lock mass calibration 

Starting lock mass calibration recalibrates the mass spectra in the analysis using the 
defined lock mass(es). The processing operations, e.g. compound finding, you perform 
on the analysis while the mode is active will use the lock mass recalibrated mass 
spectra. If you perform a new internal/ external calibration on the analysis, immediately 
a new lock mass calibration will be performed, too. The applying lock mass calibration 
mode will be active as long as it is not deactivated again.  
 
To turn off applying lock mass calibration 
To turn off applying lock mass calibration, again select the Apply Lock Mass Calibra-
tion command. Alternatively, you can uncheck the Apply lock mass calibration 
option in the method parameters.  
Deactivating the mode will automatically restore the "old" calibration which was valid 
previously to applying lock mass calibration for the very last time. Since restoring of the 
old calibration will invalidate mass spectra, which were created while applying lock 
mass calibration was active, you will first be asked whether to delete compounds/com-
pound spectra if such compounds exist. Click Yes or No to turn off applying lock mass 
calibration with or without deleting compounds/compound spectra. 
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Figure 10-11 Confirmation request on turning off lock mass calibration 
 
 
10.4 Automatic Internal Command 

The Automatic Internal command is used to automatically calibrate the mass spectra 
in the selected analysis internally using a predefined retention time range for calibrant 
search which is specified in the selected method. The average mass spectrum to use 
for calibration curve setup is defined by the program based on the parameter settings 
in the selected method. This differs to manual internal calibration performed via the 
Internal command where the user can determine and prepare the mass spectrum to 
be used. The calibration coefficients obtained can be used later for external calibration 
of other analyses. 
Note: Automatic internal calibration is a typical micrOTOF calibration. 
 
Automatic internal calibration includes the following main steps which are performed 
based on the parameter settings defined in the Calibration - Internal Calibration and 
- Automatic Internal Calibration tabs of the Method Parameters dialog: 
• Averaging a mass spectrum from the mass spectra of the specified type (line or 

profile spectra) within the specified retention time range. 
• Comparing the Mass List peaks of the calculated average spectrum to the selected 

calibration list (reference mass list) with matching current masses in the mass 
spectrum and reference masses in the calibration list that comply with the specified 
search range (m/z) and intensity threshold. 

• Calculating calibration coefficients from the found matches (reference/current mass 
pairs = calibration points) according to the specified calibration mode. 

• Applying the new calibration coefficients to all mass spectra in the analysis.  
 
To determine the retention time range for the calibrant peak you can set up e.g. a 
corresponding BPC trace, select a retention time range representing the calibrant peak 
and create an average mass spectrum from it. View the resulting average spectrum. If 
you are satisfied with the current average spectrum enter the corresponding retention 
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time range in the method parameters; otherwise, repeat the procedure for a new reten-
tion time range.  
 

 
Figure 10-12 Example of determination of the retention time range of the calibrant to be 

used for automatic internal calibration (here a Li-formiate) 

The command automatically calibrates all mass spectra in the selected analysis based 
on the defined method parameters. You can view the current calibration status of the 
analysis in the Calibration Status tab of the Analysis Properties dialog or from the 
Calibration report.  

Shortcut 
Button:   

 
 
10.5 Parameters Command 

The Parameters command is used to define parameter settings for calibration of mass 
spectra. It opens the Calibration - Internal Calibration tab of the Method Parameters 
dialog. 
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11 ANNOTATION MENU 

The Annotation menu offers the following commands: 

  
Figure 11-1 Annotation menu 

Command Used to … 

Annotate Attach an annotation to the selected chromatogram or mass 
spectrum. 

Clear All Clear all current annotations for the selected chromatogram 
or mass spectrum. 

Difference Ruler Display the Difference Ruler for searching the selected mass 
spectrum for specific building blocks. 

Extend Series Extend the current Difference Ruler search for specific 
building blocks. 

Edit Building Blocks Launch the BuildingBlockEditor for viewing and editing the 
building block sets to be used in building block annotation. 

 
 
11.1 Annotate Command 

The Annotate command is used to annotate the selected chromatogram or mass 
spectrum, to modify existing annotations or to delete them.  
Both single-point and difference annotations are possible: 
• Compound peaks in chromatogram traces can be annotated with corresponding 

retention time (single-point annotation) or retention time difference values (difference 
annotation). 

• Mass peaks in mass spectra can be annotated with corresponding m/z (single-point 
annotation) or m/z difference values (difference annotation).  
When using a building block set, m/z differences are automatically checked for 
matches with the building blocks in the selected set. In case a sufficient match is 
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found, the respective building block is displayed and will be attached instead of the 
m/z difference value. Single-point annotation uses building blocks, too. This allows 
e.g. annotating neutral loss and auto-correlation spectra or i-type ions in fragment 
spectra of protein samples with building block information.  
When the SmartFormula Annotation mode is active, m/z differences are interpreted 
by automatically generating corresponding molecular formulae. 

• Chromatograms and mass spectra can be annotated with text. Text annotations will 
move along with its associated chromatogram or spectrum when the display range is 
changed. 

Retention time or m/z values are attached with numeric precision currently defined for 
the selected analysis in the Display tab of the Method Parameters dialog. Also, you 
can modify the type (value or text annotation), orientation, vertical position, font, font 
size and position relative to the line marker of the existing annotations. Annotations can 
also be deleted. 
 
The command activates/deactivates the Annotation mode. Annotations can only be 
attached or processed when the Annotation mode is active. The mode is active when 
the command's tool button is being pressed.   
Tip: When currently in another permanent interaction mode, you can quickly switch to 

the Annotation mode by holding down the Alt key. The Annotation mode will be 
temporarily active as long as the Alt key is held down. When the Alt key is 
released the previous active mode will be activated again. 

On activating the Annotation mode, the Annotation toolbar appears which contains the 
list boxes and parameter settings currently defined for annotation. Since a new annota-
tion is attached according to the current settings of the parameters defined in this 
toolbar, first check the toolbar to see if all parameters that should be used are set as 
required. If this is not the case, it is recommended to first customize the Annotation 
toolbar and/or change its current settings. The annotation can also be modified indi-
vidually after it is attached.  
 
To attach new and to modify existing annotations, DataAnalysis provides the Annota-
tion cursors. These are displayed when the Annotation mode is active and the mouse 
cursor is positioned in that data window which displays the selected chromatogram or 
mass spectrum. Which cursor currently appears depends on whether the cursor 
currently points to an annotation-free position, an existing annotation, or the current 
selection state of the annotation.  

Attaching a retention time or m/z annotation 
To annotate a compound peak with retention time or a mass peak with m/z annotation, 
position the 'attach' cursor  to the data point on the selected chromatogram or 
mass spectrum. The retention time or m/z annotation should be attached to the coordi-
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nates of the current cursor position upon left clicking the mouse button. . The position 
of the data point, the new annotation is attached to, is indicated by a vertical line 
marker. You can change the length of this line marker by changing the vertical position 
of the annotation. 

Attaching a retention time difference or m/z difference annotation 
To annotate two compound peaks with retention time difference or to annotate two 
mass peaks with m/z difference, position the 'attach' cursor  to the data on the 
selected chromatogram or mass spectrum at which the difference annotation is to start. 
Then drag the mouse with the left mouse button held down to the desired end point. 
While dragging, the difference value is continuously displayed and adjusted to the cur-
rent cursor position. Releasing the mouse button will attach the selected start and end 
coordinates of the current cursor position. The data points this new difference annota-
tion relates to are indicated by vertical and horizontal line markers. The length of the 
vertical line marker can be changed to change the vertical position of the respective 
annotation. 

Attaching a building block annotation to a m/z (difference) 
To attach building block information to a mass spectrum, select the building block set 
suitable for the type of compound analyzed. This results in automatically comparing a 
selected m/z (difference) to the building blocks contained in the selected set and show-
ing the best matching building block for the m/z (difference) if available. You can view 
and edit the building block sets available using the Edit Building Blocks command 
from the Annotation menu. 

While dragging the 'attach' cursor , specific building block information may appear 
if the current m/z difference sufficiently matches one of the building blocks available. In 
principle, building block information consists of two parts (e.g. 'A+1' or 'C+4.0'). First 
the building block is given either by its abbreviation or full name, which is followed by a 
positive or negative value which indicates the deviation of the current m/z difference 
from the molecular weight calculated for the respective building block.  
If more than one matching building block is found automatically the best matching one 
is shown and will be used for annotating. After attaching a building block annotation to 
a m/z (difference), further less well matching building block hits for that m/z (difference) 
can be read, if available, from the combo box in the Annotation toolbar which displays 
the value of the selected annotation. If desired you can select another building block 
from that list to annotate the respective m/z (difference). 

Attaching SmartFormula annotation to a m/z difference 
To attach SmartFormula information to a m/z difference in a mass spectrum, first 
activate the SmartFormula Annotation mode. For this, either press the SmartFormula 

Annotation button in the Annotation toolbar so that is becomes pressed ( ) or hold 
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down the Space key to temporarily switch to that mode. This results in automatically 
generating possible molecular formulae for the selected m/z difference. 
While dragging the 'attach' cursor over the mass spectrum, SmartFormula information 
will appear instead of the m/z difference value if at least one molecular formula which 
sufficiently matches the current m/z difference can be generated. In principle, the 
SmartFormula annotation consists of two parts (e.g. ' '), the molecu-
lar formula and the m/z error. On releasing the mouse button, the respective molecular 
formula information is attached to the selected data points. 
If more than one sufficiently matching molecular formula is found automatically the best 
matching one is shown and will be used for annotating. After attaching a molecular 
formula annotation, further less well matching formula hits for that m/z difference can 
be read, if available, from the combo box in the Annotation toolbar which displays the 
value of the selected annotation. If desired you can select another molecular formula 
from that list to annotate the respective m/z difference. 

Attaching a text annotation 
To attach a text annotation to a compound or mass peak, you first have to attach a 
retention time or m/z annotation to the desired data point and then change the current 
value in the annotation to a text. Use the 'attach' cursor  to attach a value 
annotation to the desired data point as described above. Then navigate to the Annota-
tion toolbar. In the annotation text list box, which displays the corresponding retention 
time or m/z value, overwrite the current entry with the text you want to attach to the 
selected data point. This automatically changes the respective annotation. 
 

  
Figure 11-2 Annotating a chromatogram trace: different types of retention time, reten-

tion time difference and text annotations are shown with a retention time 
annotation being selected 



Bruker Daltonik GmbH Annotation Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  11-5

  
Figure 11-3 Annotating a mass spectrum: different types of m/z, m/z difference, 

building block and text annotations are shown with a building block 
annotation being selected (further less well matching building block hits 
for that m/z difference can be found in the corresponding combo box of 
the Annotation toolbar) 

 
Figure 11-4 Annotating a mass spectrum: annotating a m/z difference with the best 

matching SmartFormula (further less well matching SmartFormula hits for 
that m/z difference can be found in the corresponding combo box of the 
Annotation toolbar) 

Modifying an annotation 
To modify an existing annotation, select the respective annotation by positioning the 
'attach' cursor  near (3 pixel) the respective annotation so that the cursor changes 
to the 'select' cursor  and clicking left mouse button. The annotation is selected 
which is indicated by black handles present on the corresponding line marker(s).  
Depending on that kind of modification you wish to make, change the corresponding 
parameters settings in the Annotation toolbar or move the annotation to a new vertical 
position by dragging the line marker handles using the 'change' cursors ,  or .  
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Deleting an annotation 
To delete an annotation, select the respective annotation by positioning the 'attach' 
cursor  near (3 pixel) the respective annotation so that the cursor changes to the 
'select' cursor  and clicking left mouse button. Then press the Del key. To delete 
an annotation, select the respective annotation by positioning the 'attach' cursor  
near (3 pixel) the respective annotation so that the cursor changes to the 'select' cursor 

 and clicking left mouse button. Then press the DEL key. You can also delete all 
annotations at once using the Clear All command from the Annotation menu. 
 

Shortcut 
Button:   

Dedicated key for Annotation mode 
Alt 

 
 
11.2 Clear All Command 

The Clear All command deletes all annotations of the selected chromatogram or mass 
spectrum. The command can be applied to multiple selected chromatograms and/or 
mass spectra of the same analysis. If on selecting the command both (a) chromato-
gram(s) and (a) mass spectrum/spectra are selected, first a confirmation request will 
appear asking you if you want to delete all annotations of the different selected items. 
Click Yes to delete the annotations of all selected items or click No if you want to 
delete only the annotations of one kind of items. In this case, unselect all currently 
selected Analysis List items using the Select None command in the Edit menu, then 
select only the desired chromatogram(s) or mass spectrum/spectra and select Clear 
All again.  

Shortcut 
Button:   

 
 
11.3 Difference Ruler Command 

The Difference Ruler command is used to display the Difference Ruler and search the 
selected mass spectrum for m/z differences that can be assigned to specific building 
blocks available in the selected building block set. The command activates/deactivates 
the Difference Ruler mode; the mode is active when the command's tool button is being 
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pressed. You can view and edit all building block sets available with DataAnalysis 
using the Edit Building Blocks command from the Annotation menu. 
To set up the Difference Ruler, activate the Difference Ruler mode. In the Difference 
Ruler toolbar select an appropriate Building Block Set (e.g. Amino Acids). Then 

position the Difference Ruler cursor  on the mass peak on which you want to dis-
play building block information and click left mouse button. This creates the corre-
sponding Difference Ruler with the unlabeled ruler line marking the selected peak. 
Depending on whether the Mass List contains peaks showing characteristic m/z differ-
ences to this selected peak, which match the building blocks of the selected set, addi-
tional ruler lines, may appear labeled with the corresponding building block abbrevia-
tions. If the Mass List does not contain such peaks no further ruler lines will appear. 
You can move the Difference Ruler along the mass spectrum by positioning the Differ-
ence Ruler cursor on the unlabeled ruler line so that it changes to  and then dragging 
the ruler with the left mouse button held down. While dragging, the Difference Ruler 
lines present are continuously updated with regard to the current cursor position. This 
allows you to search the respective mass spectrum for specific building blocks. You 
can also use the Extend Series command from the Annotation menu to extend the 
current series. 
 

  
Figure 11-5 Difference Ruler created according to the building block set selected in 

the Difference Ruler toolbar and the current data cursor position 

Shortcut 
Button:   
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11.4 Extend Series Command 

The Extend Series command is used to extend the Difference Ruler search currently 
performed using the Difference Ruler command from the Annotation menu. This 
allows you to search the selected mass peak for the presence of further m/z 
differences that can be assigned to specific building blocks of the selected building 
block set. The command activates/deactivates the Extend Series mode; the mode is 
active when the command's tool button is being pressed. 
To extend a current Difference Ruler series, activate the Extend Series mode and 
move the Difference Ruler cursor over the mass spectrum. This may bring up addi-
tional, dotted, Difference Ruler lines. 
 

  
Figure 11-6 Extended Difference Ruler series 

Shortcut 
Button:   

 
 
11.5 Edit Building Blocks Command 

The Edit Building Blocks command is used to start the BuildingBlockEditor applica-
tion which allows you to view and edit the currently available building block sets to be 
used to automatically interpret m/z differences using the Annotate or Difference Ruler 
command from the Annotation menu. 
The command starts the BuildingBlockEditor and loads the first of the alphabetically 
ordered building block sets shown in Building block sets. The building blocks 
contained in this set are listed in Building Blocks along with their Full name, Abbrev 
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(iation) and chemical Formula. Additionally, the Symbol is shown which appears in the 
data window when the Annotation or Difference Ruler mode is active. 

 
Figure 11-7 BuildingBlockEditor showing the building blocks contained in the loaded 

building block set 

Various Bruker Default building block sets are available. A ‘<Bruker Default>‘ appendix 
to the building block set name indicates these. You cannot alter or delete them. 
However, you can set up Windows-user specific building block sets by copying such a 
Bruker Default set to a new file name and then modifying the copy according to your 
own requirements or by creating a completely new building block set. 
Note: For detailed information on how to create and edit building block sets, please 

refer to the BuildingBlockEditor Help. 

Shortcut 
Button:   



Annotation Menu Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 11-10 

 
 



Bruker Daltonik GmbH Method Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  12-1

12 METHOD MENU 

The Method menu offers the following commands: 

 
Figure 12-1 Method menu 

Command Used to … 

Run Run the VisualBasic script in the open processing method or the 
selected analysis. 

New Assign a new method to the selected analysis based on internal default 
values or the current default method. 

Open Open another processing method and attaches it to the selected 
analysis. 

Save Save the open processing method under the same file name. 
Save As Save the open processing method under an existing or a new file name. 
Parameters Edit parameter settings of the open processing method. 
Script Create or edit a VisualBasic script in the open processing method or 

selected analysis. 
Default Select a processing method to be automatically attached as default 

processing method to an analysis whose embedded method does not 
contain a processing module. 

 
 
12.1 Run Command 

The Run command runs the VisualBasic script contained in either the currently open 
processing method or the selected analysis. If a GUI has been built for this script, 
which contains a Start button, the GUI will appear, and you have to click the Start 
button to run the script. While executing the script, the currently active chroma-
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togram(s) or mass spectrum/spectra is/are automatically processed according to the 
particular processing operation(s) defined in the script. The results are displayed in the 
corresponding windows. If the script contains additional export and/or print instructions, 
the results are exported and/or printed accordingly. 

Shortcuts 
Button:  
Key: F2 

 
 
12.2 New Command 

The New command is used to assign to the selected analysis a new method based on 
either internal default parameter values or the dedicated default method. The command 
opens the New Method dialog, which allows you to select on what the new method to 
be assigned should be based on. 
 

 
Figure 12-2 New Method dialog when a default method is specified 

In Assign new method based on select on what the new processing method should 
be based: 

Internal default values. Assigns a new method based on internal default parameter 
values.  

Default method. Assigns a new method based on the current default processing 
method stated below. 
Note: This option is only enabled when a default method has already been 

selected using the Default command from the Method menu. 

Shortcut 

Button:  
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12.3 Open Command 

The Open command is used to open a processing method and attach it to the selected 
analysis in place of the previously attached method. This overwrites the previous Data-
Analysis part with the new one. The name of the processing method currently attached 
to the active analysis is displayed in the DataAnalysis title bar as well as in the Method 
Parameters dialog. 
In Compliance mode, methods can be saved as SOP or non-SOP methods (SOP = 
standard operating procedure) if the UserManagement administrator has turned on 
SOP method handling. All operators can load methods with an SOP flag but only 
operators with a special right can also load non-SOP methods. If the current operator 
does not have this right, the Open Method dialog shows SOP methods only. The 
SOP/non-SOP status of a selected method is indicated by the SOP method check box. 
If the UserManagement administrator has defined an SOP method folder, methods can 
be loaded only from that default folder except the operator has the special right to use 
non-default method folders, too.   
Tip: For supported instruments default processing methods are installed to the ‘Proc-

essing folder within the defined ‘Methods’ folder. 
 
The command opens the Open Method dialog, which allows you to select another 
method to be attached to the selected analysis. 

Look in and folder list 
Navigate to the drive and folder that contains the method you want to open. Double-
click the method or select it and click Open. 
If SOP method handling is turned on and you do not have the right to open non-SOP 
methods, the folder list shows SOP methods only. If an SOP method folder has been 
defined and you do not have the right to use non-default method folders, you can load 
methods only from the default folder. 

Method name 
Enter the name of the desired method or select a method from the folder list. 

Filter 
Select the type of methods to be displayed in the folder list: 

Methods with DataAnalysis Part (*.ms, *.m). Filters methods containing a Data-
Analysis part. 

All (*.*). Lists all data files available. 

(Method part list) 
Lists under Method Part Type all application method parts currently contained in the 
selected method and under Method Part Name the corresponding part names. 
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Figure 12-3 Open Method dialog (when in Compliance mode with SOP handling being 

enabled) 

Comment 
Displays the comment for the selected method if available. A comment can be entered 
when the method is saved using the Save As command from the Method menu. The 
comment applies to the entire method. 
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Method is SOP 
Note: This option is available when SOP handling is activated. 
Indicates the SOP/non-SOP status of the selected method. 

Open 
Opens the selected method and attaches it to the active analysis in place of the 
previously attached method.  
If SOP method handling is turned on and you have selected another folder than the 
default SOP method folder but do not have the corresponding right a corresponding 
message will appear. 

Shortcut 
Button:  

 
 
12.4 Save Command 

The Save command saves the changed parameter settings of the DataAnalysis 
processing part using the same method and part name. This overwrites the current 
DataAnalysis part in the method and thus modifies the method. Methods with an SOP 
flag cannot be saved via this command. 
If parameter settings of the open method were changed but have not been saved yet, 
this is shown by a '(modified)' indicator that is appended to the method name in the title 
bar of the Method Parameters dialog. Without saving the modified method, the current 
parameter settings will only saved in the analysis they have been defined for when the 
analysis is saved. 
If the processing part to be saved was not loaded from a method but bases on the 
internal default values, the Save DataAnalysis Method Part As dialog appears to 
save the processing part into either a new or an existing method. If you try to save a 
method with an SOP flag, an error message appears.  

Shortcut 
Button:   

 

12.5 Save As Command 

The Save As command is used to save the processing method as 'DataAnalysis part' 
either into an existing method with replacing the current DataAnalysis part or into a new 
method. The latter creates a new method with only the DataAnalysis part being 
contained whereas saving into an existing method results in modifying the selected 
original method. Each method can contain only one DataAnalysis part. 
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In Compliance mode, methods can be saved as SOP or non-SOP methods (SOP = 
standard operating procedure) if the UserManagement administrator has turned on 
SOP method handling. Methods with an SOP flag cannot be modified. Only operators 
who have the special right can mark SOP methods. If the UserManagement admini-
strator has defined an SOP method folder for saving/loading SOP methods operators 
need a special right to use non-default method folders, too. 
 
The command opens the Save DataAnalysis Method Part As dialog, which allows 
you to enter a new or select an existing method name under which the current method 
parameter settings are to be saved. 

Save in and folder list 
Navigate to the drive and folder in which you want to save the method. If SOP method 
handling is turned on and an SOP method folder has been defined you have to save 
the method in the default folder if the method should be used by operators without the 
right to use non-default method folders. To save the method to another folder you need 
the corresponding right. 
Method name 
Specify the name of the method the DataAnalysis part is to be saved in. If you want to 
create a new method, enter the desired new name. If you wish to overwrite an existing 
method, enter its name or select it from the folder list.  
Filter 
Select the type of methods to be displayed in the folder list: 

Methods with DataAnalysis Part (*.ms, *.m). Filters methods containing a Data-
Analysis part. 

All (*.*). Lists all data files available. 
Method part name 
Enter the method part name the DataAnalysis part is to be saved with in the specified 
method. The part name is entered in a sense of a comment. If you do not enter a 
name, the DataAnalysis part will get a part name that is the same as the method 
name. 
(Method part list) 
Lists under Method Part Type all application method parts currently contained in the 
method and under Method Part Name the corresponding part names. 

Comment 
Optionally enter a comment for the method. The comment applies to the entire method. 
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Figure 12-4 Save DataAnalysis Method Part As dialog (when in Compliance mode with 

SOP handling being enabled and the operator has the right to mark 
methods as SOP) 

SOP method 
Note: This option is available when SOP method handling is turned on. It is enabled 

when the operator has the right to mark a method as SOP. 
Check this option if you want to mark the method as SOP. This sets the SOP flag, 
which allows loading the method by all operators. If the flag is not set only operators 
with the right to load non-SOP methods can load the method. Default is not checked. 
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Save 
Depending on whether a new or an existing method name is chosen, the current 
parameter settings of the DataAnalysis part are saved into a new or an existing method 
file together with the specified part name and comment, if available. If the processing 
part should be saved into an existing method, the previous DataAnalysis part of the 
method becomes overwritten after you have confirmed the corresponding request. If 
the processing part is to be saved into a new method, a new method is created 
containing only the DataAnalysis method part. 
The specified new (or modified) method is automatically attached to the active analysis. 
The method name will be displayed in the title bar of the corresponding Method 
Parameters dialog instead of the previous method name. 
If SOP method handling is turned on with an SOP method folder being defined and you 
do not have the right to use non-default method folders, a message will appear if the 
default folder is not selected. 
 
 
12.6 Parameters Command 

The Parameters command is used to define parameter settings of the open processing 
method, which will be used in performing certain processing operations on the selected 
analysis and in displaying corresponding results.  
The command opens the tabbed Method Parameters dialog containing the following 
tabs with some of them having inserted tabs: Find (opens by default), MassList, 
Charge Deconvolution, Library Search, Exclusion Masses, Calibration, Layouts, 
Display, Process, Export, Chemistry and UV Data. The dialog opens on the last 
used page resp. sub-page. 
Note: The Calibration tab is only available if the Enable Mass Spectra Recalibra-

tion command from the Process menu is activated. 
 
The Method Parameters dialog is a modeless dialog. Using the Apply button, you can 
apply the current method parameter settings to the desired processing operation you 
want to perform while keeping the dialog open. This allows you to test the current 
settings.  
 
Shortcuts 

Button:  
Keys: Alt+F2 
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12.6.1 Parameters Command - Find 

The Find tab is used to define the parameter settings to be used in finding compounds 
on chromatogram traces. The settings in this tab apply to the Integrate Only - Chro-
matogram, Compounds - Chromatogram, Compounds - MS(n), Compounds – 
AutoMS(n), Compounds - Dissect, Compounds - Molecular Features and Com-
pounds Manual - Chromatogram commands in the Find menu.  
The Find tab consists of the following inserted tabs: Chromatogram, MS(n), Auto-
MS(n), Dissect and Molecular Features.  
For all finding functions, the following option can be set: 

Delete previously found compounds of same type in selected range 
Check this option to delete the compounds of the same (integration) type previously 
found in the selected retention time range before starting the selected compound 
finding procedure. Otherwise, the new compounds are added to the previous ones. 
Default is checked. 
 
 
12.6.1.1 Find - Chromatogram, MS(n) 

The Chromatogram, MS(n) tab defines the parameter settings for the Integrate Only - 
Chromatogram, Compounds - Chromatogram and Compounds - MS(n) finding func-
tions.  
S/N threshold 
Enter the S/N (signal-to-noise) threshold a signal must exceed to be used in compound 
finding. Values from 0.001 to 1000 are allowed. 
The S/N is defined as the height of the mass peak above its baseline, relative to the 
noise. The noise level is defined as 5 x sigma (sigma = standard deviation) and is cal-
culated on the full mass spectrum except the regions of peaks.  
The steps included in the signal-to-noise ratio determination in the Find Compounds 
algorithm used with the above-mentioned finding functions depend on the selected 
chromatographic peak finder version, Version 1.0 or Version 2.0 / 2.1. 
For Version 1.0: The S/N determination includes the following steps: 

1. The third derivative of the chromatogram is calculated using the Savitzky Golay 
algorithm with a smoothing width m as set in the Find Compounds parameters. 
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Figure 12-5 Method Parameters dialog - Find - Chromatogram, MS(n) 

2. The maximum value of a histogram of the absolute of the third derivative y''' 
determines the internal threshold T for the next step. 

3. The standard deviation σ′ of all values of the third derivative y''' which absolute is 
smaller or equal the internal threshold T is determined. 
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4. The standard deviation is corrected with the smoothing width giving the noise σ for 
signal-to-noise ratio calculation: 
 3' m⋅= σσ , with m = smoothing width 

5. The signal-to-noise ratio S/N of each peak is then calculated as: 
 σ5/SS/N = , with S = peak height above the peak baseline. 
The noise N is determined as 5σ; statistically 99% of the noise values are within 
this range. 
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The following drawing illustrates the Signal and the Noise values. 

 
Figure 12-6 Illustration of the Signal and the Noise values 

For Version 2.0 / 2.1: The S/N determination is done in the following way: 
1. Determination of local maxima. 
2. Splitting of spectrum in segments according to number of local maxima. 
3. Per segment: 

a. Sorting of intensity values of local maxima (histogram). 
b. Calculation of first derivative using the Savitzky Golay algorithm with a smooth-

ing width of 1/10 of the number of local maxima in the segment (formula see 
above). 

c. Determination of points of minimal and maximal derivative of the histogram, 
which give the turning points of the distribution. 

d. Use the noise obtained from the intersection of the tangents at the appropriately 
selected turning points. 

Area threshold 
Define the area threshold a signal must exceed to be found as a compound. Select the 
threshold type and enter the desired threshold value: 

Absolute. Uses the specified absolute area threshold. 
Relative [%]. Uses the specified relative area threshold with reference to the 

respective 100% (base) peak. 
(Area Threshold). Enter a value for the relative or absolute area threshold. Default is 

'10'.  

Intensity threshold 
Define the intensity threshold a signal must exceed to be found as a compound. Select 
the threshold type and enter the desired threshold value. 

Absolute. Uses the specified absolute intensity threshold. 
Relative [%]. Uses the specified relative intensity threshold with reference to the 

respective 100% (base) peak. 
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(Intensity Threshold). Enter a value for the relative or absolute intensity threshold. 
Default is '10'.  

Skim ratio 
Enter the skim ratio that influences the calculation of peak areas of overlapping peaks. 

Smoothing width 
Enter the number of mass spectra to be used for smoothing. The optimal value for the 
smoothing width is determined by the formula (n-1)/2, with n as number of data points 
of a typical peak at full width half maximum (FWHM). Values from 1 to 20 are allowed. 

Algorithm 
Select the version of chromatographic peak finder you want to use: 

Version 1.0. Uses the chromatographic peak finder version 1.0. This peak finder is 
provided for backward compatibility with previous versions of DataAnalysis. This 
peak finder was exclusively available until DataAnalysis 3.2. 

Version 2.0. Uses the chromatographic peak finder version 2.0. This is an improved 
peak finder eliminating occasional problems having been observed with version 
1.0. The peaks being found and their properties, namely the area and the S/N, will 
be different compared to version 1.0. 

Version 2.1. Uses the chromatographic peak finder version 2.1. This peak finder has 
an improved baseline and peak start and end point determination. The peaks 
being found and their properties, namely the area and the S/N, will be slightly 
different compared to the other versions. 

Spectrum type (Line/Profile) 
Select the type(s) of averaged compound spectra to be calculated: 

Auto. Calculates profile spectra if such were acquired. Otherwise calculates line 
spectra. 

Line and profile spectra. Calculates both line and profile spectra. 
Line spectra only. Calculates line spectra only. 
Profile spectra only. Calculates profile spectra only. 

Additional background subtraction (MS only) 
Select the type of additional background subtraction to be performed on the averaged 
compound spectra. This only applies to the MS spectra, not to the MS/MS spectra. 

None. Does not subtract an additional background. 
Peak (Start and end spectra). Subtracts a background spectrum that is determined 

by the program by averaging the start and end spectra of the compound peak. 
Note: Constant (Background Mass Spectrum) and Spectral background subtraction is 

defined by the chromatogram trace definition. If you want an additional back-
ground subtraction to be performed on the MS compound spectrum you can set 
Peak (Start and end spectra). 
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Add UV spectrum, resp. mass spectrum, if available 
Check this option to additionally create UV spectra, resp. mass spectra, if available. 
 

12.6.1.2 Find - AutoMS(n) 

The AutoMS(n) tab defines the parameter settings for the Compounds - AutoMS(n) 
finding function.  

 
Figure 12-7 Method Parameters dialog - Find - AutoMS(n) 

Intensity threshold 
pos. 
For spectra of positive polarity, enter the intensity threshold the internally calculated 
'TIC, + all MS/MS' must exceed to be used for finding AutoMS(n) compounds.  

neg. 
For spectra of negative polarity, enter the intensity threshold the internally calculated 
'TIC, - all MS/MS' must exceed to be used for finding AutoMS(n) compounds.  
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Maximum number of compounds 
Enter the maximum number of compounds to be detected at the most. Only those N 
compounds having the highest 'TIC, all MS/MS' will be calculated, provided the 
respective 'TIC, all MS/MS' exceed the specified intensity threshold. 

RT window [min] 
Enter the size of the retention time window [min] to be used for compound detection.  
It is recommended to adjust this value, such that the retention time window corre-
sponds to the base width of a typical chromatographic peak. The maximum allowed 
value is '1440' (= one day).  

Merge positive and negative compounds 
Compounds of alternating polarity analyses contain positive and negative spectra if 
precursors are ~2 amu apart ([M+H]+ and [M-H]-).  
For alternating polarity analyses, check this option if overlapping peaks of [M+H]+ and 
[M-H]- compounds should be merged into one compound. This results in the compound 
containing positive and negative spectra. If this option is not set [M+H]+ and [M-H]- will 
be individual compounds each of them containing only positive or negative spectra. 
Note: For non-alternating polarity analyses, it does not matter whether this option is 

checked. 

Fragments qualified by 
Check this option if compounds should be created only if MS/MS spectra are qualified 
positively. This is done by searching for typical differences between all peaks. These 
differences are specified by a building block set you have to select from the list to the 
right. A positive qualification is currently achieved if at least two meaningful differences 
are found.  

(Building block box) 
For Fragments qualified by checked, select the building block set to be used in quali-
fying MS/MS spectra. Choose that set suitable for the kind of compounds you want to 
analyze. 

Filter for detected neutral losses only 
Check this option if only those compounds should be filtered out which have a fragment 
spectrum that was acquired due to a "detected neutral loss" (in TrapControl). 

Spectrum type (Line/Profile) 
Select the type(s) of averaged compound spectra to be calculated: 

Auto. Calculates profile spectra if such were acquired. Otherwise, it calculates line 
spectra. 

Line and profile spectra. Calculates both line and profile spectra. 
Line spectra only. Calculates line spectra only. 
Profile spectra only. Calculates profile spectra only. 
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Background subtraction (MS only) 
Select the type of background subtraction to be performed on averaged compound 
spectra. This only applies to the MS spectra, not to the MS/MS spectra. 

None. Does not subtract any background.  
Constant (Background MS). Subtracts the proper of maximal four background mass 

spectra previously defined using the Define Background Mass Spectra com-
mand from the Process menu. The current background spectra are contained in 
the analysis’ Background Mass Spectra folder. 

Peak (Start and end spectra). Subtracts a background spectrum that is determined 
by the program by averaging the start and end spectra of the compound peak. 

Spectral. Subtracts the spectral background calculated for the selected analysis by 
the program. This background subtraction applies to LC/MS and LC/MS(n) 
analyses only. 

Add UV spectrum if available 
Check this option to additionally create UV spectra if available. 
 
 
12.6.1.3 Find - Dissect 

The Dissect tab defines the parameter settings for the Compounds - Dissect finding 
function.  

Internal S/N threshold 
Enter the internal S/N (signal-to-noise) threshold a signal must exceed to be used in 
compound finding. Unlike to the S/N threshold of the other compound finding functions, 
the internal S/N threshold is not a threshold applied on the resulting compound peak 
but applies to the individual mass spectral peaks within the algorithm. Values from 
0.001 to 1000 are allowed.  
The S/N is defined as the height of the mass peak above its baseline, relative to the 
noise. The noise level is defined as 5 x sigma (sigma = standard deviation) and is 
calculated on the full mass spectrum except the regions of peaks. 
Note: The internal S/N threshold can have a strong influence on the number of 

compounds being found. 

Max. number of overlapping compounds 
Enter the maximum number of overlapping compounds to be allowed in a group of 
peaks. The higher the value the longer the Dissect compound finding will take. Values 
from 1 to 20 are allowed.  
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Figure 12-8 Method Parameters dialog - Find - Dissect 

Consider exclusion masses for compound detection 
Check this option if the current exclusion masses set for the selected analysis in the 
Exclusion Masses tab of the Method Parameters dialog should be considered for 
compound detection. If unchecked, the exclusion masses are treated as normal 
masses and shown as such in the mass spectrum; however, these masses will not be 
used as a compound specific leading mass.. 

Spectrum type (Line/Profile) 
Select the type(s) of averaged compound spectra to be calculated: 

Auto. Calculates profile spectra if such were acquired. Otherwise calculates line 
spectra. 

Line and profile spectra. Calculates both line and profile spectra. 
Line spectra only. Calculates line spectra only. 
Profile spectra only. Calculates profile spectra only. 

Cut-off intensity (10 - 0.01%) 
Enter the minimum relative intensity a mass signal must reach to be included in the 
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compound spectrum. Masses having smaller relative intensities than the cut-off inten-
sity set will be removed from the mass spectrum. Values from 10% to 0.01% are 
allowed. Default is '0.1'. 

Add UV spectrum if available 
Check this option to additionally create UV spectra if available. 
 
 
12.6.1.4 Find - Molecular Features 

The Find - Molecular Features tab defines the parameter settings for the Compounds 
- Molecular Features finding function.  
 

 
Figure 12-9 Method Parameters dialog - Find - Molecular Features 

S/N threshold 
Enter the S/N (signal-to-noise) threshold that is used by the chromatographic peak 
finder, version 2.0, when applied to the traces of the peak clusters and for thresholding 
resulting compounds. 
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Correlation coefficient threshold 
Enter the correlation coefficient threshold that describes the minimal time-correlation 
that is required for peak clusters to be combined to a charge state.  

Minimum compound length 
Enter the minimum number of spectra a compound must include. Each compound 
requires at least one peak cluster with as many subsequent peaks as given by this 
parameter. 

Smoothing width 
Enter the number of mass spectra the chromatographic peak finder should use for 
smoothing. Values from 1 to 20 are allowed.  

Additional smoothing 
Check this option if the traces of the peak clusters should be smoothed prior to the 
application of the chromatographic peak finder. This option should be applied in the 
case of rough traces in order to avoid separation of compounds due to spiky data. 

Proteomics 
Check this option if the intensities of peak clusters which are combined to a charge 
state should be compared with an internal average proteomic pattern. If the com-
parison of intensity ratios fails within certain limits, the corresponding peak clusters will 
not be combined. This option should be active for proteomics analyses.  
Spectrum type (Line/Profile) 
Select the type of mass spectra to be used: 

Line spectra only. Uses line spectra only. 
Profile spectra only. Uses profile spectra only. 

Background subtraction 
Select the type of background subtraction to be applied prior to the Molecular Features 
algorithm: 

None. Does not subtract any background. 
Constant (Background MS). Subtracts the proper of maximal four background mass 

spectra previously defined using the Define Background Mass Spectra com-
mand from the Process menu. The current background spectra are contained in 
the analysis’ Background Mass Spectra folder. 

Spectral. Subtracts the spectral background calculated for the selected analysis by 
the program. This background subtraction applies to LC/MS and LC/MS(n) 
analyses only. 

Mass list peak finder 
Indicates the mass peak finder that is selected in the Mass List tab and will be used to 
generate line spectra if such are not available. If you want to use another mass peak 
finder or view/change the settings of the current finder, you have to click the Mass List 
tab and select the desired peak finder option.  
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12.6.2 Parameters Command - Mass List 

The Mass List tab is used to define the parameter settings to be used in peak finding. 
The settings in this tab apply to the Find, Edit and Integrate Manually commands in 
the MassList menu. Moreover, Mass Lists are automatically set up for the compound 
spectra found during compound finding operations performed with the Compounds - 
Chromatogram, Compounds - MS(n), Compounds - AutoMS(n), Compounds - 
Dissect and Compounds - Molecular Features commands from the Find menu. 
The Mass List tab consists of the following inserted tabs: Apex, Centroid, SNAP, 
Sum Peak and FTMS. 
 
DataAnalysis offers the Apex, Centroid, SNAP, Sum Peak and FTMS peak finder 
algorithms for finding mass peaks in profile spectra. The peak finder(s) suitable for the 
data you want to analyze depend(s) on the type of instrument these data was acquired 
with. Each instrument type has its appropriate peak finder(s) e.g., for example, for data 
from ion trap or quadrupole instruments the Apex and SNAP peak finders are suitable 
with the Apex finder recommended by default. Each peak finder has its own set of 
parameters and default settings. You can modify the settings to adapt them to the 
needs of the data you analyze.  
To get to the sub-tab for the peak finder algorithm you want to use, first select the 
instrument type your data derive from and then the respective peak finder if not already 
selected: 

Instrument type 
Analysis data can contain instrument information if the respective data format stores it. 
If such information is available, the respective instrument type will automatically be 
selected as <default> with the corresponding appropriate peak finder algorithm(s) 
enabled. If no instrument information is present, as e.g. with netCDF analyses, the 
instrument type will be set to <unknown> with all peak finder algorithms enabled for 
selecting. If you want to use another peak finder with your data than that enabled by 
default, or if you know the instrument type of an <unknown> analysis, you can select 
the respective instrument type to enable the desired/suitable peak finder(s).  
Select the desired instrument type if not already selected: 

<default>. Enables the peak finder option(s) suitable for the respective instrument 
type. This option is automatically selected when the analysis data contains instru-
ment information. The instrument type selected with this default setting is dis-
played right to the list box. 

Ion trap or quadrupole. Enables the Apex and Snap options with Apex selected by 
default. 

Time-of-flight. Enables the Sum Peak and SNAP options with Sum Peak selected 
by default. 

Fourier transform. Enables the SNAP and FTMS options with FTMS selected by 
default. 



Method Menu Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 12-20 

<unknown>. Enables all peak finder options with the Apex option selected by 
default. This option will automatically be selected if the analysis data does not 
contain any instrument information. 

Selected peak finder algorithm 
Select the peak finder you want to use. This opens the corresponding sub-tab: Apex, 
Centroid, SNAP, Sum Peak or FTMS. 
 
Generally, you can define if exclusion masses should be filtered in peak picking and/or 
if the peak finder should be used in interactive Mass List editing using the Edit com-
mand from the MassList menu: 

Filter exclusion masses 
Check this option to filter exclusion masses. This will exclude the masses currently 
defined in the Exclusion Masses tab of the Method Parameters dialog from being 
included in the Mass List. Default is unchecked.   

Use peak finder to calculate peak position 
Check this option to use the selected peak finder algorithm and its current settings in 
interactive Mass List editing to calculate the peak mass. Default is checked. 
 
 
12.6.2.1 Mass List - Apex 

The Apex tab defines the parameter settings to be used when the Apex peak finder 
algorithm is selected. The Apex algorithm uses the same algorithm to detect peaks as 
the Centroid algorithm but differs in the calculation of the peak position (m/z). The 
detection of peaks is based on the calculation of derivatives of the mass spectrum. The 
Apex algorithm is recommended for data from ion trap or quadrupole instruments and 
can also be applied to data from time-of-flight instruments. For narrow peaks with just a 
few data points, the Apex algorithm is preferable to the Centroid. The Apex algorithm is 
also suitable for isotope-resolved peaks on which the SNAP algorithm does not work 
because the average molecular composition (repetitive unit) of the analyzed polymer is 
not known. 

Peak width (FWHM) [m/z] 
Enter the expected peak width at half height (Full Width at Half Maximum) in [m/z]. 

S/N threshold 
Enter the S/N (signal-to-noise) threshold a signal must exceed to be used in peak 
detection. This parameter determines the initial peak detection before the Absolute 
intensity threshold is applied. Values between 0 and 10,000 are allowed.  
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Figure 12-10 Method Parameters dialog - Mass List - Apex 

Relative intensity threshold (base peak) 
Enter the intensity threshold relative to the most intense (base) peak in the mass 
spectrum or the selected mass range a peak must exceed to be included in the Mass 
List. This threshold is the most important variable in Mass List finding. The minimum 
value allowed is 0. 

Absolute intensity threshold 
Enter the absolute intensity threshold a peak must exceed to be included in the Mass 
List. The minimum value allowed is 0. 
 
 
12.6.2.2 Mass List - Centroid 

The Centroid tab defines the parameter settings to be used when the Centroid peak 
finder algorithm is selected. The Centroid algorithm uses the same algorithm to detect 
peaks as the Apex algorithm but differs in the calculation of the peak mass. The 
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detection of peaks is based on the calculation of derivatives of the mass spectrum. The 
Centroid algorithm can be a choice in the case of broader peaks, for protein spectra or 
for analytes without isotope resolution. If the number of data points usable for 
calculating the centroid is less than 5, Apex is more reasonable. The Centroid 
algorithm will give notable differences to the Apex algorithm on asymmetric peaks. 
 

  
Figure 12-11 Method Parameters dialog - Mass List - Centroid 

Peak width (FWHM) [m/z] 
Enter the expected peak width at half height (Full Width at Half Maximum) in [m/z].  

S/N threshold 
Enter the S/N (signal-to-noise) threshold a signal must exceed to be used in peak 
detection. This parameter determines the initial peak detection before the Absolute 
intensity threshold is applied. Values between 0 and 10,000 are allowed.  

Relative intensity threshold (base peak) 
Enter the intensity threshold relative to the most intense (base) peak in the mass 
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spectrum or the selected mass range a peak must exceed to be included in the Mass 
List. This threshold is the most important variable in Mass List finding. The minimum 
value allowed is '0'. 

Absolute intensity threshold 
Enter the absolute intensity threshold a peak must exceed to be included in the Mass 
List. The minimum value allowed is 0. 

Percent height 
Enter the percent peak height to be used in calculating the centroid. Percent height is a 
cutoff level for the data points around the peak maximum to be included in the calcu-
lation of the centroid. Only those data points that carry information about the position of 
the maximum should be included. 
 
 
12.6.2.3 Mass List - SNAP 

The SNAP tab defines the parameter settings to be used when the SNAP (Sophisti-
cated Numerical Annotation Procedure) peak finder algorithm is selected. The SNAP 
algorithm uses the knowledge about the typical molecular formula expected for the ions 
whose signals are found in the mass spectrum to annotate isotopic patterns. It calcu-
lates the isotopic distribution of a given mass, the charge and mean molecular consti-
tution, and uses this isotopic pattern for a nonlinear fit. This fit delivers the monoiso-
topic mass and the line shape parameters of the pattern. The SNAP algorithm is 
recommended if complex, overlapping isotope patterns are observed and processing 
time does not matter. SNAP version 1.0 ('SNAP1') is suitable for data from ion trap, 
quadrupole or time-of-flight instruments. SNAP version 2.0 ('SNAP2') is faster and 
supports highly resolved data from FTMS and line spectra, too. 

Quality factor threshold 
The quality factor is a measure of the reliability of the isotopic pattern and its mono-
isotopic mass. It is thought as a tool to choose monoisotopic peaks at a variable level 
of sensitivity. This combined value has shown to be more appropriate for selecting 
peaks than individual parameters. 
Enter the quality factor threshold, which a peak must exceed to be included in the Mass 
List; any value equal or larger than 0.0 is allowed. 
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Figure 12-12 Method Parameters dialog - Mass List - SNAP 

S/N threshold 
Enter the S/N (signal-to-noise) threshold the most intense peak of an isotopic pattern 
must exceed to be used in peak detection. Values between 0 and 10,000 are allowed. 
Values below 2 should not give additional reasonable results. The most appropriate 
S/N and goodness thresholds depend on the data and the aimed selectivity of the peak 
thresholding. If you are using goodness thresholding, you should choose an appro-
priate goodness threshold first and adjust the S/N threshold. The required calculation 
time depends on the S/N threshold. 

Relative intensity threshold (base peak) 
Enter the intensity threshold relative to the most intense (base) peak of the mass spec-
trum or the selected mass range a peak must exceed to be included in the Mass List. 
This allows you to choose only those patterns, which have at least e.g. 5% of the inten-
sity of the largest peak in the spectrum. The appropriate value depends on the kind of 
mass spectra and the intensity of the significant peaks. 
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Absolute intensity threshold 
Enter the absolute intensity threshold the most intense peak of a pattern must exceed 
to be included in the Mass List. The appropriate values depend on the kind of mass 
spectra and the intensity of the peaks. If the intensity of the most intense peak is 
smaller, the whole pattern will not be analyzed. The appropriate value depends on the 
kind of mass spectra and the intensity of the significant peaks. 

Maximum charge state 
Enter the highest charge state to be considered. For a MALDI source, this is usually 1 
or 2, for ESI or APCI the charge limit should be set to 4. 
 
In Building Blocks define the elementary composition of the repetitive unit and, if 
desired, of the additional constant unit to be used: 

Repetitive unit 
Enter the mean elementary composition of the repetitive unit that the compound is con-
sisted of (e.g. protein, synthetic polymer). The repetitive unit is the variable unit since it 
can be considered n-times to approximate a particular m/z value. 
The repetitive unit has to consist of elemental symbols followed by the mean abun-
dance separated by spaces.  

Additional constant unit 
Enter, if required, the mean elementary composition of a specific end group. For syn-
thetic polymers, this might for example be Li+, which has an isotopic distribution very 
different to elements forming the monomer units. The additional constant unit, in 
contrast to the Repetitive unit, will be considered exactly once in addition to the 
repetitive unit to approximate a particular m/z value. The additional constant unit has to 
consist of elemental symbols followed by the mean abundance separated by spaces. 

Algorithm 
Select the version of SNAP mass peak finder you want to use: 

Version 1.0. Uses the SNAP1 peak finder, which is suitable for data from ion trap, 
quadrupole or time-of-flight instruments. This peak finder is provided for backward 
compatibility with previous versions of DataAnalysis. The SNAP1 peak finder was 
exclusively available until DataAnalysis 3.3. 

Version 2.0. Uses the SNAP2 peak finder. The SNAP2 peak finder is faster than the 
SNAP1 peak finder and supports highly resolved data from FTMS and line spectra, 
too. 

Include component isotope pattern 
Check this option if a visualization of the fitted pattern of isotopic peaks that belong to 
each monoisotopic peak should be included. This enters a mass spectrum created 
from all snapped isotopic patterns in the Analysis List as well as all individual patterns. 
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12.6.2.4 Mass List - Sum Peak 

The Sum Peak tab defines the parameter settings to be used when the Sum Peak 
peak finder algorithm is selected. The Sum Peak algorithm is a new peak picking 
approach using sliding sums. It is a very fast peak detection algorithm suitable for time-
critical applications and is also used for on-line peak detection, e.g., in the micrOTOF 
series instruments. The Sum Peak algorithm is recommended for data from time-of-
flight instruments, especially for micrOTOF data.  
 

  
Figure 12-13 Method Parameters dialog - Mass List - Sum Peak 

Use same width as acquisition 
Check this option if the same peak width as was used in data acquisition should be 
used for peak detection. This is currently only supported for micrOTOF analyses. This 
option should be turned off for analyses of all other instruments. 

Resolution (m/dm) 
Check this option to apply the resolving power (m/Δm) for peak detection.  
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Enter the measured resolving power value of the mass spectrum in the entry field to 
the right.  
This option is recommended for Time-Of-Flight analyses.  
Note: This parameter is only enabled when Use same width as acquisition is not 

checked. 

Peak width (FWHM) 
Check this option to apply the peak width at half height (Full Width at Half Maximum) 
for peak detection.  
Enter the measured minimum peak width value either in [m/z] or [pnts.] of the spec-
trum in the entry field to the right. To toggle between [m/z] and [pnts.], click Points. 
Note: This parameter is only enabled when Use same width as acquisition is not 

checked. 

Points 
Toggles between setting Peak width (FWHM) in [m/z] and [pnts.]. 

S/N threshold 
Enter the S/N (signal-to-noise) threshold a signal must exceed to be used for peak 
detection. This parameter determines the initial peak detection before the Absolute 
intensity threshold is applied. Values between 0 and 10,000 are allowed.  

Relative intensity threshold (base peak) 
Enter the intensity threshold relative to the most intense (base) ion of the mass spec-
trum or the selected mass range a peak must exceed to be included in the Mass List. 
This threshold is the most important variable in Mass List finding. The minimum value 
allowed is '0'.  

Absolute intensity threshold 
Enter the absolute intensity threshold a peak must exceed to be included in the Mass 
List. The minimum value allowed is 0. 
 
 
12.6.2.5 Mass List - FTMS 

The FTMS tab defines the parameter settings to be used in peak finding when the 
FTMS peak finder algorithm is selected. The FTMS algorithm is characterized by not 
assuming an expected peak width or resolving power. It is recommended for data from 
Fourier transform instruments.  

S/N threshold 
Enter the S/N (signal-to-noise) threshold a signal must exceed to be used in peak 
detection. This parameter determines the initial peak detection before the Absolute 
intensity threshold is applied. Values between 0 and 10,000 are allowed.  
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Figure 12-14 Method Parameters dialog - Mass List - FTMS 

Relative intensity threshold (base peak) 
Enter the intensity threshold relative to the most intense (base) peak of the mass 
spectrum or the selected mass range a peak must exceed to be included in the Mass 
List. This threshold is the most important variable in Mass List finding. The minimum 
value allowed is 0.  

Absolute intensity threshold 
Enter the absolute intensity threshold a peak must exceed to be included in the Mass 
List. The minimum value allowed is 0. 

Use centroid for peak position 
Check this option if the centroid should be used to calculate peak position. Specify the 
peak height to be taken in Percent height.  
Percent height 
Enter the percent peak height to be used to calculate the centroid. Percent height is a 
cutoff level for the data points around the peak maximum to be included in the calcula-
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tion of the centroid. Only those data points that carry information about the position of 
the maximum should be included. 
 
 
12.6.3 Parameters Command - Charge Deconvolution 

The Charge Deconvolution tab is used to define the parameter settings to be used in 
(charge) deconvolution of mass spectra. The settings in this tab apply to the Mass 
Spectra command and Deconvolute with Charge State Ruler command found in the 
Deconvolute menu.  
The Charge Deconvolution tab may consist of the following inserted tabs depending 
on the licenses present: Maximum Entropy, Proteins/Large Molecules, Peptides/ 
Small Molecules and General. The tab displayed when clicking the Charge Decon-
volution tab depends on the deconvolution type selected for the active analysis.  
 
DataAnalysis provides three different types of deconvolution: Maximum Entropy decon-
volution, Proteins/large molecules charge deconvolution and Peptides/small molecules 
charge deconvolution. Each deconvolution type has its own set of parameters. 
Note: To deconvolute profile spectra using the Maximum Entropy algorithm, you will 

need the 'ESI Compass 1.3, Maximum Entropy Deconvolution Option' license. 
Without that license, the Maximum Entropy option and corresponding tab will 
not be available. 

Note: To charge deconvolute higher charge states when using the Proteins/large 
molecules or Peptides/small molecules algorithm, you will need the 'ESI Com-
pass 1.3, Charge Deconvolution Option' license. Without that license, you are 
permitted to deconvolute isotope-resolved signals only. The parameters that 
apply to related-ion deconvolution will not be present. 

Select the deconvolution type suitable for the data you want to analyze. Then set its 
parameters in the corresponding inserted tab. 

Maximum Entropy 
Select this option to perform deconvolution using the Maximum Entropy algorithm 
suitable for large molecules, e.g. proteins. Maximum Entropy deconvolution applies to 
profile spectra only. It is e.g. the method of choice if smaller components are to be 
detected. This deconvolution type uses the parameter settings defined in the Maxi-
mum Entropy tab.  

Proteins/large molecules 
Select this option to perform charge deconvolution using the Proteins/large molecules 
algorithm suitable for proteins and other large molecules. Proteins/large molecules 
charge deconvolution applies to both profile and line spectra. This deconvolution type 
uses the parameter settings defined in the Proteins/Large Molecules and General 
tabs. 
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Peptides/small molecules 
(Default) Select this option to perform charge deconvolution using the Peptides/small 
molecules algorithm suitable for peptides and other small molecules. Peptides/small 
molecules charge deconvolution applies to both profile and line spectra. This deconvo-
lution type uses the parameter settings defined in the Peptides/Small Molecules and 
General tabs. 

Note: Before setting the parameters, consider the type of sample that is being ana-
lyzed. For example, if the sample is an LC/MS analysis of peptide fragments, 
then the size of the peptides will translate to lower mass values and limit the 
likely charge state. Or if the sample is a large intact protein, the mass values will 
be larger and the number of charges will be as well. Also, take into considera-
tion whether smaller components are to be detected. 

Additionally, define if previous results should be cleared and neutral spectra created: 

Clear previous results 
Check this option to clear previous deconvolution results for selected mass spectrum 
before starting next deconvolution operation. If this option is not checked, the new 
results are added to the previous ones. Default is checked. 

Create neutral spectrum (instead of singly charged spectrum) 
Check this option to subtract the selected adduct ion for every charge and create a 
neutral spectrum Mr. If this option is not checked, a singly charged spectrum, e.g., 
[M+H]+ will be created. 
This option applies to Proteins/large molecule and Peptides/small molecules deconvo-
lution only. Default is unchecked. 
 
 
12.6.3.1 Charge Deconvolution - Maximum Entropy 

The Maximum Entropy tab defines the parameter settings to be used when Maximum 
Entropy deconvolution is selected.  
(Maximum Entropy Deconvolution: Copyright 1991-2004 Spectrum Square Associates, 
Inc. All rights reserved. This program or documentation contains confidential informa-
tion and trade secrets of Spectrum Square Associates, Inc. Reverse compiling, dis-
assembling, other reverse engineering and modification of object code are prohibited. 
Use, copying and disclosure are subject to a written license agreement with Spectrum 
Square Associates, Inc. Use of copyright notice is precautionary and does not imply 
publication.) 
One way to explain the idea behind the maximum entropy deconvolution is that it treats 
mass spectroscopy data as if it were a multiple exposure produced by a defective 
camera. The maximum entropy deconvolution is an application of a standard image-
processing technique, which deconvolutes the data to get the original image - in our 
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case the zero-charge, molecular mass distribution for the electrospray data. This maxi-
mum entropy deconvolution algorithm also uses Bayesian probability methods, which 
gives the most probable molecular mass distribution. 
 

 
Figure 12-15 Method Parameters dialog - Charge Deconvolution - Maximum Entropy 

Adduct ions 
Select the positive and negative adduct ions to be used. The value for the adduct ion's 
molecular weight is pre-defined in the system. 

Low mass and High mass 
Enter the low mass and high mass boundaries for the output range of the deconvoluted 
mass spectrum. 
Note: The output range for the deconvoluted spectrum should be chosen large 

enough to include all significant signals contained in selected mass range of the 
spectrum you want to deconvolute. Otherwise, artifacts may occur. This means, 
if e.g. the input spectrum is a mixture of two proteins and you select in it all 
signals of these proteins, then the output range should be so large that it 
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includes the molecular weights of both proteins at least.  
For TOF spectra only: If no mass range selection is explicitly defined an upper and 

lower bound for a selected mass range is assumed at lowest, resp. highest, 
mass values exceeding 1% of the maximum intensity. 

Data point spacing 
Enter a value (in [m/z]) for spacing data points in the resulting deconvoluted spectrum 
or select 'Auto'. In case of 'Auto' the width is chosen based on the input spectrum 
range, the output spectrum range and the peak width in the input spectrum to have 
approximately 8 points over the half width on peaks in the output spectrum.  

Instrument peak width 
Select this option for mass spectra from trap instruments. Enter the individual peak 
width value of your instrument in the entry box to the right. 

Instrument resolving power 
(Default) Select this option for mass spectra from TOF instruments. Enter the individual 
resolving power value of your instrument in the entry box to the right.  

FTMS Instrument 
Select this option for mass spectra from FTMS instruments. An appropriate value for 
the width is internally calculated and applied. 

Resolution 
Select the desired resolution mode for the Maximum Entropy deconvolution algorithm: 

Normal. Operates in the normal resolution mode. 
High. Operates in the high resolution mode. The high resolution mode is internally 

applying an increased number of computational iterations and takes considerable 
longer than the normal resolution mode. 

 
 
12.6.3.2 Charge Deconvolution - Proteins/Large Molecules 

The Proteins/Large Molecules tab defines the parameter settings to be used when 
Proteins/large molecules deconvolution is selected. Additional settings for this charge 
deconvolution type you can made in the General tab. 

Adduct ions 
Select the positive and negative adduct ions to be used. The value for the adduct ion's 
molecular weight is pre-defined in the system. 
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Figure 12-16 Method Parameters dialog - Charge Deconvolution - Proteins/Large Mole-

cules ('ESI Compass 1.3, Charge Deconvolution Option' license present)  

Low mass 
Enter the lowest molecular weight for a resulting deconvoluted mass that is to be 
reported by the deconvolution operation. 

High mass 
Enter the highest molecular weight for a resulting deconvoluted mass that is to be 
reported by the deconvolution operation. 

Abundance cutoff [%] 
Abundance cutoff determines which ions are used to find related ions for a component.  
Enter the minimum percentage abundance of an ion, relative to the most intense ion in 
the spectrum, to be used for predicting other ions in a component. Any ion whose 
abundance exceeds the abundance cutoff can be used to predict other ions in a com-
ponent. 
Note: This value does not affect the calculation of ions in a set of related ions; it just 

prevents smaller ions from being used to predict other ions in a component. 
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Abundance cutoff is particularly useful for deconvoluting strong signals. You 
may want to lower it for weak signals.  

Note: Precursor ions are always deconvoluted even if they fall below the Abundance 
cutoff threshold. 

Resolved-isotope deconvolution 
Check this option to deconvolute isotope-resolved peaks of charge states up to 4. Use 
this option if low charge states occur.  
Note: Resolved-isotope deconvolution does not depend on the setting of Min. peaks 

in comp. An isotope-resolved peak can be deconvoluted even if there is only 
one peak in a component, e.g., a doubly or singly charged ion.  

Maximum charge 
Select the maximum charge that can be applied to a peak that is used to search for 
isotopically resolved peaks.  
When setting this parameter to Auto, internally the maximum charge that is applied to 
isotopically resolved peaks is suggested as 1/average-peak-width. Isotope-resolved 
peaks of charge higher than explicitly selectable are resolved with the Auto setting, 
provided the spectrum does have sufficient resolution. 
 
Note: The following parameters are only available if the 'ESI Compass 1.3, Charge 

Deconvolution Option' license is present. 

Related-ion deconvolution 
Check this option to perform a related-ion deconvolution according to the current set-
tings for the deconvolution parameters listed below. 
If both Resolved-isotope deconvolution and Related-ion deconvolution are 
checked, related-ion deconvolution with 5 or more related ions will predominate the 
resolved-isotope deconvolution, followed by another pass of related-ion deconvolution, 
unless the Min. peaks in comp. has been set to 5 or higher. 

Maximum charge 
Enter the maximum charge that can be applied to a peak that is used to search for 
related-ion peaks. 
For example, assume the maximum charge is 20 and, if a charge of 20 is applied to 
peak 'A' when searching for related ions, peak 'A' may find related neighbors with 
charges 17-19 and 21-23. The peaks with charges 21-23 will not be ignored simply 
because the maximum charge is 20. However, a charge state above 20 would not be 
applied to peak 'A' when it is used to search for related ions. 
For example, a charge of 30 on a peak with a m/z value of about 1500 gives a mole-
cular weight near 45,000. Therefore, changing the maximum charge to 30 is sufficient 
for compounds with a molecular weight less than 45,000. If a higher maximum charge 
is required to find high molecular weight compounds, change Min. peaks in comp. to 
4 or more. High molecular weight compounds usually have multiple related ions 
carrying different charge numbers. An alternative approach is to use Low mass and 
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High mass to restrict the range of masses this deconvolution operation will report. 
When using Low mass and High mass, it is still a good idea to set the maximum 
charge to an appropriate value. 

Min. peaks in comp. 
Enter the minimum number of related ions that are required before the ions are con-
sidered a component and can be extracted from the original spectrum. Increasing this 
value can help limit the components found in a mass spectrum with lots of ions.  
Note: The minimum number of peaks for a component must be found within the 

defined Maximum charge range, whereas further related ion peaks can be 
found outside this predefined charge range. 

Max. number of comp. 
Enter the maximum number of components being found by related-ion deconvolution. 
Values between 1 and 1000 are allowed. 
Note: The total number of components can be higher if Resolved-isotope decon-

volution is enabled, too.  

Envelope cutoff [%] 
Envelope cutoff determines how much the actual shape of a set of related ion peaks 
may differ from a Gaussian distribution to be considered as a set for a component. In 
general, the shape of a group of peaks generated from a component by ESI is a 
Gaussian distribution. Depending on the solvent used for ESI, there can be a smaller, 
overlaid envelope at higher charge states. Therefore, up to two overlapping envelopes 
are accepted while still applying an adequate cutoff setting. 
Enter the maximum percentage difference that may exist between the actual shape of 
a set of peaks and a Gaussian distribution. 

MW agreement [0.01%] 
MW agreement determines how closely related ions must match each other in mole-
cular weight to be included in a component. 
Select Auto or enter a number. The Auto setting (which is identical to MW agreement 
= 0) will match related ions based on their individual peak width (FWHM).  
When a number is entered, this setting will match related ions on the relative deviation 
in steps of 0.01%. A number must be entered as whole number, but it is expressed as 
0.01%. Thus, entering a value of '10' corresponds to an allowed difference of 0.1%. A 
lower value means that the ions must be more closely matched in molecular weight 
whereas a higher value means that the ions can deviate more from the averaged 
molecular weight. A zero value means that the ions must match exactly. A lower non-
zero value tightens the restrictions when determining which components are valid for 
the data. It is recommended to use Auto. 
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12.6.3.3 Charge Deconvolution - Peptides/Small Molecules 

The Peptides/Small Molecules tab defines the parameter settings to be used when 
Peptides/small molecules deconvolution is selected. Additional settings for this 
charge deconvolution type you can made in the General tab. 
 

  
Figure 12-17 Method Parameters dialog - Charge Deconvolution - Peptides/Small Mole-

cules ('ESI Compass 1.3, Charge Deconvolution Option' license present) 

Adduct ions 
Select the positive and negative adduct ions to be used in deconvolution operations 
performed on MS Full Scan, MS MaxRes Scan or MS(n) spectra. The value for the 
adduct ion's molecular weight is pre-defined in the system. 
 
In Deconvolute, select the type of spectra to be charge deconvoluted: 

MS Full Scan and MS MaxRes Scan 
Check this option to deconvolute MS Full Scan and MS MaxRes Scan spectra accord-
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ing to the corresponding parameter settings currently defined. If a protein digest con-
tains many large peptides (> 2500) which are detected highly charged (>3), it might be 
helpful to deactivate the deconvolution of the MS spectra. 

MS(n) 
Check this option to deconvolute MS(n) spectra according to the corresponding para-
meter settings currently defined below. Unchecking this option will save time during the 
data analysis. However, keep in mind that this will extend the time required for the 
database search. 

Low mass /High mass check box 
Check this box if low and high mass boundaries should be set for a resulting decon-
voluted mass that is to be reported by the deconvolution operation. This will apply the 
mass boundaries set in Low mass and High mass. If you want to use values differ-
ent from the default values, you can enter the desired ones. If this box is not checked, 
no mass boundaries are applied in the deconvolution operation. 

Low mass 
Enter the lowest molecular weight for a resulting deconvoluted mass that is to be 
reported by the deconvolution operation. Default for MS Full Scan spectra is '250', for 
MS MaxRes Scan spectra '100' and for MS(n) spectra '50'.  

High mass 
Enter the highest molecular weight for a resulting deconvoluted mass that is to be 
reported by the deconvolution operation. 

Abundance cutoff [%] 
Abundance cutoff determines which ions are used to find related ions for a component.  
Enter the minimum percentage abundance of an ion, relative to the most intense ion in 
the spectrum, to be used for predicting other ions in a component. Any ion whose 
abundance exceeds the abundance cutoff can be used to predict other ions in a 
component.  
Note: This value does not affect the calculation of ions in a set of related ions; it just 

prevents smaller ions from being used to predict other ions in a component. 
Abundance cutoff is particularly useful for deconvoluting strong signals. You 
may want to lower it for weak signals.  

Note: Precursor ions are always deconvoluted even if they fall below the Abundance 
cutoff threshold. 

For Resolved-isotope deconvolution, set the maximum charge that can be applied to 
a peak being used to search for isotope-resolved peaks.  
Note: Resolved-isotope deconvolution does not depend on the setting of Min. peaks 

in comp. An isotope-resolved peak can be deconvoluted even if there is only 
one peak in a component, e.g., a doubly or singly charged ion.  
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Maximum charge 
Select or enter the maximum charge that can be applied to a peak that is used to 
search for isotope-resolved peaks in MS Full Scan, MS MaxRes Scan and MS(n) 
spectra. When setting this parameter to Auto, the maximum charge is internally 
determined as 1/average-peak-width. However, the Auto setting is limited to a charge 
of 100. If higher charge states are present, a higher value has to be entered here. 

Allow precursor deconvolution from fragment spectra 
Check this option if precursor charge and molecular weight calculation based on frag-
ment spectra should be allowed. 
This setting comes into effect if the charge state of a precursor could not be determined 
based on its isotopic pattern and/or related ions. If in those cases a fragment spectrum 
of that precursor is available and the signals in that fragment spectrum conclude to a 
specific charge state, the precursor’s charge state is determined by that.  
 
Note: The following parameters are only available if the 'ESI Compass 1.3, Charge 

Deconvolution Option' license is present. 

Related-ion deconvolution (MS Full Scan only) 
Check this option to perform a related-ion charge deconvolution according to the cur-
rent settings for the deconvolution parameters named below. 
Note: Related-ion deconvolution is only possible on MS Full Scan spectra. 

Maximum charge 
Enter the maximum charge that can be applied to a peak that is used to search for 
related ion peaks in MS Full Scan spectra. 
For example, assume the maximum charge is 4 and, if a charge of 4 is applied to peak 
'A' when searching for related ions, peak 'A' may find related neighbors with charges 5 
and 3. The peak with charge 5 will not be ignored simply because the maximum charge 
is 4. However, a charge state above 4 would not be applied to peak 'A' when it is being 
used to search for related peaks. 

Min. peaks in comp. 
Enter the minimum number of related ions in MS Full Scan spectra that are required 
before the ions are considered a component and can be extracted from the original 
spectrum. Increasing this value can help limit the components found in a mass spec-
trum with lots of ions.  
Note: The minimum number of peaks for a component must be found within the 

defined Maximum charge range, whereas further related ion peaks can be 
found outside this predefined charge range. 

MW agreement [0.01%] 
MW agreement determines how closely related ions must match each other in mole-
cular weight to be included in a component. 



Bruker Daltonik GmbH Method Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  12-39

Select Auto or enter a number. The Auto setting (which is identical to MW agreement 
= 0) will match related ions based on their individual peak width (FWHM). When a 
number is entered, this setting will match related ions on the relative deviation in steps 
of 0.01%.  
If you wish to enter a number this must be entered as whole number, but it is 
expressed as 0.01%. Thus, entering a value of '10' corresponds to an allowed differ-
ence of 0.1%. A lower value means that the ions must be more closely matched in 
molecular weight whereas a higher value means that the ions can deviate more from 
the averaged molecular weight. A zero value means that the ions must match exactly. 
A lower non-zero value tightens the restrictions when determining which components 
are valid for the data.  
It is recommended to use Auto. Default is 'Auto'. 
 
 
12.6.3.4 Charge Deconvolution - General 

The General tab defines some general parameter settings to be used when 
Proteins/large molecules or Peptides/small molecules deconvolution is selected. 
This tab is disabled when Maximum Entropy deconvolution is selected. 

Extend reconstructed mass envelope (profile spectra, only) 
Check this option to extend the mass envelope of the reconstructed and deconvoluted 
peak. Specify the desired direction of extension and mass range in Add before or Add 
after. 
Note: This option applies to profile spectra only. 

Add before 
Enter the mass range to be added before the reconstructed mass envelope in order to 
extend it. For peptides values from 0 to 10 are allowed and for proteins values from 1 
to 1000. 

Add after 
Enter the mass range to be added after the reconstructed mass envelope in order to 
extend it. For peptides values from 0 to 10 are allowed and for proteins values from 1 
to 1000. 

Include shifted spectrum 
Check this option to create the shifted (= deconvoluted) spectrum that consists of the 
calculated deconvoluted peaks for all components found. The shifted spectrum is 
entered in the Analysis List as a subentry of the original spectrum. The peaks in the 
shifted spectrum become labeled with the corresponding charge state, component 
name and deconvoluted mass, e.g. ‘1+ (A) 16956.1’. The peaks in the original spec-
trum become labeled with the corresponding charge state and component name, e.g., 
'12+ (A)'. 
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When unchecked, no shifted spectrum is created and the peaks in the original spec-
trum become labeled with their charge state but without any component name, e.g., 
'12+’. 
 

  
Figure 12-18 Method Parameters dialog - Charge Deconvolution - General  

Include component details 
Check this option to create component detail spectra, which show all ions in a set of 
related ions, found for the component and their corresponding charge states. The 
component detail spectra are entered in the Analysis List as subentries of the shifted 
spectrum. The peaks in the component detail spectra become labeled with the corre-
sponding charge state and component name, e.g., '12+ (A)'. Depending on whether 
Show component details and residual is set, the component detail spectra are 
enabled or disabled. When unchecked, no component detail spectra are created.  

Retain residual 
Check this option to create and retain the residual spectrum that consists of all data 
points that were not found to belong to the set(s) of related ions. Looking at a residual 
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can give you a clue of the presence of small, undetected multiply charged ion series. 
Depending on whether Show component details and residual is set, the residual 
spectrum is enabled or disabled. When unchecked, no residual spectrum is created. 

Show components details and residual 
Check this option to enable the component detail spectra and/or the residual spectrum 
automatically and display it/them in the corresponding data window. When unchecked, 
the respective spectrum/spectra are disabled. 
 
 
12.6.4 Parameters Command - Library Search 

The Library Search tab is used to define the parameters settings to be used in library 
search. The settings in this tab apply to the Mass Spectra command in the Identify 
menu. The Library Search tab consists of the following inserted tabs: Libraries, 
Settings, Retention Time, Parameter Matching, Add and Advanced.  
 
 
12.6.4.1 Library Search - Libraries 

The Libraries tab defines the mass spectral libraries to be used. 
In Libraries, link the mass spectral libraries you want to use for search and define their 
hierarchical order. 

Libraries 
Lists the libraries currently selected for library search and their status (enabled/dis-
abled). Each library contains a check box in front to include/exclude the respective 
library in subsequent library search. The sequence of the libraries in this list determines 
how a hierarchical search will proceed.  

  
Figure 12-19 Library list with two libraries, one enabled and one disabled 

You can add new libraries to, delete existing libraries from this list or change the 
hierarchical order of the libraries present with the following buttons: 

 New button 
Displays an entry box with two buttons next to it for selecting a new library to be added 
to the library list. 

  
You can add a library by  



Method Menu Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 12-42 

- entering the library's path and name in the entry box, or  
- clicking  and selecting the library in the Select Library dialog, or 
- clicking  and choosing the library from the recent library list which keeps the ten last 

used libraries.  
Adding has to be completed by clicking with the left mouse button somewhere in the 
list. This adds the selected library at the bottom of the current list. If desired change the 
library's position in the list.   
 

  
Figure 12-20 Method Parameters dialog - Library Search - Libraries  

 Delete button 
Deletes the selected library from the list 

 Move Up button 
Moves up the selected library by one line. 
Tip: You can also change a library's position by dragging it up or down with the left 

mouse button depressed. 
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 Move Down button 
Moves down the selected library by one line. 
Tip: You can also change a library's position by dragging it up or down with the left 

mouse button depressed. 

Search all libraries parallel instead of hierarchical 
Check this option if the libraries listed in Libraries should be searched parallel. 
Uncheck it if a hierarchical search is to be performed.  

Clear previous results 
Check this option to clear previous identification results of the selected mass spectrum 
before starting a new identification operation.  
 
 
12.6.4.2 Library Search - Settings 

The Settings tab defines the search parameters and mass range constrains. 
Note: For explanation of the library search scores Puritiy, Fit, RFit and Parameter 

Match and the (combined) effective scores Purity', Fit', Fit/Purity' and RFit' and 
how these scores are calculated please refer to sections 12.6.4.2.1 and 
12.6.4.2.2). 

Cross match found library compounds to all compound spectra 
Check this option if you want to cross match each compound spectrum of a compound 
with more than one spectrum (at the moment, this applies to AutoMS(n) and Dissect 
compounds) to any library compound found for this compound.  
The basic idea of the cross matching scoring scheme is that if one of the compound 
spectra has been identified as library compound A, all the other compound spectra are 
also matched to the library compound A, unless they have already been identified as A. 
For example, an MS/MS spectrum may be identified with a high score (>900) to library 
compound A. However, the MS spectrum has not been identified as compound A. Now, 
by matching the MS spectrum to compound A, a low score value (<10) is calculated. 
This low score reveals that this compound does not fit at all to compound A. The spe-
cial scoring formula applied for calculating the combined, effective score (see Mini-
mum effective score) now calculates a significantly reduced combined, effective 
score. By further applying the Post search filter setting of the Minimum effective 
score, the library hit of the MS/MS spectrum to A is removed again from the com-
pound's identification results list. All of this yields to reduced false positive hits, yet a 
much shorter list of library identifications.  
A prerequisite for applying cross matching is that the library contains MS and MS/MS 
spectra for each library compound. Although not recommended, the MS and MS/MS 
spectra may reside in different libraries. However, in such case, all of these libraries 
must be searched at once. 
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Uncheck this option if cross matching should not be performed. The scoring formula 
applied in this case for calculating the combined, effective score (see Minimum 
effective score) is designed to put a low weight on poorer or no library identifications. 
For example, an MS/MS spectrum may be identified with a high score (>900) to library 
compound A, and the MS spectrum has not been identified as compound A. The 
scoring formula now calculates a combined effective score close to the high value of 
the MS/MS identification.  
The non cross matching scoring scheme is generally recommended, when the library 
only contains MS or MS/MS spectra of each compound. 
Note: This option does not apply to NIST, NIST User and libraries created with Bruker 

Daltonics LibraryEditor 1.x. 
 

  

Figure 12-21 Method Parameters dialog - Library Search - Settings 

Desired score 
For hierarchical search, enter the desired score. If a score value is higher or equal to 
the desired score searching the next libraries in the hierarchical list is skipped. The 
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Sort results by setting determines what score values are compared; this setting is 
referred to on the right of this entry field. 

Minimum score 
Enter the minimum score. All library spectra with a score higher or equal to the 
minimum score are included in the search results. The Sort results by setting 
determines what score values are compared; this setting is referred to on the right of 
this entry field. 

Minimum parameter match score 
Enter the minimum Parameter Match score. All library spectra with a Parameter Match 
score higher or equal to the minimum parameter match score are included in the 
search results. 

Maximum number of spectra 
Enter the maximum number of library spectra to be stored in the identification results 
list of a mass spectrum. This parameter is disabled when Match found library 
compounds to all compound spectra is checked.  

Sort results by 
Select the scoring factor to be used for sorting the library spectra in the identification 
results list. The selected factor also determines the nature of the Desired score, 
Minimum score, Minimum effective score and Relative effective score difference 
values except when Unsorted or Parameter Match is set; in this case the Purity score 
is used. 

Unsorted. Does not sort by any scoring factor. 
Fit/Purity. Sorts by the Fit, resp. Purity, score that indicates how well the masses and 

intensities of the library spectrum agree with those found for the acquired spec-
trum. The Fit score is applied to precursor spectra and the Purity score is applied 
to fragment spectra. This score is applicable for mixtures of complex samples with 
overlapping chromatographic peaks and hence impure mass signals. The Fit score 
matches best these precursor spectra. Fragment spectra of isolated precursor 
values are usually of a pure compound and the Purity score best matches. See 
also below, Fit and Purity scores. 

Purity. Sorts by the Purity score that indicates how well the masses and intensities of 
the library spectrum and the acquired spectrum agree. This score would be 
applicable if the library spectrum and the spectrum being searched are both from a 
pure compound; the Dissect algorithm e.g. produces such pure compound spectra. 

Fit. Sorts by the Fit score that indicates how well the masses and intensities of the 
library spectrum agree with those found for the acquired spectrum. Other masses 
contained in the acquired spectrum are ignored. This score would be applicable if 
the library contains spectra of the pure compound, whereas the spectrum being 
searched contains other signals, e.g. from chromatographically overlapping com-
pounds. 
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RFit. Sorts by the R(everse)Fit score that indicates how well the masses and inten-
sities of the acquired spectrum agree with those found for the library spectrum. 
Other masses contained in the library spectrum are ignored. This score would be 
applicable if the spectrum being searched is pure whereas the library spectrum 
contains additional signals. 

Parameter Match. Sorts by the Parameter Match score that indicates how well the 
data acquisition parameters used for acquiring the acquired and the library spec-
trum meet. Define the settings for calculating the Parameter Match score in the 
Parameter Matching tab. If retention time matching is applied, too, the internally 
calculated retention time match factor is also included in the calculation of the 
Parameter Match score. 

Minimum effective score 
Note: This value only applies to selected compounds in the Analysis List, not to single 

selected spectra. 
Enter the minimum (combined) effective score a library hit for a compound must reach 
at least to get a chance to stay in the compound's identification results list. Library hits 
with an effective score below this value are removed again from the result list. The Sort 
results by setting determines what score values are compared; this setting is referred 
to on the right of this entry field. This value applies to both compounds with only one 
spectrum and compounds with more than one spectrum.  

Relative effective score difference 
Note: This value only applies to selected compounds in the Analysis List, not to single 

selected spectra. 
Enter a relative effective (combined) score difference. This value is subtracted from the 
highest (combined) effective score among the library hits found for the compound to 
define a threshold that must be reached by other library hits (with a lower effective 
score) to still remain in the compound's identification results list, too. Library spectra 
that give (combined) effective scores below this calculated threshold are removed from 
the results list again. The Sort results by setting determines what score values are 
compared; this setting is referred to on the right of this entry field. 
Example: The highest effective score value found is 600. If Relative effective score 
difference is set to 50, then all hits exceeding a score of 550 (600 minus 50) remain in 
the results list unless the number of valid hits exceeds the Maximum number of 
spectra set. In this case hits having the highest scores are taken only. 

Ignore library masses below measured mass range 
Check this option to ignore mass lines of library spectra below the measured mass 
range of the acquired mass spectrum for score determination. This option should be 
checked if the library spectra contain significant mass lines below the measured mass 
range of spectra to be searched. 
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Ignore library masses above measured mass range 
Check this option to ignore mass lines of library spectra above the measured mass 
range of the acquired mass spectrum for score determination. This option should be 
checked if the library spectra contain significant mass lines above the measured mass 
range of spectra to be searched. 
 
 
12.6.4.2.1 Library Search Scores: Calculation of Scores Purity, Fit, RFit and 

Parameter Match 
For each scoring operation, the corresponding Purity, Fit, RFit and Parameter Match 
scores are calculated by comparing the acquired and the library spectrum (Purity, Fit 
and RFit scores) as well as their corresponding acquisition parameters (Parameter 
Match score). 

Purity 
The Purity score indicates how well the masses and intensities of the library spectrum 
and the acquired spectrum agree. This score would be applicable if the library spec-
trum and the spectrum being searched are both from a pure compound; the Dissect 
algorithm e.g. produces such pure compound spectra. The maximum Purity score is 
1000.  

Fit 
The Fit score indicates how well the masses and intensities of the library spectrum 
agree with those found in the acquired spectrum. Other masses contained in the 
acquired spectrum are ignored. This score would be applicable if the library contains 
spectra of the pure compound, whereas the spectrum being searched contains other 
signals, e.g. from chromatographically overlapping compounds. The maximum Fit 
score is 1000. 

RFit 
The R(everse)Fit score indicates how well the masses and intensities of the acquired 
spectrum agree with those found in the library spectrum. Other masses contained in 
the library spectrum are ignored. This score would be applicable if the spectrum being 
searched is pure whereas the library spectrum contains additional signals. The 
maximum RFit score is 1000. 

Parameter Match 
The parameter Match score indicates how well the parameters used to acquire the 
library and the acquired spectrum agree. You can define the acquisition parameters to 
be included in calculating the Parameter Match score and how they should be 
weighted. If retention time matching is applied, too, the internally calculated retention 
time match factor is also included in the calculation of the Parameter Match score. The 
maximum Parameter Match score is 1000. 
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Calculation of Purity, Fit and RFit scores 
Definitions: 
P Purity score 
F Fit score 
R Reverse Fit score 
u Intensities of the unknown spectrum 
l Intensities of the library spectrum 
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A Sum of the product of the intensities of the unknown and the 

library spectrum 
U Sum of the square of the intensities of the unknown spectrum 
L Sum of the square of the intensities of the library spectrum 
T Sum of the square of the intensities of the unknown spectrum 

where the library spectrum has intensity above 0 
R Sum of the square of the intensities of the library spectrum 

where the unknown spectrum has intensity above 0 
 
Illustration of meaning of Purity, Fit and RFit scores 
The meaning of the Purity, Fit and RFit scoring factors is illustrated as follows: 
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Figure 12-22 Illustration of the meaning of Purity, Fit and RFit scores 

 
Calculation of Parameter Match score 
Calculation of Parameter Match score is based on the individual parameters selected 
for scoring and their assigned weights, low, medium, high or forbidden.  

• low weights differences in the respective parameter with a factor of 0.90 
• medium weights differences in the respective parameter with a factor of 0.75 
• high weights differences in the respective parameter with a factor of 0.50 
• forbidden weights differences in the respective parameter as 'no hit' 

By default, the Polarity and MS vs. MS/MS parameters are set to forbidden. This 
will prevent of getting any hits of spectra with different polarity or matching a 
precursor (parent) with a product (daughter) spectrum.  

Examples: When you compare mass spectra that differ in regard to one high weighted 
parameter, this results in a Parameter Match score of 500 (0.5 x 1000). Suppose an 
additional difference exists concerning a low weighted parameter, then a Parameter 
Match score of 450 (0.5 x 0.9 x 1000) is calculated.  
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12.6.4.2.2 Library Search Scores: Calculation of (Combined) Effective Scores 
Purity', Fit', Fit/Purity' and RFit' 

For library hits of compounds, additionally 'effective' scores are calculated based on the 
respective Purity, Fit, RFit and Parameter Match scores. These are listed as Purity', 
Fit', Fit/Purity' and RFit' values in the compound's Compound List. Depending on 
whether the compound contains one or more compound spectra, the 'effective' score 
(in case of one spectrum) or the 'combined, effective' score (in case of more than one 
spectrum) is calculated.  

Effective scores 
For compounds with only one compound spectrum, 'effective' scores Purity', Fit', 
Fit/Purity' and RFit' are calculated by combining the Purity, Fit or RFit score of a library 
hit with the corresponding Parameter Match score. Thus, the effective score takes into 
account possible differences in data acquisition of acquired and library spectrum. The 
effective Fit/Purity' score applies the Fit score for precursor spectra and the Purity 
score for fragment spectra.  
The effective score Score' for a compound with one spectrum is calculated by the 
following formula:  

1000
MatchScoreeScor ×

=′  

with Match = MatchParameter × MatchRetentionTime. 

Combined, effective scores 
For compounds with more than one compound spectrum, 'combined, effective' scores 
Purity', Fit', Fit/Purity' and RFit' are calculated which combine the individual scoring 
results reported for each spectrum of the compound separately. The effective Fit/Purity' 
score applies the Fit score for precursor spectra and the Purity score for fragment 
spectra. 
There are two different scoring schemes for calculating the combined, effective score. 
The scoring scheme used depends on the setting of the Cross match found library 
compounds to all compound spectra option (see above): 
• If this option is set, the combined, effective score Score′ is calculated by the following 

formula:  

1000
1

×

×
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∑
=

M
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M

i  

with M = Number of compound spectra identified or cross matched as this library 
compound, Match = MatchParameter × MatchRetentionTime. 
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• If this option is not set, the following formula is applied: 
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with N = number of compound spectra, M = Number of compound spectra identified 
as this library compound, Match = MatchParameter × MatchRetentionTime. 

 
 
12.6.4.3 Library Search - Retention Time 

The Retention Time tab defines retention time constrains. 

Apply retention time matching 
Check this option if retention time matching should be applied. Otherwise, uncheck it. 
Note: Retention time matching should only be applied when operating under the same 

LC conditions including the column. 
Retention time matching compares the retention times of the acquired and the library 
spectrum. It internally calculates the retention time match factor from the absolute 
retention time deviation as linear interpolation between the Accepted retention time 
deviation as '1' and the Maximum retention time deviation as '0', respectively as '1' 
when being smaller than the accepted deviation and '0' when being larger than the 
maximum deviation. The calculated retention time match factor is then multiplied with 
the parameter matching factors to the final Parameter Match score for each individual 
mass spectrum. 

Accepted retention time deviation 
Enter the accepted retention time deviation in [min] between the acquired spectrum 
and the library spectrum. An absolute retention time deviation of less than this value 
yields to a retention time match factor of 1.  

Maximum retention time deviation 
Enter the maximum retention time deviation in [min] between the acquired spectrum 
and the library spectrum. An absolute retention time deviation of more than this value 
yields to a retention time match factor of 0. 
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Figure 12-23 Method Parameters dialog - Library Search - Retention Time  
 
 
12.6.4.4 Library Search - Parameter Matching 

The Parameter Matching tab defines how the Parameter Match score is to be 
calculated. Define which instrumental parameters should be used for calculating the 
Parameter Match score and how they should be weighted. 

Parameter 
Lists all instrumental parameters, which can be used for calculating the Parameter 
Match score. For each parameter you can define if and how it should be weighted 
using the Weight categories low, medium, high or forbidden. A default setting of 
parameters is given.  
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Figure 12-24 Method Parameters dialog - Library Search - Parameter Matching 

Weight: low/medium/high/forbidden 
Select the parameters you want to include in calculating the Parameter Match score 
and their weighting by checking the corresponding low, medium, high or forbidden 
check boxes. Checking none of the check boxes of a parameter will exclude the 
respective parameter from being used. The following weight categories are available: 

low. Weights differences in the respective parameter with a factor of 0.90.  
medium. Weights differences in the respective parameter with a factor of 0.75.  
high. Weights differences in the respective parameter with a factor of 0.50.  
forbidden. Weights differences in the respective parameter as 'no hit'. By default the 

Polarity and MS vs. MS/MS parameters are set to forbidden. This will prevent of 
getting any hits of spectra with different polarity or matching a precursor (parent) 
with a product (daughter) spectrum.  

When a parameter is included in calculating the Parameter Match score, the following 
is required to be rated as ‘no difference’ of library and acquired spectrum: 

Instrument Type: Instrument type must be the same.  
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Ionization Method: Ionization method must be the same.  
Polarity: Polarity must be the same. Default weight for a difference is ‘forbidden’. 

Thus, if library and acquired spectrum differ in polarity this automatically results in 
‘no hit’ regardless on whether other parameters do match. 

MS vs. MS/MS: Spectra type (MS or M/MS) must be the same. Default weight for a 
difference is ‘forbidden’. Thus, if library and acquired spectrum differ in MS type 
this automatically results in ‘no hit’ regardless on whether other parameters do 
match. 

MS/MS Stage: MS/MS stage must be the same.  
Precursor Ions: Only first precursor ion is weighted. First precursor ions must match 

with an allowed deviation of m/z 1.5 at the most. 
Product Ion: Product ions must match within peak width. 
Trap Drive: Applies only if both trap drive values are non-zero. Values must match 

within 10%. 
Fragmentation Amplitude: Applies only if both values are non-zero. Fragmentation 

amplitude values must match within 10%. 
Isolation Width: Applies only if both isolation width values are non-zero. Values must 

match within 20%. 
Target Gas: Comparison not yet implemented; reserved for coming versions. 
Target Gas Pressure: Comparison not yet implemented; reserved for coming 

versions. 
Reagent Ion: Comparison not yet implemented; reserved for coming versions. 
Reagent Gas Pressure: Comparison not yet implemented; reserved for coming 

versions. 
Collision Energy: Comparison not yet implemented; reserved for coming versions. 
Peak Width: Applies only if both peak width values are non-zero. Values must match 

within 20%: 
Reflector: Mode (linear/reflector) must be the same. Not compared by default. 
Post Source Decay: Type (post source decay yes/no) must be the same.  
Charge Deconvoluted: Type (charge deconvoluted yes/no) must be the same.  

 
 
12.6.4.5 Library Search - Add 

The Add tab defines how (a) new mass spectrum/spectra should be added to a library 
if the specified compound already exists in the selected library.  
Under Add to existing compound, select how to proceed if the specified compound 
already exists: 

If compound exists, add spectra without information. Adds the spectrum/spectra 
to the existing compound without any information. 

If compound exists, ask for action. Opens the Add New Spectrum dialog and asks 
about the action to be performed. This allows you to add the spectrum/ spectra 
either to the existing compound or as a new compound entry.  
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Always create a new compound. Always creates a new compound entry. 

Add N most abundant masses 
Enter the maximum number of most abundant masses the mass spectrum may 
contain when added to a library. For spectra containing lots of masses this will result 
in reducing the masses contained in the resulting library spectra to the specified 
number of most abundant masses. Values from 1 to 10,000 are allowed.  
 

 
Figure 12-25 Method Parameters dialog - Library Search - Add  

 
 
12.6.4.6 Library Search - Advanced 

The Advanced tab defines advanced library search parameters.  
Note: Only advanced users should alter the Advanced parameter settings. 

Note: The Advanced parameters will be described in a later version of this manual. 
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Figure 12-26 Method Parameters dialog - Library Search - Advanced 

 
 
12.6.5 Parameters Command - Chemistry 

The Chemistry tab is used to define the parameter settings for automatic SmartFor-
mula and SmartFormula3D generation. The settings in this tab apply to the SmartFor-
mula, Edit and SmartFormula3D commands in the Chemistry menu. The Chemistry 
tab consists of the following inserted tabs: SmartFormula and SmartFormula3D. 
 
 
12.6.5.1 Parameters Command - Chemistry - SmartFormula 

The Chemistry - SmartFormula tab defines the parameter settings for automatic 
SmartFormula generation via the SmartFormula command or Edit command, 
respectively.  
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Figure 12-27 Method Parameters dialog - Chemistry - SmartFormula 

Lower formula and Upper formula 
Enter all elements with their allowed minimum (Lower formula) and maximum (Upper 
formula) atom numbers on which formula calculation should be based. Formula 
calculation will start at the formula entered in Lower formula and stop at the formula 
entered in Upper formula.  
Note: For m/z values < 2000, the elements C, H, N and O are considered implicitly. 
Tip: The Compass PeriodicTableEditor application allows defining new isotopically 

labeled elements. This application is available via Windows Start menu > 
Programs > Bruker Daltonics > Utilities > PeriodicTableEditor.  

Hints on how to enter minimum and maximum formulae: 
- If you want to generate formulae for m/z values < 2000 and if the element C, H, N or 

O should be excluded from calculation, you must explicitly set the respective element 
to ‘0’. For example, if there should be no N in the formulae you have to enter ‘N0’. 

- Sorting of elements is not needed. 
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- Hard brackets can be used to enter fixed atom ratios that should not be resolved. For 
example, when entering ‘[N3P3O6]CHF’ for Lower formula and 
‘[N3P3O6]C100H21F80’ for Upper formula, then calculation will use exactly 3 N, 3 P 
and 6 O but 1 to 100 C, 1 to 21 H and 1 to 80 F. 

- Chemical notation can be used. For example, ‘(CH3)6’ will be resolved to C6H18. 

Tolerance 
Define an absolute or relative tolerance for the measured m/z value, which determines 
the total mass range within which the m/z of the calculated formulae must lie. Select 
the type from the drop-down list on the right, mDa for absolute tolerance or ppm for 
relative tolerance, and enter the desired value.  

Charge 
For multiple charged ions, enter the assumed charge the ion of the measured m/z has. 
Please consider the sign of the charge. The mass of the electron is not negligible for 
high mass precision instruments. Switching between +1 and -1 makes a difference of 
two electrons or 1.1 mDa which means 2 ppm for a molecule with 548 Da.  

Maximum number of formulas 
Enter the maximum number of formulae to generate per peak. Default is '20'. 

Relative intensity threshold 
Enter the relative intensity threshold with respect to the base peak a mass peak must 
reach to be concerned in SmartFormula generation. 

Check rings plus double bonds 
Check this option if possible formulae should be checked whether the number of rings 
and double bonds present keeps within the bounds specified in Minimum and Maxi-
mum. This will exclude all possible formulae with deviating double bond equivalence 
numbers.  
The rings plus double bounds number is calculated from the number of atoms and their 
valency: 

2
)2(2 −×Σ+

=+ atomatom valencyndbR  

The valency of C and Si is 4, for N and P a valency of 3 is assumed. For O and S it is 
2, for H and the halogen atoms it is 1. For this limited set of atoms the equation 
simplifies to 

1
2
1

2
1

),(),,,,,()( ++−=+ PNIBrClFDHC nnndbR  

All other elements are considered, too. Double bonds occurring with higher valence 
states like 4 or 6 for sulfur cannot be taken into account since these valence states are 
not known. 
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Minimum 
Enter the minimum number of rings plus double bonds to be contained in a formula at 
least. This number may be negative for protonated clusters.  

Maximum 
Enter the maximum number of rings plus double bonds to be contained in the formula 
at most. 

Filter H/C ratio 
Check this option if possible formulae should be filtered for their ratio of the elements H 
and C. Only formulae that comply with the H/C ratios specified in Minimum and 
Maximum will be displayed. 

Minimum 
Enter the minimum H/C ratio to be applied.  

Maximum 
Enter the maximum H/C ratio to be applied. 

Electron configuration 
Select the kind of electron configuration to be applied to MS or MS(n) spectra, 
respectively: 

both. Calculates formulae of both electron configurations. 
odd. Calculates only formulae having an odd electron configuration. 
even. Calculates only formulae having an even electron configuration. 

The electron configuration is calculated under the assumption that we have molecular 
ions. The electron configuration is even, if [n(atom) x valency(atom) + z(ion)] is even.  

Limit 
Select the statistical value to limit formula calculation for MS or MS(n) spectra, respec-
tively and enter the corresponding maximum value (as [10^-3] value): 

Sigma. Limits by the Sigma value which is a combined value for the standard 
deviation of the masses and intensities for all peaks. 

Combined Deviation. Limits by the Combined Deviation value. For FTMS the intensi-
ties of the peaks are combined with the isotope peak distances, otherwise with the 
mean mass deviation. 

Deviation Intensity. Limits by the Deviation Intensity value which uses the intensities 
of all peaks. 

Deviation Mean Mass. Limits by the Deviation Mean Mass value which is calculated 
from the intensity weighted mass deviations of the peaks. 

Deviation Var I. Limits by the Deviation Var. I value which is similar to Deviation 
Intensity but uses a different weighting scheme for the peaks. 

Deviation Delta m/z. Limits by the Deviation Delta m/z value which is calculated from 
the intensity weighted pairwise peak distances. 
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Automatically locate monoisotopic peak 
Check this option if the monoisotopic peak that corresponds to the measured m/z 
should be located automatically. The algorithm will search to the left and right of the 
measured m/z for appropriate sum formulae with their corresponding monoisotopic 
peaks. For formulae with a monoisotopic peak different from the selected peak the 
monoisotopic mass differs by a few mDa from the selected mass. The mass error 
nevertheless is calculated for the selected peak and the exact theoretical mass of that 
peak based on the formula from Alan L. Rockwood et al. (J.Am.Soc. Mass Spectrom. 
2004, 15, 12-21). 

Estimate carbon number 
Check this option if the program should estimate the minimum number of carbon atoms 
to be used in calculating formulae. The carbon number entered in Lower formula and 
the estimated carbon number will be compared and the higher of both numbers will be 
taken over. This option should be set if the monoisotopic peak could not be determined 
reliably e.g. in case of a large number of carbon atoms or metal organic compounds.  
For estimating the carbon number, the following assumptions are made: The selected 
m/z value corresponds to the m/z of the monoisotopic peak. The next peak that 
corresponds to the isotopomer with one ^12C less and exactly containing one ^13C, is 
1.003355 +- apart from the selected m/z value. From the intensity ratio of both peaks, a 
carbon number is estimated and rounded down. This number is then used as the 
minimum carbon number in generating formulae. 

Delete previously found results in range 
Check this option if previously found results in the defined range should be deleted 
before starting a new SmartFormula calculation. Otherwise, the new results will be 
added to the previous ones. 
 

12.6.5.2 Parameters Command - Chemistry - SmartFormula3D 

The Chemistry - SmartFormula3D tab defines the parameter settings for automatic 
SmartFormula3D generation via the SmartFormula3D command. 

Neutral losses' accuracy tolerance 
Enter the greatest difference allowed between observed difference of two peaks and 
calculated mass of neutral loss assigned to that difference in [mDa]. 

Intensity threshold, MS 
Enter the intensity threshold for peaks in the MS spectrum to be taken for the 
generation of sum formulae used for SmartFormula3D. 

Intensity threshold, MS(n) 
Enter the intensity threshold for peaks in the MS/MS spectrum to be taken for the 
generation of sum formulae used for SmartFormula3D. 
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Figure 12-28 Method Parameters dialog - Chemistry - SmartFormula3D 

Filter automatically with n peaks to be explained 
Enter the number of most intense peaks in the MS/MS spectrum which has to be 
explained for a SmartFormula3D formulae set. If a set does not explain the required 
number of peaks in the MS/MS spectrum this set will be discarded.  

Highlight unexplained intense peaks 
Check this option if peaks which are above the intensity threshold calculated from the n 
most intensive peaks but which are not explained in any of the sets of explained 
MS/MS peaks should be highlighted in the peak list of product ions. Highlighting occurs 
in red. 
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12.6.6 Parameters Command - Exclusion Masses 

The Exclusion Masses tab is used to define exclusion masses that are to be used to 
enhance the S/N ratios of Extracted Ion Chromatogram (EIC) and/or Base Peak Chro-
matogram (BPC) or in finding Mass Lists. For each analysis, you can define one set of 
exclusion masses which can consist of various single masses and/or mass ranges.  
You can set the color exclusion masses are to be displayed with using the Colors com-
mand from the Tools menu. 
Note: Setting exclusion masses will affect only chromatogram traces but not the corre-

sponding mass spectra. 
Note: A new exclusion mass setting will automatically recalculate and redraw all EIC 

and/or BPC traces currently defined for the selected analysis in the Chromato-
gram window.  

 

  
Figure 12-29 Method Parameters dialog - Exclusion Masses 
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Exclusion mass ranges list 
Lists all currently defined exclusion masses or mass ranges. You can add a new mass 
or mass range to this list as well as change or delete an already existing mass or mass 
range after selecting it. 

From 
To add a new exclusion mass or mass range or to change an existing one, enter the 
desired single mass or the start mass of the desired mass range. 

To 
To add a new exclusion mass range or to change an existing one enter the end mass 
of the desired mass range. 

Add 
Adds the new exclusion mass or mass range specified in the entry box(es) to Exclu-
sion mass ranges. 

Change 
Changes the selected exclusion mass or mass range according to the new settings. 

Delete 
Deletes the selected exclusion mass or mass range. 

OK 
Activates the new exclusion mass setting. This recalculates and redraws the EIC 
and/or BPC traces already defined for the selected analysis, and applies this setting to 
the new EICs and BPCs.  
 
 
12.6.7 Parameters Command - Calibration 

The Calibration tab is used to define the parameter settings for manual and automatic 
mass spectra calibration via the Internal and Automatic Internal commands in the 
Calibrate menu as well as for additionally applying lock mass calibration. The Calibra-
tion tab consists of the following inserted tabs: Internal Calibration, Automatic Inter-
nal Calibration and Lock Mass Calibration. 
Note: This tab is available if the Enable Mass Spectra Recalibration command from 

the Process menu is activated. 
 

12.6.7.1 Calibration - Internal Calibration 

The Internal Calibration tab defines the reference mass list and some calibration 
parameters for manual and automatic internal calibration of mass spectra. The settings 
apply to the Internal and Automatic Internal commands. The recalibration masses 
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are saved in the method now; with older methods, only the name of the reference mass 
list was saved. 

 
Figure 12-30 Method Parameters dialog - Calibration - Internal Calibration with a cali-

bration list being selected (for a micrOTOF analysis) 

Calibration group 
Displays calibration group information for the selected analysis and allows selecting 
another calibration group. The current selection is saved in the method when the 
analysis is saved. The following items can be displayed when the Calibration - Inter-
nal Calibration tab is opened resp. can be selected from the drop down list to change 
the current selection:  

<not set>. Indicates that no calibration group is set. 
<not available>. Indicates that the previously defined reference mass list whose 

name is saved in the method attached to the selected analysis is no longer avail-
able. This entry should appear with older methods only. 

<Method>. Indicates that calibration group and calibration list data is saved in the 
method attached to the selected analysis. The respective calibration group and 
reference mass list, if set, are shown in Calibration list.  
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 If you have selected another calibration group and/or reference mass list but yet 
have not saved the change by saving the analysis you can switch back to the 
calibration group/reference mass list currently saved in the analysis by selecting 
<Method>. 

ESI. Indicates that the ESI calibration group is chosen for the selected analysis. If 
currently another calibration group is chosen, you can select ESI to select an ESI 
reference mass list; this lists all available ESI reference mass lists in Calibration 
list. 

MALDI. Indicates that the MALDI calibration group is chosen for the selected 
analysis. If currently another calibration group is chosen, you can select MALDI to 
select a MALDI reference mass list; this lists all available MALDI reference mass 
lists in Calibration list. 

Calibration list 
Displays the name of the selected calibration list (reference mass list, *.ref). When 
<Method> is shown in Calibration group, also the calibration group name is shown 
in front. The entry <not set> means that currently no reference mass list is selected; 
the entry <not available> indicates that the reference mass list whose name is saved 
in the method is no longer available. 
The reference masses contained in the selected list are listed in the table below. To 
select another reference mass list select it from the drop down list. The reference 
mass lists available depend on the selected Calibration group and the current 
installation.  

(Reference mass list table) 
The table lists under Name the sum formulae of all reference masses contained in the 
selected calibration list along with the referenced Mass and a Comment if available. 
(The numeric precision of the displayed Mass values depends on the Mass precision 
setting in the Display tab of the Method Parameters dialog.) 

Edit Lists 
Allows viewing and editing the reference mass lists. Starts the Windows Explorer and 
opens the folder containing the reference mass lists (*.ref). To view or edit a certain 
list, open it in e.g. Windows WordPad. 

Mode 
Select the calibration mode to be used. For description of the calibration modes Linear, 
Quadratic, HPC, Enhanced Quadratic, Linear Correction, Single Point Correction 
and Space Charge Correction, please refer to the Internal command from the Cali-
brate menu (Section 10.1). 
Note: The calibration modes actually available depend on the instrument type the 

selected analysis was acquired with (ion trap, quadrupole, time-of-flight or 
Fourier transform) and on the calibration mode used by the data acquisition 
software (mode 1 or 2). If the instrument is not known all modes are offered. 
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Search range (m/z) 
Enter the search range for the Auto Search procedure which can be used for calibra-
tion curve setup in manual internal calibration. The Auto Search procedure searches 
the mass spectrum which is selected for calibration curve setup automatically for 
current masses that differ from a reference mass in the selected calibration list by not 
more than this specified search range. When a current mass is found within the 
search range of a reference mass then the setting of the Intensity threshold deter-
mines whether it will be actually assigned to the reference mass.  
Note:  Be careful not to set a too large search range to avoid wrong mass assignment.  

Intensity threshold 
Enter the intensity threshold for the Auto Search procedure which a current mass that 
was found within the Search range (m/z) of a reference mass must exceed to be 
assigned to that reference mass in the calibration table. 
 
 
12.6.7.2 Calibration - Automatic Internal Calibration 

The Automatic Calibration tab defines parameter settings to be used in automatic 
internal recalibration via the Automatic Internal command. 
In Retention time range of calibrant, define the retention time range for the calibrant 
peak from which the mass spectrum to be used for calculating the calibration coeffi-
cients should be averaged.  

Start 
Enter the start of the retention time range for the calibrant peak.  

End 
Enter the end of the retention time range for the calibrant peak.  

Spectrum type (Line/Profile) 
Select the type of spectra to be averaged within the specified retention time range to 
extract the mass spectrum to be used: 

Auto. Uses profile spectra if such were acquired. Otherwise uses line spectra. 
Line and profile spectra. Uses both line and profile spectra. 
Line spectra only. Uses line spectra only. 
Profile spectra only. Uses profile spectra only. 
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Figure 12-31 Method Parameters dialog - Calibration - Automatic Internal Calibration 
 
 
12.6.7.3 Calibration - Lock Mass Calibration 

The Calibration - Lock Mass Calibration tab defines the parameter settings for lock 
mass calibration and is used to activate/deactivate the applying lock mass calibration 
mode.  
The lock mass calibration provides an automated way of applying the linear correction 
calibration to each spectrum in the analysis. This mode requires the presence of 
continuous signals during the analysis. When lock mass calibration is applied, each 
spectrum is searched for the masses from the specified user-definable reference mass 
list and the current calibration is adapted to the found masses. A list of lock masses 
can consist of a single or multiple entries (added substances or known background 
signals), while the result will be more accurate as more masses are found. The lock 
mass approach is especially useful to further increase accuracy for long analyses (> 
1h) in environments that show fast or large temperature changes that cannot be com-
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pletely compensated with the online temperature compensation of the mass spectro-
meter during acquisition. Lock mass calibration should be applied after recalibration. 
 

 
Figure 12-32 Method Parameters dialog - Calibration - Lock Mass Calibration (example 

of lock mass calibration being activated) 

For reference on the parameters Calibration group and Calibration list, please refer 
to the description of the Internal Calibration tab. 

(Reference mass list table) 
The table lists under Mass the lock mass(es) contained in the selected reference 
mass list. (The numeric precision of the displayed Mass values depends on the Mass 
precision setting in the Display tab of the Method Parameters dialog.) In addition, 
the corresponding Name and a Comment can be shown if available.  
A list of lock masses can consist of a single or multiple entries (added substances or 
known background signals), while the result will be more accurate as more masses 
are found. 
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Edit Lists 
Allows viewing and editing the reference mass lists. Starts the Windows Explorer and 
opens the folder containing the reference mass lists (*.ref). To view or edit a certain 
list, open it in e.g. Windows WordPad. 

Apply lock mass calibration 
Turns on/off applying lock mass calibration.  
Note: This option has the same function like the Apply Lock Mass Calibration com-

mand from the Calibrate menu. 

Check the option to activate the applying lock mass calibration mode for the selected 
analysis. Activating this mode will automatically recalibrate the mass spectra in the 
analysis using the specified lock mass(es) after you clicked OK/Apply. If compounds/ 
compound spectra were previously created in the analysis, first you have to confirm a 
request on deleting compounds/compound spectra. The processing operations, e.g. 
compound finding, you perform on the analysis while the mode is active will use the 
lock mass recalibrated mass spectra. If you perform a new internal/external calibration 
on the analysis, immediately a new lock mass calibration will be performed, too. The 
applying lock mass calibration mode will be active as long as it is not deactivated 
again. 

  
Figure 12-33 Confirmation request on applying lock mass calibration with/without 

deleting compounds/compound spectra 

Uncheck the option to turn off the applying lock mass calibration mode. Deactivating 
this mode will automatically restore the "old" calibration which was valid previously to 
applying lock mass calibration for the very last time after you clicked OK/Apply. If 
compounds/compound spectra were created while applying lock mass calibration was 
active you first have to confirm a request on deleting compounds/compound spectra. 
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Figure 12-34 Confirmation request on turning off lock mass calibration with/without 

deleting compounds/compound spectra 

Search range (m/z) 
Enter the search range for the lock mass(es) to be used. During lock mass calibration, 
each average mass spectrum created for a distinct retention time range is searched 
for current masses that differ from a referenced lock mass by not more than this 
specified search range. When such a current mass is found then the setting of the 
Intensity threshold determines whether it will be actually used to calibrate the mass 
spectra within in the corresponding retention time range. 
Note:  Be careful not to set a too large search range to avoid wrong mass assignment.  

Intensity threshold 
Enter the absolute intensity threshold which a current mass that was found within the 
Search range (m/z) of a specified lock mass must exceed to be used in lock mass 
calibration. 
 
 
12.6.8 Parameters Command - Layouts 

The Layouts tab is used to define the parameter settings for the Compound List layout 
and the Mass List layout. The Layouts tab consists of the following inserted tabs: 
Compound List Layout, Mass List Layout and SmartFormula List Layout. 
 
 
12.6.8.1 Layouts - Compound List Layout 

The Compound List Layout tab defines the layout of the Compound List which 
displays in the Compound List window. 

Compound List 
Lists all currently enabled Compound List layout items with the abbreviations they are 
represented by. The items will be ordered according to the sequence in this list. You 
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can add, delete or change items and their sequence from this list by using the following 
buttons. 
 

  
Figure 12-35 Method Parameters dialog - Layouts - Compound List Layout  

 New 
Opens an alphabetical list with the available items and their corresponding abbrevia-
tions given in brackets. The items can display the following compound information: 

Compound Label   (Cmpd. Label).  Label the compound is displayed with in the 
Compound Spectra folder.  

Fragment Intensity (total, negative)   (I (- fragment)).  Total intensity of a negative 
fragment spectrum. This item is only filled for compounds found with the 
AutoMS(n) algorithm. 

Fragment Intensity (total, positive)   (I (+ fragment)).  Total intensity of a positive 
fragment spectrum. This item is only filled for compounds found with the 
AutoMS(n) algorithm. 

Fragment Ion Mass   (Frag Ion m/z).  Fragment ion masses of the MS2, MS3, … 
spectra of an AutoMS(n) compound. At the moment, this list is restricted to the 15 
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most intensive masses. 
Integration Type   (Int. Type).  Type of compound finding performed for detecting the 

compound peak.  
Library Search: CAS Registry Number   (CAS#).  CAS number of the compound 

found to agree to the compound peak spectrum/spectra, if available. 
Library Search: Chemical Formula   (Chemical Formula).  Chemical formula of the 

compound found to agree to the compound peak spectrum/spectra, if available. 
Library Search: Compound Comment   (Cmpd Comment).  Compound comment 

for the compound found to agree to the compound peak spectrum/spectra, if 
available.  

Library Search: Compound Name  (Compound Name).  Name of the compound 
found to agree to the compound peak spectrum/spectra.  

Library Search: Eff. Fit/Purity Score  (Fit/Purity').  Effective Fit, resp. Purity, score 
of the compound found to agree to the compound peak spectrum/spectra. The 
effective Fit, resp. Purity, score is calculated by multiplying the Fit, resp. Purity, 
and Match scores that result from comparing compound peak and library spec-
trum/spectra. The Fit, resp. Purity, and Match scores are given as F, resp. P, and 
M values with the respective library spectrum in the data window and the Analysis 
List. 

Library Search: Effective Fit Score   (Fit').  Effective Fit score of the compound 
found to agree to the compound peak spectrum/spectra. The effective Fit score is 
calculated by multiplying the Fit and Match scores that result from comparing com-
pound peak and library spectrum/spectra. The Fit and Match scores are given as F 
and M values with the respective library spectrum in the data window and the 
Analysis List. 

Library Search: Effective Purity Score  (Purity').  Effective Purity score of the com-
pound found to agree to the compound peak spectrum/spectra. The effective 
Purity score is calculated by multiplying the Purity and Match scores that result 
from comparing compound peak and library spectrum/spectra. The Purity and 
Match scores are given as P and M values with the respective library spectrum in 
the data window and the Analysis List. 

Library Search: Effective RFit Score   (RFit').  Effective RFit score of the compound 
found to agree to the compound peak spectrum/spectra. The effective RFit score is 
calculated by multiplying the RFit and Match scores that result from comparing 
compound peak and library spectrum/spectra. The RFit and Match scores are 
given as R and M values with the respective library spectrum in the data window 
and the Analysis List. 

Library Search: Identified by +MS   (+).  Whether the compound was identified by a 
precursor or fragment library spectrum of positive polarity. ‘Yes’ is indicated as ‘x’.  

Library Search: Identified by MS   (MS).  Whether the compound was identified by a 
precursor library spectrum. ‘Yes’ is indicated as ‘x’. 

Library Search: Identified by -MS    (-).  Whether the compound was identified by a 
precursor or fragment library spectrum of negative polarity. ‘Yes’ is indicated as ‘x’. 
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Library Search: Identified by MS/MS   (MS/MS).  Whether the compound was iden-
tified by a fragment library spectrum. ‘Yes’ is indicated as ‘x’. 

Library Search: Library Name  (Lib).  Name of the library containing the compound 
found to agree to the compound spectrum/spectra. 

Library Search: Molecular Weight   (Lib MW).  Molecular weight of the compound 
found to agree to the compound spectrum/spectra, if available. 

Library Search: Retention Time   (Lib RT).  Retention time of the library spectrum of 
the compound found to agree to the compound spectrum/spectra, if available. 

Library Search: Spectrum Comment   (Spec Comment).  Spectrum comment for 
the library spectrum of the compound found to agree the compound spectrum/ 
spectra, if available. 

Library Search: Spectrum Info   (Spec Info).  Spectrum Info for the library spectrum 
of the compound found to agree to the compound spectrum/spectra. 

Maximum Mass-to-Charge Ratio   (Max m/z).  Mass-to-charge ratio of the most 
intense peak in the compound peak spectrum. Compounds found with the 
AutoMS(n) algorithm do not fill this item. 

Maximum Molecular Weight  (Max MW).  Molecular weight of the most intense, 
charge-deconvoluted peak in the compound peak spectrum. Compounds found with 
the AutoMS(n) algorithm do not fill this item. 

MS(n) Filter   (MS(n) Filter).  MS type ('parent', 'daughter') of the compound peak 
spectrum. 

MS(n) Isolation Masses   (MS(n) Isol. m/z).  Precursor masses the compound peak 
spectrum derives from. 

Peak Area   (Area).  Absolute area of the compound peak. Compounds found with 
the AutoMS(n) algorithm do not fill this item. 

Peak Full Width at Half Maximum  (FWHM).  Peak width of the compound peak as 
full width at half maximum. This item is only filled for compounds found with the 
Compounds - Chromatogram function. 

Peak Height   (Height).  Height of the compound peak. Compounds found with the 
AutoMS(n) or Dissect algorithm do not fill this item. 

Peak Intensity   (Intens.).  Absolute intensity of the compound peak. Compounds 
found with the AutoMS(n) algorithm do not fill this item. 

Peak Number   (#).  Peak number of the compound peak. 
Peak Range   (Range).  Retention time range of the compound peak. 
Precursor Intensity (negative)   (I (- precursor)).  Intensity of the precursor of a 

negative fragment spectrum. This item is only filled for compounds found with the 
AutoMS(n) algorithm. 

Precursor Intensity (positive)   (I (+ precursor)).  Intensity of the precursor of a 
positive fragment spectrum. This item is only filled for compounds found with the 
AutoMS(n) algorithm. 

Precursor ion charge   (prec. z).  Charge of exported precursor ion of an AutoMS(n) 
compound peak. This item is only filled for compounds found with the AutoMS(n) 
algorithm. 
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Precursor ion m/z   (prec. m/z).  Mass-to-charge ratio (m/z) of exported precursor 
ion of an AutoMS(n) compound peak. This item is only filled for compounds found 
with the AutoMS(n) algorithm. 

Precursor Molecular Weight   (MW).  Molecular weight of precursor of AutoMS(n) 
compound peak. This item is only filled for compounds found with the AutoMS(n) 
algorithm and a deconvoluted precursor. 

Related Chromatogram   (Chromatogram). Chromatogram trace on which the com-
pound peak was detected. 

Relative Peak Area [%]   (Area %).  Relative area of the compound peak with refe-
rence to the base (100%) peak. Compounds found with the AutoMS(n) algorithm 
do not fill this item. 

Relative Peak Area Fraction [%]   (Area Frac%).  Relative area of compound peak 
with reference to the sum (100%) of all peaks. Compounds found with the 
AutoMS(n) algorithm do not fill this item. 

Relative Peak Intensity  (Int. %).  Relative intensity of the compound peak with 
reference to the base (100%) peak. Compounds found with the AutoMS(n) algo-
rithm do not fill this item. 

Retention Time   (RT).  Retention time of the compound peak. 
Signal-to-Noise Ratio   (S/N).  Signal-to-noise ratio of the compound peak. 

To add one of these items to the Compound List layout, click it and then click the Com-
pound List field. This adds the selected item to the bottom of the current list. If 
required, change the item's position in this list. 

 Delete: Deletes the selected item from this list. 

 Move Up: Moves up the selected item by one line. 

 Move Down: Moves down the selected item by one line. 
 
 
12.6.8.2 Layouts - Mass List Layout 

The Mass List Layout tab defines the layout of the Mass List which displays in the 
Mass List tab of the Spectra Data window.  
Mass List 
Lists all currently enabled Mass List layout items with the abbreviations they are 
represented by. The items will be ordered according to the sequence in this list. You 
can add, delete or change items and their sequence from this list by using the following 
buttons. 
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Figure 12-36 Method Parameters dialog - Layouts - Mass List Layout 

 New button 
Opens an alphabetical list with the available items and their corresponding abbrevia-
tions given in brackets. The items can display the following mass peak information: 

Absolute Mass Defect   (|Mass Defect|).  The absolute difference to the closest inte-
ger of the m/z value of the peak. 

Average Mass (Charge Deconv.)  (Ave. Mass).  Average mass calculated in charge 
deconvolution for the component that the peak belongs to. 

Charge   (z).  Charge state applied to the peak in charge deconvolution. 
Chi Square (SNAP)   (Chi^2).  Chi square calculated for the peak when using SNAP 

peak finder.  
Component (Charge Deconv.)   (Cmpnt.).  Charge deconvolution component the 

peak belongs to. 
Delta (m/z)    (d [m/z]).  Delta m/z value of the mass peak with reference to that peak 

on which delta m/z calculation was performed. 
Full Width at Half Maximum   (FWHM).  Peak width at half peak maximum. 
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Intensity   (I).  Absolute intensity of the peak. 
Isotopic Mass (Charge Deconv.)  (Mass).  Isotopic mass calculated in charge 

deconvolution for the deconvoluted peak. 
Kendrick Mass (KM) [CH2]  (KM [CH2]).  Rescaled m/z value relative to m/z of CH2 

to be set to 14.0000. 
Kendrick Mass Defect (KMD) [CH2]  (KMD [CH2]).  KMD = (nominal Kendrick mass 

– Kendrick mass). 
Mass Defect   (Mass Defect).  The difference to the closest integer of the m/z value 

of the peak. 
Mass-to-Charge Ratio   (m/z).  M/z value of the peak. 
Molecular Mass (Charge Deconv.)   (Mol. Mass).  Molecular mass calculated in 

charge deconvolution for the component the peak belongs to.  
Nominal Kendrick Mass [CH2]  (NKM [CH2]).  The next lower integer of the 

Kendrick mass of the peak. 
Nominal m/z   (Nom. m/z).  The closest integer of the m/z value of the peak. 
Peak Area   (Area).  Absolute area of the peak. 
Peak Number   (#).  Number of the peak. 
Peak Type    (Peak Type).  Type of the peak that depends on the peak finder used 

e.g. 'Apex'. 
Quality Factor (SNAP)  Quality factor calculated for the peak when using SNAP peak 

finder. 
 
Relative Area [%]   (A %).  Relative area of the peak with reference to the base 

(100%) peak. 
Relative Intensity [%]   (I %).  Relative intensity of the peak with reference to the 

base (100%) peak. 
Resolving Power  (Res.).  Resolving power (m/Δm) of the peak. 
Signal-to-Noise Ratio    (S/N).  Signal-to-noise ratio of the peak. 

To add one of these items to the Mass List layout, click it and then click the Mass List 
field. This adds the selected item to the bottom of the current list. If required, change 
the item's position in this list.  

 Delete: Deletes the selected item from this list. 

 Move Up: Moves up the selected item by one line. 

 Move Down: Moves down the selected item by one line. 
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12.6.8.3 Layouts - SmartFormula List Layout 

The SmartFormula List Layout tab defines the layout of the SmartFormula List in the 
SmartFormula tab of the Spectra Data window resp. the Manual SmartFormula List in 
the SmartFormula Manually dialog.  
 

 
Figure 12-37 Method Parameters dialog - Layouts - SmartFormula List Layout 

SmartFormula List 
Lists all currently enabled SmartFormula List layout items with the abbreviations they 
are represented by. The items will be ordered according to the sequence in this list. 
You can add and delete items or change their sequence using the following buttons. 

 New button 
Opens an alphabetical list with the available items and their corresponding abbrevia-
tions given in brackets. The items can display the following formula information: 

|Error| [ppm]  (|err| [ppm]). Absolute value of the deviation between measured mass 
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and theoretical mass of the selected peak in [ppm]. 
Charge  (z).  Charge state. 
Electron Configuration  (e¯Conf).  Whether the electron configuration is even or 

odd.  
Elemental Composition  (Elem. Comp.).  Percentage of the single elements in the 

formula.  
Equivalent Carbon Number (Z)  (Z).  For convenience, the homologous hydrocarbon 

series can be labeled by the type and the class of the series. The elemental 
compositions of these compounds is Cc Hh Nn Oo Ss , where the lower case c, h, n, 
o and s are integers and h=2c-Z. Z defines the type or the equivalent carbon 
number of the series. 

Error [mDa]  (err [mDa]).  Deviation between measured mass and theoretical mass 
of the selected peak in [mDa]. 

Error [ppm]  (err [ppm]). Deviation between measured mass and theoretical mass of 
the selected peak in [ppm]. 

H/C Ratio  (H/C). H/C ratio in the formula. 
Homologous Series  (Series).  The class is determined by the elements in the 

compound, excluding carbon and hydrogen.   
Index  (#).  Index of the formula. 
Kendrick Mass (KM) [CH2]  (KM [CH2]).  Rescaled m/z value relative to m/z of CH2 

to be set to 14.0000. 
Kendrick Mass Defect (KMD) [CH2]  (KMD [CH2]).  KMD = (nominal Kendrick mass 

– Kendrick mass). 
m/z  (m/z).  Calculated m/z of the formula. 
Mean Error [ppm]  (Mean err [ppm]). Intensity weighted mean deviation between 

the measured masses and the theoretical masses of all peaks. This value is an 
alternative to Error [ppm]. If there are a number of peaks with a significant intensi-
ty this value should be preferable because the statistical uncertainty of the experi-
mental masses is reduced. 

Measured Intensity  (I).  Measured intensity. 
Measured m/z  (Meas. m/z).  Measured m/z. 
mSigma  (mSigma). Combined value for the standard deviation of the masses and 

intensities for all isotopic peaks, given in [milliSigma].  
N/C Ratio  (N/C). N/C ratio in the formula. 
Nitrogen Rule  (N-Rule). Whether the nitrogen rule is fulfilled. 
Nominal Kendrick Mass [CH2]  (NKM [CH2]).  The next lower integer of the 

Kendrick mass of the peak.  
O/C Ratio  (O/C). O/C ratio in the formula. 
O/N Ratio  (O/N). O/N ratio in the formula. 
Rank Sigma  (# Sigma).   Ranking according to Sigma. 
Rank Std Combined Deviation  (# Std Comb Dev). Ranking according to Std Com-

bined Deviation. 
Rank Std Intensity  (# Std I).  Ranking according to Std Intensity. 



Bruker Daltonik GmbH Method Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  12-79

Rank Std Intensity VarNorm  (# Std I VarNorm).   Ranking g according to Std 
Intensity VarNorm. 

Rank Std Mass Differences  (# Std m/z Diff).   Ranking according to Std Mass 
Differences. 

Rank Std Mean Mass  (# Std Mean m/z).   Ranking according to Std Mean Mass. 
Rings and Double Bonds  (rdb). Number of rings and double bonds in the formula. 
S/C Ratio  (S/C). S/C ratio in the formula. 
Score  (Score).  Score of the formula (a value between 0 and 100%). 
Score Rank  (# Score).  Rank of the formula according to its Score value. 
Std Combined Deviation  (Std Comb Dev). A value that combines either Std Mean 

Mass or Std Mass Differences (for FTMS) with Std Intensity VarNorm. For that 
purpose each value is normalized by its median value calculated for all formula 
candidates and the sum of the square roots is calculated. This value therefore 
depends on the set of formulae! The values are weighted in a data dependent way 
to optimize the selectivity of the resulting scoring value. 

Std Intensity  (Std I). Root mean square of the normalized intensity of the peaks. 
The peaks are normalized so that the sum of intensities is one. An offset which is 
the same for all peaks is added to reduce an intensity offset which might remain 
after optimizing the digitizer setting. 

Std Intensity VarNorm  (Std I VarNorm).  A value same as Std Intensity but the 
peaks are weighted by the square root of the intensity to take into account the ion 
statistic. 

Std Mass Differences  (Std m/z diff). Intensity weighted root mean square of the 
difference between the measured and theoretical peak distances between peaks 
being 1 or 2 Da apart. Not only the monoisotopic mass and the relative intensities 
of the peaks depend on the formula but also the distances between the various 
peaks. With instruments like the micrOTOF and especially the FTMS instruments 
this difference can be measured very precisely even if the absolute calibration 
might not be optimized. This value is especially useful to decide about the number 
of sulfur atoms. 

Std Mean Mass  (Std Mean m/z).  Root mean square of the intensity weighted mass 
differences between the measured masses and the theoretical masses for the 
given formula. 

Sum Formula  (MF).  Sum formula. 

To add one of these items to the SmartFormula list layout, click the item and then click 
in the SmartFormula List field. This adds the selected item at the bottom of the 
current list. If required, change the item's position in this list.  

 Delete: Deletes the selected item from this list. 

 Move Up: Moves up the selected item by one line. 

 Move Down: Moves down the selected item by one line. 
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12.6.9 Parameters Command - Display 

The Display tab is used to define the numeric precision of retention time and/or m/z 
values and the labeling of chromatogram peaks.  
 

  
Figure 12-38 Method Parameters dialog - Display 

In Displayed numeric precision, define the numeric precision for displaying m/z and 
retention time values: 

Mass precision 
Enter or select the post-comma precision of m/z values. 

Retention time precision 
Enter or select the post-comma precision of retention time values. 
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In Chromatogram peak labeling, define how to label chromatogram peaks. Peak 
labels are oriented horizontally by default. If more than one item is selected each label 
is placed in an own row. 
Note: Labeling with Index will always be performed as a fallback if other options than 

Index are selected but do not bring along a label (e.g. if only Compound Name 
is selected but the compound was not identified and thus got no name).  

Index 
Check this option to label peaks with running index (1, 2, 3, .....).  

Retention Time 
Check this option to label peaks with the retention time value that corresponds to the 
peak maximum. 

Maximum Mass 
Check this option to label peaks with the most intense mass in the calculated corre-
sponding averaged mass spectrum. 

Molecular Formula 
Check this option to label peaks with corresponding molecular formula obtained by a 
SmartFormula operation. The formula yielding the best Sigma value is taken. 

Compound Name 
Check this option to label peaks with corresponding compound name if available. The 
name of the library spectrum yielding the highest score in the respective results list is 
taken. 

Use color of chromatogram 
Check this option to display the peaks labels with the same color as used for the corre-
sponding chromatogram. Otherwise, peak labels are displayed in black.  

Vertical orientation (only one item) 
Check this option to orient the peak labels vertically. This option can be applied to one 
item only. If more than one item is selected a corresponding message appears and 
only that respective item that will display as top label when labels are oriented horizont-
ally is displayed. 
 
 
12.6.10 Parameters Command - Process 

The Process tab is used to define the parameter settings to be used in smoothing and 
baseline subtraction operations. The settings in this tab apply to the Smooth Chroma-
togram, Subtract Chromatogram Baseline, Smooth Mass Spectrum and Subtract 
Mass Spectrum Baseline commands in the Process menu. 
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Figure 12-39 Method Parameters dialog - Process 
 
In Smoothing of chromatograms resp. Smoothing of mass spectra, define how to 
smooth chromatograms resp. mass spectra: 

Smoothing algorithm 
Select the smoothing algorithm to use: 

Savitzky Golay. Algorithm with cubic splines. 
Gauss. Gauss algorithm.  
Square. Square algorithm.  

These smoothing algorithms are based on local smoothing 

∑
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with coefficients ck. The Smoothing width M and the number of smoothing Cycles can 
be chosen. 
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The weights for Savitzky Golay are obtained by considering a least square problem for 
2M + 1 nodes. For details, please refer to the literature, where also tables of the ck’s 
can be found.  

In the case of Square smoothing, we have 
)12(/1: += Mck  

For Gauss smoothing the weights for k ≤ M are defined by  
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The scaling factor s is chosen such that 
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The algorithm takes two specific parameters: σ and gP and defines M by M = 2 * σ * 
gP. 

Smoothing width 
Enter the smoothing width for chromatograms in [s] and for mass spectra in [Da]. 
Note: This value should not be set too high; otherwise, the curve shape can be 

dramatically affected. If more smoothing is required, run more Cycles in 
succession.  

Cycles 
Enter the number of smoothing cycles to run in succession.  

Replace original 
Check this option to replace the original chromatogram/mass spectrum data with the 
smoothed data. If unchecked, the original data is preserved in addition to the smoothed 
data. 

Disable original 
Check this option to disable the original chromatogram/mass spectrum if not replaced. 
If unchecked, both original and smoothed data is displayed. 

Use same color as original 
Check this option to display the smoothed chromatogram/mass spectrum in the same 
color as the original data. If unchecked, the program selects a different color from a set 
of predefined colors.  
 
In Baseline subtraction of chromatograms resp. Baseline subtraction of mass 
spectra, define how to subtract a baseline from chromatograms resp. mass spectra: 
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Flatness [0.0-1.0] 
Enter the flatness of the baseline to subtract. Values between '0.0' and '1.0' are 
allowed. For example, a value of '0.0' subtracts a convex/concave (waved) baseline 
and a value of '1.0' (= total flatness) subtracts a straight baseline. 

Replace original 
Check this option to replace the original chromatogram/mass spectrum with the 
baseline subtracted data. If unchecked, the original data is preserved in addition to the 
baseline subtracted data.  

Disable original 
Check this option to disable the original chromatogram/mass spectrum if not replaced. 
If unchecked, both original and baseline subtracted data are displayed. 

Use same color as original 
Check this option to display the baseline subtracted chromatogram/mass spectrum in 
the same color as the original data. If unchecked, the program selects a different color 
from a set of predefined colors.  
 
 
12.6.11 Parameters Command - Export 

The Export tab is used the parameter settings to be used in exporting compounds and 
mass spectra into the XML or Mascot file format. The settings in this tab apply to MGF 
and XML export via the Export > Compounds, Export > Mass Spectrum, Send > 
Analysis To > Mascot Batch Search with BioTools and Send > Spectrum To > 
BioTools commands in the File menu. 
 
 
12.6.11.1 Export - General 

The General tab defines general parameter settings for the XML and Mascot com-
pound export. 
In XML compound export, define which information should be included when a 
compound is exported into Compound XML File format (*.xml). 

Include detailed information 
Check this option if detailed information on each mass-spectral peak of a compound 
spectrum including all properties of each peak is required. 
Note: Setting this option increases significantly the size of the exported data file.  

Include peptide database query information 
Check this option to include information needed for peptide database search, either 
‘MS/MS Search’ or ‘Peptide Mass Fingerprint’. 



Bruker Daltonik GmbH Method Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  12-85

 
Figure 12-40 Method Parameters dialog - Export - General 

 
In Mascot compound export is defined that peptide database query information is 
included when a compound is exported into Mascot Generic File format (*.mgf). 

Include peptide database query information 
Includes information needed for Mascot database search, either ‘MS/MS Search’ or 
‘Peptide Mass Fingerprint’. This option is always checked. 
 
 
12.6.11.2 Export - Peptide Database Query 

The Peptide Database Query tab defines the parameter settings to be used in 
exporting compound mass spectra for a Mascot 'MS/MS Search' or a 'Peptide Mass 
Fingerprint'.  
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Figure 12-41 Method Parameters dialog - Export - Peptide Database Query  

Set global charge limitation 
Check this option to set a global charge limitation for the Mascot search. For more 
information, please refer to the Mascot manual. 
Note: The global charge setting applies to non-deconvoluted ions only. This setting 

here will override any other setting in the Mascot search parameter.  

'charge state' 
If Set global charge limitation is selected, choose the desired charge state(s).  

'AccuMASS' exported m/z 
The possible mass values for peptides are forming narrow clusters with a distance of 
the mean masses of approximately 1.00048 Da. Since the statistics for these clusters 
have been created based on peptide masses, the results are only valid for this type of 
compounds. 
Check this option if the AccuMASS algorithm should be applied to the m/z values to be 
exported. The AccuMASS algorithms shifts the m/z values for which the charge is 
known to the nearest theoretical value. This gives an improved performance of data-
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base searches for protein identification by Peptide Mass Fingerprint or MS/MS Search.  
 
In Export for 'MS/MS Search' and 'Peptide Mass Fingerprint', define which type of 
data is to be exported for the selected mass spectrum/spectra to perform a Mascot 
'MS/MS Search' or 'Peptide Mass Fingerprint'. In addition, define whether or not 
FWHM and S/N ratio data should be included. These options apply to both LC-MS(n) 
and LC-MS data. 
(Data type combo box) 

Non-deconvoluted data only. Exports only non-deconvoluted data. 
Deconvoluted data only. Exports only deconvoluted data. 
Mixed list (non-deconvoluted and deconvoluted). Exports both non-deconvoluted 

and deconvoluted data.  

Include S/N ratio and FWHM 
Check this option to include S/N ratio (signal-to-noise ratio) and/or FWHM (Full Width 
at Half Mass) data. 

Export deconvoluted peaks as single-charged ion 
Check this option if deconvoluted peaks should be exported as single-charged ions. 

Normalize MS(n) data 
This option refers to the intensity of signals in AutoMS(n) product ion spectra (MS(≥3)) 
which is lower than the intensity in the preceding generation spectrum.  
Check this option if AutoMS(n) product ion spectra should be normalized on the inten-
sity of the precursor ion in the preceding generation spectrum. Then the intensity of the 
highest signal in the MS(3) spectrum is set equal to the intensity of the precursor ion in 
the preceding MS(2) spectrum and the MS(3) signals are normalized accordingly. The 
same is valid for signals in the MS(4) spectrum etc. 
Setting this option is recommended for de-novo sequencing to increase the intensity of 
the MS(3) signals and to prevent those signals from getting "lost". But before exporting 
the Compound List, all MS(>3) spectra containing only noise should be deleted 
because otherwise the noise peaks are amplified. For protein identification, checking 
this option is not recommended because during the automatic export spectra cannot be 
deleted manually.  
 
In Export for 'MS/MS Search' define which deconvolution results should be preferred 
and how many non-deconvoluted ions per MS(n) spectrum are to be exported for a 
Mascot 'MS/MS Search'. These options apply to LC-MS(n) data only. 

Prefer full scan spectrum deconvolution results to MaxRes results 
Check this option to export preferably full scan spectrum deconvolution results. This 
option is only enabled when Deconvoluted data only or Mixed list (non-deconvo-
luted and deconvoluted) is selected.  
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Export N most abundant non-deconvoluted ions of each fragment spectrum 
If Non-deconvoluted data only or Mixed list (non-deconvoluted and deconvolu-
ted) is selected, enter the number of most abundant non-deconvoluted ions of each 
fragment spectrum to be exported. 
 
In Export for 'Peptide Mass Fingerprint' (MS/precursor spectra) define the number 
of most abundant deconvoluted and non-deconvoluted ions that are to be exported of 
each spectrum for a Mascot 'Peptide Mass Fingerprint'. These options apply to LC-MS 
data only. 

Export N most abundant deconvoluted ions 
Enter the number of most abundant ions to be exported.  

Export N most abundant non-deconvoluted ions 
Enter the number of most abundant non-deconvoluted ions to be exported.  
 
 
12.6.12 Parameters Command - UV Data 

The UV Data tab of the Method Parameters dialog to define the parameter settings for 
displaying UV data. 

Retention time offset correction 
Enter the retention time offset correction in [s]. The time offset shifts the time scales of 
the UV and the mass spectrum data with respect to each other to correct the time delay 
between UV detector and electrospray source.  
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Figure 12-42 Method Parameters dialog - UV Data 
 
 
12.7 Script Command 

Note: To use the Script command, you need to install Microsoft ActiveX Control Pad 
that contains the necessary modules for creating controls in the scripting dialog.  

The Script command is used to start the DataAnalysis Script Editor in order to create a 
new, view, or modify an existing VisualBasic script to be used to automatically process 
analyses. You can also run a script directly from the Script Editor. In the script code, 
you define the particular (processing) operations that should be performed on the 
selected analysis when this script is executed. Additionally, you can build a corre-
sponding graphical user interface (GUI) which serves to communicate with the user 
while the script is running. 
In the DataAnalysis environment, scripts can be a part of an analysis or a part of a 
processing method. DataAnalysis can also be controlled via external scripts with the 



Method Menu Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 12-90 

Windows Script Host. You can create such external scripts using the Automation-
Engine application, which you can start using the AutomationEngine command from 
the Tools menu.  
Reference on 
• VisualBasic scripting you can get using the VBScript Language Reference com-

mand from either the Script Editor’s or DataAnalysis’ Help menu.  
• Script forms you can get using the Forms Reference command found in the Script 

Editor’s Help menu. This includes Microsoft Forms Design Reference, Microsoft 
Forms Developer's Tips and Microsoft Object Model Reference. 

• DataAnalysis scripting is available using the DataAnalysis Script Reference com-
mand from the Script Editor’s Help menu. Alternatively, please refer to the DataAna-
lysis Script Reference Manual. 

 
The command starts the DataAnalysis Script Editor and loads the script in the open 
processing method or the selected analysis. The Script Editor provides Script View, 
which opens by default on starting the Script Editor and displays the script code and 
the Object View that shows the corresponding GUI. You can toggle between both 

views by clicking  or selecting the corresponding command (Script or Objects) 
from the View menu in Script Editor. The Script Editor's title bar shows the name of the 
open processing method and the analysis name in parentheses. If the method has 
been modified but not saved yet, the ‘(modified)’ indicator appends the method name. 

Script View 
The Script View displays the script code of the loaded script. If no script is available, 
the Script View will be empty. If currently no script is available, you can create a new 
script by entering the codes for the processing operations to be performed when the 
script is running. You can also modify an existing script code by entering new and 
changing or removing existing code. When adding a new code, please make sure that 
it is properly positioned in the sequence of operations. For help on scripting, see the 
references above 

Object View 
The Object View displays the GUI of the loaded script if a GUI has already been 
created. If no GUI or no script is available, the Object View will be empty. The Object 
View provides the Toolbox containing the controls you can use for creating a GUI and 
the layout bar for placing the controls already added to the GUI. 
To develop a GUI for a script, first select the Toolbox object you want to have in the 
GUI and then click with the left mouse button on that canvas position where you want 
to place the respective control. This adds the selected object with default size. 
Alternatively, you can hold the mouse button down and determine the size of the object 
to be added by dragging the mouse. Systematically you can add further controls, 
rearrange them and adjust the sizes. To move a control on the canvas, select it and 
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drag it with the left mouse button hold down to the new position. To delete an existing 
control from your GUI, click it and press DEL. You can use the buttons of the layout bar 
to arrange multiple selected controls. 

 
Figure 12-43 Script Editor's Object View with no GUI defined in the loaded script 
 

You can start running the loaded or created script by clicking  or selecting Run 
Script from the Script Editor's File menu. Selecting Stop Script from the File menu will 
stop running the script. Alternatively, you can run the script of the loaded method by 
selecting the Run command from the Method menu. 
You can save a modified or new script either in the open method using the Save or 
Save As commands from the Method menu or in the selected analysis by saving it 
using the Save command from the File menu. Only one script can be saved per 
method or analysis. 

Shortcuts 
Button:  
Keys: Ctrl+F2 

 
Example: the 'Metabolite.m' script 
The following example shows a script with a GUI assigned and the corresponding 
script code. The GUI contains a Start button and the 'name' and 'status' info boxes. If 
such a script is started using the Run command from the Method menu or the Script 

editor's , first this GUI appears indicating the analysis name and the status being 
'ready to go'. Clicking the Start button will start the script and the current processing 
state will be displayed in 'status'. After all specified processing steps are completed, the 
status 'ready' is displayed and the button's caption changes to 'Quit' to quit the GUI.  
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Figure 12-44 GUI of the Metabolite.m method script (example) 

  
Figure 12-45 Script code (extract) of the Metabolite.m method script 
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12.8 Default Command 

The Default command is used to select a default processing method that will automa-
tically be attached to each analysis you open in DataAnalysis whose embedded 
method does not contain a DataAnalysis processing part. You can also use this com-
mand to clear default method setting. 
The command opens the Open Method dialog if currently no default method is set and 
you confirm the corresponding information. This dialog allows you to select the desired 
default method as described for the Open command from the Method menu. 

 
Figure 12-46 Message about currently no default processing method being selected 

If a default method has already been selected, a corresponding message will appear 
when selecting the Default command.  

 
Figure 12-47 Message about the current default processing method 

This message informs you about the currently selected default method and asks you if 
you want to select another default method. It also allows you to clear default method 
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setting which will result in applying the build-in default processing parameters to analy-
ses having no method with a processing part attached. Clicking Yes opens the Open 
Method dialog for selecting another default method. Clicking No closes the dialog; the 
current default method setting is not changed. Clicking Cancel clears default method 
setting. 
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13 VIEW MENU 

The View menu offers the following commands: 

  
Figure 13-1 View menu 

Command Used to … 

Next Spectrum Display in the Spectrum View window the next measured mass 
spectrum of the selected chromatogram trace relative to the 
currently displayed mass spectrum. 

Previous Spectrum Display in the Spectrum View window the previous measured 
mass spectrum of the selected chromatogram trace relative to 
the currently displayed mass spectrum. 

Linear/Logarithmic Toggle the intensity scale of the Survey View window or 
Chromatogram window between linear and logarithmic. 

Relative Intensity Toggle the intensity scale of all mass spectra displaying 
windows between absolute and relative intensity. 

Toolbars Show, hide or customize toolbars. 
Status Bar Show/Hide the status bar. 
Auto-Scaling Toggle the abscissa and, if possible, the ordinate of the active 

data window between auto-scaling and manual scaling. 
Zoom In Zoom the selected data range. 
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13.1 Next Spectrum Command 

The Next Spectrum command shows in the Spectrum View window the next spectrum 
relative to the spectrum currently displayed. Accordingly, the Fixed Data cursor  
moves on the selected chromatogram trace to the next data point.  
Tip: Repeatedly selecting this command by using the right direction key allows a quick 

inspection of mass spectra. 

Shortcuts 
Button:   
Keys: Right 

 
 
13.2 Previous Spectrum Command 

The Previous Spectrum command shows in the Spectrum View window the previous 
spectrum relative to the spectrum currently displayed. Accordingly, the Fixed Data 
cursor  moves on the selected chromatogram trace to the previous data point.  
Tip: Repeatedly selecting this command by using the left direction key allows a quick 

inspection of mass spectra. 

Shortcuts 
Button:   
Keys: Left 

 
 
13.3 Linear/Logarithmic Command 

The Linear/Logarithmic command toggles the intensity scale of the Survey View or 
Chromatogram window between linear and logarithmic. This redraws all data currently 
displayed. The logarithmic intensity scaling is active when the command's tool button is 
being pressed; the linear intensity scaling is active when the tool button is not being 
pressed. 

Shortcuts 
Button:  
Keys: Shift+F9 
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13.4 Relative Intensity Command 

The Relative Intensity command toggles the intensity scales of all mass spectra 
displaying windows between absolute intensity and relative intensity. This redraws all 
data currently displayed. The relative intensity scaling is active when the command's 
tool button is being pressed; the absolute intensity scaling is active when the tool 
button is not being pressed. 
 
 
13.5 Toolbars Command 

The Toolbars command is used to show, hide or customize your toolbars and the 
menu bar. The command opens the Toolbars dialog, which allows you to select the 
toolbars you want to show, to customize them and to define the toolbar display. 
 

  
Figure 13-2 Toolbars dialog 

Toolbars 
Lists all toolbars currently defined (default as well as custom toolbars). Each toolbar 
has a check box in front indicating its current display state: when the box is checked 
the toolbar is shown, when it is unchecked the toolbar is hidden. Check an unchecked 
box to show the respective toolbar or uncheck a checked box to hide the toolbar. 

Toolbar name 
Displays the name of the toolbar selected in Toolbars. 
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Show Tooltips 
Check this option to show tooltips when the mouse cursor is positioned onto toolbar 
buttons. 

Customize 
Allows customizing the toolbars. Opens the Customize - Toolbars dialog. 

New 
Allows creating a custom toolbar. Opens the New Toolbar dialog (see below). 

Reset 
Resets the toolbar selected in Toolbars or the menu bar to its default settings.  
Note: This button is only available if a default toolbar or the menu bar is selected. 

Delete 
Deletes the toolbar selected in Toolbars.  
Note: This button is only available if a custom toolbar is selected. 

 
New Toolbar dialog 
Use this dialog to create a custom toolbar. 

Toolbar name 
Enter the name for the new toolbar. 

OK 
Creates a new, undocked toolbar on the DataAnalysis user interface. 

 
Figure 13-3 New Toolbar dialog 
 
 
13.6 Status Bar Command 

The Status Bar command shows/hides the status bar.  
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13.7 Auto-Scaling Command 

The Auto-Scaling command toggles the abscissa and, if possible, the ordinate of the 
active data window between auto-scaling and manual scaling. The auto-scaling mode 
is active when the command's tool button is being pressed. 
Note: When you use this command in the Chromatogram window or Mass Spectrum 

window, you are not able to set the auto-scaling state for the ordinate or 
abscissa individually. 

Shortcuts 
Button:  
Keys: Alt+F9 

 
 
13.8 Zoom In Command 

The Zoom In command is used to zoom in the display range of the Survey View 
window, Chromatogram window, Spectrum View window, Compound Spectra window, 
Mass Spectrum window or Work List window so that the selected data range is 
displayed enlarged. The command switches to the Zoom In Once mode that allows 
performing only a single zooming in operation. After that, the Zoom In mode is 
automatically deactivated and you have to activate it again if you want to perform a 
further zoom in.  
The command activates/deactivates the Zoom In Once mode. The mode is active when 
the command's tool button is being pressed.  
Tip: If you want to perform successive zoom ins without each time activating the 

Zoom In Once mode, you can switch to the Zoom In Continuously mode by 
clicking drop down button of the Zoom In tool button and selecting Zoom In 
Continuously. 

 When currently in a permanent interaction mode, you can quickly switch to the 
Zoom In mode by holding down the Shift key and perform one or several 
successive zoom ins. The Zoom In mode will be temporarily active as long as the 
Shift key is held down. When the Shift key is released, the previous active mode 
will be activated again. 

To zoom in a display range, first activate this command. Then position the mouse 
cursor in that data window whose display range you want to zoom to display the Zoom 

In cursor . To select the data range you want to zoom in, position this cursor to the 
start or final position of the abscissa range to be selected and to any intensity of the 
ordinate. Then drag the Zoom In cursor with the left mouse button held down as far to 
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the left or right, until the range to be zoomed in is inside the displayed selection rect-
angle. While dragging the cursor, the value of the extended ordinate range is always 
automatically adjusted to give a full-scale display of all peaks within the selected reten-
tion time or mass range. On releasing mouse button, the data currently enclosed in this 
selection rectangle are displayed enlarged.  

       
Figure 13-4 Zooming in a display range 

Shortcuts 
Button:  
Key: F9 

Dedicated key for Zoom In mode 
Shift 
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14 TOOLS MENU 

The Tools menu offers the following commands: 

  
Figure 14-1 Tools menu 

Command Used to … 

Protein Analysis Perform analysis for proteins on the selected analysis and 
export MGF and XML files. 

Customize Customize the toolbars. 
Options Define data window display options. 
Colors Define data window colors. 
ProcessWithMethod Launch AutomationEngine script 'ProcessWithMethod'. 
Reprocess Launch AutomationEngine script 'Reprocess'. 
 
 
14.1 Protein Analysis Command 

The Protein Analysis command performs an automatic analysis for proteins on the 
selected analysis with exporting the results obtained to MGF and XML files. The MGF 
files can directly be used for Mascot search or loaded in BioTools. The command 
operates in the selected retention time range only. 
Automatic protein analysis includes AutoMS(n) compound finding, charge deconvolu-
tion of all spectra and export of compounds to MGF and XML files. Four exported files 
(ProteinAnalysisResults.xml, ProteinAnalysisResults.CID-ETD.mgf, ProteinAnalysis-
Results.ETD.mgf and ProteinAnalysisResults.mgf) are stored in the analysis folder. 
Each compound is generated apart, deconvoluted, exported and after that immediately 
removed from the memory. Then the next compound is analyzed in the same way and 
so on. All processing operations are performed according to the method parameter 
settings defined for the respective analysis. 
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The automatic protein analysis saves memory and should be faster as there is only one 
compound in the memory at a time. However, the disadvantage is that the Merge 
positive and negative compounds filter does not work and the Maximum number of 
compounds is applied only if the Fragments qualified by and Filter for detected 
neutral losses only filters are not active. In this case, first the n most intensive com-
pounds are filtered before compounds are generated. (The filter options can be found 
in the Find - AutoMS(n) tab of the Method Parameters dialog.) 
 
 
14.2 Customize Command 

The Customize command is used to manage and customize your toolbars and the 
menu bar. Selecting this command opens the tabbed Customize dialog containing the 
following tabs: Toolbars (opens by default), Commands and Configure. 
 
 
14.2.1 Customize Command - Toolbars 

The Toolbars tab is used to manage and customize the toolbars and menu bar. This 
tab allows you to define the toolbars to be displayed on your DataAnalysis user 
interface. Also you can create and delete new toolbars or reset the default toolbars or 
menu bar to their default settings.  

Toolbars 
Lists all toolbars currently defined (default as well as customer created toolbars). Each 
toolbar has a check box in front indicating its current display state: When the box is 
checked, the respective toolbar is shown, when it is unchecked, the toolbar is hidden. 
Check an unchecked box to show the respective toolbar or uncheck a checked box to 
hide the toolbar. 

Toolbar name 
Displays the name of the toolbar selected in Toolbars. 

Show Tooltips 
Check this option to show tooltips when the mouse cursor is positioned onto toolbar 
buttons. 

New 
Allows creating a custom toolbar. Opens the New Toolbar dialog (Section 13.5). 

Reset 
Resets the toolbar currently selected in Toolbars or the menu bar to its default set-
tings.  
Note: This button is only available if a default toolbar or the menu bar is selected. 
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Delete 
Deletes the toolbar currently selected in Toolbars.  
Note: This button is only available if a custom toolbar is selected. 
 

  
Figure 14-2 Customize dialog - Toolbars tab 
 
 
14.2.2 Customize Command - Commands 

The Commands tab is used to customize the toolbars and menu bar. This tab allows 
you to add buttons to the currently displayed toolbars and menus to the menu bar. Also 
you can use it to view information about the toolbar buttons available.  

Categories 
Lists the default toolbars. On selecting a category, the buttons contained in this cate-
gory are displayed in Buttons. Menu bar displays all menus available. 

Buttons 
Displays the buttons defined for the selected category.  
To view information about a particular button, click on it. Its description is displayed in 
Description. To add a button to a toolbar, click the desired button and drag it, with the 
left mouse button depressed, to any position on the toolbar. 
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Description 
Displays the description for the button currently selected in Buttons. 

  
Figure 14-3 Customize dialog - Commands tab 
 
 
14.2.3 Customize Command - Configure 

The Configure tab is used to change the current DataAnalysis configuration. DataAna-
lysis can be configured to show only commands related to ESI, APCI and APPI 
instruments or to show all commands available in DataAnalysis. The latter adds a few 
items related to MALDI instruments. After making a configuration change, DataAnalysis 
must be restarted to activate the new settings.  
Note: Changing the configuration of DataAnalysis will cause a loss of any customiza-

tions made to the current configuration. 

Change configuration to 
Select the configuration to which DataAnalysis should be switched: 

ESI, APCI and APPI instruments. Changes configuration to fit the ESI, APCI and 
APPI instruments. This configuration will show only items related to these types of 
instruments. 

All instruments (including MALDI). Changes configuration to fit all types of instru-
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ments. This configuration will add a few items related to MALDI instruments.  
 

  
Figure 14-4 Customize dialog - Configure tab 

OK 
If another configuration was selected, the software will automatically indicate that Data-
Analysis needs to be closed and restarted in order to change the configuration. The 
following confirmation request for saving modified analyses will appear.  

  
Figure 14-5 Confirmation request appearing on configuration change 
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14.3 Options Command 

The Options command is used to define specific options, e.g. particular layout options 
for the data windows. Selecting this command opens the tabbed Options dialog 
containing the following tabs: Basic Layout (opens by default), Chromatogram, 
Spectrum View, Compound Spectra, Mass Spectrum, Labels, Info, Windows and 
Miscellaneous. 

Shortcut 
Button:  

 
 
14.3.1 Options Command - Basic Layout 

The Basic Layout tab can be used to define the relative heights of the data windows to 
be displayed as well as the number of list windows. 
 

  
Figure 14-6 Options dialog - Basic Layout tab 
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Relative Size 
Displays the relative heights (as %) of the currently displayed data windows. To change 
the relative height of a particular data window, enter the desired value in the corre-
sponding box. Changing the height of one window will automatically resize the heights 
of the other currently open data windows accordingly. 

Number of windows in list 
Displays the number of windows currently defined for the List display of the data 
windows (except for Survey View and Spectrum View windows). You can change the 
number of windows here or directly in the data window via the corresponding combo 
box. A maximum number of 12 windows is allowed. 
 
 
14.3.2 Options Command - Chromatogram 

The Chromatogram tab can be used to define the chromatogram display settings for 
the Chromatogram window. 
 

  
Figure 14-7 Options dialog - Chromatogram tab 
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Show Chromatogram window 
Shows the current display state of the Chromatogram window. Check this option to 
open the window, uncheck it to hide the window.  

Relative size 
Displays the current relative size of the Chromatogram window. To change it, enter the 
desired relative value. Changing this value will automatically resize all other open data 
windows accordingly. 

Show fractionation events 
Check this option to show fractionation events in the Chromatogram window if 
happened on the selected analysis. Events are indicated by vertical dotted lines 
labeled with corresponding loop numbers. 
 
In List display, define the number of windows displayed in the Chromatogram win-
dow's List display. 

Number of windows 
Enter the number of list windows to be displayed. 
 
In Stacked Display, define how chromatograms should be displayed in the Stacked 
display of the Chromatogram window.  
Angle 
Enter the angle by which chromatograms are to be shifted.  

Offset 
Enter the offset by which the baselines of chromatograms are to be shifted.  
 
In Scales, define the retention time and intensity scales. 

Retention time scale 
Seconds. Displays the retention time scale in seconds. 
Minutes. Displays the retention time scale in minutes. 

Intensity scale 
Linear. Displays a linear intensity scale. 
Logarithmic. Displays a logarithmic intensity scale. 
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14.3.3 Options Command - Labels 

The Labels tab defines the labeling style to be used for labeling mass spectra. 
 

  
Figure 14-8 Options dialog - Labels tab 

In Mass Spectrum Labels, define the density and orientation of mass spectrum labels. 
Density 
Select the type of labels to be displayed for the mass peaks found and the density. 
Labeling can be performed by m/z values according to the mass precision currently 
defined in the Display tab of the Method Parameters dialog or by vertical tics: 

Non-overlapping: Labels mass peaks with m/z values if enough space is available to 
display the complete value without overlapping with others. Otherwise, the respec-
tive label is not displayed. 

Non-overlapping with tics on all other: Labels mass peaks with either m/z values if 
there is enough space to display the complete value or with tics if the space is not 
sufficient.  

Overlapping: Labels mass peaks with m/z values, which may overlap with each 
other. 

Tics only: Labels mass peaks with tics only. 
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Line spectra always 'non-overlapping', only 
Check this option if labels on line spectra should always be displayed non-overlapping, 
i.e. m/z labels are only displayed if there is enough space to display the complete 
value. If you uncheck this option, labels are displayed according to the currently 
selected Density option. 
Note: Only non-overlapping labeling is suited for line spectra, the other options are not 

recommended. 

Orientation 
Select how m/z values should be oriented: 

Horizontal: Orients labels horizontally. 
Vertical: Orients labels vertically. 

 
In Mass Spectrum Peak, define display options for zoomed-in mass peaks: 

If zoomed in, mark peak position with vertical bar 
Check this option to mark the peak position of a zoomed-in mass peak by a vertical 
bar. 

If zoomed in, draw peak baseline 
Check this option to draw a baseline for a zoomed-in mass peak.  
 
 
14.3.4 Options Command - Info 

The Info tab defines the information to be displayed with particular mass spectra. 

In Line spectrum display, define which additional information should be displayed 
with a line spectrum.  

Mark non-measured mass range 
Check this option if the non-measured mass range is to be marked by a horizontal bar. 
The color this bar is displayed in can be set using the Colors command from the Tools 
menu.  

Mark threshold intensity 
Check this option if the intensity threshold (e.g. noise) is to be marked by a horizontal 
line. The color this line is displayed in can be set using the Colors command from the 
Tools menu. 
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Figure 14-9 Options dialog - Info tab 

In Mass spectrum description, define which information is to be displayed for com-
pound and library mass spectra in the Analysis List and Compound Spectra window.  

Compound spectra 
Select the information to be displayed along with a compound spectrum: 

Line vs. profile spectrum. Displays the spectrum type of the compound spectrum.  
Retention time. Displays the retention time or retention time range that corresponds 

to the compound spectrum according to the current settings in the Options - Basic 
Layout.  

Sequence index. Displays the sequence number or sequence number range of the 
mass spectrum/spectra the compound spectrum corresponds to in the respective 
chromatogram. 

Compound Name. Displays the compound name assigned to the compound spec-
trum by successful identification as well as the name of the corresponding library.  

Compound CAS number. Displays the CAS number (Chemical Abstracts Registry 
number) of the compound assigned to the compound spectrum provided a CAS 
number already exists for this compound. 

Base peak intensity. Displays the intensity of the 100% signal (base peak) in the 
compound spectrum. 
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Library spectra 
Select the information to be displayed along with a library spectrum: 

Compound Name. Displays the compound name of the library spectrum.  
Library spectrum info. Displays the instrument type (e.g. ion trap, quadrupole), ioni-

zation method, and MS/MS stage that were used to acquire the library spectrum.  
Compound CAS number. Displays the CAS number (Chemical Abstracts Registry 

number) of the compound belonging to the library spectrum provided a CAS 
number already exists for this compound.  

Library retention time. Displays the retention time of the library spectrum.  
 
 
14.3.5 Options Command - Windows 

The Windows tab defines the data windows to be automatically shown or hidden when 
opening or selecting either a chromatogram analysis or a mass spectrum analysis.  
 

  
Figure 14-10 Options dialog - Windows tab 
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In When opening / selecting a chromatogram analysis..., define the data windows 
to be shown or hidden automatically when opening or selecting a chromatogram ana-
lysis.  

Show the Chromatogram window 
Check the opening option to show the Chromatogram window automatically. Checking 
the opening option also automatically enables the selecting option. If you want to 
check only the selecting option, uncheck the opening option again.  

Show the Spectrum View window 
Check the opening and/or selecting option(s) to show the Spectrum View window 
automatically.  

Show the Compound Spectra window 
Check the opening option to show the Compound Spectra window automatically. 
Checking the opening option also automatically enables the selecting option. If you 
want to check only the selecting option, uncheck the opening option again.  

Hide the Mass Spectrum window 
Check the opening option to hide the Mass Spectrum window automatically. Checking 
the opening option also automatically enables the selecting option. If you want to 
check only the selecting option, uncheck the opening option again.  
 
In When opening / selecting a mass spectrum analysis..., define the data windows 
to be shown or hidden automatically when opening or selecting a mass spectrum ana-
lysis. 
Show the Mass Spectrum window 
Check the opening option to show the Mass Spectrum window automatically. Check-
ing the opening option also automatically enables the selecting option. If you want to 
check only the selecting option, uncheck the opening option again.  
Hide all other windows 
Check the opening option to hide all other data windows automatically. Checking the 
opening option also automatically enables the selecting option. If you want to check 
only the selecting option, uncheck the opening option again.  
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14.3.6 Options Command - Miscellaneous 

The Miscellaneous tab defines some miscellaneous actions. 
 

  
Figure 14-11 Options dialog - Miscellaneous tab 

Disable menu items if no sufficient user rights are available 
Check this option if corresponding menu items should be disabled in the case that no 
sufficient user rights are available for the respective operator logged into DataAnalysis. 
 
 
 



Bruker Daltonik GmbH Tools Menu 

DataAnalysis 4.0   Reference Manual   Revision 2  14-15

14.3.7 Options Command - Spectrum View 

The Spectrum View tab can be used to define the spectrum display settings for the 
Spectrum View window.  
 

  
Figure 14-12 Options dialog - Spectrum View tab  
 

Show Spectrum View window 
Shows the current display state of the Spectrum View window. Check this option to 
open the window, uncheck it to hide the window. 

Relative size 
Displays the current relative size of the Spectrum View window. To change it, enter the 
desired relative value. Changing this value will automatically resize all other open data 
windows accordingly. 
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14.3.8 Options Command - Compound Spectra 

The Compound Spectra tab can be used to define the spectrum display settings for 
the Compound Spectra window.  

  
Figure 14-13 Options dialog - Compound Spectra tab 

Show Compound Spectra window 
Shows the current display state of the Compound Spectra window. Check this option to 
open the window, uncheck it to hide the window. 

Relative size 
Displays the current relative size of the Compound Spectra window. To change it, enter 
the desired relative value. Changing this value will automatically resize all other open 
data windows accordingly. 

Number of windows 
Enter the number of list windows to be displayed.  

Show compound chromatogram when selecting a compound 
Check this option to show the chromatogram peak that corresponds to the selected 
compound in the Chromatogram window. If on selecting a compound its corresponding 
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peak is currently not shown, the display range is automatically adjusted to show this 
peak in the data window. 

Enlarge compound region in chromatogram 
Check this option to show the chromatogram peak that corresponds to the selected 
compound always enlarged in the center of the Chromatogram window.  
 
 
14.3.9 Options Command - Mass Spectrum 

The Mass Spectrum tab can be used to define the spectrum display settings for the 
Mass Spectrum window. 

  
Figure 14-14 Options dialog - Mass Spectrum tab 

Show Mass Spectrum window 
Shows the current display state of the Mass Spectrum window. Check this option to 
open the window, uncheck it to hide the window. 

Relative size 
Displays the current relative size of the Mass Spectrum window. To change it, enter the 
desired relative value. Changing this value will automatically resize all other open data 
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windows accordingly. 

Number of windows 
Enter the number of list windows to be displayed.  
 
In Stacked Display, define how mass spectra should be displayed in the Stacked 
display of the Mass Spectrum window.  

Angle 
Enter the angle by which mass spectra are to be shifted.  

Offset 
Enter the offset by which the baselines of mass spectra are to be shifted.  
 
 
14.4 Colors Command 
The Colors command is used to define the color settings for the data windows. The 
command opens the Colors dialog, which allows you to assign specific colors to 
particular screen elements. The colors can be selected either from a set of basic colors 
or from a set of custom colors which you can define according to your own require-
ments.  
 

  
Figure 14-15 Colors dialog 
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Screen Element 
Select the screen element whose color you wish to define. The Basic or Custom color 
currently assigned to the selected element is marked by a black frame and is displayed 
in Color/Solid. The color composition values are shown in the Hue, Sat(uration), 
Lum(inosity), Red, Green, and Blue boxes. 

Background. Background of the data windows, i.e. the area outside the frames of the 
data window display.  

Text. Text shown within the data window display.  
Frame. Frames of the data windows. 
Selected List Frame. Horizontal frames of the list window within the data window, 

which displays the currently selected chromatogram or mass spectrum. 
Scales. Scales of the data windows. 
Chromatogram Data Background. Background of Chromatogram data. 
Spectrum View Data Background. Background of Spectrum View data. 
Compound Spectra Data Background. Background of Compound Spectra data. 
Mass Spectrum Lines. Mass spectrum lines. 
Mass Spectrum Markers. Mass spectrum markers. 
Mass Spectrum Data Background. Background of Mass Spectrum data. 
Work List Data Background. Background of Work List data. 

Basic colors 
Select the basic color you want to assign to the selected screen element. Otherwise, 
assign a defined custom color. 

Custom colors 
Select the custom color you want to assign to the selected screen element.  
To define a new custom color, click a color box and change the corresponding Hue, 
Sat, Lum, Red, Green, and Blue values or select the desired color using the color field 
and the scrollbar. Then click Add to Custom Colors.  

Add to Custom Colors 
Adds the currently defined color to Custom colors. 

Reset 
Resets the current color settings to the default settings. 

OK 
Changes the color settings for the data windows according to the new settings. 
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14.5 ProcessWithMethod Command 

The ProcessWithMethod command launches the AutomationEngine script 'Process-
WithMethod' for automatic batch processing of a set of analyses using the script and 
parameter settings of the selected method. It displays the script's GUI which allows you 
to select the processing method and the analyses you want to process. Additionally, 
the DataAnalysis ProcessQueuer is started or activated, if already started, to control 
the entire batch processing once this has been started. For description of the DataAna-
lysis ProcessQueuer, please refer to the DataAnalysis Reference Manual. 
 

 
Figure 14-16 GUI of the 'ProcessWithMethod' script for selecting a method and analy-

ses for batch processing 

Method (entry box) 
Enter name and path of the method whose script should be run on the selected 
analyses. Otherwise, click Method to select the desired one. 
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Analysis List 
Lists the analyses selected for being processed. To fill this list, click Select and select 
the respective analyses. 

Method (button) 
Allows you to select the method whose script you want to use. In the appearing 
browser window select the desired method; this enters the method in the Method box. 

Select 
Allows you to select the analyses to be processed. In the appearing browser window, 
select the root folder that contains the respective analyses. This adds all analyses in 
this folder and below to the Analysis List. 
Clear 
Removes all analyses currently listed from the Analysis List. 
Exit 
Exits the 'ProcessWithMethod' script without starting processing. 

Process 
Starts automatic batch processing of the selected analyses. The DataAnalysis Proc-
essQueuer controls the batch processing using the script and parameter settings of the 
selected method. While processing is running in DataAnalysis, the DataAnalysis Pro-
cessQueuer window lists the analyses that are still to be processed; already processed 
analyses are removed from the list. If desired you can clear the current list without 
terminating the currently being processed analysis by clicking the Clear button in the 
DataAnalysis ProcessQueuer window. Batch processing has finished when the 
DataAnalysis ProcessQueuer window is empty again. 
If you do not want to process another batch with the 'ProcessWithMethod' script, you 
can close the AutomationEngine window and the ProcessQueuer window. 
Note: You cannot close DataAnalysis while the ProcessQueuer is open. 
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14.6 Reprocess Command 

The Reprocess command launches the AutomationEngine script 'Reprocess' for auto-
matic offline batch reprocessing of a set of analyses using the script and parameter 
settings of the attached method of each analysis. It displays the script's GUI which 
allows you to select the analyses you want to reprocess. Additionally, the DataAnalysis 
ProcessQueuer is started or activated, if already started, to control the entire batch 
processing once this has been started. 
The analyses are selected and batch processing is started and proceeds as described 
for the ProcessWithMethod command before. 
 

 
Figure 14-17 GUI of the 'Reprocess' script for selecting analyses for batch processing 
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15 COMPASS MENU 

The commands available in the Compass menu are determined by the applications 
currently installed on your computer; applications which are not installed are excluded 
from the menu. The Compass menu can offer the following commands.  

 
Figure 15-1 Compass menu (when in Compliance mode and with all commands 

possibly available) 

Command Used to … 

Compass Desktop Launch Compass Desktop. 
HyStar Switch to HyStar. 
TrapControl Switch to TrapControl. 
micrOTOFcontrol Switch to micrOTOFcontrol. 
apexControl Switch to apexControl. 
ChemStation Switch to ChemStation. 
Library Editor Start/Activate the LibraryEditor. 
ReportDesigner Start/Activate the ReportDesigner. 
AutomationEngine Start/Activate AutomationEngine. 
License Register your Bruker Daltonics Applications licenses. 
Operator Log in the specified operator. 
Lock All Applications Lock all Bruker Daltonics applications. 
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15.1 Compass Desktop Command 

The Compass Desktop command launches Compass Desktop which allows switching 
to other Bruker Compass applications. The buttons enabled depend on the programs 
currently installed on your computer. 

 
Figure 15-2 Compass Desktop 

Shortcut 

Button:   
 
 
15.2 HyStar Command 

The HyStar command switches to HyStar. The command is available if HyStar is 
installed on your computer. 

Shortcuts 
Button:   
Keys: Shift+F11 

 
 
15.3 TrapControl Command 

The TrapControl command switches to TrapControl. The command is available if 
TrapControl is installed on your computer. 

Shortcuts 
Button:  
Keys: Ctrl+F11 
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15.4 micrOTOFcontrol Command 

The micrOTOFcontrol command switches to micrOTOFcontrol. The command is 
available if micrOTOFcontrol is installed on your computer. 

Shortcuts 
Button:   

Keys: Ctrl+F11 
 
 
15.5 apexControl Command 

The apexControl command switches to apexControl. The command is available if 
apexControl is installed on your computer. 

Shortcuts 

Button:   
Keys: Ctrl+F11 

 
 
15.6 ChemStation Command 

The ChemStation command switches to ChemStation. The command is available if 
ChemStation is installed on your computer. 

Shortcuts 
Button:  
Keys: Shift+F11 
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15.7 LibraryEditor Command 

The LibraryEditor command starts/activates the LibraryEditor, which gives you the 
choice to build custom MS and MS/MS libraries that contain all the mass spectra you 
are interested in. You can use these custom libraries exclusively. Or you can use them 
as an addition to commercial mass libraries to identify your mass spectra using the 
Mass Spectra command from the Identify menu. Use the Open command from the 
LibraryEditor's Library menu to open a pre-existing library or use the New command to 
create a new custom library. 
Note: For detailed information on how to use LibraryEditor, please refer to the Library-

Editor help tools.  
 

  
Figure 15-3 LibraryEditor with a mass spectral library loaded 

Shortcut 
Button:   
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15.8 ReportDesigner Command 

The ReportDesigner command starts/activates the ReportDesigner, which allows you 
to create your own report layouts. You can modify existing layouts as well as set up 
new ones. Use the Open command from the ReportDesigner's File menu to open and, 
if needed, edit an existing report layout or use the File menu's New command to set up 
a new layout. 
Note: For detailed information on how to use ReportDesigner, please refer to Report-

Designer help tools. 
 

  
Figure 15-4 ReportDesigner with two loaded DataAnalysis report layouts 

Shortcut 
Button:   
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15.9 AutomationEngine Command 

The AutomationEngine command starts/activates the AutomationEngine, which 
allows you to view and create external scripts (*.script) to control DataAnalysis with the 
Windows Script Host. Use the Open command from the AutomationEngine's File menu 
to open a pre-existing script or use the New command to create a new script.  
Just as internal scripts set up using the Script command from the Method menu, 
external scripts consist of the script code and can contain a GUI to interact with the 
user. The script code is displayed or entered in the AutomationEngine's Script View 

with the GUI in its Object View. You can toggle between the views by clicking . 
 

  
Figure 15-5 AutomationEngine's Script View displaying the code of the loaded script 
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Figure 15-6 AutomationEngine's Object View displaying the GUI of the loaded script 

Note: For detailed information on how to use AutomationEngine, please refer to Auto-
mationEngine help tools. 

 Reference on automating tasks can be found in DataAnalysis object model for 
automating tasks. 

Shortcut 
Button:   
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15.10 License Command 
The License command is used to view the licenses currently available for Bruker 
Daltonics applications.  
The command also allows launching the Bruker Daltonics LicenseManager to add or 
delete licenses for Bruker Daltonics applications. However, for this Windows admini-
strator privileges are required. Furthermore, if DataAnalysis is running in Compliance 
mode, only operators who have the special UserManagement right can add and delete 
licenses. 
 
The command opens the Bruker Daltonics LicenseViewer dialog which shows any 
license currently available for any of the Bruker Daltonics applications and how long it 
will be valid.  
 

 
Figure 15-7 Bruker Daltonics LicenseViewer showing, as an example, the presence of 

Compass Security Pack license and various ESI Compass 1.3 licenses  

Existing licenses 
Lists all existing licenses alphabetically ordered. 

License key 
Lists the license keys for the products for which licenses exist. 

Valid until 
Permanent licenses are indicated as ‘unlimited’.  
For temporary licenses, the date until the respective license is valid is shown. An 
expiration warning will inform you automatically about the forthcoming expiration of a 
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temporary license firstly 30 days before the respective expiration will expire. If for one 
product more than one license is present, this warning concerns the longest valid 
license. An expiration warning will appear once per 24 hours and can be skipped by the 
operator. 

Product name 
Lists the names of the products for which licenses exist. 

Edit 
Allows launching the LicenseManager e.g. to add or delete licenses for Bruker 
Daltonics applications. Opens the Run As dialog to specify the user account to run the 
LicenseManager. 
 
Run As dialog 
The Run As dialog is used to specify the user account to run Bruker Daltonics License-
Manager. Only a user with Windows administrator privileges will be allowed to run 
Bruker Daltonics LicenseManager. 
To specify an appropriate user account, check The following user, select the respec-
tive user in User name and enter and enter the corresponding Password. Then click 
OK to run the Bruker Daltonics LicenseManager. If DataAnalysis is running in Compli-
ance mode, first the UserManagement logon dialog for the LicenseManager will be 
displayed after clicking OK. You have to identify by operator ID and password to log on 
the LicenseManager. 

 
Figure 15-8 Run As dialog 
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Bruker Daltonics LicenseManager dialog 
The LicenseManager allows adding new and deleting existing licenses.  
Note: If DataAnalysis is running in Compliance mode, only operators who have the 

special right can add and delete licenses.  
To add a new license, enter the license key you received in New license key and click 
Add. A new line is added to Existing licenses with the key you have entered, the 
product name and the date until the license will be valid. To delete an existing license 
select it in Existing licenses, click Delete and confirm the corresponding request. In 
Compliance mode, adding or deleting a license requires re-entering the password of 
the logged on operator; the respective action will be only performed if the password is 
correct and you have the UserManagement right to add/delete licenses.  
 

  
Figure 15-9 Bruker Daltonics LicenseManager showing, as an example, the presence 

of Compass Security Pack license various and ESI Compass 1.3 licenses 

New license key 
Enter the submitted license key. This enables the Add button. 

Add 
For Non-Compliance mode: Adds the license key entered in New license key to the 
list of existing licenses and licenses the corresponding product.  
For Compliance mode: Opens the Re-enter Your Password dialog to enter again the 
password for the current operator account. The license key will be added after re-
entering the correct password and if the operator has the required right. 
This button becomes enabled after the license key has been entered completely. 
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Delete 
For Non-Compliance mode: Deletes the license key selected in the Existing licenses 
list after affirming corresponding confirmation request.  
For Compliance mode: Opens after affirming the confirmation request the Re-enter 
Your Password dialog to enter again the password for the current operator account. 
The license key will be deleted after re-entering the correct password and if the 
operator has the required right. 
 
Re-enter Your Password dialog 
This dialog is used to re-enter your password when required by the program.  

Password 
Enter the password for the current operator account. 

 
Figure 15-10 Re-enter Your Password dialog 

OK 
If the password is correct for the current operator account and the operator has the 
right to add/delete licenses the entered license key is added to or the selected license 
key is deleted from the LicenseManager’s Existing licenses list. If the password is 
incorrect or the operator does not have the required right, a corresponding error 
message will inform you.  
 
 
15.11 Operator Command 

The Operator command is used to change the operator during a running DataAnalysis 
session. The currently logged in operator is displayed in the status bar. When Data-
Analysis is running in Compliance mode, you can also use this command to change 
your current password.  
Note: There is always only one operator logged into Bruker Daltonics applications on 

a specific computer at a time. 
 
The command opens the DataAnalysis dialog which allows you to log in and/or 
change your password. Depending on the current mode, Non-Compliance or Compli-
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ance, this dialog looks something different. In Non-Compliance mode you can log in 
without identifying whereas in Compliance mode you have to identify by operator name 
and password. 
Note: This dialog appears automatically on each start-up of your DataAnalysis appli-

cation unless you are currently logged in another Bruker Daltonics application 
(for both Non-Compliance and Compliance mode) or the corresponding option 
for skipping this dialog is set (for Non-Compliance mode only).  

 
Figure 15-11 DataAnalysis dialog for logging in the operator when in Non-Compliance 

mode 

  
Figure 15-12 DataAnalysis dialog for logging in the operator when in Compliance mode 

Operator 
Enter your operator ID. The ID of the current operator will automatically be entered if 
the UserManagement administrator has set the corresponding option. The operator ID 
is not case-sensitive. 
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Password 
Enter your password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. Successive wrong inputs will cause locking of 

the operator when the number of wrong login tries exceeds the number of 
wrong logins allowed by the UserManagement administrator. Only the User-
Management administrator can unlock a locked operator. 

Note: This entry field is available in Compliance mode only. 

Always log in using this operator 
Check this option if the operator named in Operator should be logged in automatically. 
This will skip this dialog when starting DataAnalysis in future. 
Note: This check box is available in Non-Compliance mode only. 

Change Password 
Allows you to change your current password. Opens the Change Password dialog 
(see below). 
Note: This button is available in Compliance mode only. 

Log On 
Logs in the (specified) operator. In Compliance mode, log in will be successful only if 
operator ID and password match. If both do not match an error message will appear. 
Successive wrong password inputs can cause locking of an operator by UserManage-
ment. If a new created operator tries to log into a Bruker Daltonics application the first 
time, the program requires for changing the password. Quitting the request opens the 
Change Password dialog (see below). 
 

Change Password dialog 
This dialog is used to change the current password for the operator named in 
Operator. The new password must comply with the password policy settings defined 
by the UserManagement administrator. 

  
Figure 15-13 Change Password dialog 
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Operator 
Displays the ID of the operator whose password can be changed. If the password for 
another operator should be changed, click Cancel and enter the desired operator in the 
previous dialog. 

Old password 
Enter your current password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. 

New password 
Enter the new password.  
Note: Passwords are case-sensitive. Make sure, that the new password complies with 

the current password policy settings. 

Confirm new password 
Confirm your new password. You must enter the same password as above. 

OK 
If the new password and its repetition are the same and the new password complies 
with the password policy settings, it changes the password. A dialog appears informing 
you that your password was changed successfully. Quitting this dialog returns you to 
the DataAnalysis dialog.  
If the new password and its repetition are different or the chosen password does not 
comply with the current password policy settings, a corresponding message appears. 
Quit the message and in the Change Password dialog make again desired entries. 
If the old password is incorrect, a message about denying password change appears. 
Quitting this message returns you to the DataAnalysis dialog. 

     
Figure 15-14 Messages on successful password change (left) and chosen password is 

violating password policy (right) 
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15.12 Lock All Applications Command 

Note: The Lock All Applications command is available only in Compliance mode. 

The Lock All Applications command is used to lock all Bruker Daltonics applications. 
This includes DataAnalysis as well as all other Bruker Daltonics applications currently 
installed on your system.  
Note: Only the previous operator or someone with the special right to unlock applica-

tions can unlock a locked application.  
Note: Automatic locking of all UserManagement using Bruker Daltonics applications 

will occur if one of these applications has not been used for a certain period 
defined by the UserManagement administrator. 

 
The command opens the DataAnalysis dialog which informs you that DataAnalysis 
has been locked, by which operator (displays the operator’s full name) and how it can 
be unlocked. Do the required entries to unlock the application. 
 

  
Figure 15-15 DataAnalysis dialog when DataAnalysis has been locked 

Operator 
Enter the operator ID of the operator who has locked DataAnalysis. The respective 
operator ID will automatically be entered if the UserManagement administrator has set 
the corresponding option. 
If not the previous operator but someone else wants to unlock the applications, enter 
the respective operator ID. 
Note: This respective operator must have the right to unlock applications. 
 

Password 
Enter the corresponding password. 
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Note: Passwords are case-sensitive. Successive wrong inputs will cause locking of 
the operator when the number of wrong login tries exceeds the number of 
wrong logins allowed by the UserManagement administrator. Only the User-
Management administrator can unlock a locked operator. 

Change Password 
Allows you to change your password before logging in. Opens the Change Password 
dialog. 

Log On 
If operator ID and password match, and the respective operator is allowed to unlock 
applications, it unlocks Bruker Daltonics applications and logs in the specified operator. 

Shortcuts 
Button:  

Keyboard: Ctrl+Alt+K 
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16 WINDOW MENU 

The Window menu offers the following commands: 

  
Figure 16-1 Window menu 

Command Used to … 

Survey View Show/Hide the Survey View window. 
Chromatogram Show/Hide the Chromatogram window. 
Spectrum View Show/Hide the Spectrum View window. 
Compound Spectra Show/Hide the Compound Spectra window. 
Work List Show/Hide the Work List window. 
Mass Spectrum Show/Hide the Mass Spectrum window. 
Analysis List Show/Hide the Analysis List window. 
Compound List Show/Hide the Compound List window. 
Spectrum Data Show/Hide the Spectrum Data window. 
Analysis Info Show/Hide the Analysis Info window. 
 
 
16.1 Survey View Command 

The Survey View command shows/hides the Survey View window.  

Shortcut 
Button:  
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16.2 Chromatogram Command 

The Chromatogram command shows/hides the Chromatogram window.  

Shortcut 
Button:  

 
 
16.3 Spectrum View Command 

The Spectrum View command shows/hides the Spectrum View window.  

Shortcut 
Button:  

 
 
16.4 Compound Spectra Command 

The Compound Spectra command shows/hides the Compound Spectra window.  

Shortcut 
Button:  

 
 
16.5 Work List Command 

The Work List command shows/hides the Work List window.  

Shortcut 
Button:  

 
 
16.6 Mass Spectrum Command 

The Mass Spectrum command shows/hides the Mass Spectrum window.  

Shortcut 
Button:  
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16.7 Analysis List Command 

The Analysis List command shows/hides the Analysis List window. 
 
 
16.8 Compound List Command 

The Compound List command shows/hides the Compound List window.  

Shortcuts 
Button:  
Keys: Ctrl+U 

 
 
16.9 Spectrum Data Command 

The Spectrum Data command shows/hides the Spectrum Data window. 

Shortcut 
Button:  
Keys: Ctrl+E 

 
 
16.10 Analysis Info Command 

The Analysis Info command shows/hides the Analysis Info window. 
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17 HELP MENU 

The Help menu offers the following commands: 

  
Figure 17-1 Help menu 

Command Used to … 

Help Topics Launch DataAnalysis Help. 
VBScript Language 

Reference 
Start Microsoft Windows Script Technologies which pro-
vides reference on VBScript Language. 

VBScript on the Web Pop up commands for launching the VB Script home page 
and installing applications via the internet. 

About Compass 
DataAnalysis 

Provide information about your present DataAnalysis copy. 

 
 
17.1 Help Topics Command 

The Help Topics command launches the DataAnalysis Help to get information about 
specific topics. DataAnalysis Help is used as other help applications running under 
Windows. 

Shortcuts 
Button:  
Key: F1 

 
 
17.2 VBScript Language Reference Command 
The VBScript Language Reference command is used to start the VBScript Language 
Reference application for help on VB scripting. The command starts the Microsoft 
Windows Script Technologies. It can be used like other help applications running under 
Windows. 
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17.3 VBScript on the Web Popup Command 
Pointing to this submenu pops up the following commands: 

 
Figure 17-2 VBScript on the Web popup command 

Command Used to … 

VBScript Home Page Load the VBScript home page. 
Install Microsoft 

ActiveX Control Pad 
Install the Microsoft ActiveX Control Pad via the internet. 

 
 
17.4 VBScript on the Web > VBScript Home Page 

Command 
The VBScript on the Web > VBScript Home Page command is used to visit the 
Microsoft VBScript home page to view actual information about VB scripting. The 
command loads the VBScript home page. 
Note: You computer must be connected to the internet to use this command. 
 
 
17.5 VBScript on the Web > Install Microsoft ActiveX 

Control Pad Command 
The VBScript on the Web > Install Microsoft ActiveX Control Pad command is used 
to install the Microsoft ActiveX Control Pad via the internet on your computer. This 
small freeware application contains the necessary modules for creating controls in the 
scripting dialog. This command should be used only if the ActiveX Control Pad is yet 
not installed. 
Note: You computer must be connected to the internet to use this command. 

The command loads the corresponding Microsoft web page for downloading the 
ActiveX Control Pad. Follow the instructions and select the folder that the setuppad.exe 
file should be saved in. Then execute this file to set up ActiveX Control Pad on your 
computer. 
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17.6 About Compass DataAnalysis Command 

The About Compass DataAnalysis command is used to display the version number 
of your present copy of DataAnalysis with the copyright notice, the user-specific license 
information, and contact information of Bruker Daltonik GmbH. The command opens 
the About Bruker Daltonics DataAnalysis dialog. 
Note: The build number of your DataAnalysis 4.0 software may differ from the build 

number given in the figure below. 
 

  
Figure 17-3 About Bruker Daltonics DataAnalysis dialog 

Shortcut 
Button:  
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Bruker Daltonik GmbH Context Menus 

DataAnalysis 4.0   Reference Manual   Revision 2  18-1

18 CONTEXT MENUS 

18.1 Survey View Window 

Right clicking in the Survey View window offers the following commands: 

  
Figure 18-1 Context menu of Survey View window 

Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Zoom In (Same as Zoom In command from View menu.) 
Set Display Range Set display range of the Chromatogram window. 
Properties (Same as Properties command from File menu.) 
 
 
18.2 Chromatogram Window 

Right clicking in the Chromatogram window offers the following commands: 
Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Zoom In (Same as Zoom In command from View menu.) 
Color (Same as Color command from Edit menu.) 
Edit Chromatograms (Same as Chromatograms command from Edit menu.) 
Add Total Ion 

Chromatogram 
Pop up commands for adding a Total Ion Chromatogram. 

Add Base Peak 
Chromatogram 

Pop up commands for adding a Base Peak Chromatogram. 

Integrate Only - 
Chromatogram 

(Same as Integrate Only - Chromatogram command from 
Find menu.) 

Find Compounds - 
Chromatogram 

(Same as Compounds - Chromatogram command from 
Find menu.) 
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Command Used to … 

Find Compounds - 
MS(n) 

(Same as Compounds - MS(n) command from Find 
menu.) 

Find Compounds - 
AutoMS(n) 

(Same as Compounds - AutoMS(n) command from Find 
menu.) 

Average Mass 
Spectrum 

(Same as Average Mass Spectrum command from 
Process menu.) 

Define Background 
Mass Spectra 

(Same as Define Background Mass Spectra command 
from Process menu.) 

Select Range/View 
Spectra 

(Same as Select Range/View Spectra command from Edit 
menu.) 

Range/Box 
Selection 

(Same as Range/Box Selection command from Edit 
menu.) 

Set Display Range Set display range of the Chromatogram window. 
Display Parameters (Same as Parameters - Display command from Method 

menu.) 
 

  
Figure 18-2 Context menu of Chromatogram window  
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18.3 Spectrum View Window 

Right clicking in the Spectrum View window offers the following commands: 

  
Figure 18-3 Context menu of Spectrum View window  

Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Zoom In (Same as Zoom In command from View menu.) 
Edit Chromatograms (Same as Chromatograms command from Edit menu.) 
Add Base Peak 

Chromatogram 
Create a Base Peak Chromatogram of the specified mass 
range. 

Add Extracted Ion 
Chromatogram 

Create an Extracted Ion Chromatogram trace of the speci-
fied mass range. 

Copy to Compound 
Spectra 

(Same as Copy to Compound Spectra command from 
Edit menu.) 

Copy to Compound 
Spectra and 
Identify 

Copy the mass spectrum displayed in the Spectrum View 
window to the Compound Spectra folder of the selected 
analysis and perform library search on it. 

Copy to Compound 
Spectra and 
Deconvolute 

Copy the mass spectrum displayed in the Spectrum View 
window to the Compound Spectra folder of the chromato-
gram analysis and charge deconvolute it. 

Copy to Work List Copy the selected spectrum to the Work List. 
Set Display Range Set display range of the Spectrum View window. 
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Command Used to … 

Display Parameters (Same as Parameters - Display command from Method 
menu.) 

Properties (Same as Properties command from File menu.) 
 
 
18.4 Compound Spectra Window 

Right clicking in the Compound Spectra window offers the following commands: 

  
Figure 18-4 Context menu of Compound Spectra window 

 
 
 
 



Bruker Daltonik GmbH Context Menus 

DataAnalysis 4.0   Reference Manual   Revision 2  18-5

Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Scale to Entire 

Spectrum 
Set the scales to full display of right-clicked mass spec-
trum. 

Zoom In (Same as Zoom In command from View menu.) 
Edit Chromatograms (Same as Chromatograms command from Edit menu.) 
Add Base Peak 

Chromatogram 
Create a Base Peak Chromatogram of the specified mass 
range. 

Add Extracted Ion 
Chromatogram 

Create an Extracted Ion Chromatogram trace of the 
specified mass range. 

Copy to Work List Copy the selected spectrum to the Work List. 
Find Mass List (Same as Find command from MassList menu.) 
Identify (Same as Mass Spectra command from Identify menu.) 
Add to Library (Same as Add to Library command from Identify menu.) 
Deconvolute (Same as Mass Spectra command from Deconvolute 

menu.) 
Show Spectrum in 

LibraryEditor 
(Same as Show Spectrum in LibraryEditor command 
from Identify menu.) 

Smooth (Same as Smooth Mass Spectrum command from 
Process menu.) 

Baseline Subtraction (Same as Subtract Mass Spectrum Baseline command 
from Process menu.) 

Subtract View Spec-
trum as Background 

(Same as Subtract View Spectrum as Background 
command from Process menu.) 

Set Display Range Set display range of Compound Spectra window. 
Range/Box Selection (Same as Range/Box Selection command from Edit 

menu.) 
Display Parameters (Same as Parameters - Display command from Method 

menu.) 
Properties (Same as Properties command from File menu.) 
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18.5 Mass Spectrum Window 

Right clicking in the Mass Spectrum window offers the following commands: 

  
Figure 18-5 Context menu of Mass Spectrum window (for List display) 

Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Scale to Entire 

Spectrum 
Adjust the scales of the Mass Spectrum window to display 
the entire spectrum (for List display only). 

Zoom In (Same as Zoom In command from View menu.) 
Color (Same as Color command from Edit menu.) 
Copy to Work List - not available for this window - 
Find Mass List (Same as Find command from MassList menu.) 
Identify (Same as Mass Spectra command from Identify menu.) 
Add to Library (Same as Add to Library command from Identify menu.) 
Show Spectrum in 

LibraryEditor 
(Same as Show Spectrum in LibraryEditor command 
from Identify menu.) 

Deconvolute (Same as Mass Spectra command from Deconvolute 
menu.) 
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Command Used to … 

Smooth  (Same as Smooth Mass Spectrum command from 
Process menu.) 

Baseline Subtraction (Same as Subtract Mass Spectrum Baseline command 
from Process menu.) 

Copy to Work List Copy the selected mass spectrum to the Work List. 
Set Display Range Set display range of the Mass Spectrum window. 
Range/Box Selection (Same as Range/Box Selection command from Edit 

menu.) 
Display Parameters (Same as Parameters - Display command from Method 

menu.) 
Properties (Same as Properties command from File menu.) 
 
 
18.6 Work List Window 

Right clicking in the Work List window offers the following commands: 

  
Figure 18-6 Context menu of Work List window 

Command Used to … 

Delete Delete selected spectrum from the Work List.  
Delete All Delete all spectra from the Work List. 

 
 
18.7 Scales 

Right clicking just left beside the ordinate of a data window offers the following com-
mands: 

          
Figure 18-7 Context menu of ordinate: Survey View window (left), Chromatogram 

window (middle), spectra displaying windows (right) 
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Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Linear/Logarithmic (Same as Linear/Logarithmic command from View menu.) 
Relative Intensity (Same as Relative Intensity command from View menu.) 
Set Display Range (Same as Set Display Range command from View menu.) 
Zoom In (Same as Zoom In command from View menu.) 
 

Right clicking in the intensity scale of the Survey View window offers the following 
commands: 

  
Figure 18-8 Context menu of intensity scale of Survey View window 

Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Linear/Logarithmic (Same as Linear/Logarithmic command from View menu.) 
 
Right clicking just below the abscissa of a data window (retention time or mass scale) 
offers the following commands: 

       
Figure 18-9 Context menu of abscissa: retention time scale (left), mass scale (right) 

Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Linked Scales Link horizontal scales (retention time scales or mass scales, 

respectively). 
Seconds (Minutes) Switch the retention time scale to displaying retention time in 

seconds (minutes). 
Set Display Range (Same as Set Display Range command from View menu.) 
Zoom In (Same as Zoom In command from View menu.) 
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18.8 Data Window Background 

Right clicking in the background of a data window offers the following commands; the 
commands available depend on the focused window:  

       
Figure 18-10 Context menu of data window background: Chromatogram/Survey View 

window (left) and mass spectra displaying windows (right) 

Command Used to … 

Auto-Scaling (Same as Auto-Scaling command from View menu.) 
Linear/Logarithmic (Same as Linear/Logarithmic command from View menu.) 
Relative Intensity (Same as Relative Intensity command from View menu.) 
Print Window Print the active data window using a predefined report 

layout. 
Copy (Same as Copy command from Edit menu.) 
Zoom In (Same as Zoom In command from View menu.) 
Range/Box 

Selection 
(Same as Range/Box Selection command from Edit 
menu.) 

 
 
18.9 Analysis List 

Right clicking in the Analysis List offers the following commands: 
Command Used to … 

Hide/Show Analysis (Same as Hide/Show Analysis command from Edit menu.) 
Disable/Enable (Same as Disable/Enable command from Edit menu.) 
Close (Same as Close command from File menu.) 
Result History (Same as Result History command from File menu.) 
Color (Same as Color command from Edit menu.) 
Copy (Same as Copy command from Edit menu.) 
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Command Used to … 

Paste (Same as Paste command from Edit menu.) 
Paste (Same as Paste popup command from Edit menu with 

additional command Paste > Calibration) 
Delete (Same as Delete command from Edit menu.) 
Expand Tree Expand the tree below the selected node. 
Collapse Tree Collapse the tree below the selected node. 
Collapse Analysis 

Tree 
Collapse the tree of the selected analysis. 

Properties (Same as Properties command from File menu.) 
 

  
Figure 18-11 Context menu of Analysis List 

 
 
18.10 Compound List 

Right clicking in the Compound List offers the following commands: 
Command Used to … 

Copy (Same as Copy command from Edit menu.) 
Delete (Same as Delete command from Edit menu.) 
Filter (Same as Filter command from Find menu.) 
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Command Used to … 

Resize Columns Resizes Compound List columns to full display of data. 
Layout Edit the layout of the Compound List. 
 

  
Figure 18-12 Context menu of Compound List 

 
 
18.11 Mass List 

Right clicking in the Mass List offers the following commands: 

  
Figure 18-13 Context menu of Mass List (for a profile spectrum being selected) 

Command Used to … 

Show Signal Show the selected mass peak in the center of the correspond-
ing data window. 

Always Show 
Signal 

Always show the selected mass peak in the center of the 
corresponding data window. 

Zoom Range Define the zoom range for the Show Signal and Always 
Show Signal commands. 
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Command Used to … 

Copy (Same as Copy command from Edit menu.) 
Delete (Same as Delete command from Edit menu.) 
Filter Filter the Mass List of the selected mass spectrum. 
Display Threshold Display in the Mass List tab of the Spectrum Data window only 

those line spectrum peaks that are more abundant than the 
specified intensity value. 

Calculate Delta m/z Calculate the delta m/z values between the highlighted Mass 
List peak and all other Mass List peaks. 

Add to Exclusion 
Masses 

Add the selected m/z value to exclusion masses. 

Layout Edit the layout of the Mass List. 
 
 
18.12 SmartFormula List 

Right clicking in the SmartFormula List offers the following commands: 

  
Figure 18-14 Context menu of SmartFormula List 

Command Used to … 

Show Signal Show the signal for the selected measured m/z value in the 
center of the corresponding data window. 

Always Show Signal Always show the signal for the selected measured m/z value 
in the center of the corresponding data window. 

Copy (Same as Copy command from Edit menu.) 
Copy Formula Copy the selected molecular formula to the clipboard. 
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Command Used to … 

Delete Delete the selected measured m/z value and corresponding 
data from the SmartFormula List. 

Add Annotation Annotate the peak in the active mass spectrum whose 
measured m/z value corresponds to the selected molecular 
formula with that formula. 

Add Simulated 
Pattern 

Add the simulated theoretical isotopic pattern spectrum for 
the selected molecular formula. 

Export Data for 
Van Krevelen Plot 

Export SmartFormula data to support a Van Krevelen Plot. 

Layout Edit the layout of the SmartFormula List. 
 
 
18.13 Manual SmartFormula List 

Right clicking in the Manual SmartFormula List offers the following commands: 

 
Figure 18-15 Context menu of Manual SmartFormula List 

Command Used to … 

Copy To Upper 
Formula 

Copy the selected formula to the Max formula box of the 
dialog. 

Copy To Clipboard Copy the selected formula to the clipboard. 
Copy To Spectrum 

Annotation 
Annotate the selected peak in the active mass spectrum with 
the selected formula. 

Delete Formula Delete the selected formula from the list. 
Layout Edit the layout of the SmartFormula List. 
 



Context Menus Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 18-14 

18.14 SmartFormula3D Lists 

Right clicking on an entry in the SmartFormula3D fragment spectrum peak list, the pre-
cursor ion formula list or the fragment ions formula list offers the following commands: 
 

 
Figure 18-16 Context menu of SmartFormula3D fragment spectrum peak list 

Command Used to … 

Show Signal Show the signal for the m/z value selected in the fragment 
spectrum peak list in the center of the Compound Spectra 
window. 

Check None Uncheck all checked m/z values in the fragment spectrum 
peak list. 

Manually Generate possible molecular formulae for a selected m/z 
value in the fragment spectrum peak list using SmartFormula 
Manually. 

 

 
Figure 18-17 Context menu of SmartFormula3D precursor ion formula list 

Command Used to … 

Delete Unchecked Delete all unchecked sum formulae from the precursor ion 
formula list. 

Check All Check all sum formulae in the precursor ion formula list. 
Check None Uncheck all checked sum formulae in the precursor ion 

formula list. 
Copy to 

SmartFormula List 
Copy the selected precursor ion formula and its correspond-
ing fragment ions formulae to the SmartFormula List of the 
fragment spectrum. 

Neutral Losses  Annotate the fragment spectrum with selected neutral 
loss(es). 
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Figure 18-18 Context menu of SmartFormula3D fragment ions formula list 

Command Used to … 

Show Signal Show the signal corresponding to the sum formula selected in 
the fragment ions formula list in the center of the Compound 
Spectra window. 

Check All Check all sum formulae in the fragment ions formula list. 
Check None Uncheck all checked sum formulae in the fragment ions 

formula list. 
 
 
18.15 Commands Accessible from Context Menus 

Only 

Some DataAnalysis commands are accessible from context menus only. These com-
mands are described in the following in alphabetical order. 
 
 
18.15.1 Add Annotation Command 

The Add Annotation command annotates that peak in the active mass spectrum 
whose measured m/z value corresponds to the molecular formula selected in the 
SmartFormula tab of the Spectrum Data window with the respective formula. All added 
formula annotations can be cleared at once using the Clear All command from the 
Annotation menu. To clear only a single of several annotations you have to use the 
Annotate command. 
 
 
18.15.2 Add Base Peak Chromatogram Command 

The Add Base Peak Chromatogram command is used to add a Base Peak 
Chromatogram for the selected analysis. This BPC trace is calculated based on the MS 
type and polarity of mass spectrum currently selected in the Spectrum View window or 
Compound Spectra window and the selected mass or mass range. If a single mass is 
selected, a BPC trace of the selected m/z ±0.5 Da is calculated.  
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Before selecting this command, you have to select in the Spectrum View window or 
Compound Spectra window the mass spectrum and the mass or mass range based on 
which you want to create a BCP trace.  
The command calculates the corresponding BPC trace and adds it to the analysis' 
Chromatograms folder. The software sets the display color, but you can change it 
afterwards. 
 

  
Figure 18-19 Added Base Peak Chromatogram (BPC), which was calculated based on 

the MS type and polarity of the mass spectrum displayed in the Spectrum 
View window and the selected m/z value 

 
 
18.15.3 Add Base Peak Chromatogram > All (MS and MSn) 

Command 

The Add Base Peak Chromatogram > All (MS and MSn) command is used to add a 
Base Peak Chromatogram for the selected analysis. This BPC trace is calculated from 
all MS and MS(n) spectra acquired in full mass range. 
The command calculates the corresponding 'BPC, "acquired mass range", All, ±' trace 
using the respective default settings of the Edit Chromatogram Traces dialog and 
adds it to the analysis' Chromatograms folder. The software sets the display color, but 
you can change it afterwards. 
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18.15.4 Add Base Peak Chromatogram > All MS Command 

The Add Base Peak Chromatogram > All MS command is used to add a Base Peak 
Chromatogram for the selected analysis. This BPC trace is calculated from all MS 
spectra acquired in full mass range. 
The command calculates the corresponding 'BPC, "acquired mass range", All MS, ±' 
trace using the respective default settings of the Edit Chromatogram Traces dialog 
and adds it to the analysis' Chromatograms folder. The software sets the display color, 
but you can change it afterwards. 
 
 
18.15.5 Add Base Peak Chromatogram > All MSn Command 

The Add Base Peak Chromatogram > All MSn command is used to add a Base Peak 
Chromatogram for the selected analysis. This BPC trace is calculated from all MS(n) 
spectra acquired in full mass range. 
The command calculates the corresponding 'BPC, "acquired mass range", All MSn, ±' 
trace using the respective default settings of the Edit Chromatogram Traces dialog 
and adds it to the analysis' Chromatograms folder, provided the respective analysis 
contains MS/MS data. The software sets the display color, but you can change it 
afterwards. 
 
 
18.15.6 Add Extracted Ion Chromatogram Command 

The Add Extracted Ion Chromatogram command is used to add an Extracted Ion 
Chromatogram for the selected analysis. This EIC trace is calculated based on the MS 
type and polarity of the mass spectrum selected in the Mass Spectrum View or 
Compound Spectra window and the selected mass or mass range. If a single mass is 
selected, an EIC trace of the selected m/z ±0.5 Da is calculated. 
Before selecting this command you have to select in the Spectrum View window or 
Compound Spectra window the mass spectrum and the mass or mass range based on 
which you want to create an EIC trace. 
The command calculates the corresponding EIC trace and adds it to the analysis' 
Chromatograms folder. The software sets the display color, but you can change it 
afterwards. 
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18.15.7 Add Simulated Pattern Command 

The Add Simulated Pattern command creates the theoretical isotopic pattern spec-
trum for the molecular formula selected in the SmartFormula tab of the Spectrum Data 
window. The simulated pattern spectrum is added in the Analysis List as a subentry of 
the active mass spectrum referenced by the respective molecular formula and its 
corresponding m/z value. 
 
 
18.15.8 Add to Exclusion Masses Command 

The Add to Exclusion Masses command adds the m/z value selected in the Mass List 
to the exclusion masses of the active analysis. The m/z value is entered in the 
exclusion masses list found in the Exclusion Masses tab of the Method Parameters 
dialog as a mass range (current m/z ± 0.2) by default. Using multiple selections, you 
can add several masses at once. If desired you can change the range afterwards. The 
command applies to profile spectra only. 
 

 
Figure 18-20 Added Extracted Ion Chromatogram (EIC), which was calculated based on 

the MS type and polarity of the mass spectrum displayed in the Spectrum 
View window and the selected m/z value 
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18.15.9 Add Total Ion Chromatogram > All (MS and MSn) 
Command 

The Add Total Ion Chromatogram > All (MS and MSn) command is used to add a 
Total Ion Chromatogram for the selected analysis. This TIC trace includes data from all 
MS and MS(n) spectra acquired. This may be required if the default TIC trace has been 
deleted. 
The command calculates the corresponding 'TIC, All, ±' trace using the respective 
default settings of the Edit Chromatogram Traces dialog and adds it to the analysis' 
Chromatograms folder. The software sets the display color, but you can change it 
afterwards. 
 
 
18.15.10 Add Total Ion Chromatogram > All MS Command 

The Add Total Ion Chromatogram > All MS command is used to add a Total Ion 
Chromatogram for the selected analysis. This TIC trace is calculated from all MS 
spectra acquired. 
The command calculates the corresponding 'TIC, All MS, ±' trace using the respective 
default settings of the Edit Chromatogram Traces dialog and adds it to the analysis' 
Chromatograms folder. The software sets the display color, but you can change it 
afterwards. 
 
 
18.15.11 Add Total Ion Chromatogram > All MSn Command 

The Add Total Ion Chromatogram > All MSn command is used to add a Total Ion 
Chromatogram for the selected analysis. This TIC trace is calculated from all MS(n) 
spectra acquired. 
The command calculates the corresponding 'TIC, All MSn, ±' trace using the respective 
default settings of the Edit Chromatogram Traces dialog and adds it to the analysis' 
Chromatograms folder provided the respective analysis contains MS/MS data. The 
software sets the display color, but you can change it afterwards. 
 
 
18.15.12 Always Show Signal Command 

The Always Show Signal command activates/deactivates the Always Show Signal 
mode. When this mode is active, the peak which is currently selected in the Mass List 
tab resp. the SmartFormula tab of the Spectrum Data window is displayed centered 
and enlarged in the corresponding data window (Compound Spectra window or Mass 
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Spectrum window). The display range is adjusted automatically when another mass 
peak is selected. The zoom range to display can be specified using the Zoom Range 
command from the Mass List resp. SmartFormula List context menu. 
 
 
18.15.13 Calculate Delta m/z Command 

The Calculate Delta m/z command calculates for the selected mass spectrum the 
delta m/z values between the selected Mass List peak and all other peaks contained in 
the respective Mass List. The delta m/z values are entered as negative or positive 
values in the Mass List's d (m/z) column. To view the results, the Mass List layout must 
contain the Delta (m/z) item, which is abbreviated as d (m/z) in the Mass List tab of the 
Spectrum Data window. If this column is currently not present, you first have to edit the 
Mass List layout to add it. 

 
Figure 18-21 Selecting a mass peak (here the base peak) for which delta m/z values 

should be calculated 

  
Figure 18-22 Delta m/z values calculated for the base peak 
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18.15.14 Check All Command 

The Check All command checks all sum formulae in the right-clicked list, Precursor Ion 
Formula List or Fragment Ion Formula List, respectively. 
 
 
18.15.15 Check None Command 

The Check None command unchecks all checked sum formulae in the right-clicked 
list, Precursor Ion Formula List or Fragment Ion Formula List, respectively. 
 
 
18.15.16 Collapse Analysis Tree Command 

The Collapse Analysis Tree command collapses the tree of the selected analysis.  

Shortcut 
Keys: Ctrl+Shift+Num- 

 
 
18.15.17 Collapse Tree Command 

The Collapse Tree command collapses the tree below the selected node. 

Shortcut 
Keys: Ctrl+Num- 

 
 
18.15.18 Copy Formula Command 

The Copy Formula command copies the molecular formula selected in the SmartFor-
mula tab of the Spectrum Data window to the clipboard. This allows pasting the formula 
into an appropriate application. 
 
 
18.15.19 Copy To Clipboard Command 

The Copy To Clipboard command copies the formula selected in the Manual 
SmartFormula List to the clipboard. This allows pasting the formula into an appropriate 
application. 
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18.15.20 Copy to Compound Spectra and Deconvolute 
Command 

The Copy to Compound Spectra and Deconvolute command is used to copy the 
single measured or averaged mass spectrum selected in the Spectrum View window to 
the Compound Spectra folder of the active chromatogram analysis with automatically 
performing a charge deconvolution operation on it. 
The command copies the selected spectrum, enters it at the bottom of the analysis’ 
Compound Spectra folder and Compound List and automatically performs charge 
deconvolution operation on it. Depending on the deconvolution type selected in the 
open processing method (Maximum Entropy, Proteins/large molecules or Peptides/ 
small molecules deconvolution), the deconvolution procedure uses the parameter 
settings defined in either the Charge Deconvolution - Maximum Entropy tab, or the -
 Proteins/Large Molecules and - General tabs or the - Peptides/Small Molecules 
and - General tabs of the Method Parameters dialog. 
If charge deconvolution was successful, the results that are calculated and entered for 
the copied spectrum in the Analysis List depend on the selected deconvolution type 
and its corresponding settings. For reference on charge deconvolution results please 
refer to the Mass Spectra command from the Deconvolute menu. 

Shortcut 
Button:   

 

18.15.21 Copy to Compound Spectra and Identify Command 

The Copy to Compound Spectra and Identify command is used to copy the single 
measured or averaged mass spectrum selected in the Spectrum View window to the 
Compound Spectra folder of the active chromatogram analysis with automatically 
performing a library search on it. 
The command copies the selected mass spectrum, enters it at the bottom of the analy-
sis’ Compound Spectra folder and Compound List and automatically performs a library 
search on it according to the Library Search - Libraries, - Settings, - Retention 
Time, - Parameter Matching, - Add and - Advanced parameter settings defined in the 
Method Parameters dialog.  
If library search was successful, the library spectrum/spectra found to meet the mass 
spectrum is/are entered along with corresponding information in the Analysis List as a 
subfolder of the copied spectrum. For reference on library search results please refer to 
the Mass Spectra command from the Identify menu. 

Shortcut 
Button:  



Bruker Daltonik GmbH Context Menus 

DataAnalysis 4.0   Reference Manual   Revision 2  18-23

18.15.22 Copy To SmartFormula List Command 

The Copy to SmartFormula List command copies the selected precursor ion formula 
and its corresponding fragment ion formulae to the SmartFormula List of the MS/MS 
spectrum. This list displays in the SmartFormula tab of the Spectrum Data window 
when the MS/MS spectrum is selected and allows viewing additional data on the 
calculated precursor and fragment ion formulae. The formulae are listed with increasing 
measured m/z value. This data will be saved to the MS/MS spectrum when the analysis 
is saved. 
 

 
Figure 18-23 SmartFormula List showing a copied SmartFormula3D precursor ion 

formula (bottom entry) and the corresponding product ion formulae 
(entries above) 

 
 
18.15.23 Copy To Spectrum Annotation Command 

The Copy To Spectrum Annotation command annotates the selected peak in the 
active mass spectrum with the molecular formula selected in the Manual SmartFormula 
List. All added formula annotations can be cleared at once using the Clear All 
command from the Annotation menu. To clear only a single of several annotations you 
have to use the Annotate command. 
 
 
18.15.24 Copy To Upper Formula Command 

The Copy To Upper Formula command copies the molecular formula selected in the 
Manual SmartFormula List to the SmartFormula Manually dialog's Max entry box. 
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18.15.25 Delete Command (Work List) 

The Delete command deletes the selected spectrum from the Work List. 
 
 
18.15.26 Delete All Command 

The Delete All command deletes all spectra from the Work List. 
 
 
18.15.27 Delete Formula Command 

The Delete Formula command deletes the selected formula from the Manual Smart-
Formula List. 
 
 
18.15.28 Delete Unchecked Command 

The Delete Unchecked command deletes all currently unchecked sum formulae from 
the right-clicked list, Precursor Ion Formula List or Product Ion Formula List, 
respectively. 
 
 
18.15.29 Display Parameters Command 

The Display Parameters command is used to set the numeric precision of retention 
time and/or m/z values and the labeling of chromatogram peaks. The command opens 
the Display tab of the Method Parameters dialog.  
 
 
18.15.30 Display Threshold Command 

The Display Threshold command is used to display in the Mass List tab of the 
Spectrum Data window only those peaks of a selected line spectrum that are more 
abundant than the specified intensity value. The current display threshold is displayed 
at the bottom of the Mass List tab. This command applies to the automatically set up 
line spectrum Mass Lists only but not to the line spectrum Mass Lists set up with the 
SNAP2 peak finder. It does not alter the Mass List at all but only reduces or increases 
the number of peaks currently displayed.  
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The command opens the Mass List Display Threshold dialog which allows you to 
specify the intensity threshold that a line spectrum peak must exceed to be displayed in 
the Mass List. 

  
Figure 18-24 Mass List Display Threshold dialog 

Display only signals more abundant than 
Enter the minimum intensity a signal must exceed to be displayed in the Mass List for a 
line spectrum. By default, the intensity value of the selected Mass List peak is sug-
gested. You can use this value or enter a desired one. 

OK 
Changes the peaks displayed in the Mass List tab according to the new intensity 
threshold setting. It hides all peaks that do not exceed the specified intensity value.  
 
 
18.15.31 Expand Tree Command 

The Expand Tree command expands the tree below the selected node.  

Shortcut 
Keys: Ctrl+Num+ 

 
 
18.15.32 Export Data for Van Krevelen Plot Command 

The Export Data for Van Krevelen Plot command exports specific data of the 
SmartFormula List of the selected mass spectrum to support a Van Krevelen Plot. The 
data is exported to Van Krevelen Plot Data format (*.csv). The exported file contains all 
measured m/z values currently in the SmartFormula List with their corresponding 
intensities and calculated molecular formulae. For each formula, the theoretical m/z 
value and elemental composition as well as the mSigma value are included. 
The command opens the Export Data for Van Krevelen Plot dialog to specify the 
name and target folder of the export file. Clicking Save exports the data accordingly. 
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18.15.33 Filter Command 

The Filter command is used to filter the current Mass List of the selected mass 
spectrum to reduce the number of peaks contained. A Mass List can be filtered to 
display either a specified number of most intense peaks or peaks exceeding a specified 
intensity threshold. You can filter only Mass Lists of profile spectra and of line spectra 
that were set up using the SNAP2 peak finder; the automatically set up line spectrum 
Mass Lists cannot be filtered. 
The command opens the Mass List Filter dialog which allows you to select the filter 
criterion and set the corresponding value as shown below. 

  
Figure 18-25 Mass List Filter dialog 

In Filter options, define how to filter the Mass List: 

Delete peaks with intensity lower than 
Check this option to delete all masses from the Mass List that have intensities below 
the specified threshold. By default, the intensity value of the currently selected Mass 
List peak is suggested. You can use this value or enter a desired threshold.  

Leave N most abundant peaks 
(Default) Check this option to reduce the Mass List to the specified number of most 
abundant masses. By default, the number of peaks that exceed the intensity value of 
the currently selected Mass List peak is suggested. You can use this value or enter a 
desired one. 

OK 
Filters the Mass List according to the currently defined criterion.  
 
 
18.15.34 Layout Command 

The Layout command is used to edit the layout of the Compound List, Mass List or 
(Manual) SmartFormula List. Depending on the list the command was launched from it 
opens either the Layouts - Compound List Layout, - Mass List Layout or - Smart-
Formula List Layout tab of the Method Parameters dialog. Changing the layout items 
to display and clicking OK or Apply immediately updates the current list accordingly. 
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18.15.35 Linked Scales Command 

The Linked Scales command toggles between linked and unlinked horizontal scales. 
The retention time scales of the Survey View and Chromatogram windows are linked 
by default as well as the m/z resp. wavelength scales of the spectra displaying 
windows. Linked scales means that if you change one of the linked scales the other 
scale(s) will automatically be changed accordingly. If the retention time scales or the 
m/z resp. wavelength scales are not linked, the scales can be changed individually. 

Alternatively, you can use the Linked Scales button  found in the lower left corner of 
each data window or the respective toolbar button to link (pressed state) or unlink 
(released state) scales. 

Shortcut 
Button:  (Linked Retention Time Scales) 

  (Linked Mass Scales) 
 
 
18.15.36 Minutes Command 

The Minutes command switches the retention time scale of the Chromatogram 
window to displaying the retention time in minutes. 
 
 
18.15.37 Manually Command 

The Manually command generates possible molecular formulae for the m/z value 
selected in the SmartFormula3D fragment spectrum peak list and displays the result in 
the SmartFormula Manually dialog. Initial calculation is based on the settings current-
ly defined in the Chemistry - SmartFormula tab of the Method Parameters dialog. 
You can modify the current SmartFormula Manually parameters, if desired, and repeat 
formula calculation. For reference on SmartFormula Manually and the results obtained 
please refer to the description of the SmartFormula Manually command (Chemistry 
menu). 
Note: Changing values in the SmartFormula Manually dialog will not change the 

values in the method.  
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Figure 18-26 SmartFormula Manually dialog showing the result of generating possible 
molecular formulae for a selected m/z value in the SmartFormula3D frag-
ment spectrum peak list 

 
 
18.15.38 Neutral Losses Command 

The Neutral Losses command lists for the selected precursor ion formula all neutral 
losses that exist between the precursor ion formula and the corresponding fragment ion 
formulae as well as between all the individual fragment ion formulae. This list can be 
used to annotate the fragment spectrum with selected particular neutral losses. 
The Neutral Losses command also allows a comprehensive viewing of all neutral 
losses calculated for the differences of involved precursor ion and fragment ion formu-
lae. The SmartFormula3D dialog shows, by default, only the differences between the 
selected precursor ion formula and the fragment ion formulae which are listed in the 
SumFormula Loss column of the Fragment Ion Formula List. When selecting a formu-
la in the Fragment Ion Formula List, the dialog also shows in the Delta SF column for 
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each fragment ion formula the difference between the respective fragment ion formula 
and the currently selected fragment ion formula provided the respective difference can 
be explained by a particular neutral loss. The Neutral Losses command gives you the 
advantage of including neutral loss information of all possible fragment selections into 
one single list which you can view and, if desired, resort. 
 

  
Figure 18-27 Neutral Losses dialog for the selected precursor ion formula; the figure 

also shows for a selected fragment ion formula the neutral losses 
compared to the other fragment ion formulae and the sum formulae found 
to explain the respective losses (Delta SF column) 

The Neutral Losses dialog includes the following data: 
Column Description 
Neutral Loss Sum formula of the neutral loss for the given educt (precursor ion 

resp. fragment ion formula) and product (fragment ion formula). 
Mass[Da] Mass of the neutral loss in [Da]. 
Err[mDa] Deviation of the mass of the neutral loss from the m/z difference 

between educt and product in [mDa]. 
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Column Description 
Educt Sum formula of the educt. 
m/z m/z value of the educt. 
I Intensity of educt peak. 
Product Sum formula of the product. 
m/z m/z value of the product. 
I Intensity of the product peak. 
 
To easier deal with this list you can define how many fragments should be concerned 
in neutral loss calculation using the parameter Use n most abundant ion clusters.  
To annotate the fragment spectrum with one or several neutral losses, check the check 
box(es) of the respective neutral loss(es) and click Add Annotation. To annotate 
overlapping m/z ranges without overwriting annotations you can set the height of 
annotation; however, annotating with different heights requires separate annotating 
operations. You can modify or delete single neutral loss annotations you attached to 
the fragment spectrum when the Annotation mode is active (Annotate command from 
the Annotation menu) and clear all annotations via the Clear All command. 

  
Figure 18-28 Example of annotating a fragment spectrum with two selected neutral 

losses  
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18.15.39 Paste > Calibration Command 

The Paste > Calibration command pastes the calibration coefficients contained on the 
clipboard into the selected analysis. This automatically calibrates the analysis based on 
the pasted calibration coefficients. 
Before selecting this command, you have to select the analysis whose calibration 
coefficients you want to copy and copy it to the clipboard using the Copy command 
from the Edit menu or the Analysis List context menu. Then select the analysis the 
copied calibration coefficients should be pasted in. 
 
 
18.15.40 Print Window Command 

The Print Window command prints the active window (view) using a predefined report 
layout. 

Shortcut 
Button:  

 
 
18.15.41 Resize Columns Command 

The Resize Columns command resizes the Compound List columns currently dis-
played in the Compound List window. This results in the width of the individual columns 
being adjusted to full and optimal display of all data currently to be shown. Resizing of 
columns may be needed since Compound List columns, in contrast to Mass List 
columns, are not adjusted automatically to full display of current data. This is because 
the amount of data to be displayed in certain columns can largely differ between 
different analyses.  

 
Figure 18-29 Compound List before resizing columns 



Context Menus Bruker Daltonik GmbH 

 DataAnalysis 4.0   Reference Manual   Revision 2 18-32 

 
Figure 18-30 Compound List after resizing columns 
 
 
18.15.42 Scale to Entire Spectrum Command 

Note: For the Mass Spectrum window, the Scale to Entire Spectrum command is 
only available in List display. 

The Scale to Entire Spectrum command adjusts the m/z scale of the active data 
window (Compound Spectra window or Mass Spectrum window) to display the entire 
spectrum in the right-clicked list window. Depending on the current state of the 
window's Individual Axes option the display range of the spectra in the other list 
windows is adjusted accordingly (option not checked) or remains unchanged (option 
checked). 

Shortcut 
Keys: Shift+F9 

 
 
18.15.43 Seconds Command 

The Seconds command switches the retention time scale of the Chromatogram 
window to displaying the retention time in seconds. 
 
 
18.15.44 Set Display Range Command 

The Set Display Range command is used to displace, increase or decrease the 
display range of the Chromatogram window, Spectrum View window, Compound Spec-
tra window or Mass Spectrum window. The command opens the Set Display Range 
dialog to set the display range and the type of the intensity scale. 
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Figure 18-31 Set Display Range dialog (when the Chromatogram window is active) 

Retention Time [current unit] or Mass [m/z] 
Enter the start (left box) and end (right box) values for the retention time or mass range 
you want to display in the active data window. To enter values, Auto-scaling must be 
unchecked. Otherwise, these boxes are disabled. 

Intensity 
Enter the start (left box) and end (right box) values for the intensity range you want to 
display in the active data window. To enter values, Auto-scaling must be unchecked. 
Otherwise, these boxes are disabled. 

Auto-scaling 
Check this option to set the display range of the corresponding axis to auto-scale. 
Uncheck this option to specify a display range. 

 Linear/logarithmic intensity scale 
Click this button to toggle the ordinate of the Chromatogram window between linear or 
logarithmic scaling. When the button is depressed, the logarithmic scale is displayed. 
When the button is not depressed, a linear scale is displayed. 
Note: This button is only enabled when the Chromatogram window is active. If one of 

the other data windows is currently active, this button is disabled. 

OK 
Changes the display range of the active data window according to the specified 
settings.  
 
 
18.15.45 Show Signal Command 

The Show Signal command shows a selected signal centered and enlarged in the 
corresponding data window (Compound Spectra or Mass Spectrum window). The 
command applies to peaks selected in the Mass List tab or SmartFormula tab of the 
Spectrum Data window. It also applies to peaks selected in the fragment spectrum 
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peak list of the SmartFormula3D dialog and to sum formulae selected in the precursor 
ion formula list of the dialog.  
The zoom range to display can be specified using the Zoom Range command from the 
Mass List resp. the SmartFormula List context menu. 
Tip: Alternatively to using the Show Signal command you can just double-click on a 

peak resp. sum formula in the respective list to zoom in the corresponding peak 
in the data window. 

Tip: If you wish to show the peak selected in the Mass List resp. the SmartFormula 
List always in this way, activate the Always Show Signal mode by selecting the 
Always Show Signal command from the Mass List resp. the SmartFormula List 
context menu. 

 
 
18.15.46 Zoom Range Command 

The Zoom Range command is used to specify the zoom range for the Show Signal 
and Always Show Signal commands. The zoom range can be adjusted automatically 
according to the peak width of the peak to show or you can specify a fixed zoom range. 
The command opens the Zoom Range dialog to define the zoom range. 

  
Figure 18-32 Zoom Range dialog 

Zoom range for 'Show Signal': (m/z) 
Select 'Auto' to adjust the zoom range automatically according to the peak width of the 
peak to show or enter a value if you want to specify a fixed zoom range. If you enter a 
value, the specified m/z range is added before and after the m/z value of the selected 
peak resulting in a displayed zoom range of twice the entered value. Default is 'Auto'. 
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